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			Welcome	to	TrainPlayer

TrainPlayer	simulates	operating	a	model	railroad	layout	on	the	computer.		It	is	designed	for	all
types	of	model	railroad	fan,	from	the	one	who	has	built	a	railroad	empire	in	the	basement,	to
the	one	who	dreams	of	doing	so,	to	the	one	who	never	will,	but	just	likes	to	run	trains.

Opening	a	layout	file	in	TrainPlayer	is	like	walking	into	a	room	and	finding	a	fully-built	model
railroad	with	clean	tracks,	attractive	scenery,	a	couple	of	trains,	and	a	control	panel	sitting	in
the	corner.		You	nudge	the	speed	dial	and	one	of	the	trains	starts	to	move.		You	form	a	smile
and	crank	up	the	speed.		Welcome	to	TrainPlayer.

TrainPlayer	works	with	pictures	of	track	plans	which	have	been	specially	prepared	by	the
addition	of	electronic	tracks.		The	pictures	might	be	renderings	by	Kalmbach	artists,	or	digital
output	from	your	favorite	CAD	program,	or	scanned-in	drawings	made	with	pencil	and	paper.		A
set	of	features	known	as	TrackLayer	--	described	in	the	second	half	of	this	manual	--	is	used
to	apply	the	track,	switches,	and	turntables.		In	TrainPlayer,	you	add	trains,	cars,	and	stations,
and	you're	ready	to	run.
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What's	New	in	Version	8.2

Version	8.2	delivers	a	new	user	interface	based	on	an	improved	system	of	toolbars	along	with
some	new	components.	For	a	detailed	description	in	a	web-based	PDF	file,	see	A	New	Style
for	the	TrainPlayer	User	Interface.

8.2	features	include:

Dynamic	Toolbars	--	revamped	toolbars	with	labels	and	new	icons,	context-sensitive,
customizable,	easy	to	follow
New	TrainPlayer	Toolbar	Reference	--	handy	guide	to	the	new	toolbar	buttons
Tabbed	documents	--	easier	working	with	multiple	layouts	open
Quick	Access	Toolbar	--	handy	small	set	of	selected	tools	embedded	in	the	window	frame
Scripting	enhancements:	new	functions,	improved	working	of	rewinds
Easier	scenery	styling	using	the	Painter/Dropper	tool
AnyRail	import	improvements:	now	imports	working	transfer	tables
Paint	Shop	improvements:	new	wireframe	decal	for	painting	Pedersen	cars;	new	shaded-
cylinder	decal
Updated	framework	library,	provides	new	app	styles	and	other	enhancements
Other	fixes	as	listed	in	TrainPlayer	Version	History.

https://www.trainplayer.com/Goods/TPnewstyle.pdf
https://trainplayer.com/Features/version_history.htm


in	Version	8.1

The	major	effort	in	8.1	went	to	the	Linked	Layouts	feature,	which	was	overhauled,	expanded,
and	improved.		For	complete	details	about	this	feature	and	related	changes	in	8.1,	including	tips
for	multi-layout	scripting,	see	the	new	web	PDF	document	Introduction	to	Linked	Layouts.

Here	is	the	list	of	8.1	enhancements	documented	in	this	manual:

Overhaul	of	linking	features:	see	Linked	Layouts
Improved	Layout	Link	dialog,	now	accessible	from	Track	Properties
New	property	LayoutID.		See	Layout	Properties
Scripting	enhancements:	multi-layout	scripting	(detailed	in	PDF	linked	above);	two
commands	now	take	arguments	(File	Open,	File	Save	As)	--	see	Script	Menu	Commands
Multi-document	handling:	File	Save	All,	Stop	All	Scripts,	File	Open	<multiple>
Turntable	rotation	now	allows	overhang	--	see	Operating	a	Turntable
Fixes	in	Track	Check	dialog	--	better	sizing,	zooming	to	error	region
New	car-top	display	of	numeric	ids	--	see	Car	IDs
New	arguments	for	script	functions	($car,	$train,	$layout)	--	see	TPL	Reference

https://trainplayer.com/Features/Version81/LinkedLayouts.pdf


in	Version	8.0

Paint	Shop!	a	new	facility	for	decorating	your	cars	and	engines	with	paint	and	decals.		For
overview,	see	Decorating	Cars.		For	usage	info,	see	Paint	Shop.
New,	improved	Color	Chooser.
Improvements	in	Map	View:	new	markers	for	layout	links;	adjustable	marker	colors.
Links	are	now	displayed	as	special	labels	with	adjustable	font	on	the	layout;	see	Linked
Layouts.
New	collision	mode:	dead	stop.		See	Operation	Preferences.
New	choice	to	show	or	hide	Status	Bar	in	Full	Screen	View.
Various	fixes,	speed	improvements,	enhancements	all	over.		Complete	list	is	at	TrainPlayer
Version	History.

https://trainplayer.com/Features/version_history.htm


in	Version	7.2

Digital	clock	--	we	finally	did	some	modernizing	of	this	device
Route	Finder	improvements	--	now	faster	and	more	useful,	can	now	throw	switches	along
route
Advances	in	Advanced	Ops	--	more	flexible	dispatching,	multiple	start	/	finish	locations
All-new	AO	documentation,	dozens	of	new	ready-to-operate	layouts
Modifiable	font	for	loads	--	see	Text	Loads	Style
Switchlist	Robot:	complete	the	deliveries	in	your	AO	session	with	one	click
1:1	Scale	--	now	simulate	a	full-size	model
Track	capacity	calculator,	available	via	new	script	function	$CAPAC	
Many	tweaks	and	fixes	throughout



What	For?

Q:		Is	there	any	point	to	moving	little	make-believe	trains	around	an	image	of	a	model
pretending	to	be	a	railroad?

A:	Sure.

Explore	layout	designs.		When	you're	thinking	about	designing	a	railroad,	there	is	nothing
handier	than	a	book	of	track	plans.		Well-designed	plans	give	you	ideas	about	how
different	track	configurations	might	work	with	your	theme	and	fit	in	the	space	you	have.	
Attractive	artwork	inspires	you	to	think	about	the	terrain	and	the	scenery.		TrainPlayer
brings	you	some	great	track	plans	to	browse,	appreciate,	and	try.
	
Develop	operating	plans.		If	you	had	an	operating	railroad	and	an	unlimited	supply	of
rolling	stock,	how	would	you	go	about	running	it?		You	need	to	figure	out	how	to	deliver
goods	and	passengers	for	your	customers,	what	cars	you	need	to	run	on	what	schedule,
how	to	avoid	delaying	the	express	while	the	local	is	tying	up	the	main	line.		With
TrainPlayer,	you	can	develop	timetables	and	schedules	by	driving	the	layout	and	letting	the
program	keep	track	of	times	and	distances.
	
Test	your	equipment.		Do	you	already	have	a	collection	of	cars?		Customize	the	ones	in
the	program	so	they	match	yours,	and	see	if	your	86-foot	flatcars	look	realistic	going
around	the	16-inch	curves	on	your	target	plan.
	
Learn	train	moves.		It	isn't	obvious	how	to	shuffle	a	dense	yard	of	cars	when	you	have	a
schedule	to	meet.		With	TrainPlayer,	you	can	learn	by	practicing.		Figure	out	how	to
classify	cars	so	they're	on	the	right	tracks	at	the	right	time.		Learn	to	minimize	the	number
of	moves	it	takes.		Try	your	hand	at	a	switching	puzzle.
	
Teach	train	moves.		If	you're	already	a	skilled	operator,	use	TrainPlayer	to	spread	your
knowledge.		Use	the	recorder	to	capture	a	sequence	of	moves,	and	play	it	back	for	the
learners.		Demonstrate	how	to	handle	a	meet	on	the	main	line,	or	switch	an	industrial
siding.	
	
Share	your	layout.		If	you	have	a	layout	that	welcomes	visiting	operators,	TrainPlayer	is
an	excellent	introduction	and	training	tool	for	them.	Send	them	a	copy	of	your	layout	before
their	visit	and	they'll	feel	far	more	comfortable	operating	with	you!		Or	post	a	copy	of	the
file	on	your	website	and	allow	people	to	experience	your	railroad	from	a	distance.	

and	of	course

Play	with	trains.						



About	This	Manual

This	manual	is	in	two	parts.		The	first	covers	TrainPlayer,	and	describes	how	to	run
trains	on	prepared	layouts.		The	second	covers	TrackLayer,	and	describes	how	to
prepare	the	layouts.

We	don't	really	expect	you	to	read	the	manual.		Most	of	what	you	need	to	know	about
TrainPlayer	you	can	figure	out	by	opening	a	layout	and	running	trains.		But	you	might	glance
through	to	pick	up	tips	which	could	enhance	your	enjoyment.		TrackLayer	is	a	little	more
involved,	so	it	is	recommended	that	you	at	least	go	through	the	TrackLayer	tutorial.

The	manual	is	organized	by	topic.		The	first	chapter	tells	how	to	open	a	layout,	what	you'll	see,
and	how	you	can	adjust	the	screen	as	you	like.		The	next	two	chapters	describe	how	to	run
trains,	and	how	to	assemble	and	dismantle	them.		The	next	two	chapters	cover	advanced
features:	scheduling	and	recording.		Last	is	a	chapter	on	how	to	tailor	the	program	to	suit	your
preferences.		The	TrackLayer	portion	begins	with	an	introduction	and	some	basic	information
about	files	and	images,	followed	by	a	tutorial	which	goes	through	the	process	of	building	a
layout.		Subsequent	chapters	go	into	detail	about	drawing	track,	curves,	switches,	and
turntables.

The	manual	assumes	a	basic	level	of	familiarity	with	Windows.		You	should	know	how	to
operate	a	drop-down	menu,	and	what	it	means	to	"navigate"	in	a	file	dialog.		Menu	commands
are	given	as	phrases,	often	in	bold	type,	with	>	symbols	separating	levels:	Tools	>	Customize
refers	to	the	Customize	item	on	the	Tools	menu.

Many	of	the	concepts	in	TrainPlayer,	and	diagrams	in	this	manual,	are	based	on	the	classic
book	101	Track	Plans	for	Model	Railroaders,	by	Linn	Westcott,	©	Kalmbach	Publishing,	1956.	
We	no	longer	distribute	these	layouts	with	the	program.		The	book	is	still	in	print	and	can	be
obtained	from	Kalmbach,	Amazon,	or	most	hobby	shops.		There	is	a	free	download	here.

https://www.trains.com/wp-content/uploads/2021/01/101-Track-Plans.pdf


Where	to	Go	for	Help

	

We're	committed	to	delivering	a	quality	product	which	runs	on	your	machine	and
doesn't	crash	unless	you	want	it	to.		If	you	have	trouble	with	the	program,	the

installation,	or	the	layouts,	here	are	some	places	to	look	for	help:
	

Help	menu.		The	Help	menu	in	the	program	has	links	to	built-in	online	help,	to	web	pages,
and	other	sources.		Try	the	online	help,	which	includes	index	and	full-text	search.
	
Readme.		The	Readme	file	installed	in	your	TrainPlayer	directory	has	up-to-date	details
about	known	problems,	tips,	version	history,	and	other	information.		You	can	view	the	file
from	the	Start	menu,	under	TrainPlayer.
	
Web.		The	Support	page	on	our	website	has	a	list	of	resource,	and	Frequently-Asked
Questions	which	cover	many	common	problems.
	
User	groups	and	forums.		There	is	a	friendly,	open,	and	well-attended	TrainPlayer
Forum,	where	you	can	contact	us	or	our	users.		If	you	have	a	problem,	try	posting	a
question.		Joining	the	forum	is	simple	and	free.
	
Send	e-mail.		Lines	are	open:	support@trainplayer.com.
	
Send	U.	S.	Mail.		The	address	is	on	the	Contact	page	of	the	website.
	
If	you	find	a	bug	in	the	program	or	the	layouts,	send	e-mail	with	the	details	and	we'll	try	to
fix	it	in	an	upcoming	version.		The	e-mail	should	include	the	program	version	and	operating
system	you	are	using,	and	a	layout	(.rrw)	file	if	necessary	to	reproduce	the	problem.
	

http://www.trainplayer.com/Site3/Support.html
https://trainplayerforum.groups.io
mailto:support@trainplayer.com
http://www.trainplayer.com/Site3/Contact.html


			TrainPlayer	Menu	Reference	v.	8.2			

File New Create	a	new	document
Open... Open	an	existing	document
Open	Layout... Open	from	layout	list
Close Close	the	active	document
Save Save	the	active	document
Save	As... Save	the	active	document	with	a	new	path	or	name
Save	All Save	all	open	documents
Revert	to	Saved Discard	changes	since	last	save
Restore	Backup... Open	backup	file
Publish... Check	layout	and	copy	to	publish	directory
Export	Image... Export	layout	to	graphics	file
Import	AnyRail... Import	and	convert	.any	file
Open	Data	Folder Open	TP	App	Data	folder	in	Windows	Explorer
Module	Manager... Open	Module	Manager	to	arrange	modules
Properties... Layout	and	train	properties
Preferences... Preferences	dialog
Save	Preferences Save	all	settings	now
Print	Setup... Change	the	printer	and	printing	options
Print	Preview... Display	full	pages
Print... Print	the	active	document
Exit Quit	the	application

Edit Undo Undo	the	last	action
Redo Redo	the	previously	undone	action
Cut Cut	the	selection	and	put	it	on	the	Clipboard
Copy Copy	the	selection	and	put	it	on	the	Clipboard
Paste Insert	objects	from	clipboard
Delete Erase	the	selection
Select	All Select	all	objects

View Fit	To	Window Fit	layout	to	current	window	size
see	Adjusting	the	View Refresh Redraw	layout	and	trains

Pause... Pause	all	trains
Rotate	Layout	Clockwise Rotate	layout	90	degrees	clockwise
Rotate	Layout	Counter-clockwise Rotate	layout	90	degrees	counterclockwise
Auto-Follow Follow	lead	car	of	train	as	it	travels
Follow	Selected	Car Follow	selected	car	as	it	travels
Running	Sounds Turn	on/off	engine	running	sounds
Car	IDs Show/hide	labels	on	car	tops
Remove	All	Car	IDs Turn	all	car	id's	off
Status	Bar Show/hide	status	bar
Full	Screen Toggle	full-screen	view

Tools Train	Control	Bar Show	or	hide	train	control/train	window	bar
Car	Inventory	Bar Show	or	hide	car	inventory	bar
Map	View Show	or	hide	map	view	window
Route	Finder Show	dialog	for	finding	routes
Clock Show	or	hide	clock
Schedule Show	or	hide	schedule	window
Control	Panel Show	or	hide	train	control	panel
Train	Tree Show	or	hide	train	tree	control



Switch	Window Show	or	hide	closeup	view	of	switch
Script	Central Show	or	hide	Script	Central	dialog
Ops	Central Show/hide	Ops	Central	dialog
Car	Chooser View	car	chooser
Sound	Chooser View	chooser	for	all	sounds
Paint	Shop Show	Paint	Shop	Dialog
Road	Styles Show	Road	Styles	dialog
Enable	Yard	Mode Enable	yard	mode
Check	Track Check	layout	for	errors	and	status
Show	Numbers Display	track	and	junction	numbers	temporarily
Highlight	Track... Prompt	for	track	or	junction,	then	highlight
Show	Tooltips Enable	or	disable	tooltips
Resize	/	Rescale Drag	outer	rectangle	to	resize	layout,	inner	to	rescale	track
Run Run	mode
Customize... Customize	menus	and	toolbars

Train Train	Menu... Show	menu	to	select	a	train
	 New	Train Create	new	small	train

New	Locomotive Create	steam	locomotive
Name... Provide	name	for	train	or	cut

see	Add	Car Add	Car	By	Name... Show	car	names	list	and	car	inventory	bar
	 Add	Car	Car	Chooser... Show	Car	Chooser

Add	Car	Car	Inventory	Bar Show	or	hide	car	inventory	bar
	 Add	Car	Diesel Add	diesel	locomotive	to	train

Add	Car	Steam Add	steam	locomotive	to	train
Add	Car	Tender Add	coal	tender	to	train
Add	Car	Pullman Add	passenger	car	to	train
Add	Car	Baggage Add	baggage	car	to	train
Add	Car	Reefer Add	refrigerator	car	to	train
Add	Car	Hopper Add	hopper	to	train
Add	Car	Gondola Add	gondola	to	train
Add	Car	Boxcar Add	boxcar	to	train
Add	Car	Tankcar Add	tank	car	to	train
Add	Car	Flatcar Add	flatcar	to	train
Add	Car	Caboose Add	caboose	to	train

see	Train	Controls Speed	Slower Decrease	speed	by	1	MPH
Speed	Faster Increase	speed	by	1	MPH
Speed	Half Cut	speed	in	half
Speed	Double Double	the	speed
Forward/Reverse Reverse	direction	of	travel
Stop Stop	train
Uncouple Uncouple	selected	car
Sound	Horn Sound	horn
Flip	Train Change	train	orientation
Throw	Upcoming	Switch Throw	next	switch	ahead	of	train
Stop	All	Trains Immediately	stop	all	running	trains

see	also	Car	Popup
below Car	Copy	Car Copy	selected	car	to	clipboard

	 Car	Cut	Car Copy	and	delete	selected	car
Car	Delete	Car Delete	selected	car
Car	Paste Insert	objects	from	clipboard

see	Car	Loads Car	Load	Empty Mark	car	empty
Car	Load	Loaded Load	car	or	choose	load



Car	Load	Load	Chooser... Bring	up	Load	Chooser	dialog

Car	Load	Load/Unload	Car Toggle	loaded	status	of	selected	car
Car	Load	Load/Unload	Cut Toggle	loaded	status	of	connected	equivalent	cars
Car	Load	Load/Unload	Train Toggle	loaded	status	of	all	cars	in	train
Car	Load	Properties... View/edit	load	properties	in	load	collection
Car	Shift	Forward Swap	car	closer	to	front	of	train\Shift	Forward
Car	Shift	Backward Swap	car	closer	to	rear	of	train\Shift	Backward
Car	Properties... Properties	of	selected	car

see	Train	Script	Menu Script	Play Play	script	of	selected	train
	 Script	Stop Stop	script	and	train

Script	Rewind Set	train	position	to	start	of	script
Script	Edit... Edit	or	create	script
Script	Start	Recording Start	or	stop	recording

	 Script	Set	Rewind	Point Set	new	Rewind	Point	to	current	positions
see	Uncoupling	Pin Uncoupling	Pin	Right	> Move	uncoupling	pin	one	car	to	the	right

Uncoupling	Pin	Left	< Move	uncoupling	pin	one	car	to	the	left
Uncoupling	Pin	Front	>> Move	uncoupling	pin	all	the	way	to	the	right
Uncoupling	Pin	Rear	<< Move	uncoupling	pin	all	the	way	to	the	left
Properties... Properties	of	selected	train

Window New	Window Open	another	window	for	the	active	document
Cascade Arrange	windows	so	they	overlap
Tile	Horizontal Arrange	windows	as	non-overlapping	tiles
Tile	Vertical Arrange	windows	as	non-overlapping	tiles
Close	All Close	all	open	documents
Window	Manager... Dialog	for	arranging	windows

Help Contents... Program	instructions
see	Help	Menu TrainPlayer	Home	Page Main	TrainPlayer	website

Frequently-Asked	Questions FAQ	on	TrainPlayer	website
Upgrade	License... Prompt	to	enter	new	license	code
Check	for	Upgrades... Check	website	for	updated	versions	and	additional	products
About	This	Layout... Layout	and	train	properties
About	TrainPlayer... Program	information

Car	Popup Called	up	by	right-click	on	car
see	About	Cars Copy	Car Copy	selected	car	to	clipboard
	 Cut	Car Copy	and	delete	selected	car

Delete	Car Delete	selected	car
Paste Insert	objects	from	clipboard
Uncouple Uncouple	selected	car
Flip	Car Reverse	car	on	tracks

see	Add	Car Add	Car	By	Name... Show	car	names	list	and	car	inventory	bar
Add	Car	Car	Chooser... Show	Car	Chooser
Add	Car	Diesel Add	diesel	locomotive	to	train
Add	Car	Steam Add	steam	locomotive	to	train
Add	Car	Tender Add	coal	tender	to	train
Add	Car	Pullman Add	passenger	car	to	train
Add	Car	Baggage Add	baggage	car	to	train
Add	Car	Reefer Add	refrigerator	car	to	train
Add	Car	Hopper Add	hopper	to	train
Add	Car	Gondola Add	gondola	to	train
Add	Car	Boxcar Add	boxcar	to	train
Add	Car	Tankcar Add	tank	car	to	train

http://www.trainplayer.com/
http://www.trainplayer.com/Site3/Support.html


Add	Car	Flatcar Add	flatcar	to	train
Add	Car	Caboose Add	caboose	to	train

see	Train	Menu	above Train	Cut Copy	and	delete	selected	train
	 Train	Copy Copy	selected	train	to	clipboard

Train	Delete Delete	selected	train
Train	Name... Provide	name	for	train	or	cut
Train	Flip	Train Change	train	orientation
Train	Sound	Horn Sound	horn
Train	Throw	Upcoming	Switch Throw	next	switch	ahead	of	train
Train	Show	Car	IDs Toggle	appearance	of	labels	on	all	cars	of	train
Train	Exclude	From	Ops Toggle	ops	exclusion	for	all	cars	of	train

see	Train	Script	Menu Train	Script	Start Start	all	scripts	and	trains
Train	Script	Stop Stop	all	scripts	and	trains
Train	Script	Rewind Rewind	all	scripts	to	last	snapshot
Train	Script	Edit... Edit	or	create	script
Train	Script	Remove... Remove	and	erase	script	from	train
Train	Properties... Properties	of	selected	train

see	Car	Loads Load	Empty Mark	car	empty
Load	Loaded Load	car	or	choose	load
Load	Load	Chooser... Bring	up	Load	Chooser	dialog
Load	Choose	By	Name... Choose	load	name	from	list	or	type	in
Load	Load/Unload	Car Toggle	loaded	status	of	selected	car
Load	Load/Unload	Cut Toggle	loaded	status	of	connected	equivalent	cars
Load	Load/Unload	Train Toggle	loaded	status	of	all	cars	in	train
Load	Properties... View/edit	load	properties	in	load	collection
Shift	Forward Swap	car	closer	to	front	of	train\Shift	Forward
Shift	Backward Swap	car	closer	to	rear	of	train\Shift	Backward
Zoom	To Zoom	to	selected	item
Show	Car	ID Toggle	appearance	of	label	on	car	top
Exclude	from	Ops Toggle	whether	car	can	be	included	in	switchlists
Show	in	Car	Bar Bring	up	car	within	its	collection	in	car	bar
Show	Waybill Show	car	waybill
Properties... Properties	of	selected	car

Layout	Popup right-click	blank	spot	on	layout
Stop	All	Trains Stop	all	moving	trains

see	Zooming Zoom	To Zoom	in	and	center	on	clicked	point
Zoom	From Zoom	out	from	clicked	point
Zoom	50% Zoom	to	50%	of	full	size
Zoom	100% Zoom	to	full	size	-	one	inch	per	grid
Zoom	150% Zoom	to	150%	of	full	size
Zoom	200% Zoom	to	200%	of	full	size
Zoom	400% Zoom	to	400%	of	full	size
Zoom	Fit	to	Window Fit	layout	in	window
Zoom	To	Active	Engine Zoom	to	engine	active	in	ops
Zoom	On	Drag Zoom	so	dragged	rectangle	fills	window
Auto-Follow Follow	lead	car	of	train	as	it	travels
Follow	Selected	Car Follow	selected	car	as	it	travels
Running	Sounds Turn	on/off	engine	running	sounds
Paste Insert	objects	from	clipboard
Layout	Properties... Layout,	train,	car	properties
Full	Screen	On/Off Toggle	full-screen	view



Full	Screen	Show	Main	Menu Show/Hide	main	menu	in	full	screen
Full	Screen	Show	Control	Bar Show/Hide	train	control	bar	in	full	screen
Full	Screen	Show	Close	Box Show/Hide	close	box	in	full	screen
Full	Screen	Show	Train	Tools Show/Hide	train	toolbar	in	full	screen

Turntable	Popup right-click	turntable	rim
see	Turntables Rotate	Right	(CW) Rotate	clockwise
	 Rotate	Left	(CCW) Rotate	counterclockwise

Show	Bridge	Track Show	or	hide	bridge	track(s)
Cut Cut	the	selection	and	put	it	on	the	Clipboard
Copy Copy	the	selection	and	put	it	on	the	Clipboard
Delete Erase	the	selection
Select	All Select	all	objects
Properties... Properties	of	selected	turntable

Track	Popup right-click	a	track	section	with	track	or	edit	tool
	 Delete	Track Delete	selected	track
	 Hidden Mark	as	hidden	track

Tunnel Mark	as	instant-tunnel	track
Untouchable Mark	track	and	junctions	as	unselectable
All	Retouchable Revert	retouchable	tracks	to	normal

see	Editing	Track Cut Cut	the	selection	and	put	it	on	the	Clipboard
Copy Copy	the	selection	and	put	it	on	the	Clipboard
Delete Erase	the	selection
Select	All Select	all	objects
Place	Train	Here Move	train	to	cursor

see	Add	Car Add	Car	Here	By	Name... Show	car	names	list	and	car	inventory	bar
Add	Car	Here	Car	Chooser... Show	Car	Chooser
Add	Car	Here	Diesel Add	diesel	locomotive	to	train
Add	Car	Here	Steam Add	steam	locomotive	to	train
Add	Car	Here	Tender Add	coal	tender	to	train
Add	Car	Here	Pullman Add	passenger	car	to	train
Add	Car	Here	Baggage Add	baggage	car	to	train
Add	Car	Here	Reefer Add	refrigerator	car	to	train
Add	Car	Here	Hopper Add	hopper	to	train
Add	Car	Here	Gondola Add	gondola	to	train
Add	Car	Here	Boxcar Add	boxcar	to	train
Add	Car	Here	Tankcar Add	tank	car	to	train
Add	Car	Here	Flatcar Add	flatcar	to	train
Add	Car	Here	Caboose Add	caboose	to	train
Paste	Here Paste	car	or	train	on	track
Split	Track	Here Split	track	and	create	junction
Highlight	By	Location Turn	on/off	hiliting	by	entire	location
Select	Location Select	all	tracks	of	location

see	Track	Transforms Transform	Selection	Flip	Horizontal Invert	selection	horizontally
Transform	Selection	Flip	Vertical Invert	selection	vertically
Transform	Selection	Rotate	90	deg
CW Rotate	selection	90	degrees	clockwise

Transform	Selection	Rotate	90	deg
CCW Rotate	selection	90	degrees	counter-clockwise

Transform	Selection	Rotate... Rotate	selection	by	specified	angle
Advanced	Link	to	Layout... Connect	track	to	separate	layout
Advanced	Create	Action	Here Split	track,	create	junction,	show	action	dialog
Advanced	Make	Double	Track Split	selected	track	into	double



Advanced	Track	To	Scenery Create	scenery	object	overlaying	selected	track
Advanced	Grow	Roadbed	Scenery Generate	roadbed	scenery	below	track
Advanced	Generate	Trains... Populate	layout	with	random	set	of	trains
Properties... Properties	of	selected	track	or	object	(circle,	etc.)

Circle	Popup right-click	rim	of	circle
see	Drawing	Curves Cut Cut	the	selection	and	put	it	on	the	Clipboard

Copy Copy	the	selection	and	put	it	on	the	Clipboard
Delete Erase	the	selection
Select	All Select	all	objects
Properties... Properties	of	selected	circle:	id	and	radius

Horn	Popup right-click	horn	button	on	toolbar	or	control	panel
see	Horns	and	Sounds Freight Freight	whistle

Horn Diesel	horn
Bell Streetcar	bell
Whistle Loco	whistle
Other... Prompt	to	choose	horn	sound
Running	Sounds Turn	on/off	engine	running	sounds

Clock	Popup right-click	clock	window
see	Clock Start Start	clock

Stop Stop	clock
Reset Reset	clock	to	start	time
Settings... Clock	settings
Digital	display If	checked,	display	digital	clock	face
24-Hour If	checked,	display	time	in	24-hour	(military)	format

Track	Run	Popup right-click	track	section	with	Run	tool	active
Place	Train	Here Move	train	to	cursor
Paste	Here Paste	car	or	train	on	track

see	Add	Car Add	Car	Here	By	Name... Show	car	names	list	and	car	inventory	bar
Add	Car	Here	Car	Chooser... Show	Car	Chooser
Add	Car	Here	Diesel Add	diesel	locomotive	to	train
Add	Car	Here	Steam Add	steam	locomotive	to	train
Add	Car	Here	Tender Add	coal	tender	to	train
Add	Car	Here	Pullman Add	passenger	car	to	train
Add	Car	Here	Baggage Add	baggage	car	to	train
Add	Car	Here	Reefer Add	refrigerator	car	to	train
Add	Car	Here	Hopper Add	hopper	to	train
Add	Car	Here	Gondola Add	gondola	to	train
Add	Car	Here	Boxcar Add	boxcar	to	train
Add	Car	Here	Tankcar Add	tank	car	to	train
Add	Car	Here	Flatcar Add	flatcar	to	train
Add	Car	Here	Caboose Add	caboose	to	train
Properties... Properties	of	selected	track	object

Station	Popup right-click	station	border	with	Station	tool	active
see	Stations Station	Properties... Properties	of	selection	station

Cut Cut	the	selection	and	put	it	on	the	Clipboard
Copy Copy	the	selection	and	put	it	on	the	Clipboard
Delete Erase	the	selection
Select	All Select	all	objects

Switch	Script	Popup right-click	a	switch	when	Script	Editor	is	up
Throw	Switch Throw	switch
Action... Define	or	edit	junction	action



see	Script	Inserts Insert	junction	number Insert	junction	number	in	script
Insert	throw	here Insert	throw	command	to	current	position
Insert	throw	alternate Insert	throw	command	to	next	position

Script	Edit	Popup right-click	a	script	text	window
Undo Undo	the	last	action
Cut Cut	the	selection	and	put	it	on	the	Clipboard
Copy Copy	the	selection	and	put	it	on	the	Clipboard
Paste Insert	objects	from	clipboard
Delete Erase	the	selection
Select	All Select	all	objects

Schedule	Window
Popup right-click	inside	Schedule	Window

see	Schedule	Window Copy Copy	selection	to	Clipboard
Select	All Select	all	text
Clear	All Erase	all	text	from	schedule	window
Show	Station	Changes Show	or	hide	station	arrivals,	departures
Show	Script	Output Show	or	hide	script	comments
Show	Script	Commands Echo	script	commands	as	they	execute
Echo	to	Status	Bar Show	output	on	status	bar	as	well	as	in	window

Scenery	Obj	Popup right-click	a	scenery	object
see	Scenery	Context
Menu Load	Bitmap... Attach	bitmap	to	scenery	object

Cut Cut	the	selection	and	put	it	on	the	Clipboard
Copy Copy	the	selection	and	put	it	on	the	Clipboard
Delete Erase	the	selection
Select	All Select	all	objects
Flip	Horizontal Flip	object	right	for	left
Flip	Vertical Flip	object	top	for	bottom

see	Polygon	Smoothing Smoothing	Smooth	This	Vertex Smooth	or	unsmooth	right-clicked	vertex
Smoothing	Smooth	All Smooth	at	all	vertices
Smoothing	Unsmooth	All Unsmooth	at	all	vertices
Smoothing	Auto-Smooth Smooth	all	vertices	while	drawing

see	Default	Styles Style	Apply	Default	Fill Set	object	fill	to	default	fill	style
Style	Apply	Default	Line Set	object	line	to	default	line	style
Style	Use	As	Default	Fill Set	default	fill	style	to	match	object
Style	Use	As	Default	Line Set	default	line	style	to	match	object
Save	to	Scn	File... Save	selected	object(s)	to	scn	file
Properties... Properties	of	selected	object

Transfer	Table	Popup right-click	a	transfer	table
see	Transfer	Tables Move	Right	> Rotate	clockwise

<	Move	Left Rotate	counterclockwise
Show	Bridge	Track Show	or	hide	bridge	track(s)
Cut Cut	the	selection	and	put	it	on	the	Clipboard
Copy Copy	the	selection	and	put	it	on	the	Clipboard
Delete Erase	the	selection
Select	All Select	all	objects
Properties... Properties	of	selected	object

Train	Popup right-click	a	train	in	the	Train	Tree
see	Train	Menu	above Cut Copy	and	delete	selected	train

Copy Copy	selected	train	to	clipboard
Delete Delete	selected	train
Name... Provide	name	for	train	or	cut



Flip	Train Change	train	orientation
Sound	Horn Sound	horn
Zoom	To Zoom	to	selected	item
Load	All	Cars Fill	all	loadable	cars
Unload	All	Cars Empty	all	loaded	cars
Show	Car	IDs Toggle	appearance	of	labels	on	all	cars	of	train
Script	Start Start	all	scripts	and	trains
Script	Stop Stop	all	scripts	and	trains
Script	Rewind Rewind	all	scripts	to	last	snapshot
Script	Edit... Edit	or	create	script
Script	Remove... Remove	and	erase	script	from	train
Properties... Properties	of	selected	train

Chooser	Tree	Popup right-click	a	file	or	folder	in	a	chooser	tree	control
see	Choosers Open Open	selected	folder	or	item

Refresh Refresh	folder
Find... Find	name	under	selected	folder	in	tree
Find	Next Find	next	hit	on	previous	query
New	Folder Create	new	folder	under	selected
Add	File... Add	specified	file	to	tree
Remove Remove	folder	and	contents	from	tree
Rename Rename	folder	in	tree
Export	Filenames... Export	names	and	paths	under	selected	folder
Download	All... Download	contents	of	selected	folder	and	subfolders
Download	Missing	Items... Download	files	not	found	locally
Clear	Download	Cache... Clear	temporary	download	files
Import	from	Folder... Create	new	car	collection	from	folder	of	image	files
Properties... Folder	or	item	properties

Chooser	List	Popup right-click	a	row	in	a	chooser	list	control
see	Choosers Open Open	selected	folder	or	item

Side	Views Show	car	side	icons
Top	Views Show	car	top	icons
Icon	View Show	items	as	icons
List	View Show	items	as	list
Properties... Folder	or	item	properties
Refresh	Thumbnail Redraw	layout	thumbnail

Industry	Editor	Popup 	 right-click	a	cell	in	a	grid	in	Ops	Central
used	in	AO	Grids	 Add	New	Row Add	new	grid	row

Duplicate	Row Duplicate	selection
Delete	Row Delete	selection
Copy Copy	the	selection	and	put	it	on	the	Clipboard
Select	All Select	all	objects
Print	Grid... Print	text	on	display	in	grid
Refresh Rebuild	grid	from	source	data
Expand	All	Items Expand	all	collapsed	items
Collapse	All	Items Collapse	all	expanded	items
Field	Chooser Bring	up	fields	to	choose	by	drag	and	drop
"Group	By"	Box Show	box	for	grouping	by	drag	and	drop
Column	Auto-Resize Resize	columns	to	fit

	 Help Display	grid	help
Car	Bar	Popup click	down-arrow	at	right	end	of	Car	Bar
see	Car	Inventory	Menu Car	Chooser... Bring	up	car	chooser



Choose	By	Name... Choose	car	from	list	of	names
Car	Bar	Settings... Bring	up	bar	settings	dialog
Snap	to	Fit Snap	image	size	to	fit	on	change	bar	size
Roll Roll	train	forward

Control	Bar	Popup right-click	controls	section	of	train	bar
see	Control	Bar Show	Buttons	Forward/Reverse Show/hide	forward/reverse	button	on	control	bar

Show	Buttons	Uncouple Show/hide	uncouple	button	on	control	bar
Show	Buttons	Horn Show/hide	horn	button	on	control	bar
Show	Buttons	Load/Unload Show/hide	load	button	on	control	bar
Show	Buttons	Car	Monitor Show/hide	car	monitor	window	on	control	bar
Show	Buttons	Speed	Slider Show/hide	speed	slider	on	control	bar
Show	Buttons	MPH	Display Show/hide	mph	display	on	control	bar
Enable	Yard	Mode Enable	yard	mode

Load	Popup right-click	Load/Unload	button	on	control	bar
see	Car	Loads Empty Mark	car	empty

Loaded Load	car	or	choose	load
Load	Chooser... Bring	up	Load	Chooser	dialog
Choose	By	Name... Choose	load	name	from	list	or	type	in
Load/Unload	Car Toggle	loaded	status	of	selected	car
Load/Unload	Cut Toggle	loaded	status	of	connected	equivalent	cars
Load/Unload	Train Toggle	loaded	status	of	all	cars	in	train
Load	Properties... View/edit	load	properties	in	load	collection

Script	Central	Popup right-click	a	row	in	Script	Central	list	control
see	Script	Central Edit... Edit	in	script	editor

Delete Delete	script
Copy Copy	selection	to	clipboard
Select	All Select	all	rows
Enabled Enable/disable	script	action
Clear	Sort	Order Revert	to	standard	sort	order
Refresh Refresh	grid	contents

Note	Window	Popup right-click	inside	Note	Window
see	Note	Window Hide Take	down	note	window

Framed Toggle	frame	around	note	window
Auto-Fit Auto-fit	window	on	change	text
Auto-Hide Automatically	take	down	window	after	ten	seconds
Properties... Set	color	and	font	of	note	window	using	scenery	properties

Route	Finder	Popup right-click	a	row	in	Route	Finder	list	control
see	Route	Finder Copy	Row Copy	selected	row	to	Clipboard

Copy	Route Copy	selected	route	to	Clipboard
Copy	All	Rows Copy	all	rows	to	Clipboard
Display	Switch	Positions Turn	on/off	throw	positions,	for	route	scripting
Set	Switches	Along	Route Set	switches	to	open	selected	route

Road	Styles	Popup 	 from	View>Windows>Road	Styles	or	buttons	in	dislogs
see	Road	Styles Create	New	Style Add	new	custom	style
	 Delete	Style... Delete	current	style

Copy	Style Copy	current	style	to	clipboard
	 Paste	Style Paste	from	clipboard	to	current	style
	 Select	By	This	Style Select	all	tracks	having	current	style
	 Make	This	The	Default... Set	global	default	to	current	style
	 Set	To	Factory	Default Restore	style	to	factory	defaults
Video	Options	Popup 	 called	up	by	right-click	on	video



Hide	Video Hide	video	player
	 Show	Video Show	video	player
Map	Window	Popup 	 called	up	by	right-click	on	Map	View
see	Map	View Zoom	To	Cursor Move	view	to	be	centered	at	cursor	position

Spotted	Cars Show/hide	spotted	cars	on	map

Unspotted	Cars Show/hide	unspotted	cars	on	map
Engines Show/hide	engines	on	map
Industries Show/hide	industry	locations	on	map
Class	Yards Show/hide	yard	locations	on	map
Staging	Tracks Show/hide	staging	locations	on	map
Interchanges Show/hide	interchange	locations	on	map
XO	Reserved	Tracks Show/hide	XO	reserved	tracks	on	map
Linked	Tracks Show/hide	linked	tracks	on	map
Legend Show/hide	map	legend
Tooltips Show/hide	tooltips	when	hovering	over	highlights

Dest	Arrows Show/hide	destination	arrows	when	hovering	over	unspotted
cars

	 Settings... Open	Map	View	Settings	dialog
Car	Swap	Options
Popup 	 called	up	by	right-drag	from	car	window	onto	car

see	Car	Swap Replace	This	Car... Replace	car	with	chosen	type
Replace	All	of	This	Type... Replace	all	cars	of	this	type	on	layout

	 Car	Swap	Settings... Advanced	car	replace	options
Scroll	Popup Page	Up Scroll	view	by	fixed	amount
via	right-click	scrollbar Page	Down (Commands	listed	here	are	scriptable...

Scroll	Up those	shown	on	menu	are	different)
Scroll	Down 	
Page	Left 	
Page	Right 	
Scroll	Left 	
Scroll	Right 	

Paint	Shop	Popup Select	This	Color Select	right-clicked	color	for	editing
see	Paint	Shop Paste	Decal Paste	decal	from	Clipboard
also	Decorating	Cars Undo Undo	last	change	made	in	Paint	Shop

Redo Revert	last	undo
Copy	Image Copy	image	to	Clipboard
Save	Image... Save	image	to	file
Show	All	Decals Highlight	all	decals
Revert	to	Factory... Reset	colors	to	factory	car

Decal	Popup Copy	Decal Copy	decal	to	Clipboard
see	Paint	Shop Cut	Decal Copy	and	delete	decal
also	Decorating	Cars Delete	Decal Delete	selected	decal

Bring	Forward Bring	selected	decal	forward	in	display	order
Send	Backward Move	selected	decal	backward	in	display	order
Bring	to	Front Move	selected	decal	to	top	of	display	order
Send	to	Back Move	selected	decal	to	bottom	of	display	order
Transparent Decal	background	transparent
Lock	Proportions Lock	to	prevent	changing	proportions
Flip	Horizontal Invert	decal	horizontally
Flip	Vertical Invert	decal	vertically
Edit	in	Paint... Open	image	in	paint	program



Return	to	Clone	Site Return	clone	to	original	site
Properties... Decal	properties

Road	Popup Tracks Show	or	hide	track	center	line
Rails Show/hide	double	rail
Ties Show	or	hide	ties	on	all	track
Roadbed Show	or	hide	roadbed	under	all	track

Track	Labels Show	or	hide	labels	on	track	sections
Display	Popup Background Show	or	hide	scenery

Grid Show	or	hide	grid	lines
Trains Show/hide	trains
Stations Show	or	hide	stations
Foreground	Scenery Show/hide	foreground	scenery	objects
Background	Scenery Show/hide	background	scenery	objects

Edit	Popup Undo Undo	the	last	action
Redo Redo	the	previously	undone	action
Cut Cut	the	selection	and	put	it	on	the	Clipboard
Copy Copy	the	selection	and	put	it	on	the	Clipboard
Paste Insert	objects	from	clipboard
Delete Erase	the	selection
Select	All Select	all	objects

Layer	Popup Foreground Enable	editing	of	foreground	scenery
Background Enable	editing	of	background	scenery

Arrange	Popup Bring	Forward Bring	selected	object(s)	forward
Send	Backward Move	selected	objects(s)	backward
Bring	to	Front Bring	selected	objects	to	front
Send	to	Back Move	selected	objects	to	back

Group	Popup Group Combine	selected	objects	into	group
Ungroup Ungroup	selected	object

Track	Tools	Popup Straight Draw	straight	track
Circle Draw	guide	circle
Turntable Draw	turntable
Station Define	and	view	station	areas

Scenery	Tools	Popup Line/Poly Drag	lines	to	create	scenery	object
Rectangle Drag	rectangle	to	create	scenery	object
Ellipse Drag	to	create	circular	scenery	object
Text Drag	to	create	text	object
Painter Click	a	scenery	object	to	recolor

Scripting	Popup Record Start	or	stop	recording
Rewind Rewind	all	scripts	to	last	snapshot
Stop Stop	all	scripts	and	trains
Play Start	all	scripts	and	trains
Edit Edit	or	create	script
Pause Pause	all	trains
Script	Central Show	or	hide	Script	Central	dialog
Command	Prompt Bring	up	prompt	for	one-line	script
Set	Rewind	Point Set	new	Rewind	Point	to	current	positions

Ops	Popup Ops	Central Show/hide	Ops	Central	dialog
Active	Engine Zoom	to	engine	active	in	ops
Schedule	Window Show	or	hide	schedule	window
Route	Finder Show	dialog	for	finding	routes
Waybill Show/hide	waybill	for	selected	car



Map	Window Show	or	hide	map	view	window
Train	Tools	Popup Slower Decrease	speed

Stop Stop	train
Faster Increase	speed
Reverse Reverse	direction
Uncouple Uncouple	selected	car
Auto-Follow Follow	lead	car	of	train	as	it	travels

Upcoming	Switch Throw	next	switch	ahead	of	train
Add	Car	Popup By	Name Show	car	names	list	and	car	inventory	bar

Car	Chooser Show	Car	Chooser
Car	Inventory	Bar Show	or	hide	car	inventory	bar
Diesel Add	diesel	locomotive	to	train
Steam Add	steam	locomotive	to	train
Tender Add	coal	tender	to	train
Pullman Add	passenger	car	to	train
Baggage Add	baggage	car	to	train
Reefer Add	refrigerator	car	to	train
Hopper Add	hopper	to	train
Gondola Add	gondola	to	train
Boxcar Add	boxcar	to	train
Tankcar Add	tank	car	to	train
Flatcar Add	flatcar	to	train
Caboose Add	caboose	to	train



			TrainPlayer	Toolbar	Reference	v.	8.2		

For	general	instructions	about	toolbars,	see	Dynamic	Toolbars.

This	page	shows	all	toolbars	and	all	available	buttons.		Toolbars	marked	(TL)	are	available	only
with	a	TrackLayer	license.		Buttons	marked	(H)	are	hidden	by	default;	to	see	these,	click	the
down-arrow	at	toolbar	right	and	use	Add	or	Remove	Buttons.

Main	Tools 	 	

Open	Layout Open	layout	from	Layout	Chooser 	
View View	Options	subtoolbar 	
Pause Pause	all	trains	and	all	action	until	click	OK	or	press	ESC 	
Stop	Trains Immediately	stop	all	running	trains (H)
Auto-Follow Toggle:	when	on,	view	follows	lead	car	of	train	as	it	travels
Throw	Next Throw	next	switch	ahead	of	train (H)
Scripts Script	Tools	subtoolbar 	
Ops Ops	Tools	subtoolbar 	
Train Train	Tools	subtoolbar 	
Paint	Shop Show	Paint	Shop	Dialog 	
Full	Screen Toggle	full-screen	view (H)
Refresh Redraw	layout	and	trains (H)

Build	Tools 	 (TL)

Run Run	mode 	
Edit	Track Edit	track 	
Straight Draw	straight	track 	
Circle Draw	guide	circle 	
Turntable Draw	turntable 	
Station Define	and	view	station	areas (H)
Edit	Scn Drag	selection	rectangle	to	select	scenery	objects 	
Scn	Tools Scenery	Tools	subtoolbar 	

Train	Tools 	 	

Shift	Forward Swap	car	closer	to	front	of	train 	
Shift	Backward Swap	car	closer	to	rear	of	train 	
Flip	Car Reverse	car	on	tracks 	
Flip	Train Change	train	orientation 	
Follow	Sel	Car Follow	selected	car	as	it	travels 	



Train	Properties Properties	of	selected	train 	
Add	Car Add	Car	menu 	

Slower Reduce	speed	by	1	MPH.		In	Yard	Mode,	if	speed	goes	below	zero,	reverse	direction	of
travel. (H)

Stop Cut	power	and	coast	to	a	stop. (H)
Faster Increase	speed	by	1	MPH.		In	Yard	Mode,	if	speed	goes	above	zero,	reverse. (H)
Reverse Reverse	direction	of	travel	(toggle	Forward/Reverse). (H)
Uncouple Uncouple	at	pin	position (H)

Ops	Tools 	 	

Ops	Central Show/hide	Ops	Central	dialog 	
Active	Engine Zoom	to	engine	active	in	ops 	
Route	Finder Show	dialog	for	finding	routes 	
View	Waybill Show/hide	waybill	for	selected	car 	
Map	View Show	or	hide	map	view	window 	
Schedule	Window Show	or	hide	schedule	window 	

Script	Tools 	 	

Rewind	All Rewind	all	scripts	to	last	snapshot 	
Stop	All Stop	all	scripts	and	trains 	
Start	All Start	all	scripts	and	trains 	
Edit	Script Edit	or	create	script 	
Script	Central Show	or	hide	Script	Central	dialog 	
Command	Box Bring	up	prompt	for	one-line	script 	
Schedule	Window Show	or	hide	schedule	window 	
Record Start	or	stop	recording 	
Set	Rewind	Point Set	new	Rewind	Point	to	current	positions 	

View	Options 	 	

Background Show	or	hide	scenery 	
Track	Grid Show	or	hide	grid	lines	--	see	Adjusting	the	Grid 	
Trains Show/hide	trains 	
Stations Show	or	hide	stations 	
FG	Scenery Show/hide	foreground	scenery	objects 	
BG	Scenery Show/hide	background	scenery	objects 	
Trackline Show	or	hide	track	center	line	--	for	info	on	track	display	see	Road	Styles 	
Rails Show/hide	double	rail 	
Ties Show	or	hide	ties	on	all	track 	
Roadbed Show	or	hide	roadbed	under	all	track 	
Labels Show	or	hide	labels	on	track	sections 	



Car	IDs Show/hide	labels	on	car	tops	--	see	Car	IDs	and	Car	ID	display 	

Arrange
Options

	 (TL)

Bring	Forward Bring	selected	object(s)	forward 	
Send	Backward Move	selected	objects(s)	backward 	
Bring	to	Front Bring	selected	objects	to	front 	
Send	to	Back Move	selected	objects	to	back 	
Group Combine	selected	objects	into	group 	
Ungroup Ungroup	selected	object 	

Scenery	Tools 	 (TL)

Foregr	Layer Enable	editing	of	foreground	scenery 	
Backgr	Layer Enable	editing	of	background	scenery 	
Edit	Scn Drag	selection	rectangle	to	select	scenery	objects (H)
Line/Polygon Drag	lines	to	create	scenery	object 	
Rectangle Drag	rectangle	to	create	scenery	object 	
Ellipse Drag	to	create	circular	scenery	object 	
Text Drag	to	create	text	object 	
Painter Click	a	scenery	object	to	recolor 	
Arrange Arrange	Options	subtoolbar 	
Scenery	Grid Show/hide	scenery	snap	grid 	
Scn	Chooser Show	or	hide	dialog	for	adding	scenery	objects 	
Scn	Styles Bring	up	Scenery	Styles	dialog 	

	



			Getting	Started

By	now	you	have	installed	the	program	and	figured	out	how	to	start	it.		It's	time	to	open	a
layout	and	take	a	look	around.		Trains	will	be	covered	in	the	following	chapters.

About	Files

Opening	a	Layout

Tour	of	the	Screen

Layout	Properties

About	Sizes	and	Scales

Adjusting	the	View

Layout	Printing

Help	Menu

What's	Next:

Touch	the	speed	slider	on	the	control	bar,	and	the	train	will	move.		See	the	next
chapter	for	instructions	on	how	to	drive	it.

	

	



About	Files

TrainPlayer	has	a	lot	of	mechanism	for	dealing	with	files,	because	it	has	a	lot	of	files	to	deal
with.		A	fully-equipped	TrainPlayer	site	has	thousands	of	files,	including	layouts,	layout
backgrounds,	car	collections,	scenery	objects,	and	sounds.	

Typically,	the	installer	brings	you	only	a	small	set	of	files.		Most	of	the	content	you	use	comes
by	download	from	the	web,	and	accumulates	over	time.		To	help	you	manage	this	content,	both
local	and	web,	the	program	has	special	dialogs	called	"choosers,"	which	organize	the	data	into
trees	and	allow	you	to	browse	preview	images.		For	details,	see	Choosers.

Where	do	you	find	the	TrainPlayer	files	on	your	computer?		The	answer	to	this	question	has
changed	over	the	history	of	the	program,	as	Windows	conventions	have	evolved.		In	the	latest
version,	most	of	your	data	files	are	found	in	your	"application	data	folder,"	a	system-defined
location	on	disk	which	depends	on	your	operating	system.	You	can	find	this	location	easily	by
choosing	the	command	Open	Data	Folder	from	the	File	menu.		This	opens	Windows	Explorer
to	your	TrainPlayer	app	data	directory.



Opening	a	Layout

When	you	start	TrainPlayer,	the	Layout	Chooser	appears:

If	the	chooser	doesn't	appear	at	startup,	you	can	bring	it	up	using	File	>	Open	Layout.		To	open
a	layout:	click	to	select	it	in	the	list,	then	click	Open.		Or	double-click	in	the	list.		Multiple
selections	are	allowed,	causing	several	layouts	to	open	at	once.

To	sort	the	list	by	number,	name,	size,	date,	or	filename:	click	on	the	header	at	the	top	of	the
corresponding	column.		Click	again	to	sort	in	reverse	order.		To	resize	the	dialog:	drag	by	the
lower	right	corner.		For	more	about	this	dialog,	see	Layout	Chooser	and	Choosers.

Other	ways	to	open	layout	files:

Use	File	Open	 	and	choose	a	file	from	the	Windows	file	system*
Use	File	Open	Layout	 	to	bring	up	the	Layout	Chooser
Double-click	an	.rrw	file	on	your	desktop	or	in	Windows	Explorer
Select	one	or	more	.rrw	files	in	Windows	Explorer	and	drag	them	into	the	TrainPlayer
window

*	In	the	File	Open	dialog	you	can	select	more	than	one	file	to	be	opened.		Use	Shift	or	Ctrl	keys
to	create	a	multiple	selection.

Errors	on	Opening	Layout

When	you	open	a	layout,	the	program	checks	to	see	if	all	the	referenced	components	are	available.

If	the	layout	refers	to	a	non-existent	background	file,	an	alert	informs	you	of	this	and	the	layout	opens
without	the	background.

If	the	layout	refers	to	cars	or	scenery	objects	which	cannot	be	found	in	your	local	collections,	the
Missing	Car/Scenery	dialog	comes	up	and	offers	to	download	the	missing	items.	



If	the	layout	refers	to	other	layouts	linked	to	it,	you	will	get	an	alert	when	the	train	reaches	the
jumping-off	spot	on	the	track	and	tries	to	go	to	the	missing	linked	layout.

Revert	To	Saved

The	command	File	>	Revert	To	Saved	restores	the	layout	to	the	same	state	as	when	it	was
last	opened.		It	has	the	same	effect	as	closing	the	file,	answering	No	if	asked	to	save	changes,
then	reopening	the	file.

This	command	is	handy	for	resetting	trains	and	switches	back	to	a	fixed	starting	point.		Popular
with	script	developers.

Read-Only	Layouts

You	can	mark	a	layout	file	as	Open	for	read	only.		This	mark	gives	the	layout	author	a	way	to
protect	the	file	from	inadvertently	being	overwritten.		This	mark	is	applied	using	a	checkbox	in
the	Advanced	Layout	Properties	dialog.

When	a	file	is	marked	for	read	only,	it	means	that	when	you	choose	File	>	Save,	the	program
instead	brings	up	the	Save	As	dialog,	and	offers	a	new	filename	different	from	the	original.	
You	can	then	click	OK	to	save	the	file	without	modifying	the	original.

If	you	do	wish	to	overwrite	the	original,	you	can	change	the	name	in	the	Save	As	dialog.	
Change	it	back	to	the	original	name,	then	answer	Yes	when	prompted	if	ok	to	overwrite.



Dynamic	Toolbars

At	Version	8.2	we	introduced	a	new	user	interface	scheme	called	"Dynamic	Toolbars."	As
before,	it	is	based	on	customizable	toolbars	provided	by	BCGSoft,	now	improved	in	several
ways:	toolbars	are	easier	to	see	--	larger	by	default,	with	text	labels	and	all	new	scalable	icons;
easier	to	navigate,	with	a	new	button	groups	in	a	simple	hierarchy;	easier	to	customize,	with
drop-down	menus	for	fast	adding	and	removing	of	common	buttons.	There	is	a	handy	new
quick-access	toolbar,	and	the	list	of	open	documents	is	now	tabbed.

This	page	gives	general	instructions	for	working	with	toolbars.		For	details	about	the	individual
bars	and	buttons	on	them,	see	the	Toolbar	Reference.

For	a	detailed	description	of	the	changes	in	8.2,	see	the	web-based	PDF	document	A	New
Style	for	the	TrainPlayer	User	Interface.

Toolbar	Operation

Default	toolbar	arrangement

By	default,	the	program	starts	with	one	or	two	toolbars	docked	at	the	top	of	the	screen:	the
Main	Toolbar	--	a	set	of	common	tools	for	all	users	(shown	above),	and	the	Build	Toolbar	--
tools	for	creating	track	and	scenery,	available	only	with	a	TrackLayer	license.	

The	other	toolbars	are	called	subtoolbars;	these	are	called	up	by	clicking	down-arrow	buttons
such	as	shown	above.

At	the	right	end	of	each	toolbar	is	a	Quick	Customize	button,	providing	ways	to
change	toolbar	contents.		On	a	floating	toolbar,	this	is	a	down-arrow	on	the	title
bar,	with	tooltip	"Toolbar	Options"	=>

Also	shown	above	are	two	components	along	the	top:	the	Quick	Access	Toolbar
(details	below)	and	the	Document	Tabs,	showing	the	layout	name	and	filename	of	each	open
document.		Click	a	tab	to	bring	its	layout	to	the	front;	click	the	X	on	a	tab	to	close	it.	

Dynamic	positioning	(DP)

https://www.bcgsoft.com
https://www.trainplayer.com/Goods/TPnewstyle.pdf


A	new	user-settable	property	called	Dynamic	Positioning	controls	several	aspects	of	toolbar
behavior.	DP	is	on	by	default,	which	means:

Only	the	Main	and	Build	toolbars	are	shown	at	program	start,	and	they	are	always	docked
to	screen	top.

Only	one	subtoolbar	is	shown	at	a	time	--	when	you	bring	one	up,	the	others	go	down.*	
The	aim	is	to	devote	screen	space	only	to	tools	you	are	actively	using.

Positioning	of	subtoolbars	is	handled	automatically	--	they	are	initially	positioned	on	top	of
the	train	window,	and	return	there	after	a	restart	or	reset

*	Exception:	when	you	click	Arrange	on	the	Scenery	toolbar,	both	toolbars	remain	visible.

When	DP	is	off,	the	toolbars	work	as	they	did	in	previous	versions:	you	can	position	and	dock
them	around	the	screen	as	desired,	and	they	remain	where	placed.

To	turn	DP	on	or	off,	use	the	checkbox	in	Preferences	>	Style.

Opening	and	closing	toolbars

To	show	or	hide	toolbars:

to	show	a	specific	subtoolbar,	click	the	appropriate	down-arrow	button	on	a	parent
toolbar.		When	DP	is	in	effect,	this	causes	all	other	subtoolbars	to	be	hidden.

to	show	or	hide	any	toolbar:	check	or	uncheck	items	under	View	>	Toolbars,	or	go	to	the
Toolbars	tab	of	the	Customize	dialog.		These	actions	are	not	affected	by	the	DP	setting	--
if	DP	is	off,	this	is	the	way	to	see	more	than	one	toolbar	at	a	time	(at	least	temporarily).

to	hide	an	individual	toolbar:	undock	it	if	it	is	not	already	floating,	then	click	the	close	button
(X).

Moving	and	docking	toolbars

To	undock	a	toolbar:	press	and	drag	on	the	grabber	at	left	(see	screen	shot	above).		This
converts	the	toolbar	to	a	floating	window,	with	quick-customize	and	close	buttons	on	the	title
bar.

To	dock	a	floating	toolbar:	drag	by	the	title	bar	onto	any	edge	of	the	main	window,	until	the	bar
snaps	into	place,	then	let	go.

To	resize	a	floating	toolbar:	drag	an	edge	or	corner.		You	can	change	between	a	single	row	of
buttons	and	a	grid	with	multiple	rows.

Adding	and	removing	toolbar	buttons



The	quick	way	to	modify	a	toolbar	is	to	press	the	Quick	Customize
button.		This	brings	up	Add	or	Remove	Buttons,	from	which	you
can	choose	a	toolbar	and	check	or	uncheck	items	to	be	shown	on
it.		This	method	is	limited	--	it	lets	you	show	or	hide	buttons	only
from	the	fixed	set	attached	to	each	toolbar.

	The	more	complete	way	to	modify	toolbars	is	to	use	the	Customize	dialog.		There	you	can	add
or	remove	any	command	on	any	toolbar	using	drag	and	drop.

Setting	toolbar	styles

To	modify	the	appearance	of	toolbars,	use	the	Toolbars	section	of
Preferences	>	Style	=>

	Size:	choose	one	of	three	fixed	button	sizes.		Default	is	Medium.

With	text	labels:	check	to	show	text	on	all	toolbar	buttons.	
Default	is	ON.

Dynamic	positioning:	check	to	enable	DP.		Default	is	ON.

The	choices	here	apply	to	all	toolbars	at	once.		To	modify	the	appearance	of	a	single	toolbar,
use	the	Customize	dialog.		Any	choice	you	make	here	is	applied	immediately	on	the	screen,	so
you	can	experiment	to	find	what	you	like	best.

To	revert	to	factory	settings,	(a)	click	Reset	at	the	bottom	of	the	Add	or	Remove	Buttons	menu,
(b)	click	Defaults	in	Preferences	>	Style,	or	(c)	click	Reset	or	Reset	All	in	the	Toolbars	tab	of
the	Customize	dialog.

Quick-Access	Toolbar

The	top	left	corner	of	the	TrainPlayer	window	shows	the	Quick-Access	Toolbar
(QAT),	a	small	customizable	set	of	frequently-used	commands.

This	menu	comes	with	a	built-in	list	of	eight	common	commands,	five	enabled	by
default	--	as	you	can	see	=>
when	you	right-click	anywhere	on	the	QAT.		Under	More>	are	listed	all	the
commands	in	the	program	which	have	icons	associated	with	them.

To	add	or	remove	buttons	from	the	QAT,	just	check	or	uncheck	items	on	the
menu.		If	you	choose	an	item	under	More>,	it	is	appended	to	the	menu;	unchecking	removes	it.



Tour	of	the	Screen

Here	is	a	screen	shot	of	a	layout	surrounded	by	various	gadgets,	showing	Dynamic	Toolbars
introduced	at	Version	8.2.		Click	for	full-sized	image.

Shown	above	are:

Main	Toolbar	and	Build	Toolbar:	default	arrangement	for	a	TrackLayer	user
Quick-Access	Toolbar:	small	buttons	for	frequently-used	commands
Document	tabs:	to	select	an	active	document
Train	control	bar:	combination	control	panel	and	train	window,	for	operating	and
displaying	the	selected	train.
Layout:	top	view,	with	current	zoom	and	view	settings
Car	inventory	bar:	source	of	cars	for	adding	to	the	layout,	by	drag-and-drop	or	click
Zoom	slider:	for	adjusting	zoom	of	layout	view
Status	bar:	showing	messages	and	data	of	interest

Shown	below	are	some	of	the	optional	docking	windows:

Train	Tree	--	hierarchy	of	trains	and	cars	(superseded	by	Train	Menu)
Switch	Window	--	showing	switches	around	active	train
Map	View	--	miniature	view	of	entire	layout,	showing	locations	of	various	ops-related	cars
and	locations
Clock	--	scale	railroad	clock,	in	antique	(shown)	or	digital



Schedule	Window	--	shows	train	movements,	script	output,	messages	



Layout	Properties

Properties	of	the	current	layout.	Called	from	Properties	on	the	Layout	context	menu.		See	also
About	the	Properties	Dialog.

This	dialog	shows	general	properties	of	the	layout	and	lets	you	edit	certain	items.		Additional
layout	properties	are	on	the	Advanced	tab.

Dialog	controls:

Name Name	of	the	railroad.		This	name	appears	at	the	top	of	the	layout
window	and	in	other	displays.

Layout	ID
Short	text	identifier	used	when	working	with	linked	layouts.	
Assigned	automatically	by	the	program	but	can	be	edited.		In
order	for	linkages	to	work,	the	LayoutID	must	be	unique	among
all	open	layouts..(New	in	8.1)

Scale Choose	your	modelling	scale	--	see	About	Sizes	and	Scales.		The
scale	affects	dimension	measurements	throughout	the	program.

Description

Information	about	the	layout,	as	provided	by	the	author.	Often
includes	the	author's	name,	operating	instructions,	and	other
information	of	interest.		New	in	v	6.6:	if	the	layout	has	no
description,	but	does	have	a	master	script	with	introductory
notes,	then	the	latter	are	displayed	here.

Overall	size	of	the	layout	image	(width	x	height)	in	units	selected



Size from	the	drop-down	to	the	right.		The	size	shown	here	is
approximate	--	it	is	calculated	from	the	image	file,	not	the	layout
itself.		These	values	are	not	editable;	to	change	the	layout	size,
adjust	the	grid.

Units
Choose	model	scale	or	prototype,	English	or	metric.		Units
chosen	in	this	dialog	will	apply	throughout	the	program,	but	can
be	changed	in	several	other	dialogs.

About	the	Properties	Dialog

The	Properties	dialog	is	for	viewing	and	editing	properties	of	the	layout	and	the	currently-selected	car
and	train.	It	is	inconvenient	to	do	this	with	a	normal	modal	dialog,	because	you	have	to	close	and	open	the
dialog	for	each	object	you	want	to	inspect.	Instead	(as	of	Version	5.2)	the	Properties	dialog	is	modeless	--
it	stays	on	the	screen	as	you	click	cars	and	trains	around	the	layout.

The	dialog	has	four	buttons:

OK apply	changes	from	all	tabs	and	close	the	dialog.
Cancel close	the	dialog	without	applying	changes.
Apply apply	changes	made	in	any	tab	to	the	selected	car,	train,	and	layout.
Help provide	help	for	the	current	tab.

The	Apply	button	is	dimmed	until	you	modify	some	property.	Once	you	click	it,	the	modifications	are
applied	to	the	layout,	and	you	can	no	longer	cancel	--	the	Cancel	button	becomes	dimmed,	and	OK
becomes	Done.		At	this	point	if	you	want	to	revert	back	to	the	original,	you	can	use	Edit	>	Undo.

The	dialog	belongs	to	the	layout	window.	It	does	not	remain	on	display	if	you	close,	minimize,	or
deactivate	the	layout.

Edits	are	applied	automatically	when	you	change	the	selected	car	or	train.		If	you	select	a	car,	edit	one	of
its	properties,	then	select	a	different	car,	it	behaves	as	if	you	had	clicked	Apply.



About	Sizes	and	Scales

The	Grid	According	to	Westcott

The	layouts	in	Linn	Westcott's	101	Track	Plans	are	designed	to	be	independent	of	scale,	so
that	any	plan	can	be	used	to	design	a	railroad	in	any	scale.		Each	plan	in	the	book	is	overlaid
with	a	square	grid,	with	the	following	legend	on	many	pages:

Ruled	lines	across	plan	are:						6"	apart	in	N
					9"	apart	in	TT
				12"	apart	in	HO
				18"	apart	in	S
				24"	apart	in	O

The	idea	is	that	you	can	take	a	plan	designed	for	a	4x8	table	in	HO,	divide	everything	by	two,
and	get	a	perfectly	good	plan	for	a	2x4	table	in	N.		It's	a	convenient	system	for	a	book	of	track
plans,	and	TrainPlayer	has	been	based	on	it	for	years.

However,	as	our	N-scale	users	have	pointed	out,	this	approach	does	not	give	accurate
measurements	in	most	scales.		N	scale	is	approximately	half	of	HO,	but	not	exactly.		To	get	it
right,	it	is	necessary	to	use	true	scale	ratios,	and	to	make	some	compromises	in	the	Westcott
model.		We	undertook	these	changes	in	Version	6.5	(2017),	so	that	it	now	works	as	follows.	
The	1:1	scale	was	added	in	Version	7.2	(2020).

The	Modelling	Scales

The	accurate	approach	is	based	on	official	scale	specs	as	documented	by	the	National	Model
Railroad	Association	(NMRA)	and	summarized	in	the	following	table:

Scale	Name Scale	Ratio 				Grid
Spacing				 Proto	F/G RRU/G

Z 220 4 73 1011
N 160 6 80 1103
TT 120 9 90 1241
HO 87 12 87 1200
OO 76 15 95 1310
S 64 18 96 1324
O 48 24 96 1324
I 32 36 96 1324
G 24 48 96 1324
1:8 8 120 80 1103
1:1 1 960 80 1103

Columns:

Scale	Name:	official	name	of	the	modelling	scale



Scale	Ratio:	ratio	of	model	to	actual	size.		This	defines	the	scale;	"HO"	means	"1/87
actual	size."
Grid	Spacing:	Westcott-inspired	distance	between	grid	lines,	in	inches
Proto	F/G:	prototype	feet	per	grid	square.		Calculated	from	other	columns;	see	below.
RRU/G:	internal	units	(RRU)	per	grid	square.		Calculated;	see	below.

The	first	two	columns	define	the	modelling	scales,	per	NMRA	standards.		The	next	column	gives
the	definition	of	the	TrainPlayer	grid,	per	Westcott.		The	other	columns	used	to	be	fixed	values,
but	are	now	variables,	calculated	as	follows:

Proto	F/G:	size	of	a	grid	square	in	prototype	feet	=	(grid	spacing	in	inches)	x	(scale	ratio)
/	12

A	grid	square	occupies	a	slightly	different	amount	of	real	estate	in	the	prototype	world,
depending	on	scale.		Values	in	the	table	indicate	that	a	ninety-foot	flatcar	would	just	exactly
fit	inside	a	grid	square	in	TT	scale,	where	in	N	or	HO	it	would	fit	with	room	to	spare,	but	in
O	or	G	it	would	overflow.

RRU/G:		RRU	per	grid	square	=	1200	x	(proto	feet	per	grid)	/	87

Internal	units	of	measurement	in	TrainPlayer	are	called	RRU,	defined	as:	1	RRU	=	0.01"	in
HO.		Thus	a	4x8	layout	in	HO	is	4800	x	9600	RRU.		Prior	to	version	6.5,	a	grid	square	was
fixed	at	1200	RRU	in	all	scales;	now	it	varies	as	shown	in	the	table.

Consequences

Changes	made	in	6.5	give	accurate	scaling	at	the	cost	of	some	simplifications	of	the	Westcott
model.		The	main	one	is	this:	when	you	change	from	one	scale	to	another,	the	overall	size	of
the	layout	does	not	multiply	evenly.		Start	with	a	4x8	HO	layout,	change	to	N	scale,	and	you	no
longer	get	2x4,	but	something	a	little	larger.		The	grid	does	not	remain	fixed	as	before,	but
changes	to	maintain	the	required	spacing	(6"	in	N).	

Try	it.		Create	a	4x8	HO	layout,	then	change	it	to	N	(using	the	drop-down	in	Layout	Properties):

change
scale
=>

HO:	48	x	96" 	 N:	26	x	52"

The	result	is	not	2x4,	and	the	grid	adjusts	accordingly.



Adjusting	the	View

There	are	many	ways	to	modify	what	you	see	on	the	screen:

Turn	visible	features	on	or	off	--	background	image,	scenery	layers,	track	styles.		See	the
View	Options	toolbar

Zoom	in	or	out	--	see	Zooming	below

Resize	or	rotate	the	layout	--	see	Rotating	a	Layout	below;	also	the	Resize/Rescale	tool

Show	or	hide	toolbars	--	see	Dynamic	Toolbars,	Train	Control	Bar,	Car	Inventory	Bar

Show	or	hide	special-purpose	docking	windows	--	found	on	the	Tools	menu:

Map	View	--	miniature	view	of	entire	layout
Schedule	--	window	for	display	of	message	and	script	output
Clock	--	railroad	clock	running	at	scale	time
Switch	Window	--	simplified	view	zoomed	to	upcoming	switch

Open	a	second	window	--	see	Windows	and	Views

Use	Full-Screen	view	--	see	below

Zooming

Zooming	the	document	image	is	a	feature	of	many	Windows	programs,
and	there	is	a	common	zoom-slider	control	available	for	this	purpose,
found	on	the	right	end	of	the	status	bar:

To	zoom:

1.	If	the	zoom	control	is	not	visible	at	the	lower	right	of	your	app	window,	use	View	>	Status
Bar	to	display	it.

2.	Click	+	or	-	button	to	zoom	in	or	out	by	one	tick.	Press	and	hold	button	to	auto-repeat.

3.	Or,	rress	and	drag	the	thumb:	right	to	zoom	in,	left	to	zoom	out.	Or	click	a	spot	along	the
slider	bar	to	zoom	to	that	point.

On	the	left	of	the	slider	is	the	magnification	ratio,	where	1:1	means	the	image	is	the	same	size
as	the	model.		For	example,	at	1:1,	a	60-foot	HO	boxcar	would	measure	8.3"	on	the	screen,
the	same	as	the	model	in	the	Walthers	box.	Maximum	magnification	is	2:1.

Other	ways	to	zoom:

Use	zoom	commands	on	the	layout	context	menu.		When	you	choose	a	command	from	the
context	menu,	the	zoom	will	be	centered	on	the	point	you	right-clicked.		Commands	are:



Zoom	To/From:		zoom	in	or	out	by	a	fixed	amount,	centering	on	the	right-clicked	location.

Zoom	<percent>:	zooms	to	a	specific	magnification.		100%	is	defined	as	where	grid	lines
are	one	inch	(72	pixels)	apart	on	the	screen.		At	50%	they	are	a	half	inch	apart,	at	200%,
two	inches.
Fit	to	Window:	scales	so	the	entire	layout	fits	into	the	frame	window.		This	is	a	mode:
when	on,	any	resize	of	the	window	causes	the	layout	to	resize	accordingly.
Zoom	To	when	pointing	to	car	in	train	window:	zooms	view	to	center	on	indicated	car

Zoom	On	Drag:	zooms	in	to	an	area	defined	by	a	user-drawn	rectangle.		This	command	is
available	only	in	TrackLayer.		To	use:
1.	 Activate	the	Edit	or	the	Track	tool.		The	command	is	dimmed	if	any	other	tool	is	in	use.
2.	 Right-click	anywhere	on	the	layout	and	choose	Zoom	On	Drag.		This	checkmarks	the

item	on	the	menu,	and	puts	you	in	a	special	mode	temporarily.
3.	 Press	and	drag	to	define	a	selection	rectangle	around	the	area	you	want	to	zoom	in

on.	
4.	 When	you	release	the	drag,	the	indicated	area	will	zoom	to	fill	the	window.
5.	 The	command	works	for	one	drag	only;	it	automatically	reverts	to	unchecked	after

each	use.
6.	 If	you	change	your	mind,	choose	Zoom	On	Drag	again	from	the	menu	to	toggle	it	off.

Rotating	a	Layout

Any	layout	can	be	rotated	a	quarter	turn	in	either	direction.		Both	the	track	and	the	background
image	are	rotated,	and	both	can	be	saved	in	the	new	orientation.

To	rotate	a	layout,	choose	View		>	Rotate	Layout	>	[direction].		The	layout	rotates	90	degrees
in	the	indicated	direction.		Repeat	for	180,	270,	etc.

To	save	the	layout	in	the	new	orientation,	choose	File	Save	or	File	Save	As.		Both	the	rotated
layout	and	the	rotated	image	file	are	saved.		The	default	action	in	both	cases	is	to	overwrite	the
original	background	image.		You	are	warned	about	this,	and	given	an	opportunity	to	save	the
image	to	a	different	file.



Dragging	the	View	by	Hand

As	an	alternative	to	using	the	scrollbars,	you	can	pan	the	view	by	dragging	with	the	mouse.
When	the	view	is	zoomed	in	(so	the	layout	is	larger	than	the	document	window),	and	the	Run
tool	is	selected,	then	press	and	drag	any	point	on	the	layout	and	the	view	will	move.

If	the	layout	extends	beyond	the	window	in	only	one	direction,	you	can	only	drag	that	way.		For
example,	if	the	layout	is	a	long	horizontal	strip	which	extends	to	left	and	right,	but	is	completely
visible	vertically,	then	you	can	only	drag	in	a	horizontal	direction.

This	feature	can	be	disabled.		In	General	Preferences,	uncheck	the	box	"View	drag	by	hand."

Auto-Follow

When	a	train	is	about	to	run	off	the	edge	of	the	screen,	you	can	arrange	to	have	the	view
automatically	scroll	so	the	train	stays	visible.		This	feature	is	called	"Auto-Follow."		It	applies	to
the	selected	train.		It	happens	when:

	the	selected	train	is	moving,	including	being	dragged	by	hand
	the	view	is	zoomed	in	such	that	there	is	more	layout	beyond	the	edge	of	the	screen	in	the
direction	of	travel
Auto-Follow	is	turned	on,	i.e.,	the	command	is	checkmarked	on	the	menu

When	these	conditions	are	met,	then	when	a	certain	car	gets	within	a	certain	distance	from	the
screen	edge,	the	view	starts	to	scroll.		By	default	the	car	moving	the	view	is	the	"lead	car,"
meaning	the	car	in	front	in	the	direction	of	travel	--	engine	if	going	forward,	caboose	if	in



reverse.		Or	you	can	override	this	and	choose	a	specific	car,	by	checking	the	menu	command
Follow	Selected	Car	--	when	this	is	checked,	then	whatever	car	is	currently	selected	moves
the	view.

Auto-Follow	is	automatically	turned	off	whenever	you	scroll	manually	using	the	scrollbars.		If	this
were	not	the	case,	then	the	view	would	oscillate	when	pulled	in	different	directions.		However,
auto-follow	is	not	turned	off	when	dragging	the	view	by	hand.

Full	Screen	View

Full	Screen	View	(FSV)	removes	menus	and	toolbars	and	extends	the	view	to	the	edges	of	the
screen*.		Taken	to	the	extreme,	this	would	leave	you	with	no	way	to	operate	the	trains,	so	we
provide	ways	to	augment	the	view	with	various	control	devices.	

To	enter	Full	Screen	View:	

choose	View	>	Full	Screen	from	the	main	menu,	or
choose	Full	Screen	>	On/Off	from	the	layout	context	menu,	or
click	the	toolbar	icon	 .

By	default,	the	view	enlarges	to	fill	the	screen,	and	you	get	a	small	floating	close	box,	train
toolbar,	and	the	main	menu	across	the	top.

To	return	to	normal:

click	Close	Full	Screen	in	the	Close	Box	(if	visible),	or
press	ESC	on	the	keyboard

To	show	or	hide	the	controls:	check	or	uncheck	items	from	the	submenu:

Main	Menu full	menu	bar	--	gives	access	to	all
menus	and	functions

Control	Bar Train	Control	Bar	and	train	window
--	right-click	to	choose		buttons

Close	Box small	box	with	one	button,	for
exiting	full-screen	view

Train	Tools Train	Toolbar	--	toolbar	of	controls
for	operating	trains**

Status	Bar status	bar	with	zoom	slider	at
bottom	of	screen

Each	checked	device	is	displayed	automatically	on	entering	FSV,	and	taken	down	on	leaving.	
Default	is	to	display	all	except	Control	Bar.



Note:		the	Train	Control	Bar	can	be	made	very	small.		Any	of	its	controls,	including
the	speed	slider,	can	be	hidden	from	view.		Any	adjustments	made	in	FSV	apply	only
there,	and	you	can	have	different	TCB	arrangements	in	normal	vs.	full-screen..		In
FSV	you	might	have,	for	example,	a	little	window	displaying	just	the	car	monitor	=>

*	Actually,	not	quite.		Full-screen	view	retains	scrollbars	when	needed.

**	This	toolbar	by	default	is	not	optimized	for	use	in	FSV.		Consider	using	Add	or	Remove
Buttons	to	put	speed	and	direction	controls	on	the	Train	Toolbar	--	see	instructions	under
Dynamic	Toolbars.



Layout	Printing

In	TrainPlayer,	you	can	print	your	layout	as	it	looks	on	the	screen	--	with	switch	lights,	with	or
without	trains,	background,	track,	or	grid.		The	printout	reflects	the	current	settings	on	the	View
menu.

Use	Print	Setup,	Print	Preview,	or	Print	commands	on	the	File	menu,	the	same	way	you	do	with
most	Windows	programs.

The	image	is	always	scaled	to	fit	the	page.		For	most	images,	landscape	orientation	works
best	(choose	in	Print	Setup).		There	is	currently	no	way	to	scale	up	to	print	to	multiple	pages.



Exporting	Images

Export	Image	was	introduced	as	a	way	of	creating	a	snapshot	of	your	layout	in	a	graphics	file.
The	feature	has	been	improved	over	time:

A	"Merge	Background"	mode	is	designed	for	layouts	with	lots	of	scenery	(especially
roadbed	and	ties).	It	draws	the	scenery	into	the	background	image,	then	deletes	it	from
the	layout	and	swaps	in	the	new	background.	The	result	is	a	richer	background	underneath
a	simpler,	more	responsive	track/scenery	layer.
The	exported	image	is	no	longer	limited	to	what	you	see	on	the	screen.	You	can	now
choose	at	export	time	which	features	you	would	like	to	see	in	the	output	--	track,	trains,
scenery,	stations,	etc.
Output	sizes	are	now	more	sensible.	The	default	is	the	native	size	of	the	current
background,	adjustable	within	reasonable	limits.
A	wizard	leads	you	through	the	steps	of	the	process.

To	export	or	merge,	choose	File	>	Export	Image.		This	brings	up	the	Image	Export	Wizard.

Image	Export	Wizard

Welcome	screen	
Introduces	the	wizard.		Shows	the
current	layout	background	image,	if
any,	with	its	size	in	pixels.		Reports
whether	the	layout	has	scenery,	and
if	so,	how	much.

Export	Mode

Choose	Export	Image	if	you	wish
to	create	a	graphics	file	containing



an	image	of	the	layout.		This	mode
does	not	modify	the	layout.

Choose	Merge	Background	if	you
want	to	replace	the	current
background	image	with	a	new	one
containing	both	background	and
scenery.		In	this	mode	you	will	be
offered	to	have	the	scenery	deleted
after	export.

Output	File

Specify	the	output	path	for	the
graphics	file.		Use	the	Browse
button	to	bring	up	a	file	dialog	for
choosing	a	path.

The	text	box	shows	the	full	path.	
Below	that	for	convenience	is	the
filename	and	extension,	plus	an
indication	of	whether	the	file	is	new
or	already	exists.

The	initial	path	offered	is	unique,	it
does	not	match	an	existing	file.

Image	Features

Select	the	display	features	to	be
drawn	in	the	exported	image.	
Selections	made	here	will	not	affect
the	layout	on	the	screen.

The	initial	choices	depend	on	the
mode.		For	Export	Image,	choices
match	the	features	on	display	in	the
current	view.		For	Export



Background,	choices	are
Background	and	Scenery	only.

Image	Size

Specify	the	size	of	the	exported
image.

The	default	choice	(middle	of	the
slider)	is	the	current	size	of	the
background	image	if	any;	if	there	is
no	background,	the	choice	is	based
on	the	size	of	the	layout.		Move	to
the	right	to	generate	a	larger	file
with	higher	resolution,	left	for	a
smaller	file.		

You	may	need	to	experiment	for
best	results.		If	you	are	not	merging
scenery,	there	is	no	reason	to
export	a	file	larger	than	the	current
background;	if	you	export	ties	and
roadbed,	you	will	want	a	larger	file
for	a	sharper	image.		However,
choose	too	large	and	you	may
exceed	memory	capacity,	so	you
will	be	alerted	and	required	to
choose	a	smaller	size.

Finish	Screen

Concludes	the	wizard	and	carries
out	the	export.		Your	choices	are
shown.		Checkboxes	allow



additional	input:

Show	picture	after	export	(Export
Image	mode	only)	--	launch	the	new
image	in	your	default	image	viewing
program.

Delete	scenery	after	export
(Merge	Background	only)	--	delete
all	scenery	from	the	layout,	since	it
will	be	embedded	in	the
background.

Save	file	after	export	(Merge
Background	only)	--	bring	up	a	file
dialog	for	saving	the	modified	rrw
file.

Click	Finish	to	do	the	export,	or
Cancel	to	dismiss	the	wizard
without	finishing.



The	Help	Menu

The	Help	item	on	the	main	menu	provides	access	to	built-in	help	and	to	license-related
commands.

		

Menu	commands:

Contents
Brings	up	the	TrainPlayer	User	Manual	in	Microsoft	Help	Viewer.	
You	can	search	or	browse	through	the	help,	or	jump	to	keywords
in	the	index.

TP	Home	Page Brings	up	the	TrainPlayer	home	page	in	your	browser.

Freq-Asked
Questions Goes	to	the	FAQ	portion	of	the	web	support	page.

Upgrade	License Brings	up	the	Upgrade	License	dialog	to	enter	name	and	license
key	provided	by	e-mail	from	TrainPlayer.

Check	for	Upgrades Brings	up	the	Check	for	Upgrades	dialog	to	see	what	other
versions	of	program	or	car	collections	are	available.

About	This	Layout Brings	up	the	Layout	Properties	dialog,	showing	author-provided
comments	and	instructions	about	the	layout.

About	<license> Brings	up	the	TrainPlayer	About	Box,	showing	the	user	name	and
license	type.

	 	

Upgrade	License	Dialog

This	dialog	is	where	you	enter	the	username	and	license	key	sent	to	you	by	TrainPlayer.		The
most	convenient	way	to	do	this	is	to	copy	both	the	name	and	key	from	the	e-mail,	then	paste
into	the	Name	box	of	the	dialog;	this	will	fill	both	lines	at	once.



		

If	the	key	is	valid,	you	are	informed,	and	are	then	licensed	to	use	the	program.

Check	for	Upgrades	Dialog

This	dialog	takes	your	current	license	into	consideration	and	shows	you	what	upgrades	are
available,	if	any.

		

The	dialog	check	for	three	types	of	upgrade:

New	version	available	for	free	download.		If	the	"Latest	Available"	version	number	is	later
than	the	one	you	are	running,	you	are	offered	a	free	download	of	the	new	version.
Updates	available	to	Chris	Pedersen	cars.		If	new	cars	have	been	added	or	modified,
and	you	are	licensed	to	use	the	collections,	then	you	are	offered	a	free	download	of	the
new	parts.
Chargeable	upgrades.		If	you	are	not	running	the	full	version	of	the	system,	you	might	be



offered	one	or	more	upgrades	at	special	prices.		For	these,	the	button	says	Buy	Now;
clicking	it	adds	the	selected	upgrade	to	your	shopping	cart,	then	takes	you	to	the	Checkout
page,	where	you	complete	the	purchase	by	entering	card	or	PayPal	information.

Once	you	click	the	button,	it	becomes	dimmed,	to	prevent	accidentally	clicking	twice.



			Running	Trains

If	you've	operated	trains	on	a	model	railroad,	then	operating	them	in	TrainPlayer	should	come
easily.		This	chapter	gives	the	details.

About	Trains

The	Train	Control	Bar

Moving	Trains	By	Hand

Yard	Mode

Switches

Coupling	and	Uncoupling

Horns	and	Sounds

Turntables	and	Transfer	Tables

	



About	Trains

In	TrainPlayer,	a	train	is	defined	as	any	contiguous	set	of	cars,	whether	moving	or	not,	with	or
without	motive	power	--	a	single	car	sitting	on	a	siding	is	considered	a	train.		However,	a	train
will	not	move	unless	it	has	an	engine.		To	move	an	engineless	set	of	cars,	you	must	either
couple	them	to	a	powered	train,	or	use	"artificial	means"	equivalent	to	a	railroader's	hand
reaching	across	the	tracks.

In	some	areas,	the	TrainPlayer	definition	of	the	word	"train"	is	different	from	that	of	the
prototype,	where	the	definition	is	"one	or	more	engines,	with	or	without	cars,	displaying
markers."		In	this	definition,	a	train	need	not	have	cars	coupled	to	the	engine,	but	cars	without
an	engine	are	NOT	a	train.

In	Ops,	we	use	the	prototype	definition.	In	some	older	functions,	such	as		the	Train	Tree
window	display,	a	train	is	defined	as	any	contiguous	set	of	cars,	whether	moving	or	not,	with	or
without	motive	power	--	a	single	car	sitting	on	a	siding	is	considered	a	train.		However,	such	a
train	will	not	move	unless	it	has	an	engine.

You	may	have	any	number	of	trains	on	your	layout,	all	running	simultaneously	if	you	can	manage
it.

All	of	the	layouts	supplied	with	TrainPlayer	come	equipped	with	one	or	more	trains.		You	don't
have	to	settle	for	our	selection	--	you	can	delete	or	modify	the	provided	ones	and/or	add	your
own,	as	described	in	Building	Trains.



The	Train	Control	Bar

The	Train	Control	Bar	(TCB)	is	a	combination	control	panel	and	train	window,	for	viewing	and
operating	a	single	train.

The	TCB	comes	up	by	default	docked	across	the	top	of	the	application	window.		It	is	meant	to
be	displayed	at	all	times,	so	has	no	Close	(X)	box.		You	can	take	it	down	or	bring	it	back	using
Tools	>	Train	Control	Bar	on	the	main	menu.	

To	undock	or	dock	elsewhere,	press	and	drag	the	header.		To	auto-hide,	click	the	push-pin	icon
at	upper	right;	the	bar	will	then	collapse	to	a	button	when	not	in	use;	hovering	over	the	button
will	bring	it	back.

The	bar	is	in	two	inseparable	parts:	control	panel	on	the	left,	train	window	on	the	right.		You	can
change	their	relative	sizes	by	dragging	the	divider	in	the	middle.		You	cannot	reduce	the	control
panel	below	its	minimum	size,	but	you	can	reduce	the	minimum	by	removing	buttons	or
enlarging	the	panel	vertically.

Train	side	views	are	scrollable	and	resizable	in	both	directions,	so	if	you	have	Chris	Pedersen
cars,	you	can	enlarge	the	bar	to	see	them	in	full	size,	or	make	it	smaller	and	they	will	scale	to
fit.		The	control	panel	wraps	its	buttons	in	multiple	rows	to	improve	fit.

The	control	bar	has	everything	you	need	to	run	and	interact	with	trains.		There	is	no
longer	any	need	to	bring	up	the	old	rotary-dial	control	panel,	though	it	is	still	available	if
you	want	it.	

Control	Panel	of	the	TCB



The	control	panel	consists	of	a	set	of	buttons	and	controls	on	a	wood-panel	background.		They
are	arranged	in	one	row,	unless	the	control	bar	is	resized	tall	enough	so	they	can	wrap	to	two
or	three.	

Right-click	on	the	wood	to	bring	up	the	context	menu.	This
allows	you	to	choose	which	controls	to	show	or	hide.		It	also
allows	enabling	Yard	Mode,	a	way	to	set	both	speed	and
direction	with	a	single	gesture.		In	Yard	Mode,	the	speed
range	is	divided	in	half,	with	zero	in	the	middle	(as	shown
above);	moving	the	slider	away	from	zero	increases	speed,
crossing	zero	changes	direction.

Controls	in	the	panel	are:

Forward/reverse	(rocker	switch):	click	to	change	the	direction	of	train	movement.

Uncouple	button:	click	to	uncouple	at	the	position	indicated	by	the	orange	uncoupling	pin	in	the
train	window.	Dimmed	if	pin	is	not	between	two	cars.	To	reposition	the	pin,	click	the	desired
spot	in	the	train	window.

Horn	button:	press	and	hold	to	sound	train's	horn.	Dimmed	if	train	has	no	engine.	Right-click
the	button	to	select	a	different	horn	for	the	train,	or	to	toggle	running	sounds	on	and	off.

Load	button:	click	to	load	or	unload	the	selected	car.	Dimmed	if	no	car	is	selected	or	car	is
unloadable;	otherwise	click	once	to	toggle	the	status.	Right-click	for	more	options:	ability	to
load	or	unload	the	entire	cut	or	train;	access	to	Load	Chooser	or	list	of	load	names.

Speed	(MPH)	display:	shows	current	train	speed,	green	if	forward,	yellow	if	reverse,	in	current
units	(MPH	or	kp/h).	To	set	the	speed:	double-click	the	display	so	it	converts	to	an	edit	box;
enter	a	value,	then	press	Enter.		To	change	units,	use	the	Metric	checkbox	in	Preferences	>
General.

Speed	controls	on	resizable	plate:

Red	light:	glows	yellow	when	train	is	moving	in	reverse;	glows	red	briefly	while	pressed.	Click
red	light	to	stop	train.

Green	light:	glows	green	when	train	is	moving	forward.	If	train	is	not	moving,	click	to	start.

Slower	(-)	button:	click	or	press	and	hold	to	reduce	speed.*

Faster	(+)	button:	click	or	press	and	hold	to	increase	speed.*

Slider:	drag	right	for	faster,	left	for	slower.*	Click	a	point	on	the	scale	to	go	to	that	setting.

*	Applies	to	panel	in	normal	mode,	or	in	yard	mode	when	speed	slider	is	right	of	center.	In	yard
mode	with	slider	left	of	center,	moving	it	further	left	or	clicking	(-)	increases	speed	in	reverse.

Note:	it	is	possible	to	resize	the	control	panel	such	that	the	slider	shrinks	to	zero	and



disappears.		In	this	case,	you	control	speed	and	direction	using	buttons	and	lights	alone.

Note:	as	of	Version	7.1,	the	Train	Control	Bar	can	be	made	small.		Now	any	of	its	controls,
including	the	speed	slider,	can	be	hidden	from	view.	

Train	Window

The	train	window	in	the	TCB	shows	a	side	view	of	the	selected	train.		The	same	type	of
window	is	used	to	display	car	collections	in	the	Car	Inventory	Bar	(CIB),	so	much	of	this	section
applies	to	both.

The	uncoupling	pin	is	a	tall	orange	spike	in	the	train	window	(TCB	only).		Its	position	indicates
where	the	train	will	separate	when	you	uncouple,	and	where	a	car	will	be	inserted	when	you
add	or	paste.		The	selected	car	is	indicated	with	a	colored	underline.

To	move	the	uncoupling	pin:

Click	a	location	in	the	train	window	between	two	cars,	or	at	the	end	of	a	car.		The	pin
moves	there	and	the	selected	car	changes.		Or:

Click	a	car	top	on	the	layout.		This	selects	the	clicked	car,	and	moves	the	uncoupling	pin
adjacent	to	it.

Notes	about	the	train	display	and	interactions:

Image	sizes:	See	discussion	below	under	Control	Bar	Settings.

Tooltips,	menus:	hover	over	a	car	image	to	see	information	about	it;	right-click	to	view	and
edit	properties.		(If	you	do	not	see	a	tooltip,	check	that	Tools	>	Show	Tooltips	is	on,	and	click
the	window	to	make	sure	it	has	focus.)

Selection	(TCB):		click	a	car	to	select	it.		Its	image	becomes	underlined,	the	uncoupling	pin
moves	to	the	clicked	point.		The	car	becomes	selected	on	the	layout,	and	highlighted	with	a
pink	X.		(CIB):	click	a	car	type	to	select	it	in	the	Car	Types	listbox.		Double-click	to	add	a	car	of
that	type	to	the	selected	train.

Scrolling:	a	standard	scrollbar	appears	beneath	the	train	or	collection	when	it	is	too	long	to	fit
in	the	window.		Scrolling	to	the	right	moves	toward	the	front	of	the	train.

Menu:	a	down-arrow	button	at	the	right	end	of	the	scrollbar		brings	up	a
menu.		In	the	TCB,	this	is	the	Train	Menu	--	a	pictorial	list	of	trains	on	the
layout,	used	to	select	a	train,	described	below.		In	the	CIB,	the	down-arrow
brings	up	the	Car	Inventory	Menu,	described	on	the	Car	Inventory	Bar	page.

Train	Menu

The	Train	Menu	shows	a	list	of	all	trains	on	the	layout,	and	allows	you	to	select	one	by	clicking



it	--	just	like	any	other	menu,	except	that	it	shows	pictures,	and	the	display	can	be	customized.	

At	the	top	of	the	menu,	above	the	list	of	trains,	are	two	text	commands:

Train	Menu	Settings Settings	for	displaying	trains	in	the	menu;	see	Train	Menu
Train	Bar	Settings Settings	for	car	image	sizing;	see	below

The	first	command	applies	to	the	Train	Menu.		For	details	of	how	this	menu	is	used	to	display
and	select	trains,	and	how	to	work	the	Train	Menu	Settings,	see	Train	Menu	in	the	Building
Trains	chapter.		The	other	command	applies	to	train	or	car	bars,	described	here.

Control	Bar	Settings

The	train	and	car	bars	offer	some	adjustability	regarding	how	car	images	are	to	be	sized	and
displayed.		Click	the	down-arrow	in	the	lower	right	of	train	or	car	bar,	choose	Train[Car]	Bar
Settings...,	and	get	one	of	the	dialogs	shown	below.	

These	bars	are	designed	to	let	you	adjust	the	height	up	to	see	more	detail,	or	down	to	see
more	cars;	then,	with	one	click,	snap	back	to	a	standard	size	designed	for	optimum	viewing.	
"Standard	size"	depends	on	the	cars	and	their	size	classes	(see	50-Pixel	Cars)	--	if	you	have	a
train	with	nothing	but	small	cars,	it	can	be	drawn	native	size	in	a	window	about	30	pixels	high;	if
the	train	has	medium-size	cars,	it	needs	50	pixels;	Pedersen	cars,	still	bigger.		Mixed	trains	are
sized	according	to	the	largest	car.

You	may	have	to	experiment	to	find	the	right	settings	for	you.		If	you	have	trains	of	all	sizes,	you
might	want	to	see	each	in	its	best	size;	on	the	other	hand	you	might	find	it	annoying	to	have	the
bar	size	keep	changing	as	you	click	trains.



			

Dialog	controls	are:

Snap	on	Select
Checked	means:	whenever	you	select	a	train,	draw	the	train	in
standard	size,	and	adjust	("snap")	the	height	of	the	bar	so	it	will
just	fit.		Uncheck	to	leave	bar	size	alone	when	selecting	trains.	
Default	is	ON.

Uniform	Size
Applies	only	if	Snap	on	Select	is	on.		Checked	means:	on	snap,
show	all	trains	medium	size.		Uncheck	to	allow	size	to	change
depending	on	train.			Default	is	ON.

Scale	on	Resize
Checked	means:	when	you	drag	to	resize	the	height	of	the	bar,
scale	the	train	up	or	down	to	fit	the	window.		Uncheck	to	stop	train
from	resizing.		Default	is	OFF.

Background Click	to	set	bar	background	color.		Default	is	beige	for	train	bar,
light	blue	for	car	bar.

Show	default
collections

(Car	bar	only):	in	the	Car	Inventory	Menu,	include	the	names	of	all
default	car	collections

Show	MRU	list	+	size (Car	bar	only):	in	the	Car	Inventory	Menu,	include	recent	picks,	as
many	as	specified

Defaults Click	to	reset	current	dialog	to	factory	default	settings



Moving	Trains	By	Hand

In	the	real	world,	the	only	way	to	move	a	train	is	to	attach	an	engine	and	give	it	power.		For
years	this	has	also	been	true	in	TrainPlayer.		Not	any	more!		You	can	now	reach	across	the
track	with	a	non-prototypical	railroader's	fingertip	and	move	the	train	along	the	tracks,	just	as
you	would	on	a	real	layout	if	you	needed	to	relocate	some	cars	or	your	engine	had	stalled.

To	enable	this	feature:	check	Allow	train	drag	by	hand	in	Operation	Preferences.

To	move	a	train	by	hand:	position	the	cursor	over	the	car	you	want	to	drag.		The	cursor
changes	to	a	hand:	

Press	and	drag	in	either	direction,	and	the	train	follows.		You	will	get	the	hang	of	this	in	about	five
seconds.		Train	dragging	works	no	matter	what	tool	you	are	using:	Track,	Edit,	Run,	etc.		If	you	have
Auto-Follow	enabled,	the	view	scrolls	as	needed	when	you	drag	near	the	edge.

To	throw	a	switch	while	dragging:	press	the	space	bar.		This	throws	the	next	switch	coming	up	in	the
direction	the	train	is	moving.		The	train	must	be	moving	for	this	to	work.

To	couple	while	dragging:	bump	the	train	you	are	dragging	into	another	one	and	they	couple.

To	uncouple:	position	the	cursor	between	two	cars;	it	changes	to	an	uncouple	icon,	like	this:	

									<==		Click	to	uncouple	at	this	position.	

Note:	the	checkbox	Shift-click	between	cars	to	uncouple	in	Preferences	>	Operation	determines
whether	uncoupling	requires	shift-click	instead	of	simple	click.		If	this	box	is	checked,	the	uncouple	icon
does	not	appear	and	uncoupling	does	not	happen	unless	you	are	pressing	the	Shift	key.

If	the	train	is	already	moving:	you	can	drag	by	hand;	when	you	let	go,	the	train	resumes	its	previous
speed	and	direction.

You	can	drag	across	linked	layouts!		push	the	train	across	a	linked	track	stub	and	it	will	appear	on	the
linked	layout,	where	you	can	grab	it	and	continue	to	drag.		This	works	as	of	v	8.1.

What	does	not	happen	while	dragging:	some	actions	which	normally	occur	for	a	moving	train	do	not
apply	when	the	train	is	being	dragged	by	hand.		These	include:

Crashes	and	bounces.		The	train	just	stops	when	it	can't	go	any	further.

Acceleration/deceleration.		The	train	moves	at	the	speed	you	drag.



Speed	display	on	control	panel	or	toolbar.

Running	sounds.

Correct	behavior	on	tunnel	track.		If	you	attempt	to	drag	the	train	onto	a	tunnel	track	(invisible	link
to	another	location),	it	can	be	made	to	work,	but	feels	strange.		The	trick	is	to	watch	when	the	car
you	are	dragging	enters	the	tunnel;	it	jumps	to	the	other	end	and	takes	the	cursor	with	it,	at	which
point	you	may	have	to	continue	the	drag	in	another	direction.



Switches

Where	three	or	more	tracks	join	at	a	point,	they	form	a	throwable	switch.	
Green	lights	indicate	the	open	route	through	the	switch;	reds	indicate
closed	tracks.		A	train	doesn't	necessarily	crash	if	it	attempts	to	pass
through	a	red	light;	it	can	roll	right	on	through,	or	throw	the	switch
automatically,	depending	on	settings	in	the	Options	dialog.

To	throw	a	switch:	position	the	cursor	over	the	"frog"	--	the	point	where
the	tracks	join	--	so	you	see	a	blue	highlight,	then	click.		The	lights	change
to	show	which	route	is	now	open.

If	there	are	more	than	two	routes	through	a	switch,	then	each	throw
cycles	to	the	next	available	open	route.		For	example,	here	are	the	results
of	repeated	clicks	at	a	four-way	junction:

A	switch	will	not	open	a	route	which	requires	a	sharp	turn.		If	a	route	through	a	switch	forms	too
sharp	an	angle,	then	throwing	the	switch	will	not	open	that	route.

If	you	prefer,	you	can	have	only	the	green	lights	show,	or	only	the	red,	or	you	can	change	to
different	colors.		For	details	of	settings	regarding	switches,	see	Switch	Preferences.

Press	the	space	bar	to	throw	the	next	switch	the	selected	train	will	cross.		For	details,	see
Upcoming	Switch	below.

The	Switch	Window

The	Switch	Window	provides	a	close-up	of	the	area	around	a
switch.		The	chosen	switch	is	shown	in	the	center	of	the
window,	surrounded	by	a	rectangular	frame,	zoomed	in,	without
background,	so	that	you	can	easily	see	and	operate	it.

To	bring	up	the	window,	choose	View	Switch	Window.		The
window	can	be	positioned	anywhere	on	the	screen,	resized,	or
docked	to	any	side	of	the	frame.

When	the	switch	window	is	on	display,	and	you	position	the
cursor	over	a	switch	on	the	layout,	the	display	zooms	in	on	that

switch.

By	default,	the	window	automatically	updates	every	time	the	train	goes	across	a	switch,	so	that
it	shows	the	next	switch	in	the	direction	of	travel.		(This	feature	can	be	disabled;	see	below.)

To	throw	the	switch	centered	in	the	switch	window,	click	the	blue	highlight,	or	press	the	space
bar.		To	throw	any	other	switch	visible	in	the	window,	click	its	frog	point.



To	change	characteristics	of	switches	or	the	switch	window,	see	Switch	Preferences.

Upcoming	Switch

As	you	drive,	the	program	knows	what	switch	is	coming	up
next	along	your	direction	of	travel,	whether	an	inch	or	a	mile
away,	and	makes	it	easy	to	see	and	throw.	

When	the	Switch	Window	is	on	display,	it	automatically	shows
a	close-up	of	the	upcoming	switch,	while	a	red	double	frame	highlights	it	on	the	layout,	as
shown	here:

To	throw	the	upcoming	switch,	press	the	space	bar.		This	works	whether	or	not	the	switch
window	is	on	display.

The	upcoming	switch	changes	whenever	the	train	(a)	passes	over	a	switch	or	(b)	reverses
direction.		The	switch	window	automatically	updates	at	those	events	(or	not;	see	note	below),
as	well	as	whenever	you	position	the	mouse	cursor	over	a	different	switch	on	the	layout.



Coupling	and	Uncoupling

TrainPlayer	allows	cars	to	be	coupled	or	uncoupled	anywhere	on	the	track.		You	cannot	couple
if	you	are	going	too	fast,	but	you	can	uncouple	at	any	speed.

There	are	two	general	ways	to	uncouple:	(a)	indicate	which	cars	are	to	be	uncoupled,	then
issue	an	uncouple	command,	or	(b)	click	directly	on	the	layout	in	the	space	between	two	cars.	
To	couple,	as	in	real	life,	you	simply	move	one	car	slowly	into	another,	and	they	automatically
couple.

To	uncouple	by	command:

1.	 Specify	the	uncoupling	point.		The	easiest	way	to	do	this	is	to	click	in	the	Train	Control	Bar
to	position	the	uncoupling	pin.		You	can	click	between	cars,	or	near	the	end	of	a	car.		Once
the	pin	is	positioned	between	two	cars	(not	at	the	beginning	or	end	of	the	train),	you	can
uncouple.

For	example,	in	this	illustration,	uncoupling	will	occur	between	boxcar	and	tanker:

		

Another	way	to	specify	the	uncoupling	point	is	to	select	a	car	by	clicking	on	it.		The
uncoupling	pin	goes	behind	the	selected	car,	unless	it	is	the	last	car,	in	which	case	the	pin
goes	ahead	of	it.

Another	way:	use	the	submenu	Train	>	Uncoupling	Pin	>	(Right,	Left,	Front,	Rear)	which	lets	you
move	the	pin	by	one	car	or	all	the	way	to	either	end	of	the	train.		Keyboard	accelerators	are	assigned
to	these	commands	so	you	can	execute	them	using	arrow	keys.		Moving	the	pin	using	one	of	these
commands	also	changes	the	selected	car.

2.	 Choose	the	Uncouple	command	in	one	of	these	ways:	(a)	by	pressing	Ctrl-U;	(b)	by
clicking	the	Uncouple	button		 	on	the	Control	Panel	or	Train	Toolbar;	(c)	by	choosing
Train	>	Uncouple	from	the	main	menu,	or	(d)	by	choosing	Uncouple	from	the	car	context
menu.



When	the	train	uncouples,	you	are	left	driving	only	part	of	it.		The	uncoupled	portion
becomes	a	new	train,	no	longer	connected	to	your	engine.		The	following	illustration	shows
the	result	of	the	uncouple	operation	begun	above:

To	uncouple	by	click:

You	can	uncouple	two	cars	by	holding	down	the	shift	key	and	clicking	in	the	space	between	the
cars.		When	the	cursor	changes	to	a	four-headed	arrow,	click	to	uncouple	the	cars.		The	Run
tool	must	be	active	for	this	to	work.

Uncoupling	may	require	holding	down	Shift	as	you	click;	this	is	a	setting	in	Operation
Preferences.

To	couple:

1.	 Slow	down	and	move	toward	the	cars	to	be	coupled.		For	example,	if	the	situation	is	as
shown	in	the	above	diagram,	click	into	Reverse	so	the	three-car	train	is	moving	toward	the
two	stationary	hoppers.
	

2.	 Bump	gently.		The	cars	couple	automatically,	and	the	train	is	reassembled	as	shown	in	the
top	diagram.

These	instructions	would	have	to	be	reworded	somewhat	to	apply	to	other	configurations,	for
example	with	the	engine	at	the	rear	of	the	train,	or	going	in	reverse.		Experiment.



Horns	and	Sounds

There	are	two	types	of	sound	associated	with	a	train:	the	"horn"	(or	whistle	or	bell)	which
operates	on	demand,	and	the	running	sounds	which	you	hear	constantly	as	the	train
moves.	

There	are	other	sounds	which	come	from	the	layout	and	not	the	train;	these	are	discussed
under	Stations.	

The	TrainPlayer	website	now	has	a	large	and	growing	selection	of	all	types	of	sounds.		These	are
available	on	the	Web	tab	of	the	various	Sound	Choosers.

To	sound	the	horn:		press	the	Horn	button	 	on	the	control	panel	or	control	bar.		The
horn	continues	to	sound	as	long	as	the	button	is	held	down.

To	choose	a	different	type	of	horn:	either	(a)	right-click	the
Horn	button	on	the	control	panel	and	choose	from	the	context
menu	(see	picture)	or	(b)	right-click	the	train,	choose
Properties,	and	select	a	horn	type	from	the	drop-down	in	the
Train	Properties	dialog.

Choose	Other	at	the	bottom	of	the	menu	to	pick	from	a	wider
variety	of	horn	and	engine	sounds	via	the	Sound	Chooser.

To	turn	running	sounds	on	or	off:	check	or	uncheck	Running
Sounds	from	the	context	menu	on	the	Horn	button	(pictured)	or
the	one	you	see	when	you	right-click	an	empty	space	on	the
layout.	

Running	Sounds

In	TrainPlayer,	you	have	several	choices	of	speed-dependent	running	sounds,	steam	or	diesel.

To	choose	running	sounds:

1.	 Right-click	a	train	or	engine	and	choose	Properties.		Go	to	the	Train	tab,	shown	below.
2.	 There	is	a	drop-down	menu	for	running	sounds.		Choose	one.	

If	you	see	only	a	small	number	of	choices	(as	shown	below	left),	choose	Download...	and
you	will	get		the	complete	set	of	running	sounds	available	on	our	site.		This	may	take	a	few
minutes,	but	next	time	your	choice	of	running	sounds	in	this	drop-down	will	be	much	larger.

3.	 To	hear	the	sounds,	start	the	train	moving.		If	you	don't	hear	anything,	right-click	a	blank
spot	on	the	layout	and	check	Running	Sounds	on	the	context	menu	(below	right).



										

To	add	your	own	running	sounds:

1.	 If	you	want	to	add	your	own	running	sounds,	you	will	need	a	set	of	wav	files,	each	having	a
sound	at	a	different	speed.		The	program	cannot	read	mp3	or	other	formats;	in	fact	there
are	variations	on	wav	files	and	not	all	of	them	work	in	TrainPlayer.

2.	 In	Windows	Explorer,	locate	the	folder	TrainPlayer\Sounds\Chuff	in	your	data	directory.	
You	should	see	a	collection	of	files	with	filenames	like	<name>_nn_mm.wav,		where	name
is	the	sound	name	which	will	appear	in	the	menu,	nn	is	the	minimum	speed	in	MPH	at	which
the	sound	takes	effect,	mm	is	the	maximum	speed	(or	the	letters	max	representing	the
train's	top	speed).		For	example,	the	file	"diesel_26_35.wav"	is	the	sound	listed	on	the
menu	as	"diesel,"	which	is	played	when	the	train	is	going	between	26	and	35	MPH.		Name
your	files	accordingly	and	deposit	them	in	the	Chuff	folder.

	



Turntables	and	Transfer	Tables,	Operation

About	Turntables	and	Transfer	Tables

Turntables	and	transfer	tables	are	motorized	devices	for	reversing	cars	or	engines	or	moving	them
between	tracks.		They	are	popular	on	model	railroads,	because	they	are	useful,	don't	take	up	much	space,
and	are	fun	to	watch.

A	turntable	is	a	rotating	circular	platform	equipped	with	a	single	section	of	track	through	the
center	--	the	bridge	track	--	and	one	or	more	sections	of	track	touching	the	circumference	--
the	external	tracks.		Before	you	can	drive	a	car	onto	or	off	the	turntable,	the	platform	must	be
rotated	so	the	bridge	track	is	aligned	with	an	external	track.

An	alternative	to	a	turntable	is	a	transfer	table	--	a	rectangular	platform	which	moves	laterally
and	has	one	or	more	bridge	tracks.		A	short	table	can	be	used	like	a	turntable,	for	moving	a
single	engine	(as	shown	here);	a	long	table	can	serve	as	a	moving	staging	yard	for	entire	trains.

			

On	this	page	are	instructions	for	operating	these	devices.		For	info	about	creating	and
modifying	them,	see	Turntables	and	Transfer	Tables	in	the	TrackLayer	section.

Operating	a	Turntable

Right-click	a	point	on	the	circle	and	choose	^Rotate	Right	(clockwise)	or	Rotate	Left^
(counterclockwise).		The	table	will	rotate	in	the	indicated	direction	until	either	end	of	the	bridge
track	hits	an	external	track.

Or,	double-click	a	point	on	the	circle;	the	table	will	rotate	in	whatever	direction	it	previously	did.	
Double-click	again	and	the	table	will	stop	rotating.

You	do	not	have	to	rotate	through	each	stop.		You	can	double-click	the	point	where	any	external
track	touches	the	table	rim,	and	the	turntable	will	rotate	directly	to	that	stop	by	the	shortest
route.

Note:	a	turntable	will	not	rotate	if	a	car	or	engine	is	fouling	the	junction,	i.e.,	is	partly	on	the
table	and	partly	outside.		However,	as	of	Version	8.1,	a	small	amount	of	overhang	is	allowed:	a
car	may	extend	up	to	1/8	of	its	length	beyond	the	rim,	and	will	still	rotate.



Operating	a	Transfer	Table

Right-click	a	point	on	the	transfer	table	and	choose	Move	Right	>	or	<	Move	Left.		The
platform	will	move	in	the	indicated	direction	until	either	end	of	any	bridge	track	hits	an	external
track.		Right	and	left	are	based	on	the	initial	orientation	of	the	rectangle;	if	you	have	rotated	the
table,	these	terms	may	not	apply.

Or:	double-click	a	point	within	the	transfer	table,	between	the	platform	and	an	edge;	the	table
will	move	in	that	direction.		Double-click	again	to	stop	movement.

Or:	double-click	a	point	where	an	external	track	touches	the	table	rim;	the	table	will	move	until
one	of	its	bridge	tracks	connects	to	that	track.



			Managing	Cars

Railroads	need	cars	to	carry	goods	and	passengers.		The	typical	model	railroad	has	cars	of	various	types
sitting	around	on	the	track,	a	bunch	more	in	a	cabinet	on	the	wall,	and	probably	a	few	more	still	in	their
boxes,	waiting	to	be	painted.

In	TrainPlayer,	there	are	no	cars	waiting	to	be	painted,	and	that	cabinet	is	huge.		There	are	thousands	of
car	types	to	choose	from,	and	an	infinite	supply	of	each	--	when	you	pull	one	down	from	the	cabinet,
another	appears	in	its	place.		All	kinds	of	cars	are	available	--	diesel	locomotives,	steam	engines,	freight
cars,	passenger	cars,	snowplows	--	in	a	large	variety	of	colors	and	styles.	

Cars	are	organized	in	car	collections,	groups	of	cars	related	by	style	or	road	name,	like	individual
shelves	in	the	cabinet.		Several	car	collections	are	provided	with	the	program,	many	more	are	available
by	download.		If	you	don't	find	what	you	need,	and	you	have	some	artistic	ability,	you	can	create	your
own,	or	you	can	ask	one	of	the	friendly	guys	on	the	forum	to	make	a	custom	set	of	cars	for	you.

With	the	introduction	of	Ops,	freight	cars	have	become	more	capable.		They	can	carry	loads.		Each	car	is
assigned	a	detailed	classification,	which	determines	what	sorts	of	load	it	can	carry,	which	in	turn
determines	what	sorts	of	industry	it	can	serve.		The	loads	themselves	are	objects	much	like	cars,
organized	in	downloadable	collections.

About	Cars

Car	Collections

Default	Car	Sets

Car	Loads

Car	Properties

Car	Collection	Editors

The	Car	Inventory	Bar



About	Cars

There	are	some	terms	you	need	to	know	when	working	with	cars.	To	understand	them,
consider	this	scenario.

You	need	some	cars	to	carry	grain	on	your	prairie	railroad.	You	go	to	your	big-box	hobby	shop,
wander	the	aisles	until	you	find	one	called	"Steam-Era	Freight	Cars,"	and	locate	a	shelf	called
"Grain	Cars	and	Hoppers."	You	pick	out	a	nice	model	of	a	2-bay	open-side	covered	hopper	in
Great	Northern	colors.	In	TrainPlayer	terms,	a	car	built	from	this	kit	would	be	described	as:

Car	collection:		Steam-Era	Freight
Car	class:		covered	hopper
Generic	class:	hopper
Car	type:		GN	70-ton	2-bay	open-side	covered	hopper

The	"car	type"	is	the	name	on	the	box	--	a	particular	model	from	a	manufacturer.	The	"car
class"	is	a	code	from	an	industry-wide	list	indicating	what	the	car	is	used	for	or	can	carry.	The
"car	collection"	is	a	group	of	car	types	related	by	era,	class,	manufacturer,	etc.		The	"generic
class"	is	a	program-assigned	category,	as	described	below.

When	you	add	a	car	to	your	layout,	you	start	by	choosing	a	car	type	from	a	collection,	and	the
program	adds	a	car	of	that	type	on	your	track.		You	can	then	modify	this	car	--	repaint	it,
change	its	size	--	but	you	can't	change	its	type.		You	can,	however,	modify	the	collection	and
change	the	car	type	definition,	so	next	time	you	add	a	car	of	this	type,	it	will	have	the	style	you
want.

Generic	Car	Classes

Every	car	you	add	to	a	layout	is	assigned	one	of	twelve	generic	classes:

Diesel,	Steam,	Tender,	Pullman,	Baggage,	Reefer,	Hopper,	Gondola,

Boxcar,	Tankcar,	Flatcar,	Caboose

This	is	partly	for	historical	reasons,	and	partly	because	we	have	only	these	twelve	icons	on	the
car	toolbar.

A	car's	generic	class	determines	certain	aspects	of	its	behavior:

Diesel	and	Steam	are	the	only	classes	which	have	motive	power.		If	you	want	a	car	to
move	when	you	hit	the	throttle,	make	sure	it	is	classified	as	one	of	these	(even	if	it	is	an
electric	trolley,	mule-drawn	wagon,	handcar,	etc.).
Freight	types	are	the	six	from	Reefer	through	Flatcar.
Passenger	types	are	Pullman	and	Baggage.
Only	freight	types	are	loadable.		You	cannot	attach	load	types	to	engines,	cabooses,	or
(currently)	passenger	cars.



When	you	add	a	car	using	the	car	toolbar,	you	are	choosing	a	generic	class.		The	actual	car
type	you	get	is	whichever	member	of	the	current	Default	Car	Collection	has	been	assigned	to
this	class.		For	example,	if	you	click	the	hopper	icon,	and	the	current	default	collection	is
"Default	Steam,"	the	car	you	create	is	of	type	"2-bay	hopper."

AAR	Codes

To	classify	cars	precisely	for	ops	purposes,	we	use	AAR	Codes.		An	AAR	Code	is	a	one-	to
three-letter	string	representing	a	specific	type	of	car,	as	classified	by	the	Association	of
American	Railroads.		The	TrainPlayer	list	is	adapted	from	that	on	the	Great	Northern	Empire
site	(we	appreciate	the	author's	permission	to	use	this	list).		For	an	informative	article	on	the
subject,	see	AAR	Freight	Car	Codes	from	the	Model	Railroad	Operations	SIG.

In	TrainPlayer,	a	two-	or	three-letter	code	refers	to	a	specific	type,	where	one	letter	is	a
generic	type.	For	example,	a	code	of	"GD"	means	a	side-dump	gondola,	suitable	for	gravel;
"G"	means	a	general-purpose	gondola,	suitable	for	loads	which	can	be	carried	in	any	type	of
gondola.

The	complete	list	of	AAR	codes	available	in	TrainPlayer	can	be	seen	in	the	AAR	Codes	Dialog,
accessible	when	editing	car	properties.

A	car	load	has	a	special	string	as	its	AAR	property	--	a	list	of	individual	codes	indicating	what
cars	can	carry	that	load.		For	details,	see	Load	AAR	Strings.

AAR	Override

Normally	an	AAR	code	is	assigned	to	a	car	"at	the	factory,"	which	in	our	case	means	"in	the
Car	Chooser."		If	you	select	a	solid-bottom	gondola,	it	will	have	a	code	of	GB	(as	supplied	by
the	author	of	the	car	collection)	and	will	be	restricted	to	jobs	requiring	that	specific	type.

To	add	flexibility	in	the	ops	system,	Version	7.1	introduces	new	car	property	AAR	Override	(or
AAR/o).		A	non-blank	entry	in	this	field	replaces	a	car's	factory-supplied	code	with	another
code,	and	the	car	then	becomes	available	to	the	ops	system	as	this	type.

Example.		You	are	working	with	a	layout	which	calls	for	cars	of	type	GB	to	carry	mixed	loads	to
an	industry.		The	yards	are	populated	with	suitable	cars	from	the	default	steam	collection.		You
would	like	to	upgrade	to	snazzy	Chris	Pedersen	gondolas,	but	the	CP	cars	you	want	are
designated	as	type	G,	and	ops	will	not	use	them.		The	solution	is	AAR	Override	--	bring	in	a	CP
car,	set	its	override	to	GB,	and	ops	will	not	know	the	difference.

This	feature	was	designed	to	work	with	another	new	7.1	feature:	Car	Swap,	an	ops-
independent	method	for	changing	car	types	on	a	layout	using	drag	and	drop.

Types	of	Cars

The	AAR	code	assigned	to	a	car	dictates	its	behavior.		TrainPlayer	recognizes	several	types	of

http://www.aar.org/
http://www.greatnorthernempire.net/index2.htm?GNE_AARCarCodes.htm
https://www.opsig.org/files/resources/AARFreightCarCodes.pdf


cars	based	on	their	codes.		Some	of	these	can	be	overridden	by	adding	or	changing	a	code	in
the	carcodes.csv	file;	the	following	rules	apply	when	not	overridden:

Passenger	cars:	code	starts	with	one	of:	B,	C,	D,	P	or	is	equal	to	EP,	MA,	MB,	MR
Locomotive	power:	code	starts	with	E,	except	for	ET	(tender)	--	all	cars	of	this	type	move
when	power	is	applied
Freight	cars:		all	types	which	are	not	passenger	or	locomotive	or	tender	or	caboose
Loadable	cars:	any	car	is	loadable	if	it	has	a	default	load	assigned	to	it	(this	applies	to
most	passenger	and	freight	cars)
Closed	cars:	cars	with	codes	not	starting	with	G	or	H	or	F	or	O

Normally	it	is	easy	to	tell	whether	a	car	is	loadable	--	most	dialogs	which	display	cars	give	you
the	option	to	show	them	with	loads	displayed,	but	(a)	the	option	is	dimmed	for	unloadable	cars,
and	(b)	for	closed	cars,	loads	are	shown	as	text	labels	above	the	car.

Default	Cars

There	are	two	ways	to	add	cars	to	a	layout:	(a)	using	the	Car	Chooser,	which	lets	you	pick	any
car	from	any	collection,	or	(b)	choosing	from	the	Add	Car	menu	or	its	toolbar	(see	Adding	Cars
And	Trains).		The	second	method	is	quicker,	but	means	you	don't	get	to	choose	the	collection	--
in	this	case	the	car	comes	from	the	Default	collection,	one	of	a	few	collections	specially	set	up
for	this	purpose.

The	program	comes	with	several	basic	default	sets,	including	Default	Steam	and	Default
Modern.		(Examples	from	Default	Steam	are	shown	at	the	top	of	this	page;	Default	Modern
examples	are	on	the	Car	Collections	page.)		The	program	activates	one	or	the	other	of	these
when	you	open	a	layout,	depending	on	the	ratio	of	steam	to	diesel	engines	on	the	layout.		You
can	override	this	choice,	and	specify	your	choice	of	defaults	for	any	layout,	whether	Steam	or
Diesel,	or	one	of	several	others	you	can	download,	or	one	you	create	yourself.		For	details,	see
Default	Car	Sets.

Car	IDs

Every	car	on	the	layout	has	two	forms	of	identification:

a	numeric	ID	(also	called	"tag"),	assigned	and	managed	by	the
program	and	not	editable	by	you.		This	is	used	internally	for
keeping	track	of	cars.		The	program	goes	to	some	trouble	to
ensure	that	every	car	on	the	layout	has	a	unique	tag,	and	warns
you	if	this	is	not	the	case.		The	tag	is	shown	on	the	car	tooltip
and	in	Car	Properties.		Or	you	can	opt	to	have	it	displayed	on
the	car	top	(see	link	below).

a	text	label	(also	called	"ID")	is	normally	displayed	on	top	of	the	car.		Initially	the	label	is	a
combination	of	the	car	class	and	the	tag,	where	the	class	is	represented	by	one	or	two
letters	--	a	gondola	might	be	labelled	"G64,"	a	steam	engine	"ES99."		However,	the	label
can	be	edited,	so	you	can	change	it	to	say	whatever	you	like.		You	do	not	need	to	ensure
the	label	is	unique.		The	label	is	shown	in	Car	Properties,	and	also	in	the	car	tooltip	(where



it	is	called	"ID").

Note	that	a	car	top	may	display	the	identifying	label	or	ID,	or	it	may	instead	display	the	Dest
value	assigned	to	the	car.		See	Car	ID	Display.

Car	Notes

New	in	version	6.0	is	the	ability	to	add	a	car	note	to	any	car.		This	can	be	any	string	of
information	you	wish	to	attach	to	the	car,	like	a	post-it	note	stuck	to	the	side.		You	create	a	car
note	in	Car	Properties.		It	is	saved	with	the	car	in	the	layout	file,	and	displayed	in	various	places
(tooltips,	dialogs).		It	is	accessible	via	the	$car	system	function	in	scripts,	so	it	is	handy	for
script	authors	keeping	track	of	car	movements.

Car	notes	are	used		to	keep	track	of	car	movements.		Each	note	contains	a	comma-delimited
list	of	values,	created	and	used	by	scripts.		For	info	about	this	field	and	others	described	below,
see	the	AO	documentation.

Car	PropStr

For	ops	purposes,	an	additional	string	of	data	is	often	needed	on	a	car,	so	we	added	one	with
a	generic	name.		It	is	accessible	in	scripts	via	the	$CAR	function,	and	in	the	Car	Data	Props
dialog;	can	be	displayed	in	the	Cars	grid.	

Car	Dests

New	in	6.3	is	the	Dest	field.		Similar	to	a	car	note,	a	dest	is	a	short	string	of	text	associated
with	a	car.		Unlike	a	note,	it	can	be	displayed	on	top	of	the	car	in	place	of	the	usual	id	label.	
Dest	values	can	be	modified	by	scripts,	or	edited	by	hand	in	Car	Properties.		They	are	normally
used	in	conjunction	with	track	labels	as	a	visual	aid	in	ops.

Car	Images

Cars	are	displayed	in	two	ways:	as	top	views	on	the	layout,	and	as	side	views	in	the	train
windows.		Each	view	of	each	car	type	is	in	a	separate	file,	so	a	typical	car	collection	has	a
folder	containing	dozens	of	small	image	files.		You	can	find	plenty	of	examples	in	your	Cartypes
folder.

These	image	files	are	not	created	or	edited	in	TrainPlayer.		If	you	want	to	modify	car	images	--
say,	to	apply	your	own	paint	scheme	to	a	set	of	cars,	or	create	a	new	collection	from	scratch	--
you	will	need	to	use	a	bitmap	editing	program	such	as	Paint,	which	comes	with	Windows.		You
will	also	need	to	be	aware	of	certain	size	and	style	limitations;	details	are	spelled	out	on	the
Car	Collections	page.

Large	Car	Images

As	of	Version	5.2,	certain	car	collections	provide	large,	detailed	side	views	in	addition	to	the
normal	toolbar-sized	ones.		Here	for	example	is	an	Athearn	boxcar	from	the	Chris	Pedersen
Cars	collection:

http://www.trainplayer.com/Features/CP_Cars/Version52.html


In	Version	6.0	we	went	a	step	further	and	introduced	a	new	50-pixel	medium-sized	car	image.	
When	you	are	working	with	any	of	these	collections,	the	large	and	medium	images	can	be	seen
in	several	places:

Car	Properties		--	in	the	car	panel,	scalable	up	to	full	size
Car	Collection	Editor	--	in	the	car	panels,	scalable	up	to	full	size
Car	Chooser	--	in	the	Preview	window
Train	Window	--	in	the	resizable	train	window
Car	Inventory	Bar	--	in	the	resizable	car	bar

All	of	these	displays	are	resizable;	for	optimal	viewing,	enlarge	until	the	image	reaches	its	full
size.

50-Pixel	Cars

New	in	Version	6.0	are	several	new	car	collections	in	a	new	size	category.		Car	collections	now
come	in	three	sizes:

small:	the	original	cars	since	Version	1.0,	with	side	images	made	from	train	gifs,	maximum
height	around	28	pixels
medium:	new,	more	detailed	images,	with	side	views	maximum	height	50	pixels;	sample
shown	above	at	full	size
large:	the	Chris	Pedersen	cars,	with	side	views	actual	size	of	HO	models

Medium	size	is	now	the	standard	for	all	default	cars	and	for	most	new	collections	being	built.	
The	50-pixel	size	allows	for	quite	a	bit	of	detail,	without	taking	up	too	much	screen	space.

Every	collection	belongs	to	one	of	the	three	size	types,	as	shown	under	Image	Type	in	the
Images	tab	of	the	Car	Collection	Editor.		All	cars	in	a	single	collection	are	of	the	same	type.	
However,	this	does	not	mean	your	trains	are	restricted	to	a	single	type.		A	train	can	contain	a
mixture	of	sizes;	for	example,	this	train	has	four	50-px	cars	followed	by	two	small,	then	two
Pedersen:



In	this	case	the	program	applies	some	rules	and	attempts	to	scale	the	cars	more	or	less
uniformly.		For	more	about	train	side-view	scaling,	and	what	control	you	have	over	it,	see	Train
Control	Bar	Settings.

Car	Panels

A	single	display	device	called	a	car	panel	is	used	to	display	cars	of	all	size	types.		This	panel
appears	in	Car	Properties	and	in	several	tabs	of	the	Car	Collection	Editor.		It	consists	of	two
images,	side	image	on	the	left,	top	image	on	the	right,	separated	by	a	moveable	divider.		All
dialogs	containing	car	panels	are	resizable,	so	you	can	make	the	panel	as	large	as	you	like,
then	move	the	divider	to	make	one	size	large	relative	to	the	other.		Both	side	and	top	view
rescale	accordingly.

Most	car	panels	have	a	checkbox	nearby	allowing	you	to	turn	on	and	off	the	display	of	the	load
for	loadable	cars.



Car	Collections

A	car	collection	is	a	set	of	car	type	definitions.		To	add	a	car	to	the	layout,	you	choose	it	from	a
car	collection.		If	you	use	a	quick	method	--	click	a	button	on	the	toolbar	or	choose	from	the
Add	Car	menu	--	you	are	choosing	from	a	special	collection	called	the	Default	Car	Set.		The
other	method	is	to	select	from	the	Car	Chooser,	where	you	can	browse	through	many
collections	and	choose	cars	from	any.

TrainPlayer	is	installed	with	several	car	collections,	including	a	few	default	sets.		There	are
many	(many!)	others	available	for	download	from	the	TrainPlayer	website.		You	can	shop
through	these	on	the	Web	tab	of	your	Car	Chooser;	if	you	find	a	collection	you	like,	you	can
download	the	entire	set	with	one	click,	and	then	use	the	car	types	in	your	layouts.

If	you	have	a	layout	which	uses	cars	from	some	non-default	collection,	and	you	want	to	send	it
to	your	friend	Joe,	then	if	he	is	going	to	see	the	right	cars	he	will	need	the	same	collection	on
his	machine.		If	the	collection	came	from	TrainPlayer,	Joe	will	be	given	a	chance	to	download	a
copy	for	himself.		If	it	is	a	custom	set	you	created	yourself,	then	you	will	need	to	publish	the
collection	--	process	it	into	a	separate	folder	and	send	him	a	zip	of	that.

Using	Car	Collections

Most	of	the	instructions	for	using	car	collections	are	found	in	other	sections	of	the	manual.	
Follow	links	below	for	details.

To	browse	car	collections:		choose	Other...	from	one	of	the	Add	Car	commands	--	(a)	on	the
Train	menu,	(b)	on	right-click	of	a	car,	(c)	on	toolbar	button	 ,	(d)	from	Add	Car	Here	on	a
track	section.		Any	of	these	brings	up	the	Car	Chooser,	where	you	can	browse	and	select	cars
to	be	added.



To	edit	a	car	type	or	collection:		right-click	an	icon	in	the	Car	Chooser	middle	window,	or	a
folder	in	the	tree	at	the	left,	and	choose	Properties.		This	brings	up	the	Car	Collection	Editor,
for	browsing	and	editing	the	selected	car	type	or	any	other	type	in	the	same	collection.

To	download	a	car	collection:	in	the	Car	Chooser,	go	to	the	Web	tab.		Browse	and	find	what
you	like,	then	click	Install.		The	actual	download	is	done	into	a	temporary	directory	while	you
browse,	so	that	you	can	view	the	images;	clicking	Install	copies	the	files	from	the	temp	location
into	Cartypes.

To	publish	a	car	collection:	in	the	Car	Collection	Editor	(Collection	tab),	click	Export.		This
brings	up	the	Car	Collection	Publisher.

Creating	a	Collection	by	Hand

If	you	know	Microsoft	Paint®,	Adobe	Photoshop®,	or	some	other	bitmap	editing	program,	you
can	create	your	own	car	side	and	top	images.		This	doesn't	require	a	lot	of	artistic	skill	--	it's	a
little	grid	of	pixels,	not	a	blank	mural	--	and	even	less	if	you	just	want	to	copy	an	existing	set
and	do	a	recoloring	or	kitbashing	job.

To	create	your	own	collection	from	scratch:

1.	 Create	an	image	for	each	side	and	top	view	in	the	collection.		See	instructions	under
Editing	Images	below.

2.	 Name	the	files	appropriately.		The	name	you	give	the	side	view	image	is	the	name	you	will
see	in	the	chooser	for	the	car	type,	so	make	it	something	friendly.		A	top	file	is	associated
with	a	side,	and	must	have	the	same	name	with	"_T"	before	the	extension.		The	top	and
side	need	not	be	in	the	same	format.	

Example:	side	=	"Pacific	Fruit	Reefer.gif"			top	=	"Pacific	Fruit	Reefer_T.bmp"

3.	 Collect	all	side	and	tops	into	a	single	folder,	named	what	you	want	to	call	the	collection.	



This	folder	can	go	anywhere	on	your	disk.

4.	 Bring	up	the	Car	Chooser.

5.	 Right-click	the	folder	under	which	you	want	the	new	collection	to	appear,	and	choose
Import	From	Folder.

6.	 Navigate	to	the	folder	of	images	and	click	OK.

The	program	will	create	a	new	xml	file	and	subfolder	in	your	TrainPlayer\Cartypes	directory,
copy	the	side	and	top	image	files	into	it,	then	add	the	new	collection	to	your	chooser	tree.

Editing	Images	in	Microsoft	Paint®

Click	Paint...	in	the	Car	Collection	Editor	Images	tab	and	it	will	open	the	selected	image	in
Paint.

The	preferred	format	for	top	and	side	images	is	24-bit	BMP,	but	other	formats	will	work	too
(.jpg,	.png,	.gif).

To	edit	in	Paint:

1.	 Zoom	to	enlarge	the	image	so	you	can	see	what	you're	doing.

2.	 Use	paint	tools	to	color	or	modify	the	image	to	suit.		Read	the	technical	details	below
regarding	sizes	and	shapes.

3.	 Save	the	file,	either	using	File	Save	or	confirming	save	when	closing	the	window.		(Do	not
use	Save	As.)

4.	 Return	to	TrainPlayer;	the	modified	image	will	show	up	in	the	Car	Collection	Editor.

Changes	made	and	saved	in	Paint	cannot	be	undone	or	cancelled.		If	you	want	to	modify
factory-supplied	images,	we	recommend	you	first	make	your	own	copy	(using	the	Save	As
button)	and	work	with	that.		If	you	accidentally	change	a	factory-supplied	image	and	want	to
revert	to	the	default,	download	a	new	copy	of	the	collection.

Note:	if	you	prefer	to	use	a	program	other	than	Paint	when	you	click	the	Edit	button,	this	can	be
arranged.		There	is	a	registry	value	called	PaintExeName	which	you	can	set	to	the	name	of	a
program.		This	value	is	located	under	HKCU\Software\TrainPlayer\TrainPlayer\Settings.		For
help	modifying	this	value,	send	e-mail	to	support.



									

Side-view	images	must	be	sized	correctly	so	they	will	look	ok	when	mixed	with	other	cars,	and
so	they	will	fit	in	the	train	windows.	

Use	a	drawing	space	32	pixels	high.	

Draw	the	image	so	it	touches	the	bottom.		Do	not	exceed	a	height	of	26	pixels,	otherwise	it
will	not	show	fully	in	the	control	panel.	

The	width	can	be	whatever	you	need	--	to	change	the	width,	drag	the	tiny	blue	dot	at	right
center.		A	good	rule	of	thumb	is	that	one	pixel	equals	about	a	foot	on	the	prototype,	so	a
50-foot	car	is	around	50	pixels	wide.		(Note	that	the	size	in	pixels	is	shown	on	the	status
bar	as	you	drag	the	dot).

The	transparent	color	is	whatever	color	is	in	the	top	left	pixel.		If	the	top	left	pixel	is	pink,
then	all	pink	pixels	in	the	image	will	become	invisible	when	the	image	is	displayed.		In	the
above	example,	the	transparent	color	is	light	grey.

Top-view	images	may	be	any	size	or	shape	--	the	program	scales	them	as	needed	to	fit	the	car
tops	on	the	layout.

Top	images	must	be	oriented	vertically,	with	the	nose	of	the	car	at	the	top.	

The	transparent	color	of	a	top	image	is	taken	from	the	lower	left	pixel.

Car	Collection	Errors

When	you	open	a	layout,	it	may	require	cars	not	found	among	your	installed	collections.		When
this	happens,	you	are	presented	with	an	alert	showing	several	choices:



OK:	ignore	the	errors;	for	the	current	session,	substitute	cars	from	the	standard	set	for	the
ones	specified	in	the	layout.

Cancel:	do	not	open	the	layout.

Download:	download	and	install	the	collection	from	the	web,	then	proceed	to	open	the	layout
with	its	full	set	of	cars.		This	button	is	available	only	if	you	have	an	internet	connection,	and	if
the	requested	collection	is	available	on	our	website.

If	someone	sends	you	a	layout	file,	and	it	requires	a	car	collection	not	available	on	our	website,
you	will	need	to	ask	that	person	to	send	you	the	collection.		Or	zip	it	up	and	send	it	to
TrainPlayer,	so	we	can	post	it	for	general	use.

Convert:	modify	the	layout	so	that	it	uses	standard	cars	instead	of	the	specified	ones.		The
modifications	are	saved	the	next	time	you	save	the	layout.		Warning!		once	you	make	this
change	to	a	layout,	it	cannot	be	changed	back!		The	layout	permanently	forgets	what	car
collection	it	was	originally	designed	to	use.



Default	Car	Sets

When	you	are	adding	cars	to	a	layout,	you	have	a	big	catalog	of	types	to	choose	from.	Flipping
through	it	in	the	Car	Chooser	is	straightforward	but	a	bit	of	a	job.	As	a	convenient	alternative,
you	can	use	the	menu	or	car	bar	to	choose	from	a	special	collection	called	the	default	car	set.

What	Is	a	Default	Set

A	default	set	is	a	collection	with	a	full	complement	of	the	basic	passenger,	freight,	and
locomotive	types,	all	related	by	theme	or	era.	TrainPlayer	comes	with	several	of	these.		You
can	choose	one	to	be	associated	with	a	layout,	then	use	it	as	your	main	car	source.	

Here	are	some	excerpts	from	the	supplied	default	sets:

Steam	--	1930's-era	equipment	with	steam	locomotives		

Modern	--	1990's-era	equipment	with	diesels			

Lionel	--	O-scale	equipment		

To	browse	the	whole	collection,	open	the	Defaults	folder	in	your	Car	Chooser	and	take	a	look
around:

Choosing	a	Default	Set	for	a	Layout

A	default	car	set	is	assigned	to	each	layout	you	open.		The	program	makes	an	initial
assignment	as	described	below;	to	override	it,	use	the	drop-down	at	the	bottom	of	Layout
Properties:



Choose	the	default	car	set	you	want	to	be	associated	with	the	layout.		The	choice	you	make	is
saved	in	the	rrw	file.

Note:	it	is	no	longer	necessary	to	choose	a	conplete	default	set	as	defined	above.		You	can
choose	any	car	collection	and	use	it	as	the	layout	default	set.

Modifying	this	choice	will	affect	the	layout	and	the	display	as	soon	as	you	click	OK	or	Apply	--
all	standard	car	types	on	the	layout	will	be	converted	to	the	newly-chosen	default	set.		Rules
for	doing	this	are	complicated,	but	basically	a	boxcar	of	one	style	is	converted	to	a	boxcar	of
the	other,	unless	it	is	a	car	which	was	not	chosen	from	the	default	set	to	begin	with.

The	initial	default	assigned	by	the	program	is	one	of	four	sets	--	Default	Steam	/	Modern	/	Brit
Steam	/	Brit	Modern	--	based	on	your	US-UK	preference,	and	the	ratio	of	steam	to	diesel	locos
on	the	layout.	

More	default	sets	are	available	for	download	in	your	Web	Car	Chooser.

Using	the	Default	Set



The	default	set	comes	into	play	in	the	Add	Car	menu	=>

The	twelve	class	names	below	the	line	refer	to	cars	in	the
current	default	set.		When	you	choose	By	Name,	the	Car
Inventory	Bar	comes	up,	showing	the	default	set.

For	more,	see	Car	Inventory	Bar	and	Adding	Cars	and	Trains.



Car	Loads

A	load	is	a	batch	of	goods	you	can	carry	in	a	freight	car.		It	has	a	name,	like	"coal"	or	"pipes,"
along	with	top	and	side	images	which	are	superimposed	on	the	car	images	when	you	load	a
car.		Associated	with	each	load	is	a	list	of	car	types	eligible	to	carry	the	load,	so	you	can't	put
coal	in	a	flatcar	or	farm	equipment	in	a	hopper.

Loads	with	images	are	suitable	for	use	in	open-top	cars,	like	flatcars,	gondolas,	and	hoppers.	
For	closed	cars,	like	boxcars	and	tankcars,	any	load	names	may	be	used	as	"closed-car
loads,"	represented	by	generic	symbols	on	top	views,	and	by	text	on	side	views.

TrainPlayer	comes	with	hundreds	of	load	types	and	easy	ways	to	browse	and	deposit	them	in
cars.	The	loads	come	ready	to	use	--	open	a	random	layout,	and	you'll	see	that	every	freight
car	has	already	been	assigned	a	typical	load,	ready	to	be	loaded	or	emptied	with	a	click.		You
can	change	the	load	associated	with	any	car,	and/or	set	a	default	load	for	each	car	type.

About	Loads

Loads	come	in	two	varieties.		Open-car	loads	are	for	open-top	cars	--	gondolas,	flatcars,
hoppers	--	and	have	a	pair	of	images	for	each	load.		Closed-car	loads	are	for	closed	cars	--
boxcars,	reefers,	tankcars	--	and	are	represented	by	generic	symbols	in	top	views,	text	in	side
views.		The	above	picture	shows	both	types.

Loads	are	similar	in	many	ways	to	car	types.		They	come	in	sets,	like	car	collections,	each
defined	by	a	file	of	data	and	(for	open-car	loads)	a	folder	of	images.		Like	car	types,	they	are
selected	from	a	chooser,	and	edited	in	a	collection	editor.		The	installer	delivers	a	sample	set	of
loads;	more	can	be	downloaded	from	the	collections	on	the	web.

There	are	several	moving	parts	associated	with	loads,	and	they	appear	in	various	places	in	the
program.		Here	is	a	compact	guide	to	relevant	reading	matter:

Load	Management 	
Load	Menu popup	menu	for	choosing	a	load	for	a	car
Load	Chooser dialog	for	choosing	pictorial	loads	for	one	or	more	cars
Load	Collection
Editor dialog	for	editing	load	collections	or	modifying	individual	load	definitions

	 	
Loads	Appear	In 	
Car	Properties where	the	load	for	a	car	can	be	viewed	or	changed
Car	Collection	Editor where	a	default	load	can	be	assigned	to	a	car	type

Loading	Cars

Every	freight	car	has	a	load	type	assigned	to	it,	whether	by	default	or	by	you.		There	are	two



steps	to	loading	a	car:	selecting	a	load	for	the	car	--	which	you	normally	do	once	--	then
toggling	it	on	or	off	whenever	the	car	is	loaded	or	unloaded.

To	select	a	load	for	a	car:

Right-click	the	car	and	make	a	choice	from	the	Load	Menu	described	below.		This	lets	you
choose	from	a	list	of	load	names	or	from	the	gallery	of	pictures	in	the	Load	Chooser.		Both
the	Load	Menu	and	Load	Chooser	offer	ways	to	load	more	than	just	the	selected	car.
Or:	right-click,	choose	Properties,	and	select	from	the	Load	drop-down	in	Car	Properties.

Either	way,	if	the	car	already	has	a	load	assigned,	it	will	be	replaced	by	the	new	choice,
and	the	car	status	will	be	set	to	Loaded.

Note:	another	way	to	set	a	load	for	a	car	is	to	set	a	default	load	for	the	car	type.		Then
every	time	you	create	a	car	of	that	type,	it	will	be	assigned	the	default	load.		See	Default
Loads	below.

To	load	or	unload	the	car:

Right-click	the	car	and	choose	Load	>	Loaded	to	mark	the	car	as	loaded,	or	Load	>
Empty	to	mark	it	empty.
Or:	click	Loaded	or	Empty	on	the	toolbar.

Setting	the	loaded/empty	status	of	a	car	modifies	its	image	in	side	and	top	views.	
Emptying	the	car	does	not	remove	its	assigned	load	type.

Car	Load	Menu

1.	Right-click	a	freight	car	to	see	the	Load	submenu.



The	menu	does	not	appear	for	unloadable	cars	--	locomotives,	tenders,	or	cabooses.	
Commands	on	the	menu	are:

Empty/Loaded:	changes	the	empty/loaded	status	of	the	car.	If	no	load	is	associated	with
the	car,	choosing	Loaded	brings	up	the	Load	Chooser.
Load	Chooser:	brings	up	the	Load	Chooser	for	selecting	loads.
Choose	By	Name:	shows	a	list	of	loads	suitable	for	the	car	--	pick	one	and	it	deposits	the
load	in	the	car.
Load/Unload	Car:	toggles	the	loaded	status	of	the	selected	car.
Load/Unload	Cut:	toggles	the	loaded	status	of	the	selected	car	and	any	coupled	cars	of
the	same	type.
Load/Unload	Train:	toggles	the	loaded	status	of	all	loadable	cars	in	the	train,	regardless
of	type.

Note:	the	Load	menu	is	also	available	from	the	main	menu	under	Train	>	Car.		This	makes	it
accessible	in	Tools	Customize,	so	you	can	create	your	own	keyboard	shortcuts	or	toolbar
buttons	for	load	commands.

Default	Loads

The	load	system	features	a	scheme	of	"cascading	defaults,"	designed	to	make	it	easy	to	use
loads	without	a	lot	of	setup.	The	following	diagram	illustrates	this.

In	the	AAR	Car	Types	list	(just	above),	you	can	see	that	a	default	load	is	assigned	to	each	car



class,	or	AAR	type.		This	allows	you	to	open	a	random	layout	and	find	meaningful	loads	on	all
cars	without	having	to	specify	anything.

In	the	Car	Collection	Editor	(above	right),	a	default	load	can	be	assigned	to	each	car	type,
overriding	the	default	based	on	the	AAR	code.	The	default	load	for	a	car	type	applies	only
when	you	create	a	car	of	that	type	--	it	does	not	automatically	change	the	load	of	every	such
car	on	the	layout.		For	example,	the	diagram	shows	that	the	next	time	you	create	a	gondola
(class	G)	from	the	named	collection,	its	load	will	be	"scrap	metal."

In	the	Car	Properties	dialog	(top	left),	a	specific	load	can	be	assigned	to	any	car	on	the
layout,	overriding	any	defaults.		The	same	result	is	achieved	by	dropping	a	load	on	the	car	from
the	load	chooser,	or	choosing	it	by	name	from	the	load	menu.			In	the	illustrated	example,
gondola	G1	is	modified	to	have	the	load	"crates2."

The	loaded/unloaded	status	of	a	car	is	also	changed	by	the	program	to	accommodate	switchlist
moves	or	as	a	car	is	delivered	to	its	destination.	No	user	action	is	required	for	this.

Creating	Your	Own	Loads

Creating	a	new	open-car	load	is	just	like	creating	a	new	car	type.		First	you	will	need	to	decide
which	load	collection	you	want	it	to	go	into,	and	use	a	paint	program	to	prepare	top	and	side
images	of	the	load.	Then	bring	up	the	Load	Collection	Editor	and	follow	the	instructions	for
Adding	a	New	Car	Type.

Creating	a	closed-car	load	is	not	necessary,	as	of	Version	7.		Any	load	names	can	be	used	in
Ops,	with	no	need	to	pre-register	into	the	load	list.



Car	Properties

For	viewing	and	editing	properties	of	the	selected	car.	Called	from	Properties	on	the	Car
context	menu.		See	also	About	the	Properties	Dialog.

							 				

As	of	version	6.6,	car	properties	are	split	between	two	tabs:	Car	(this	one)	and	Car	Data.		In	these	tabs,
you	set	properties	of	the	individual	selected	car.		You	cannot	change	the	car	type	--	if	you	have	a	boxcar
and	want	a	flatcar	instead,	you	have	to	delete	the	car	and	create	a	new	one.

Most	of	the	properties	you	set	in	these	tabs	are	displayed	on	the	car	tooltips,	as	shown	above.	(In	the
tooltip,	the	Car	Note	field	is	designated	with	a	prefix	of	"=>.")

Dialog	data	on	the	Car	tab:

Images
Top	and	side	images	of	the	car	type.		Images	resize	with	the
dialog.		These	images	belong	to	the	car	collection	and	cannot	be
changed	here.		Images	are	displayed	in	a	car	panel.

Tag Internal	program-assigned	numeric	ID.		Every	car	on	the	layout
has	a	unique	tag.

Text
The	block	of	text	at	the	upper	right	includes	car	type	name,
collection	name,	AAR	code,	class,	class	description,	load
information,	identifying	tag,	and	car	notes	if	any.

Label

The	identifier	of	the	car.		This	can	be	displayed	on	the	car	top
(see	Car	ID	Display	below),	and	may	be	used	in	scripts	to	refer
to	this	car.	The	initial	ID	assigned	to	a	car	is	a	one-letter	initial	of
the	car	class,	followed	by	a	number	which	makes	the	label
unique.		You	can	change	this	to	any	short	string,	as	long	as	it



remains	unique.		See	also	Car	ids.

Size
Size	of	the	car,	length	x	width	as	viewed	from	the	top,	in	units
selected	in	the	drop-down.		Changing	the	size	in	this	dialog
changes	only	the	currently-selected	car.		To	change	the	size	of	all
cars	of	this	type,	use	the	Car	Collection	Editor.

Units Units	for	car	size	display.		Units	chosen	in	this	drop-down	will
remain	in	effect	throughout	the	program	until	changed.

Collection... Click	to	view	or	edit	the	car	type	properties	in	the	Car	Collection
Editor.	

Car	ID	Display

It	is	often	useful	to	see	car	identifiers	on	the	layout.		These
can	be	turned	on	and	off	for	all	or	selected	cars.

Think	of	car	ids	as	lighted	signs	on	top	of	the	cars.		There
are	two	mechanisms	for	controlling	them:	(1)	inside	each	car
is	a	switch	to	turn	its	own	sign	on	and	off,	and	(2)	there	is	a	master	power	switch	to	disable	or
enable	all	lighting.		The	idea	is	that	you	can	display	ids	on	a	set	of	cars	of	interest,	and	with	one
click,	turn	them	on	or	off	without	losing	the	selection.

Another	feature	affecting	car	id	display	is	the	option	Turn	off	labels	while	moving	in	Train
Preferences.		This	causes	ids	to	be	suppressed	when	cars	are	moving,	re-displayed	when	they
stop.		This	applies	both	in	and	outside	of	ops.

The	appearance	of	the	id	display	can	be	customized.		You	can	set	font	and	background	color.	
As	of	Version	8.1,	you	can	choose	to	see	numeric	ids	(train	and	car)	instead	of	the	car	label.
See	Train	Preferences.	

What	you	see	on	top	of	a	car	may	not	be	its	label	or	ids,	but	instead	a	code	indicating	the	car's
destination	(the	car	Dest).		If	a	car	has	a	nonblank	Dest	field,	you	see	that	instead	of	the
regular	label.	This	is	normally	the	case	when	running	an	ops	session.	

To	turn	ids	on	or	off	for	specific	cars:

1.	 Right-click	a	car	and	choose	Show	Car	ID.		This	displays	the	id	on	the	selected	car,	and
turns	on	the	master	switch	if	necessary	so	you	can	see	it.

If	the	id	is	already	showing,	the	command	changes	to	Hide	Car	ID.		Choose	that	to	turn	off
the	id.



2.	 To	toggle	ids	for	an	entire	train:	right-click	any	car	of	the	train	and	choose	Train	>	Show
Car	IDs.		This	changes	to	Train	>	Hide	Car	IDs	if	any	car	in	the	train	is	displaying	an	id.

To	turn	all	car	ids	on	or	off	(master	switch):	

1.	 Choose	View	>	Car	IDs	from	the	main	menu.

This	toggles	the	master	switch.		If	some	ids	are	already	showing,	this	command	hides
them	but	does	not	change	the	internal	car	switches;	choosing	the	command	again	turns
them	back	on.		This	item	is	checkmarked	on	the	menu	so	you	can	tell	if	the	master	switch
is	on	or	off.

If	you	have	not	yet	turned	on	ids	for	any	cars	or	trains,	then	View	>	Car	IDs	turns	them	on
for	all	cars	on	the	layout.

2.	 Or	choose	View	>	Remove	All	Car	IDs.		This	hides	all	the	labels	and	resets	all	internal	car
switches	to	off.		The	next	use	of	View	>	Car	IDs	will	show	labels	on	all	cars.



Car	Collection	Editors

The	Car	Collection	Editor	is	for	viewing	and	editing	properties	of	car	types	within	a	collection.	
Also	described	on	this	page	are	the	related	dialogs	Load	Collection	Editor	and	AAR	Car	Types.

To	bring	up	the	Car	Collection	Editor:	(a)	click	the	Collection	button	in	Car	Properties,	or	(b)	in
the	Car	Chooser,	right-click	a	collection	in	the	tree	and	choose	Properties.		This	dialog	has
three	or	four	tabs.		One	has	properties	for	the	overall	collection;	others	refer	to	a	specific	car
type	within	it.		The	Load	tab	appears	only	when	a	loadable	car	is	active.

Car	Type	Tab

This	tab	is	for	viewing	and	editing	a	single	car	type.		It	has	VCR-style	back/forward	buttons	to
let	you	move	to	other	types	in	the	collection.		The	"current"	type	is	the	one	on	display	in	this
tab.		The	instructions	in	this	section	apply	if	you	are	building	a	car	collection	or	adding	a	new
type;	for	most	collections,	all	the	data	is	already	filled	in.

images Resizable	car	panel	showing	side	and	top	views.		Drag	the	divider	to
enlarge	one	side.

Name Name	of	the	car	type.	Enter	a	short,	descriptive	name,	suitable	for
display	on	the	icon	in	the	car	chooser.

Class

General	category	of	car.		Choose	one	unless	you	are	assigning	an	AAR
code,	in	which	case	the	class	will	be	automatically	set	to	match	the
code.		For	more,	see	Car	Classes	below.		To	choose	an	AAR	code	from
the	dialog,	select	AAR	Codes...	--	the	last	item	on	the	drop-down	menu.

Note:	if	you	want	a	car	of	this	type	to	have	power,	choose	Diesel	or



Steam	as	its	class.

AAR A	one-	to	three-letter	code	specifying	the	car	type	in	detail.		You	can
either	type	a	code	into	this	box,	or	choose	from	a	list.		See	AAR	Codes.	

Size Dimensions	of	a	car	of	this	type	--	length	x	width,	as	seen	from	above.	
Displayed	in	the	units	selected	in	the	drop-down.

Units Units	for	size	values.		If	you	change	the	units	in	this	drop-down,	the
choice	will	apply	throughout	the	program.

Show	load
Check	to	have	the	load	displayed	in	the	car	panel.		Dimmed	if	car	is	not
loadable.		Note	that	in	this	dialog,	the	load	you	see	is	the	default	load
connected	to	the	car	type;	if	may	not	match	the	load	of	a	car	on	the
layout.

Arrows	<	> Buttons	for	scrolling	through	the	list	of	car	types	in	the	collection.

Index Position	of	current	car	type	within	the	collection.		You	can	type	a	number
in	this	box	to	go	to	a	specific	index.

Add Click	to	add	a	new	car	type	to	the	collection.		See	Adding	a	New	Type
below.

Delete Click	to	delete	the	current	car	type	from	the	collection.

Images	Tab

This	tab	is	for	changing	the	side	and/or	top	images	for	the	current	type.		Each	car	type	has	two
images:	a	top	view	and	a	side	view.		Each	view	is	in	a	separate	graphics	file.

images Resizable	car	panel	showing	side	and	top	views



Side	Image
path

Path	to	the	graphics	file	of	the	side	image.		To	choose	a	different	file,
click	Browse.

Image	type Image	size	type	for	the	collection:	small,	medium,	or	large;	see	50-pixel
cars

Paint Click	to	call	up	a	paint	program	to	edit	the	side	image.		See	Editing
Images.

Browse Click	to	call	up	a	file	dialog	to	select	a	side	image	file.		Supported	types
are	as	listed	in	the	drop-down	--	bmp,	jpg,	gif,	png.

Top	image	path Path	to	the	graphics	file	of	the	top	image.		To	choose	a	different	file,
click	Browse.

Choose Select	a	new	top	image	from	a	chooser	of	available	tops.

Paint Click	to	call	up	a	paint	program	to	edit	the	top	image.		See	Editing
Images.

Browse Click	to	call	up	a	file	dialog	to	select	a	top	image	file.

Note:	CP	car	images	are	special	cases	in	the	Images	tab.		If	a	car	type	has	a	CP	image,	it	is
in	a	file	with	the	same	name	and	path	as	the	top	image,	but	with	"_F"	instead	of	"_t"	at	the
end.		If	you	want	to	view	the	large	image	in	Paint,	make	this	change	in	the	Top	Image	box	and
click	Paint.		But	then	be	sure	to	click	Cancel!		You	do	not	want	either	of	the	paths	in	this	dialog
to	point	to	a	_F	file.

Collection	Tab

This	tab	is	for	editing	properties	of	the	overall	collection.



Name This	can	be	any	name	you	like,	but	best	to	keep	it	short.

Info Description	and	author.	If	the	collection	is	of	your	own	creation,	include	some
information	about	it.

Path Full	pathname	to	the	xml	file	defining	the	collection.	You	cannot	change	the	path	in	this
dialog.

Export Copy	collection	data	to	output	directory	and	prepare	for	publication;	see	Car	CollectionPublisher.

Load	Tab

This	tab	gives	properties	of	the	default	load	for	the	car	type,	and	access	to	adjustable
parameters	having	to	do	with	how	loads	sit	in	this	type	of	car.		Most	of	these	parameters	are
new	in	Version	6.0,	and	are	intended	for	experts	to	fine-tune	their	loaded	cars.		These	settings
take	effect	immediately	on	the	car	images,	so	you	can	fool	with	them	to	see	what	effect	they
have,	then	Cancel	if	you	did	not	intend	to	make	changes.

images Resizable	car	panel	showing	side	and	top	views
car	type	name Name	duplicated	from	Car	Type	tab

Default	Load Name	of	load	to	fill	this	car	by	default,	if	no	other	has	been	defined.		Drop-down
gives	list	of	load	names	suitable	for	this	car	type.

Chooser Click	to	bring	up	Load	Chooser,	where	you	can	choose	a	new	default	load
graphically	instead	of	by	name

Load	AAR List	of	AAR	codes	indicating	cars	which	can	accept	this	load;	this	duplicates
what	is	seen	in	the	Load	Chooser

Closed	Car A	text	label	"Closed	Car"	appears	above	the	display	frame	when	a	car	is



indicator classified	as	closed;	see	Types	of	Cars

Display	Length
Percent	of	car	length	which	can	be	occupied	by	load.		For	most	cars,	leave	this	as
0	(default)	and	loads	will	look	ok;	change	to	a	smaller	value	if	load	images	stick
out	over	the	ends	of	the	car.		Applies	to	both	top	and	side	views.

Show	load	as	text
Check	means	this	car	type	is	closed,	and	a	graphical	load	image	will	not	work;
instead,	display	the	load	by	name	above	the	car.		Applied	by	default	to	closed
cars;	use	this	checkbox	to	override	normal	behavior	for	special	cars.

Draw	load	in	front
Load	image	is	to	be	displayed	in	front	of	car	image.		Use	this	for	example	in	a
barrel	rack	car,	where	there	is	one	inner	wall	instead	of	two	outer	ones,	and	the
load	shows	visibly.

Floor	Height Height	of	car	floor	above	ground;	for	positioning	loads	within	gondolas	or	drop-
bottom	flats.		Default	of	zero	gives	acceptable	positioning	in	most	cases.

Insets
Distance	load	should	be	inset	from	outer	edges,	in	top	view.		These	values
represent	the	"wall	thickness"	of	the	car,	ends	x	sides	--	i.e.,	a	larger	value	for	the
first	value	will	cause	the	load	to	sit	less	close	to	the	end	walls

units Units	apply	to	insets	and	floor	height
arrows Click	to	move	through	the	collection,	same	as	on	the	Car	Type	ta
Show	load Toggles	display	of	load	in	the	car	panel

Adding	a	New	Car	Type

To	add	a	new	type	to	a	collection,	click	the	Add	button	on	the	Car	Type	tab.		This	creates	a
new	undefined	type	and	blanks	the	dialog	for	entry	of	data.		To	provide	a	complete	definition,
you	will	need	to	enter	data	into	both	the	Car	Type	and	Images	tabs.	



Name Provide	a	short,	descriptive	name	of	the	new	car	type.
Class,	AAR Choose	a	car	class	or	an	AAR	code.
Size,	Units Specify	the	car	size,	length	x	width,	in	the	selected	units.
Default	Load Choose	a	load	to	be	the	default	for	this	car	type.

The	OK	button	remains	dimmed	until	you	have	entered	all	the	necessary	information.		On
Cancel,	the	new	type	is	discarded	and	no	change	is	made	to	the	collection.

AAR	Car	Types	Dialog

An	AAR	code	is	a	symbol	for	a	specific	type	of	car,	as	explained	under	AAR	Codes.		Every	car
and	car	type	has	one,	whether	assigned	by	the	program	or	by	you,	as	described	here.	

To	assign	an	AAR	code	to	a	car	type:

1.		In	the	Class	drop-down,	choose	the	last	item,	"AAR	Types	List."		This	brings	up	the	AAR
types	in	a	separate	list	window:

Each	row	has	the	AAR	Code	as	defined	in	TrainPlayer,	a	description	of	the	car	type,	the
corresponding	generic	class,	and	the	default	load	for	the	car	type.	

The	class	name	varies	depending	on	the	setting	in	the	drop-down	at	the	bottom.		The	US
version	is	shown	in	the	screen	shot;	an	alternate	version	is	available	for	UK	users.		If	you
change	the	selection	in	the	drop-down,	it	will	change	the	entries	in	the	Class	column,	and
whenever	a	car	description	appears	in	the	program	(on	dialogs,	tooltips,	etc.),	the	name	given
in	this	column	will	be	used.		This	choice	can	also	be	made	in	Preferences	--	see	Car	Defaults.

2.		Click	a	row	in	the	list	window	to	select	a	type.		This	updates	the	AAR	text	in	the	Car	Type



tab.	

Note:	if	you	are	in	the	Load	Collection	Editor,	the	code	you	select	will	be	appended	to	the	text
in	the	AAR	box	(with	comma)	rather	than	replacing	it.

3.		Or:	type	a	code	directly	into	the	AAR	box.		If	the	code	is	a	valid	one,	the	list	window	will
scroll	to	that	type.

The	AAR	Car	Types	window	remains	up	as	you	browse	through	the	car	collection.		To	take	it
down,	click	the	close	box	or	OK	button.

Load	Collection	Editor

The	Load	Collection	Editor	is	very	similar	to	the	Car	Collection	Editor,	and	can	be	operated	as
described	above.		To	bring	up	the	Load	Collection	Editor,	right-click	a	load	image	in	the	Load
Chooser	and	choose	Properties.

The	differences	between	the	Load	version	and	the	Car	Collection	one	are	(a)	some	controls	are
removed	from	the	former	which	do	not	apply	to	loads	(Size,	Units,	Default	Load,	Show	Load);
(b)	the	AAR	box	in	the	Load	dialog	contains	a	different	kind	of	string,	described	below.

Load	AAR	Strings

What	you	see	in	the	AAR	box	for	a	load	definition	is	not	a	single	code,	but	a	list	of	codes
indicating	all	car	types	suitable	to	carry	the	current	load.		For	example,	as	shown	above,	a
bulldozer	can	be	transported	by	a	general-service	flatcar	(FM),	or	a	well	car	(FW),	or	a	solid-
bottom	gondola	(GB).

	A	single-letter	code	represents	all	car	types	of	the	same	class;	for	example,	"G"	means	"all
types	starting	with	G."		A	minus	sign	before	a	code	means	"except	this	type;"	for	example,	"F,-
FA"	means	"all	types	F	except	FA."

A	letter	in	parentheses	is	a	display	code	for	modifying	the	appearance	of	the	load.		At	the



moment	there	is	only	one	such	code:	"(S)"	=>	"stretchable,"	meaning	the	load	image	is	to	be
stretched	horizontally	to	cover	the	entire	car	top.		Without	this	indicator,	a	load	image	is	shown
at	its	natural	size,	even	if	it	is	shorter	than	the	car.		Stretchable	loads	are	those	like	coal	or
gravel,	which	look	like	piles	covering	the	whole	car;	unstretchable	are	those	like	bulldozers,
which	remain	fixed	size	regardless	of	the	size	of	the	car.

You	can	use	the	AAR	Car	Types	window	to	create	a	multi-code	string.		When	you	click	a	row	in
that	window,	it	adds	a	comma	and	a	new	code	to	the	string	in	the	AAR	box.	For	example,	you
can	click	three	rows	in	the	AAR	Car	Types	window	(one	at	a	time)	and	get	a	string	like
"FA,FB,FC."

	



The	Car	Inventory	Bar

The	Car	Inventory	Bar	(CIB)	replaces	the	old	twelve-button	car	toolbar	with	a	new	docking,	resizable,
scrollable	window	where	you	choose	rolling	stock	to	populate	your	layout.	The	window	is	a	source	of
cars	--	it	shows	a	complete	car	collection,	from	which	you	can	drag	any	car	type	onto	the	track	or	into	the
train	window.	Initially,	the	collection	shown	in	the	CIB	is	the	default	set	associated	with	the	layout,	but
you	can	choose	any	other	set.

The	CIB	is	one	of	two	new	control	bars	introduced	in	Version	5.2.		The	other	is	the	Train	Control	Bar
(TCB).		Both	use	the	same	train	display	window	--	see	Train	Window.

To	view	the	Car	Inventory	Bar:

(a)	toggle	using	Tools	>	Car	Inventory	Bar	from	the	main
menu.	OR:

(b)	in	a	track	or	train	context	menu,	choose	Add	Car	>	By
Name	(or	Add	Car	Here	>	By	Name).	This	brings	up	the
CIB	at	the	bottom	of	the	screen,	along	with	a	floating	window
called	Car	Types	showing	the	same	collection	as	a	list	of
names.

The	header	of	the	CIB	window	shows	the	name	of	the
collection	on	display.	The	order	in	which	cars	are	displayed
in	the	CIB	is	by	car	type.	Engines	are	shown	first,	at	the	left,	then	passenger	cars,	then	freight.	You	can
hover	over	an	image	to	see	information	about	it	--	in	a	tooltip	if	those	are	enabled,	otherwise	on	the	status
bar	--	or	right-click	and	choose	Properties	to	get	the	full	details.	Clicking	a	car	type	selects	it	--	gives	it	a
pink	underline,	and	highlights	it	in	the	Car	Types	window	if	visible.

Like	the	TCB,	the	Car	Inventory	Bar	can	be	dragged	by	its	header	to	undock	or	dock	elsewhere,	or	it	can
be	set	up	for	auto-hide.	It	has	a	horizontal	scrollbar	for	viewing	long	trains.	It	can	be	resized	vertically,
and	can	show	large-image	(Chris	Pedersen)	collections	at	any	size	up	to	full.

To	add	a	car	from	the	Car	Inventory	Bar:

(a)	right-click	a	car	image	and	choose	Add	Car;	or	double-click	an	image.	This	adds	a	car	of	the	selected
type	to	the	current	train	at	the	insert	position	--	the	place	where	you	see	the	orange	pin	in	the	train
window.	To	change	the	insert	position,	click	a	different	spot	in	the	train	window.

(b)	select	the	name	in	the	Car	Types	list	and	click	Add.

(c)	press	the	image	and	drag.	You	can	drag	to:



(1)	any	point	along	any	track,	where	the	cursor	changes	to	an	arrow	--	let	go	and	a	new	car	is	created	at
that	position.	OR:

(2)	the	top	of	an	existing	train	on	the	layout	--	point	to	an	end	car	or	to	a	space	between	cars,	where	you
see	one	or	two	red	highlights	around	the	cars	--	let	go	and	a	new	car	is	created,	attached	to	the	indicated
car(s).	OR:

(3)	a	position	in	the	train	window.	The	orange	pin	moves	as	you	drag	--	let	go	and	a	new	car	is	added	at
the	pin	position.

To	display	a	different	collection	in	the	Car	Inventory	Bar:

Click	the	down-arrow	and	use	the	Car	Inventory	menu,	as	follows.

Car	Inventory	Menu

	The	down-arrow	at	lower	right	of	the	bar	brings	up	the	Car	Inventory	Menu,	similar
to	this:

The	menu	is	in	three	sections.		At	the	top	is	a	list	of	all	installed	default	collections	(see	Default	Car
Sets).		This	is	followed	by	a	most-recently-used	list	of	collections	previously	on	display.		Choose	a	name
from	either	section	to	select	it	and	display	it	in	the	bar.

Commands	in	the	lower	section	of	the	menu	are:

Car	Chooser	--	brings	up	the	Car	Chooser,	where	you	can	(a)	select	an	individual	car	type	in	the	usual
way,	or	(b)	select	a	car	collection	to	be	displayed	in	the	bar	--	to	do	this,	select	a	folder	in	the	chooser
tree,	then	click	OK	to	dismiss	the	chooser.

Choose	By	Name	--	brings	up	the	Car	Types	list,	so	you	can	choose	a	car	type	by	name.



Car	Bar	Settings	--	brings	up	the	Car	Bar	Settings	dialog,	where	you	set	properties	of	the	bar	and	the
menu.

Snap	to	Fit	--	if	checked,	means	bar	height	is	automatically	adjusted	to	fit	the	selected	collection.

	



Decorating	Cars										

There	are	thousands	of	cars	available	for	your	use	in	TrainPlayer,	but	if	you're	looking	for	one
with	a	particular	color	scheme	or	road	name,	you're	probably	out	of	luck.		Or	used	to	be.	
Version	8.0	introduces	Paint	Shop,	a	new	facility	for	applying	your	own	color	schemes	and
decals	to	the	cars	and	engines	on	your	layout.

Despite	the	name,	this	is	not	a	"paint	program"	or	bitmap	editor.		The	result	of	a	Paint	Shop
session	is	not	an	image	in	a	file,	but	rather	a	set	of	instructions	for	modifying	the	existing	image
from	a	car	collection	file.		These	instructions	(which	we're	callling	a	paint	job)	are	saved	with
the	cars	in	the	layout	file,	and	do	not	affect	the	collections	themselves.		This	means	you	can
apply	a	custom	paint	job	to	some	car	on	a	layout,	and	a	different	one	to	the	same	car
elsewhere.

About	Paint	Jobs

A	paint	job	has	two	components:	a	color	scheme	and	a	set	of	decals,	both	described	below.	
The	system	comes	with	a	new	set	of	artwork	in	the	Decal	Chooser	--	hundreds	of	images	of
logos,	road	names,	detail	parts,	and	decorations.		In	addition,	there	are	specialized	types	of
decal	which	have	special	functions	and	no	images.

A	car	has	one	paint	job	for	its	side	view	(as	seen	in	the	train	bar,	train	menu,	and	various
dialogs)	and	a	different	one	for	the	top	view	(as	seen	moving	around	the	layout).		Creating	and
modifying	paint	jobs	is	done	in	the	Paint	Shop	dialog.		This	dialog	works	on	one	car	at	a	time,	in
both	top	and	side	view,	and	is	modeless	so	you	can	do	a	series	of	cars	without	bringing	it	up
each	time.		For	details,	see	Paint	Shop.

About	Color	Schemes

A	color	scheme	consists	of	one	or	more	color	change	instructions.		Each	has	a	pair	of	colors,
FROM	and	TO,	and	means	"wherever	the	original	image	has	color	F,	change	it	to	T."		You	can
define	as	many	of	these	as	needed	to	repaint	a	multi-colored	car.

The	concept	is	simple,	but	in	practice	there	is	more	to	it.		Generally	a	car	with	color	F	has	not
just	F	but	also	lighter	and	darker	shades	of	it	--	a	range	of	colors	around	F.		So	when	you
specify	the	From	color,	you	also	give	a	number	specifying	the	range	width.		The	color	change
is	thus	more	accurately	expressed	as	"wherever	the	original	image	has	color	F	or	any	within	W
shades	of	it,	change	them	all	to	T."

Each	color	change	also	involves	one	more	bit	of	data:	a	binary	choice	called	gradient.		When



this	is	off,	then	all	pixels	in	the	F	band	are	changed	to	the	color	T.		When	gradient	is	on,	then
only	pixels	of	exactly	F	are	changed	to	T,	F+1	are	changed	to	T+1,	etc.		This	has	the	effect	of
preserving	shadings	and	gradients	in	the	original	image	while	still	changing	the	overall	color.

Here	is	an	example	showing	the	tankcar	from	the	Default	Steam	collection	--	the	effects	of
color	changes	using	different	range	widths	and	gradient	choices.

original	image color	change,	narrow	range

wide	range	no	gradient wide	range	with	gradient

About	Decals

Decals	in	Paint	Shop	are	a	bit	like	those	in	the	real	world:	choose	one	from	a	gallery,	drag	it
onto	your	car,	and	slide	it	into	position.		But	the	virtual	ones	go	a	lot	further.		When	you	slide
them	you	don't	have	to	keep	them	wet,	and	you	never	have	to	worry	about	wrinkles!		Also,	you
can	resize,	flip	in	either	direction,	copy	and	paste,	and	choose	opaque	vs.	transparent
background.

In	addition	to	the	image-based	decals	available	in	the	chooser,	there	are	several	other	types
used	for	special	purposes.		To	create	one,	draw	a	rectangle,	then	choose	a	type:

Solid	Color:	as	it	says,	just	a	rectangular	swatch	of	the	color	of	your	choice.		This	can	be
useful	for	covering	up	unwanted	parts	of	the	original	image.

Mask	Region:	a	region	in	which	no	color	changes	are	applied	--	not	unlike	an	area	you
cover	with	masking	tape	before	spraying.		An	example	is	shown	in	the	images	above:	the
wheels	and	undercarriages	are	covered	by	a	mask	region,	thus	unaffected	by	the	color
changes.

Text	Box:	a	block	of	text	in	your	choice	of	font	and	color.		The	font	you	choose	determines



the	text	size;	the	rectangular	region	defines	bounds	for	wrapping	multi-word	text.		

Clone:	a	copy	of	a	region	from	elsewhere	in	the	image.	The	initial	rectangle	defines	the
clone	site;	when	you	move	or	resize	the	decal,	and	it	continues	to	display	what	is	at	that
site.		This	is	useful	for	covering	up	parts	of	the	image	--	make	a	clone	of	some	blank	area
and	use	it	to	cover	somewhere	else.

See-Through:	a	region	which	completely	erases	the	image	and	shows	through	to	the
background.		This	can	be	useful	for	hiding	portions	of	the	image	to	be	replaced	by	other
decals.

Shaded	Cylinder:	a	region	representing	a	horizontal	cylinder	(e.g.,	a	tankcar),	with	an
automatic	gradient	around	a	chosen	color.

Wireframe:	a	transparent	decal	automatically	created	from	a	car	diagram,	taking	just	the
dark	lines

For	examples,	see	the	How-To	sections	under	Paint	Shop.



			Building	Trains

In	TrainPlayer,	you	can't	modify	the	tracks	on	a	layout,	but	you	can	equip	it	with	the	rolling	stock
of	your	choice.		This	chapter	tells	how.

Selecting	Cars	and	Trains

Adding	Cars	and	Trains

Removing	Cars	and	Trains

Relocating	a	Train

Naming	Trains

Train	Properties

Train	Tree



Selecting	Cars	and	Trains

If	there	are	any	trains	on	a	layout,	then	one	of	them	is	always	designated	the	"selected	train."	
This	is	the	one

which	appears	in	the	train	window	on	the	Control	Panel	or	Train	Control	Bar
which	is	being	controlled	by	the	the	panel	or	bar
which	appears	outlined	or	checked	in	the	Train	menu
which	is	the	one	affected	by	most	of	the	commands	under	Train	on	the	main	menu

To	select	a	train:	(a)	click	any	car	in	the	train,	(b)	choose	its	name	or	picture	from	the	Train
menu,	or	(c)	click	its	name	in	the	Train	Tree.

At	any	given	time	there	may	be	at	most	one	"selected	car"	on	the	layout.		If	a	car	is	selected:

a	pink	X	is	shown	on	the	car	top*
an	orange	line	is	shown	under	the	car	in	the	Train	Window
the	uncoupling	pin	is	positioned	before	or	after	the	car
the	Add	Car	command	will	deposit	its	new	car	at	the	pin	position
Edit	commands	(cut,	copy,	delete)	apply	to	the	selected	car

To	select	a	car:	(a)	click	its	image	on	the	layout,	(b)	click	its	icon	in	a	train	window,	or	(c)	click
its	name	in	the	Train	Tree.		When	you	select	a	car,	you	also	select	its	train.

To	unselect:	click	a	blank	space	on	the	layout,	or	the	blank	space	behind	the	train	in	the	train
window.

*	When	you	first	click	to	select	a	car,	the	X	appears.		By	default	it	will	disappear	automatically
after	5	seconds.		You	can	change	this	behavior	in	Operation	Preferences.	

Train	Menu

To	select	a	train	on	the	layout,	you	can	choose	from	either	a	normal	text	menu	or	a	menu	of
pictures.		These	can	be	annotated	with	the	train	and	car	identifiers	if	you	choose.



The	Train	Menu	appears	when	you	click	the	down-arrow	at	the	right	in	the	train	window,	or
choose	Train	>	Train	Menu	from	the	main	menu.		The	currently-selected	train	is	shown	with	a
blue	outline,	or	a	checkmark	if	you	have	a	text-only	menu.		To	select	a	train	from	the	menu,	just
click	its	row.

To	specify	what	the	train	menu	should	display,	click	Train	Menu	Settings...	and	see	the
following	dialog.		(For	information	about	the	other	menu	item,	see	Train	Control	Bar	Settings.)

Controls	are:

Show	on	Menu
choose	whether	you	want	to	see	all	the	trains	on	the	layout,	or	only
those	having	engines,	or	only	those	to	which	you	have	assigned	non-
default	names

Text	only check	if	you	want	a	normal	text	menu	without	pictures

Show	train	names
check	if	you	want	train	names	displayed	along	with	the	pictures.		The
train	name	is	shown	at	top	left	of	the	picture.		This	option	is
disregarded	if	"Text	only"	is	checked.

Show	car	ID's check	if	you	want	each	car	to	have	its	ID	shown	underneath	(as	in	the
picture	above).		This	option	is	disregarded	if	Text	only	is	checked.

Note:	trains	do	not	have	names	until	you	provide	them.		Do	not	choose	"Only	named	trains"	or
"Text	only"	unless	you	have	some	named	trains	on	the	layout.		Most	of	the	ops-ready	layouts
you	can	download	from	your	web	chooser	have	train	names.

Settings	you	make	in	this	dialog	stay	in	effect	until	you	change	them	again	in	this	or	another
session.



Adding	Cars	and	Trains

Building	trains	on	your	layout	is	a	matter	of	choosing	the
types	of	cars	and	locos	you	want,	and	placing	them	on	the
track.		There	are	a	number	of	ways	to	do	this:

From	the	Add	Car	menu	(shown	at	right).		See	below
for	instructions	accessing	and	using	this	menu.
	
From	the	Car	Chooser.		Choose	a	car	from	our	huge
catalog,	click	to	add	it	to	the	selected	train.		See	Car
Chooser.
	
By	drag	and	drop.		Drag	a	car	type	from	a	car
source	and	drop	it	onto	a	track	or	window	or	car.		See
Car	Swap	and	Drag	and	Drop	below.
	
By	copy	and	paste.		Copy	a	car	or	train	to	the
clipboard,	then	right-click	a	target	track	and	choose
Paste	Here.		Use	just	Paste	to	add	the	copied	car(s)	at	the	position	of	the	uncoupling	pin.
	
Using	menu	commands	Train	>	New	Locomotive	or	New	Train.		Each	creates	a	new
train	on	the	first	available	track;	the	latter	with	a	few	cars	behind	the	engine.
	
Via	random	train	generation.		Populate	some	or	all	tracks	with	a	random	selection	of
cars	and	trains.		Details	below.
	

Once	you	build	a	train,	you	may	need	to	rearrange	its	cars.		For	a	handy	method,	see	Car	Shift
below.

Accessing	the	Add	Car	menu

This	menu	provides	ways	of	choosing	the	type	of	car	you	want	to	add.	It	comes	up	when	you:

right-click	a	track	section	and	choose	Add	Car	Here.	This	deposits	the	chosen	car	at	the
specified	location	on	the	track.		Use	this	to	place	the	first	car	of	a	train,	or	to	deposit	an
isolated	car.
	
right-click	a	train	and	choose	Add	Car.	This	deposits	the	car	in	the	clicked	train	at	the
clicked	position.		Use	this	to	add	or	insert	a	car	into	an	existing	train.
	
choose	Train	>	Add	Car	from	the	main	menu.	This	inserts	the	car	into	the	selected	train	at
the	position	of	the	uncoupling	pin	--	the	orange	spike	in	the	train	window.



Reposition	this	pin	by	(a)	clicking	in	the	train	window,	(b)	selecting	a	different	car,	(c)	using
a	command	from	the	Train	>	Uncoupling	Pin	menu.		For	more	info,	see	the	Uncoupling
Pin	description	on	the	train	control	bar	page.

Using	the	Add	Car	menu

On	the	Add	Car	menu,	pick	one:

By	Name...	This	brings	up	both	the	Car	Inventory
Bar	and	the	Car	Type	Names	list	box	(shown	at
right),	displaying	the	layout's	default	car	set.
Choose	a	car	type	by	(a)	clicking	a	name	in	the	list
box,	or	(b)	double-clicking	an	image	in	the	car	bar,
or	(c)	dragging	an	image	from	the	car	bar	onto	the
layout	or	the	train	window.		For	more	info,	see	Car
Inventory	Bar.
	
Car	Chooser...	This	brings	up	the	Car	Chooser,	where	you	can	browse	and	select	from
the	entire	catalog	of	cars	and	locos,	including	both	ones	locally	installed	and	others
downloadable	from	the	web.
	
<a	class	name>.	As	a	convenient	shortcut,	the	menu	lists	a	dozen	standard	car	classes.
Each	retrieves	a	car	of	that	class	from	the	default	car	set,	if	there	is	one.	If	there	is	more
than	one,	the	first	one	is	used.
	

Car	Drag	and	Drop

Drag	and	drop	can	be	used	to	add	new	cars	to	the	layout,	or	to	change	existing	cars	to	new
types.		In	both	cases,	you	drag	from	one	of	two	car	sources	onto	various	kinds	of	drop	targets.

Car	Sources:

Car	Inventory	Bar	(shown	below	left)		This	is	usually	docked	to	the	bottom	of	the	screen.	
Scroll	horizontally	to	the	car	type	you	want	(the	source	car),	press	on	the	image	and	begin
drag.
	
Car	Chooser	(below	right).		Navigate	so	the	car	type	you	want	is	visible	in	the	middle	pane,
then	drag	the	image.		You	need	enough	screen	space	to	move	the	chooser	off	to	the	side
so	it	doesn't	obscure	the	target	car.



drag	from	Car	Bar	onto	layout or	from	Car	Chooser	middle	pane

Highlighting:

As	you	drag	across	other	cars,	some	highlight	as	shown	here.		A	wedge	indicates	that	dropping
will	add	a	new	car,	coupled	at	the	wedge	position.		A	full-frame	highlight	means	the	car	will	be
swapped	--	replaced	by	the	dragged	type.		A	car	with	no	full	highlight	is	not	eligible	for
swapping	with	the	dragged	type.

couple	to	north	end couple	to	south	end Insert	between	cars swap	car	with	new	type

Drop	Targets:

Release	the	mouse	button	when	positioned	at:

a	vacant	spot	on	a	track	--	creates	a	new	one-car	train	at	that	location.
	
one	end	of	an	existing	car	top	on	the	layout,	or	between	two	car	tops	(as	in	left	images
above)	--	adds	a	source	car,	coupled	at	the	wedge(s).
	
the	Train	Window	--	adds	a	source	car	at	the	uncoupling	pin	position.
	
on	top	of	a	swappable	cartop	on	the	layout	(rightmost	image)	--	does	a	Car
Swap,changing	the	target	car	to	the	source	type,	after	confirmation.
	
onto	a	cell	in	the	Image	column	of	the	Cars	Grid	or	XO	Cars	Grid	in	Ops	Central	--	does	a
Car	Swap.

Car	Swap



To	swap	a	car	means	to	pull	it	off	the	layout	and	replace	it	with	a	different	model.		The	brute-
force	way	to	do	this	is	to	delete	the	car	and	add	a	new	one	in	its	place,	but	this	method
changes	the	car	data	and	is	sure	to	foul	up	the	layout's	ops	scheme.		The	Car	Swap	feature,
introduced	in	Version	7.1,	does	the	job	in	a	safe	and	convenient	way,	using	drag	and	drop.

To	swap	a	car	for	another	type:

1.	 Bring	up	a	car	source	(Car	Inventory	Bar	or	Car	Chooser)	and	navigate	to	the	car	type	you
want	to	swap	in.
	

2.	 Make	the	target	car	visible	on	screen,	either	(a)	its	car	top	on	the	layout	view,	(b)	its	side
view	in	the	train	window,	or	(c)	its	car	image	in	one	of	the	Ops	Central	car	grids.	
	

3.	 Drag	from	source	to	target.		As	you	drag	over	a	car,	it	is	highlighted	with	a	full	red	frame	if
it	is	eligible	to	be	replaced	by	the	source	type,	as	determined	by	settings	(see	below).
	

4.	 Once	the	target	car	is	highlighted,	release	the	drag.		You	get	an	confirmation	alert	like	this,
telling	what	car	is	about	to	replaced	by	what	type,	and	what	will	be	done	about	the	AAR
codes:

Choose	YES,	and	the	car	will	change	to	the	specified	type	--	without	changing	its	ID,	car-
top	label,	or	other	data	except	possibly	for	the	AAR	code.		This	will	either	change	to	match
that	of	the	new	car	type,	or	be	left	alone	("overriding"	the	new	type),	depending	on
settings.

The	car	swap	operation	is	undoable,	whether	done	on	one	or	multiple	cars.

Car	Swap	Settings

Car	swap	behavior	can	be	modified	by	holding	down	the	RIGHT	mouse	button	as	you	drag.		On
release,	you	get	a	menu:

Choose	Replace	This	Car	to	modify	just	the	target	car,	same	as	if	you	left-dragged	as	above.	

Choose	Replace	All	of	This	Type	to	do	the	same	replacement	over	all	cars	of	the	same	type



as	the	target	car.		In	this	case,	the	alert	tells	the	number	of	cars	which	will	be	modified.

Choose	Car	Swap	Settings	to	bring	up	this	dialog:

			

The	radio	buttons	let	you	choose	what	happens	when	the	source	car	type	has	an	AAR	code
different	from	the	target	car.		Choose	when	it	is	ok	to	highlight	and	replace	the	car:

if	both	source	and	target	AAR	codes	have	the	same	first	letter.		This	allows	you	to
replace	a	GB	with	a	GA	but	not	an	F.
if	both	source	and	target	have	the	same	exact	AAR.		This	prohibits	you	from	replacing	a
GB	with	anything	except	another	GB.
any	time.		This	allows	you	to	replace	a	GB	with	an	F	or	anything	else.

The	checkbox	turns	on	or	off	the	AAR	Override	flag	on	the	target	car.	When	this	box	is	checked
(recommended),	the	AAR	code	of	the	source	car	type	is	disregarded,	and	the	target	car
retains	its	current	code.

Note:	to	do	a	car	swap	which	is	guaranteed	not	to	damage	the	ops	setup,	either	check	the
Override	box		or	choose	the	middle	(exact	AAR)	radio	choice.		Any	other	choice	is	likely	to
cause	breakage	in	the	ops	scheme	when	you	are	working	with	a	fully-configured	Advanced	Ops
layout.

Random	Train	Generator

To	populate	a	layout	quickly	with	a	random	but	realistic	assortment	of	rolling	stock,	use	the
Random	Train	Generator.		With	this	device,	you	indicate	a	target	area	of	track,	what	kinds	of
cars	you	want	on	it	and	how	densely	you	want	them	arranged,	then	click	Go.		This	removes	any
existing	cars	from	the	target	area	and	fills	it	with	strings	of	cars	of	varying	lengths	and	consists.

Before	using	the	generator	it	you	might	want	to	do	a	File	Save,	so	you	can	revert	if	the	new
trains	are	not	satisfactory.

1.		Using	the	Track	or	Track	Edit	tool,	right-click	a	section	of	track	and	choose	Generate
Trains...		(To	populate	a	specific	batch	of	tracks,	start	by	shift-clicking	or	dragging	a	rectangle
to	select	the	ones	you	want,	then	right-click	on	any	selected	section.)		Or:

In	Preferences	>	Trains,	click	Generate	Trains.



Either	method	brings	up	the	dialog:

2.		Specify	your	choices:

Fill	density
(%) drop-down percentage	of	target	track	to	be	populated	with	trains.		To	clear

the	target	tracks,	choose	zero.

Target
tracks drop-down

choose	one:	(a)	selected	tracks	--	all	sections	currently
selected,	or	if	none,	the	single	right-clicked	section;	(b)	straight
tracks	--	all	non-curve	sections	on	the	layout;	(c)	stub	tracks	--
all	sections	having	one	dead	end;	(d)	all	tracks	on	the	layout.

Cars	to
include checkboxes

check	types	of	cars	to	be	included,	uncheck	types	to	exclude.	
The	six	boxes	on	the	right	are	dimmed	unless	Freight	cars	is
checked	on	the	left.

Steam-
diesel	ratio slider

proportion	of	steam	engines	to	be	generated	vs.	diesel.		Move
the	slider	all	the	way	left	or	right	to	restrict	to	a	single	engine
type,	otherwise	you	get	a	mixture.		Slider	is	inactive	unless
Engines	is	checked	at	left.

Source
collection drop-down

Choose	the	collection	from	which	generated	cars	are	to	be
taken.		The	choices	here	are	the	same	as	on	the	menu	of	the
Car	Inventory	Bar,	and	the	list	can	be	modified	as	described
there.

3.		Click	Go	to	generate	trains	as	indicated,	Cancel	to	dismiss	the	dialog	without	generating.

This	operation	is	not	undoable.		If	you	are	not	happy	with	the	results,	repeat	steps	1	and	2	until
you	get	something	you	like.

Car	Shift

If	you	need	to	rearrange	the	order	of	cars	in	a	train,	you	can	use	cut	and	paste,	but	that	takes
a	lot	of	clicking	and	can	cause	changes	in	car	data.		The	Car	Shift	feature,	introduced	in
Version	7.1,	makes	the	job	easier.		To	"shift"	a	car	means	to	move	it	one	slot	closer	to	the	front



or	back	of	the	train,	i.e.	to	swap	its	position	with	its	neighbor	ahead	or	behind.

To	shift	a	car:	right-click	the	car	top	on	the	layout	(or	the	side	view	in	the	train
window)	and	choose	Shift	Forward	or	Shift	Backward.		Forward	moves	the
car	toward	the	front	of	the	train,	i.e.,	to	the	right	in	the	train	window.

Or:	select	the	car,	then	press	the	keyboard	shortcut	>	or	<.		(shift-period	and	shift-comma	on
most	keyboards).		Press	repeatedly	and	the	car	will	keep	shifting	until	it	reaches	the	end	of	the
train.



Removing	Cars	and	Trains

To	delete	a	train:		right-click	the	train	image	or	one	of	the	train	windows	and	choose	Delete
Train.		The	train	is	permanently	erased	from	the	layout.

To	delete	a	car	do	one	of	the	following:

right-click	the	car	image	or	icon	in	a	train	window	and	choose	Delete	Car
click	to	select	the	car	image	and	press	the	Del	key
select	the	car	and	choose	Edit	Cut	or	Edit	Delete

All	these	actions	are	undoable.



Relocating	a	Train

Normally	you	place	a	train	where	you	want	it	by	driving	it	there.		However,	not	all	situations
allow	that,	and	sometimes	you	find	yourself	wishing	you	could	just	reach	out	and	pick	the	thing
up	off	the	track.		TrainPlayer	has	a	couple	of	commands	for	this	purpose:	one	moves	a	train
from	its	current	location	to	the	spot	of	your	choice,	the	other	turns	a	train	around	end	for	end.

To	move	a	train	to	a	specific	location:

1.	 Select	the	train	to	be	moved.
2.	 Position	the	cursor	on	the	destination	track,	right-click	and	choose	Place	Train	Here.

The	train	jumps	immediately	to	an	end	of	the	specified	track.		If	it	lands	pointing	in	the	wrong
direction,	read	on.

To	reverse	the	direction	a	train	is	pointing:

1.	 Right-click	the	train	on	the	layout	or	in	a	train	window.
2.	 Choose	Train	>	Flip	Train.

The	train	picks	itself	up,	rotates	180	degrees,	and	sets	down	again.

To	move	or	copy	a	train	to	a	different	layout:

1.	 Have	the	target	layout	open	in	a	window	on	the	screen.
2.	 Unselect	the	selected	car,	if	any	(see	Selecting	Cars	and	Trains).
3.	 Choose	Edit	Copy	to	copy	or	Edit	Cut	to	move.
4.	 Click	in	the	target	layout	to	make	it	active.
5.	 Choose	Edit	Paste.		The	copied	train	is	deposited	at	the	normal	new	train	location.



Naming	Trains

On	a	real	railroad,	trains	have	names.	You	can	name	your	trains	in	TrainPlayer,	to	aid	in	setting
up	switching	moves,	identifying	car	and	train	locations	and	giving	your	railroad	that	prototype
feel.

In	earlier	versions	of	the	program,	train	names	were	provided	automatically	but	could	be
overridden.		This	is	no	longer	the	case.		In	4.0,	if	you	want	trains	to	have	names,	you	have	to
provide	them	yourself.		There	is	some	complexity	about	what	happens	to	a	name	during	a
series	of	moves,	so	we	provide	the	details	on	this	page.

Definitions

The	standard	AAR	definition	of	a	train	is:	one	or	more	engines,	with	or	without	cars,	displaying
markers.		A	train	need	not	have	cars	coupled	to	the	engine,	but	cars	without	an	engine	are	not
a	train.		Note	that	this	is	not	the	same	definition	used	elsewhere	in	TrainPlayer.

Two	or	more	cars	coupled	together	and	not	coupled	to	a	train	is	a	cut.

To	name	a	train	or	cut:

You	can	name	a	train	in	either	of	two	ways:

Right-click	any	car	in	a	train	or	cut	(either	on	the	layout	or	in	a	train	window)	and	choose
Name.		Enter	a	name	in	the	prompt	dialog	and	click	OK.		The	title	of	the	dialog	indicates
whether	you	are	naming	a	train	or	a	cut.

Or:	Right-click	a	car,	choose	Properties,	go	to	the	Train	tab	and	enter	a	name:



The	name	you	supply	may	get	passed	around	as	cars	are	coupled	or	uncoupled.		In	general,
for	a	train,	the	name	stays	with	the	engine;	for	a	cut,	it	applies	to	that	specific	set	of	cars,
whenever	they	are	coupled	together	(in	any	order)	and	not	coupled	to	any	other	cars.		But
there	are	other	details	to	consider,	as	spelled	out	in	the	Naming	Rules	below.

Train	Naming	Rules

It	is	not	really	necessary	for	you	to	know	the	details	of	how	names	move	around.		Our	goal	is
to	retain	any	name	you	provide,	and	make	sure	it	shows	up	where	you	would	expect.		The
particulars	are	as	follows.

1.	 When	you	first	open	a	layout,	any	old	style	names	from	previous	versions	are	erased.
2.	 When	you	name	a	train,	you	are	actually	naming	the	engine.
3.	 The	name	of	a	train	does	not	change	when	cars	are	coupled	to	it	or	uncoupled	from	it.
4.	 If	all	the	cars	are	uncoupled	from	an	engine,	the	engine	retains	the	name	of	the	train.
5.	 Cuts	of	cars	may	be	named	in	the	same	manner	as	trains.	The	name	is	specific	to	the	cut

of	cars.
6.	 If	a	named	cut	of	cars	is	coupled	to	a	named	train,	the	train	name	is	preserved.
7.	 If	a	named	cut	is	uncoupled	from	a	train,	its	original	name	returns.	This	rule	allows	a	train

to	move	a	cut	of	cars	around	a	yard	without	erasing	the	name	of	the	cut.
8.	 If	a	named	cut	is	coupled	to	unnamed	cars,	the	cut	name	is	lost.		It	will	come	back	if	the

named	cut	becomes	again	isolated.
9.	 If	two	named	trains	are	coupled,	the	new	train	takes	the	name	of	the	longer	train.	For

example,	if	“Helper	2345”	with	one	car	is	coupled	to	“The	Denver	Flyer”	with	ten	cars,	the
resulting	train	is	called	“The	Denver	Flyer.”

10.	 When	two	named	trains	uncouple,	each	retains	its	original	name.	Thus,	when	“Helper	2345”
uncouples	from	“The	Denver	Flyer,”	its	name	returns.		

11.	 Copying	and	pasting	a	named	train	or	named	cut	produces	a	named	train	or	cut	whose
name	is	the	original	name	plus	a	number.	Copying	and	pasting	“The	Denver	Flyer”	gives
you	“The	Denver	Flyer1.”		However,	if	you	cut	and	paste,	the	name	does	not	change.



Train	Properties

Properties	of	the	selected	train.	Called	from	Properties	on	the	Train	context	menu.		See	also
About	the	Properties	Dialog.

Dialog	controls:

image

Shows	side	view	of	the	train.	

If	the	train	is	too	long	to	fit	in	the	window,	you	can	enlarge	the
dialog.		This	train	window	is	mainly	for	display	but	is	partly
interactive	--	you	can	select	a	car	by	clicking,	or	access	its	car
menu	by	right-clicking.

Name

The	train's	name,	used	to	identify	it	in	the	Train	Tree,	on	the	Train
menu,	and	in	scripts.

The	initial	name	assigned	to	a	train	is	blank;	for	display	purposes,
a	blank	name	is	usually	shown	as	"Train<id>"	with	the	current	ID
of	the	train.		Once	you	assign	a	name,	it	stays	with	the	engine	as
the	train	consist	changes.		For	more	information,	see	Naming
Trains.

Horn

Choose	the	sound	to	be	generated	by	this	train	when	pressing
the	Horn	button	on	the	control	panel	or	using	Sound	Horn	from	the
Train	menu.

Choose	one	of	the	four	built-in	loco	sounds,	or	choose	Other	to
bring	up	the	Sound	Chooser.		The	sound	you	select	for	this	train
will	remain	attached	to	the	engine	if	the	train	consist	changes.



Running

Choose	the	sound	to	be	generated	by	this	train	whenever	it	is
moving.		Sounds	vary	depending	on	speed.		Default	is	either
Steam	or	Diesel,	depending	on	the	train's	engine	type.

For	more	information,	see	Running	Sounds.

Default	Car
Collection

The	car	collection	to	be	available	on	menus	and	toolbar	when	this
layout	is	active.

For	more	information,	see	Default	Car	Sets.

	



The	Train	Tree

The	Train	Tree	is	a	standard	Windows	tree	control	useful	for	surveying	and	navigating	your
rolling	stock.		It	displays	car	ID's	and	train	names.		For	example:

A	train	having	a	script	attached	to	it	is	shown	with	(s)	in	the	tree.

This	tree	shows	that	the	Jersey	Valley	Central	has	four	trains:	two	freights	and	two	strings	of
boxcars.	

To	use	the	Train	Tree:

Click	to	select	a	train	and/or	car.		If	you	click	a	train	name,	it	selects	the	train	and	makes
it	active.		If	you	click	a	car	name,	it	selects	both	the	train	and	the	car.

Right-click	a	car	or	train	and	choose	an	action	from	the	context	menu.		The	context
menu	is	the	same	as	the	one	you	get	when	you	right-click	a	car	in	a	train	window	or	on	the
layout:



Note:	as	soon	as	you	right-click	a	car	or	train	in	the	tree,	it	becomes	the	selected	car	or
train.

Use	up/down	arrow	keys	to	navigate	the	tree.		As	you	move	to	a	car	or	train,	it
becomes	selected.



			Operations

Operations,	or	Ops,	is	the	set	of	activities	which	give	purpose	to	your	railroad.		It	means	not
just	running	trains,	but	doing	so	in	a	way	that	generates	revenue,	by	transporting	goods	from
suppliers	to	consumers.		In	TrainPlayer,	we	provide	tools	and	functions	so	you	can	simulate	the
customers,	the	goods	they	ship,	and	the	daily	patterns	of	work	required	to	serve	them.

This	chapter	briefly	describes	the	Ops	features	in	the	program.		For	a	deeper	understanding	of
the	system,	consult	the	materials	on	the	web,	linked	below.

About	Ops

Ops	Central

About	AO	Grids

Further	Reading



About	Ops

Ops	is	a	package	of	features	for	operating	your	railroad.	An	ops	session	in	TrainPlayer
simulates	a	day's	work	on	the	railroad	--	you	report	for	duty,	are	assigned	your	engine	and
tasked	with	a	list	of	cars	to	be	transported	(the	"switchlist").	Your	job	is	to	deliver	the	cars	to
their	destinations;	completion	of	the	task	gets	you	a	virtual	pat	on	the	back	and	a	new	switchlist
for	next	session.

In	TrainPlayer	the	Ops	system	involves	several	UI	components	along	with	a	sophisticated
engine	which	drives	the	process.	There	is	a	lot	of	data	behind	the	scenes,	but	you	do	not	need
to	know	about	it	--	all	the	info	you	need	for	operating	is	on	the	screen	and	the	car-top	labels.

Ops	Features

Like	our	product	line,	Ops	has	two	levels:	Operator,	for	the	user	who	wants	to	run	pre-
prepared	layouts,	and	Builder,	for	the	author	who	designs	op	schemes	and	prepares	layouts
for	operating.		Features	of	the	ops	package	are	divided	accordingly.

For	the	Operator:

Ops	Toolbar	--	small	toolbar	providing	quick	access	to	Ops	features,	as	detailed	below.
Car	Monitor	--	a	little	window	on	the	control	panel	showing	number	of	cars
remaining	to	be	spotted.	Double-click	in	the	window	zooms	to	the	active	engine.	
The	window	comes	up	by	default	in	an	ops-ready	layout,	is	hidden	in	others,	can
be	toggled	using	the	control	panel	menu.
Loads	--	features	for	loading	and	unloading	freight	cars	with	graphical	loads;	see	Car
Loads.
Instructions	--	a	page	of	info	and	instructions	comes	up	on	opening	an	ops-ready	layout.	
Required	moves	are	indicated	by	destinations	shown	on	car-top	labels.
Waybills	--	point	to	a	car	to	see	its	waybill,	showing	status	and	route	info;	see	Waybills.
Map	View	--	an	interactive	miniature	view	of	the	layout,	showing	cars	and	locations	of
interest;	see	Map	View.
Layouts	--	our	AO	gallery	includes	over	two	hundred	fifty	original	ops-ready	layouts.		For
the	complete	list	with	descriptions	and	thumbnail	images,	see	the	three	galleries	on	the
web:	Shelf-sized;	Room-sized;	Club-sized.

Also	of	interest	to	the	Operator	is	the	process	of	operating	a	pre-prepared	layout.	described
below.

For	the	Builder:		all	of	the	above	plus:

Ops	Central	--	a	tabbed	dialog	with	the	database	of	ops	information	for	the	layout.
Development	Commands	--	a	drop-down	menu	of	actions	for	developing	ops	and
preparing	the	layout.
AO	Prep	Checklist	--	a	list	of	steps	for	preparing	the	layout,	with	current	status	reports;
summarized	below.
Layout	Tester	--	a	dev	command	to	run	a	series	of	tests	to	check	for	ops	readiness	and

http://www.trainplayer.com/Features/AO/grid_1.html
http://www.trainplayer.com/Features/AO/grid_2.html
http://www.trainplayer.com/Features/AO/grid_3.html


report	errors.
Route	Finder	--	an	interactive	dialog	for	finding	a	list	of	routes	between	two	locations.
Stations	--	the	old	way	of	identifying	locations;	deprecated	for	ops,	but	still	useful	for
assigning	location-specific	sounds.

Also	of	interest	to	the	Builder	is	the	outline	of	how	to	prepare	a	layout	for	ops,	given	below.

Ops	Toolbar

	

Ops	toolbar	buttons	from	left	to	right:

Ops	Central	--	bring	up	Ops	Central	dialog
Active	Engine	--	center	and	zoom	the	view	on	the	Active	Engine
Route	Finder	--	bring	up	Route	Finder	dialog	for	discovering	track	paths
Waybill	--	bring	up	the	Waybill	window	for	the	selected	car
Map	View	--	bring	up	the	Map	View	window
Schedule	Window	--	bring	up	the	Schedule	window	for	messages	and	reports

How	To	Run	an	Ops-Ready	Layout

If	you	would	like	to	operate	one	of	our	prepared	layouts,	the	instructions	are	pretty	simple:

1.	Open	an	ops-ready	layout.

In	the	layout	chooser,	open	any	layout	under	"Advanced	Ops	Layouts."	If	you	have	the	whole
package,	there	are	over	200	plans	available	in	three	size	categories.		For	a	complete	list,
including	thumbnail	images,	see	the	galleries	on	the	web:	Shelf	size,	Room	size,	Club	size.

You	might	find	Map	View	to	be	helpful	in	learning	your	way	around	a	large	layout	before	you
begin	operating.

2.	Read	the	instructions.

Each	of	these	layouts	automatically	brings	up	a	page	of	information	about	the	layout,	with
instructions	for	operating.	Enjoyable	reading!

The	introduction	is	on	the	front	page	of	a	tabbed	dialog	with	a	lot	more	data	underneath,	but
you	will	not	need	to	use	any	of	this	data	until	you	are	ready	to	build	or	customize.

3.	Deliver	the	cars.

The	layout	opens	centered	on	the	Active	Engine.	Around	the	layout	are	cars	with	labels	on	top	-

http://www.trainplayer.com/Features/AO/grid_1.html
https://www.trainplayer.com/Features/AO/grid_2.html
https://www.trainplayer.com/Features/AO/grid_3.html


-	short	abbreviations	referring	to	locations	on	the	track.	Your	job	is	to	use	this	engine	to	deliver
the	cars	to	their	indicated	destinations.

The	instructions	sound	easy,	but	getting	the	job	done	requires	planning	and	switching	skills.
Some	of	the	layouts	are	quite	challenging.	Learn	by	doing!

The	job	is	called	a	"switchlist."	Once	you	complete	it,	you	get	a	prize,	then	click	a	button	and
generate	a	new	switchlist	for	the	next	session.	You	can	stop	at	any	time,	save	your	situation,
come	back	later	and	pick	up	where	you	left	off.

How	to	Prepare	Your	Layout	for	Ops

If	you	want	to	ready	your	own	layout	for	ops,	the	instructions	are	more	involved,	and	many
details	are	beyond	the	scope	of	this	manual.	But	there	are	tools	to	help.

A	good	place	to	start	is	the	"AO	Checklist"	built	into	the	program.	(You'll	find	this	in	the
Development	combo	on	the	Advanced	tab	of	Ops	Central.)	This	outlines	the	steps	needed	to
prepare	your	layout,	with	status	reports.	The	steps	are	as	follows,	with	references	to	other
options	in	that	combo:

1.	 Tracks.	Add	track	labels	to	identify	industries,	yards,	interchanges.	Enter	labels	using
Track	Properties	on	selected	tracks.
	

2.	 	Locations.	Edit	Locations	grid	to	provide	locale	names	and	track	types.
	

3.	 Cars.	Populate	layout	with	cars	suitable	for	the	industries	served.	Position	cars	at
industries,	staging	yards,	interchanges.
	

4.	 Industries.	Edit	Industries	grid	to	provide	ship/receive	instructions.	Or	use	'Build	Industry
Grid	from	Cars'	to	create	a	set	of	rows	based	on	cars	(and	their	loads)	at	industries.
	

5.	 Sequence.	Edit	Sequence	grid	to	specify	train	movement	patterns.	Or	use	'Add	Basic	Train
Sequence'	to	create	a	single	row	suitable	for	basic	operation.
	

6.	 XO	Cars.	Flag	cars	to	be	used	for	dedicated	service.	Use	'Flag	XO	Cars'	to	flag	all
engines	and	passenger	cars;	to	flag	a	freight	car,	right-click	and	check	'Excluded	from
Ops'	under	Car	Data.
	

7.	 Document.	Use	'Edit	Intro'	to	provide	notes	and	instructions	for	the	user.
	

8.	 	Test.	Run	'Test	Layout'	to	check	for	errors	and	report	on	missing	data.
	

9.	 Generate.	Run	'Gen	First	Switchlist'	to	process	the	grid	data	and	create	switchlist	#1.
	

10.	 Save.	Save	the	layout.	Save	As	is	recommended,	to	avoid	overwriting	the	original.
	

11.	 Enjoy.	Deliver	the	cars	and	win	the	award!	Click	button	to	generate	the	next	switchlist	and



keep	going.

Ops	History

The	Ops	system	in	TrainPlayer	has	evolved	through	several	stages.		In	Version	1.0	(2005)
there	were	stations	and	simple	tools	for	monitoring	train	moves	in	and	out	of	them.		Car	loads
were	introduced	in	Version	2	(2006),	then	our	first	complete	Ops	system	in	4.0	(2011).		Along
the	way,	scripting	features	were	being	developed,	so	that	in	Version	6	(2016)	we	brought	out	a
series	of	script-based	systems,	from	the	Directed	Ops	Generator	(DOG)	to	the	full-featured
YardMaster	system	in	6.4.

In	TrainPlayer	7	the	evolution	took	another	large	step.	The	extensive	body	of	scripting	code
from	YardMaster	was	converted	to	c++	and	incorporated	directly	into	the	program.		Older
facilities	were	scrapped	--	old	engine,	color	codes,	stations,	ops	windows	--	and	new	ones
introduced:	Ops	Central,	track	labels,	new	ops	engine	built	from	the	ground	up,	based	on	logic
developed	over	years.

Ops	Further	Reading	from	the	website

AO	PDF	Files

AO1	Advanced	Ops	for	the	Operator
	
AO2	Advanced	Ops	for	the	Designer
	
AO3	Advanced	Ops	for	the	Expert

AO	Layout	Galleries

Shelf	size
	
Room	size
	
Club	size

Older	Documents

Advanced	Ops	User	Guide	(PDF	file)
	
Tutorial:	converting	your	layout	for	AO
	
Sample	layout	for	tutorial:	Marplain	Crossing	(zip	file)
	

https://www.trainplayer.com/Features/AO/AO1_AdvancedOps_Operator.pdf
https://www.trainplayer.com/Features/AO/AO2_AdvancedOps_Designer.pdf
https://www.trainplayer.com/Features/AO/AO3_AdvancedOps_Expert.pdf
http://www.trainplayer.com/Features/AO/grid_1.html
https://www.trainplayer.com/Features/AO/grid_2.html
https://www.trainplayer.com/Features/AO/grid_3.html
http://www.trainplayer.com/Features/AO/AO_User_Guide.pdf
http://www.trainplayer.com/Features/AO/TP7_Tutorial/main.html
http://www.trainplayer.com/Features/AO/TP7_Tutorial/marplain terminal_basic.zip


Ops	Central

Ops	Central	is	the	headquarters	of	Advanced	Ops.		It	provides	the	casual	user	with	instructions
for	running	an	operational	layout,	and	provides	the	layout	author	much	more:	full	access	to	the
ops	database,	details	of	the	car	inventory,	statistics	about	the	layout,	commands	for	setting	up
or	converting	a	layout	for	AO	use.

To	view	Ops	Central,	use	the	main	menu	command	Tools	>	Ops	Central	or	the	toolbar	button	
.		However,	you	don't	often	need	to	do	this,	as	opening	an	AO-ready	layout	usually	brings	up

OC	automatically.		(TL	users	can	change	this	preference	on	the	Advanced	tab.)

Ops	Central	is	a	tabbed	dialog.		The	first	tab	is	Intro,	which	displays	a	body	of	text	created	by
the	layout	author	--	usually	a	description	of	the	railroad,	operating	instructions,and	other
information	of	interest	to	a	user	wishing	to	operate	the	layout.

Note:	if	you	do	not	have	a	license	for	Advanced	Ops,	you	only	see	a	subset	of	the	tabs	shown
above.		Seeing	and	using	the	other	tabs	requires	a	license.

The	next	six	tabs	are	spreadsheet-like	grids	where	the	complete	body	of	AO	data	can	be
viewed	and	edited.		Here	is	the	list,	with	links	to	the	individual	help	pages;	also	see	About	AO
Grids	for	information	common	to	all.

Locations	--	for	managing	named	areas	on	the	track	and	identifying	as	industries,	yards,
etc.
Industries	--	for	specifying	goods	to	be	shipped	and	received	by	industries
Sequence	--	for	scheduling	regular	train	runs
XO	Cars	--	for	setting	up	dedicated	service	jobs
Switchlist	--	showing	cars	remaining	to	be	moved	in	the	current	session
Cars	--	showing	a	list	of	all	cars	on	the	layout,	with	side	views	and	details

The	final	tab	in	OC	is	Advanced,	where	you	can	set	AO	preferences	or	choose	from	a	list	of
advanced	commands	for	developers.





About	AO	Grids

The	AO	database	consists	of	a	group	of	data	tables.You	can	see	and	edit	these	using	grid
controls	on	six	tabs	of	Ops	Central.	

Each	grid	has	its	own	page	of	details.	This	page	describes	features	common	to	all.

Working	With	AO	Grids

The	grids	are	miniature	spreadsheets,	each	displaying	a	set	of	rows	in	a	series	of	columns.
Columns	can	be	moved	or	sorted,	some	are	editable,	and	there	are	a	number	of	convenient
features	for	working	with	them.	Most	of	these	are	available	through	the	context	menus,
described	below.	Other	features	include:

Rearranging	columns:	Drag	a	column	header	and	drop	it	between	two	others,	or	hide	it	by
dragging	offscreen.	To	restore	a	hidden	column,	use	Field	Chooser.

Grouping:	Choose	"Group	By	Box"	to	bring	up	a	special	box	where	you	can	drag	columns	in
and	out	to	group	the	fields	in	different	ways.

Editing:	On	clicking	a	data	cell,	either	(a)	the	column	is	read-only,	so	nothing	happens;	(b)	a
down-arrow	appears	so	you	can	choose	from	a	drop-down	list;	or	(c)	the	text	can	be	edited	in
place.

Sorting:	click	a	column	header	to	sort	on	that	column.		Click	again	to	sort	in	reverse	order.

AO	Grid	Column	Tables

A	table	on	each	page	describes	the	columns	of	each	type	of	grid.		These	tables	show	column
names	and	descriptions,	along	with:

Input	type:		edit	=	text	is	editable	in	place;	r/o	=	read-only,	cannot	be	modified;	combo	=	has
drop-down	menu	of	the	given	type	(see	list	below).

Hidden:	H	=	column	is	hidden	by	default.		To	display	a	hidden	column,	use	the	Field	Chooser.

AO	Grid	Context	Menus

Right-click	a	column	header,	row	header,	or	cell	in	the	grid,	and	you	get	a	context-sensitive
menu	showing	a	subset	of	the	following	commands:

Command Action Notes
Move	Row	Up Swap	selected	row	with	row	above only	in	orderable	grids

Show	Waybill Display	waybill	window	for	car	on
selected	row only	in	car-based	rows



[object]	Properties Bring	up	properties	dialog	for	selected
object

object	=	Car,	Station,	Load,
Train,	Track,	Locale

Zoom	to	[object] Zoom	to	selected	object
Add	New Add	new	empty	row
Duplicate Duplicate	selected	row(s)
Delete Delete	selected	row(s)

Copy Copy	selected	rows	or	cells	to	the
Clipboard

suitable	for	pasting	into	Excel
or	Notepad

Select	All Select	all	rows
Print	Grid Print	text	on	display	in	grid
Refresh Rebuild	grid	on	display
Expand	All	Items Expand	all	collapsed	rows
Collapse	All	Items Collapse	all	expanded	rows

Field	Chooser Shows	list	of	hidden	columns;	drag	one
onto	or	off	of	grid	header

Group	By	Box Shows	box	for	grouping	by	drag	and
drop

Column	Auto-
Resize Resize	columns	to	fit

Help Display	grid	help

AO	Grid	Drop-Down	Menus

When	you	click	a	cell	in	certain	columns,	a	down-arrow	appears	so	you	can	choose	from	a
drop-down	menu.	The	grid-specific	pages	In	this	help	file	tell	which	columns	work	this	way,	and
include	a	two-letter	code	indicating	which	of	the	following	lists	you	can	choose	from:

Combo
Code Type List	of

TL 	track	labels all	track	labels	on	the	layout

LD load	names all	names	in	the	Load	Chooser	plus	any	others	mentioned
on	layout

STG storage
tracks labels	of	all	tracks	classified	as	yard	or	staging

EN engines labels	of	all	engines	on	layout
AAR aars AAR	codes	of	all	loadable	cars

SR industry
actions Ship	or	Receive

TT location
types industry,	yard,	staging,	interchange,	XO	reserved



			Scripting

You've	worked	out	a	particularly	elegant	sequence	of	moves	in	a	dense	yard,	and	you'd	like	to	remember
it	so	you	can	show	it	to	your	fellow	operators	on	club	night.		TrainPlayer	can	help	by	letting	you	capture,
program,	and	play	back	operations	using	"scripts,"	little	programs	written	in	a	language	designed	for
running	trains.

Advanced	Scripting	in	6.1

Scripting	was	introduced	in	TrainPlayer	version	2.3,	back	in	2006.		Then,	a	script	was
something	rather	simple	that	you	could	attach	to	a	train.		In	versions	6.0-1	we	introduce
Advanced	Scripting,	with	plenty	of	enhancements,	such	as:

Scripts	may	now	be	attached	to	locations	on	the	layout,	to	spring	into	action	when
specified	cars	pass	by
A	master	script	can	be	attached	to	the	layout,	to	carry	out	startup	operations	when	the
layout	opens
The	script	language	now	becomes	a	full	programming	language,	including	variables,	if,
while,	subroutines,	inline	procedures,	arithmetic,	system	functions,	property	set/get
New	Script	Central	dialog	organizes	all	scripts	and	reference	materials
Variables,	system	functions,	function	families

This	chapter	has	been	completely	rewritten	to	describe	the	new	system.		See	About	Scripting
for	a	guide	to	the	documentation,	or	just	march	through	the	links	below.

About	Scripting

Scripting	UI	Devices

Working	With	Scripts

How	to	Get	Started	in	Scripting

TP	Programming	Language

For	more	information,	visit	the	Scripting	Page	on	the	TrainPlayer	website.

http://www.trainplayer.com/Features/Scripts/index.htm


How	To	Get	Started

There	is	a	lot	of	material	to	be	covered	on	the	subject	of	scripting.		Here	is	a	suggested	recipe
for	easing	your	way	into	it.

1.		Watch	the	Arlington	in	action.

Included	with	the	release	is	the	Arlington	RR	(filename	arlington_s.rrw).		This	layout	has	a	set
of	scripts	which	automatically	run	the	Local	along	its	route.	At	each	stop,	a	Junction	Action
takes	control	of	the	train,	pulls	it	into	the	station,	waits	while	passengers	exchange,	then	pulls	it
out	again	and	turns	it	back	over	to	the	main	script.

Instructions	for	running	the	demo:

1.	 Open	Layouts\Scripts	and	Puzzles\Scripting	examples\Arlington	RR	in	the	Layout
Chooser.

2.	 Use	Tools	>	Schedule	to	bring	up	the	window	which	shows	script	text	output.		Right-click
and	make	sure	Show	Script	Output	is	checked.

3.	 Open	Script	Central	using	the	button	on	the	Script	toolbar.		This	dialog	shows	the	scripts
and	junction	actions	on	the	layout,	and	a	page	of	notes.		Browse	around	if	interested.

4.	 Double-click	Script	1	in	the	Scripts	tab.		This	opens	the	train	script	in	the	Script	Editor.	
This	dialog	highlight	script	lines	as	they	execute,	to	give	you	a	dynamic	picture	of	what	the
script	is	doing.		(Note	that	it	follows	only	the	main	train	script,	not	the	junction	actions.)

5.	 Arrange	windows	on	the	screen	so	you	can	see	all.		(If	tight	for	space,	close	Script
Central.)

6.	 When	ready,	click	on	the	toolbar:	Stop	All	(if	not	dimmed),	Rewind	All	(just	to	be	sure),
then	Start	All.		Then	sit	back	and	watch.

The	train	starts	to	move	and	so	does	the	script.		Script	comments	and	messages	are	echoed
to	the	schedule	window	to	keep	you	informed	as	the	scripts	run.		With	luck,	the	train	will	run	all
the	way	around	the	layout,	making	three	stops,	then	wait	a	bit	and	start	over.		And	you	will	have
gotten	a	reasonable	idea	of	what	a	script	can	do.

2.		Record	a	script.

You	can	create	a	script	without	doing	any	programming	or	having	any	knowledge	of	the	script
language:	just	press	Record,	and	let	the	program	generate	a	script	as	you	operate	the	train;
change	speed,	throw	switches,	reverse,	uncouple	--	every	action	generates	the	corresponding
script	language.		Press	Stop	when	done,	and	there	you	have	a	script	you	can	rewind,	replay,
save,	and	study.		If	you	have	the	Script	Editor	up	while	recording,	you	can	see	the	script	as	it
gets	created.	

It	is	just	that	easy	to	record	a	script,	but	here	are	a	few	disclaimers.		First,	when	you	replay	a
recorded	script,	it	may	not	exactly	reproduce	your	sequence	of	actions.		You	have	to	cut	it
some	slack	as	it	tries	to	convert	mouse	moves	into	script	commands.		Second,	the	result	is	not
optimized	for	readability.		For	example,	varying	the	train	speed	while	recording	often	generates
a	pile	of	speed-change	commands,	where	in	a	hand-made	script,	only	a	single	speed	command
is	needed	to	do	the	job.



If	you	are	not	the	programmer	type,	you	don't	need	to	go	beyond	this	step.		Use	script
recording	to	capture	the	action	on	your	layout,	then	play	it	back,	or	send	it	to	another	TP	user
to	play	back.

3.		Write	a	Junction	Action.

The	low-barrier	way	to	write	your	first	script	is	to	right-click	a	track	junction	and	create	a	little
action	there	--	say	a	one-line	script	to	announce	something	in	the	output	window.		Bring	a	car
up	next	to	the	junction,	roll	it	across,	and	the	action	executes.		Do	this	a	time	or	two	and	you
might	find	yourself	wanting	to	make	fancier	actions.

The	procedure:

1.	 Choose	a	convenient	junction	or	switch;	use	the	Track	or	Edit	tool,	right-click	and	choose
Action...

2.	 In	the	Junction	Action	Editor,	you	can	choose	a	triggering	device,	or	leave	the	default	Any
Train,	then	click	in	the	text	box	to	enter	your	script.		You	might	start	with	something	like
this:			

echo	Crossing	the	junction!

3.	 Click	OK.		This	saves	the	action	to	the	layout	(but	not	yet	to	the	disk	until	you	save	the
layout).

4.	 Bring	up	the	Schedule	Window	so	you	can	see	the	output.
5.	 Run	a	car	across	the	junction,	using	the	throttle.		As	soon	as	the	center	of	an	eligible	car

crosses	(in	this	case	the	first	car	of	any	train),	the	action	should	trigger	and	show	the
message.		

6.	 Go	hog	wild.		Look	at	the	Reference	window	in	Script	Central	to	get	an	idea	what
commands	you	can	use,	type	one	into	the	text	box,	run	your	car	across	and	see	what
happens.

4.		Write	a	Train	Script

Writing	a	train	script	is	no	harder	than	writing	a	junction	action,	but	it	involves	an	additional
complexity	or	two.

The	procedure:

1.	 Select	the	train	you	want	to	drive	and	move	it	into	a	starting	position.		The	script	will	begin
running	the	train	from	this	position.

2.	 Right-click	any	car	and	choose	Train	>	Script	>	Edit.		Either	that	or	click	the	Edit	button	on
the	Script	Toolbar.		Either	way	you	get	the	Script	Editor,	showing	a	blank	script	with	a
machine-generated	header.

3.	 Type	some	commands	into	the	text	box.		The	most	reasonable	way	to	start	is	to	give	the
train	some	speed	and	throw	some	switches	to	direct	its	route.		Your	code	might	look	like:

speed	20

throw	J36	1



at	J37	stop

except	yours	will	of	course	have	appropriate	junction	numbers	for	your	layout.

4.	 Click	Apply	to	save	the	code.	
5.	 In	the	Script	Editor,	click	Rewind.		This	highlights	the	first	line	of	the	script,	and	moves	the

train	to	its	starting	position	if	necessary.
6.	 Click	Play.		Off	goes	your	train,	until	it	gets	to	the	destination,	then	it	stops.

A	couple	of	shortcuts:

a.	 When	the	Script	Editor	is	up	on	the	screen,	and	the	cursor	is	positioned	at	the	next	line	in
the	text	box,	right-click	a	junction	on	the	layout	and	you	get	a	little	menu	of	commands:
Insert	Throw	Here,	In...		The	first	adds	a	Throw	statement	which	causes	the	switch	to	go
to	its	current	position,	...

b.	 You	can	copy	code	to	the	Windows	Clipboard	and	paste	it	into	the	Script	Editor.		In	case
you	prefer	to	do	your	editing	in	Notepad	or	elsewhere.

5.		Join	the	Scripters'	Forum

You	will	surely	come	up	with	questions.		The	best	place	to	go	for	answers	is	our	panel	of
experts.

6.		Become	an	expert.

Script	your	layout,	or	do	one	of	ours,	send	us	the	result	and	we'll	post	it	for	others	to	enjoy.		To
inquire,	send	e-mail.

mailto:info@trainplayer.com?subject=script expert question


TrainPlayer	Programming	Language	v.	8.2

The	vocabulary	and	grammar	you	use	to	write	scripts	is	called	TrainPlayer	Programming
Language,	or	TPL.		It	recognizes	a	given	list	of	commands	and	keywords	--	some	related	to
trains,	such	as	setting	speed	and	direction,	and	some	standard	programming	constructs,	like
loops,	ifs,	and	branches.		It	allows	you	to	create	and	substitute	variables,	and	to	separate
frequently-used	code	into	subroutines	and	procedures.		It	is	rudimentary	but	reasonably
complete.

This	document	gives	an	overview	of	the	components	of	the	language.		It	does	not	attempt	to
teach	you	programming,	or	even	give	you	much	more	than	a	brief	overview	and	a	command
reference.		The	main	documentation	is	built	into	the	program,	and	can	be	found	on	the
Reference	tab	of	Script	Central	--	the	same	table	of	commands	and	variables	as	shown	below,
but	with	more	detail	and	examples	under	each	topic.

Further	reading	matter	can	be	found	on	the	Scripting	page	of	the	TrainPlayer	web	site.	Of
special	note	are	two	PDF	documents	giving	a	wealth	of	expert-level	discussion	and	details:

TrainPlayer	6.1	-	Extensions	to	the	Trainplayer	Programming	Language	(TPL)
TrainPlayer	8.1	-	Introduction	to	Linked	Layouts

Additions	and	changes	for	Version	8.1	are	noted	in	the	text	below.

TPL	Overview

A	script	consists	of	a	series	of	statements.		Some	are	comments	--	text	provided	by	the	script
author	to	annotate	or	explain	--	and	are	skipped	over	when	the	script	is	executed.		Others	are
either	executable	statements,	which	cause	actions	to	occur,	or	wait	conditions,	which	cause	the
script	to	pause	for	some	specified	event	or	time	period	before	proceeding.		The	text	in	the
script	is	sometimes	referred	to	as	code,	and	the	act	of	creating	it	is	called	coding.

An	executable	statement	begins	with	a	command	--	one	of	the	words	or	phrases	recognized	by
the	language,	such	as	those	listed	below	--	followed	by	arguments	providing	data	needed	by
the	command.	An	argument	might	consist	of	a	single	string	or	numeric	value,	or	an	expression
formed	by	combining	multiple	values	using	arithmetic	operators.	In	place	of	a	literal	string	or
numeric	value,	you	can	use	the	name	of	a	variable,	and	it	will	be	replaced	by	the	corresponding
value	when	the	statement	is	executed.

Statements	are	normally	executed	one	after	another	as	they	appear	in	the	script.		However,
this	behavior	can	be	altered	using	flow	commands.		A	loop	is	a	block	of	statements	which	are
executed	repeatedly	a	given	number	of	times.		A	branch	is	a	jump	to	another	place	in	the	script,
sometimes	based	on	a	decision	made	in	an	IF	statement.	

A	call	is	a	jump	to	a	separate	external	block	of	statements;	these	execute	in	their	entirety,	and
then	control	jumps	back	to	the	statement	after	the	call.		There	are	three	variations	on	this.		A
subroutine	is	a	block	of	script	code	stored	in	a	text	file;	a	call	to	the	subroutine	executes	the	file
and	then	returns.		A	proc	is	a	small	routine	stored	between	two	tags	within	another	script;	the
first	time	it	is	encountered,	as	its	parent	script	executes,	it	is	extracted	and	saved	in	memory

http://www.trainplayer.com/Features/Scripts/index.htm
https://www.trainplayer.com/Features/Scripting6/TPL_Ref_Doc_3.pdf
https://trainplayer.com/Features/Version81/LinkedLayouts.pdf


under	a	specified	name;	subsequently	it	can	be	called	using	this	name.		A	function	is	a	body	of
code	which	carries	out	a	calculation	and	returns	a	result	to	be	used	by	the	calling	script.

Whenever	a	train	script	or	junction	action	is	running,	it	is	connected	to	a	train.		Commands	in	the
script	which	do	not	specify	otherwise	are	directed	to	this	train.		Train	control	commands	can	be
used	to	redirect	commands	from	the	script-owning	train	to	another	one.

Variables	are	created	and	assigned	using	a	Set	statement,	or	the	equivalent	Let.		This	takes
the	name	of	a	variable	and	an	expression;	the	expression	is	evaluated	and	its	value	assigned	to
the	variable.			If	the	name	is	new,	the	variable	is	created,	otherwise	the	existing	variable	is
updated.	

TPL	Statements

A	script	consists	of	a	series	of	statements,	usually	one	per	line	in	a	text	file.	Lines	starting	with
*	are	comments,	and	are	not	executed.		By	default,	comments	starting	with	a	single	asterisk
are	echoed	to	the	output	window	as	the	script	runs;	those	starting	with	**	are	not.		Blank	lines
are	ignored.

An	executable	statement	consists	of	a	command	or	wait	condition	name	--	one	of	the	words	in
the	first	column	of	the	table	below	--	followed	by	any	required	arguments.

Multiple	statements	may	be	concatenated	on	a	single	line,	using	semicolon	(;)	as	delimiter.		As
a	special	case,	a	wait	statement	may	be	followed	immediately	by	a	command	on	the	same	line.

Built-in	Commands

A	command	is	an	instruction	telling	the	program	to	take	some	action.		There	are	two	types:
commands	accessible	from	the	program	menus	vs.	those	built	into	the	language.		The	menu
commands	are	described	in	the	next	section.		The	built-in	commands	are	in	these	categories:

Train	commands:	for	setting	speed	and	direction	and	operating	the	train	owning	the	script.	
This	group	of	commands	is	the	script	equivalent	of	the	control	panel.
Layout	commands:	for	throwing	switches,	rotating	turntables,	and	carrying	out	other
layout-based	actions.
Train	control	commands:	for	directing	movements	of	other	trains,	or	turning	control	over
to	them.
Flow	commands:	for	looping,	branching,	choosing	different	courses	of	action	based	on
conditions.
Set/Let	commands:	for	creating	variables	and	assigning	values.
UI	commands:	for	taking	input	from	or	providing	feedback	to	the	user.
Subroutine	commands:	for	calling	and	defining	subroutines,	plus	special	commands	for
use	within	them
User	interface	commands:	for	communicating	with	the	user,	both	input	and	output

Most	commands	consist	of	a	single	verb	followed	by	one	or	more	arguments	telling	what	to	act
on	or	what	to	do.		In	the	table	below,	arguments	are	indicated	by	angle	brackets	--	you	supply
the	value,	not	the	brackets.		Optional	arguments	are	enclosed	in	braces;	if	omitted,	these	take



on	default	values.

speed	20 set	speed	of	script	owner	to	20;	start	moving	if	stationary
echo	"note	to	user!" display	message	in	output	window
throw	J35	1 throw	switch	at	junction	35	to	position	1
drive	"Broadway	Limited" begin	block	of	statements	to	be	directed	to	another	train

A	complete	list	of	commands	is	given	below.		A	better	one	is	found	in	the	Reference	tab	of
Script	Central.

Menu	Commands

When	you	select	any	command	from	a	menu,	you	see	a	cascading	series	of	names	starting
with	a	top-level	menu.		Write	these	names	down	one	after	another	and	you	have	a	command
you	can	use	in	a	script.		Menu	names	must	be	separated	by	spaces,	multi-word	names	must	be
quoted.	

Version	8.1	update:	two	special	menu	commands	can	now	take	an	additional	argument:	File
Open	and	File	Save	As	can	be	followed	by	a	full	pathname,	or	a	path	relative	to	the	layout
owning	the	script.		If	no	filename	is	given,	the	file	dialog	comes	up	as	before.

Examples:

file	open bring	up	Open	File	dialog
file	"open	layout" bring	up	Layout	Chooser;	note	quotes	required	around	two-word	command
file	open	mylayout.rrw open	named	file;	simple	filename	must	be	in	same	folder	as	current	layout
file	"save	as"	new.rrw save	current	layout	to	specified	filename
train	"add	car"	boxcar add	car	to	selected	train	at	insert	position;	note	menu	command	applies	to	selected	train,	not	script	owner

Wait	Conditions

A	wait	condition	tells	the	script	to	wait	for	a	certain	event	or	until	a	certain	time	before
proceeding.		There	are	only	a	few	wait	condition	keywords,	serving	multiple	purposes:	AT	a
certain	time	on	the	clock,	or	when	the	first	car	of	the	train	reaches	a	certain	junction	or	station;
AFTER	an	elapsed	time,	or	when	the	last	car	passes	the	given	location;	or	ON	specified
events.

at	J35	stop when	first	car	of	train	crosses	junction	35,	stop	train,	continue	with	script
after	0:0:02	speed	20 wait	2	seconds,	then	set	speed	to	20

Flow	Control

Script	statements	are	normally	executed	one	after	another.		Commands	in	the	"flow	control"
category	change	this	behavior,	by	jumping	to	other	parts	of	the	code	based	on	some	criterion.	
The	following	types	of	flow	control	are	available:



Conditionals.		Use	If/Endif	to	evaluate	a	criterion	and	take	different	courses	of	action
depending	on	the	result.		A	criterion	is	two	expressions	connected	by	a	comparison
operator,	enclosed	in	parentheses.
Loops.		Use	While/Endwhile	to	execute	the	same	block	of	statements	as	long	as	a	given
criterion	is	met.
Branches.		Use	Goto	to	jump	to	a	specified	location	elsewhere	in	the	code.
Calls.		Use	Call	to	jump	to	an	external	body	of	code,	execute	it,	then	return	and	continue	at
the	next	statement.
Procs.		Use	Proc	to	define	a	small	subroutine	within	a	script.

goto	nextPart jump	to	statement	"nextPart:"
call	sitandwait	10 call	subroutine	"sitandwait.txt"	and	pass	one	argument

If	Statement

An	IF	statement	takes	the	form

if	(val1	comp-op	val2)

				code	block	1

[else

				code	block	2]

endif

where	val1	and	val2	are	string	or	numeric	values,	variables,	or	expressions,	and	comp-op	is
a	comparison	operator,	one	of:

=		<		>		<>		<=		>=

The	two	values	are	compared	using	the	given	operator;	if	the	result	is	TRUE,	then	code	block	1
is	executed;	if	FALSE,	code	block	1	is	skipped,	and	control	passes	to	the	optional	code	block	2
or,	if	none,	to	the	statement	after	the	endif.

let	ncars	=	$train(train1,	length) create	a	variable	and	assign	value	from	a	system	function
if	(ncars	<	10)	

				echo	"short	train" compare	value	to	literal;	if	true,	output	this	text
else	

				echo	"long	train" if	comparison	is	false,	output	alternate	text	instead
endif 	

While	statement

A	while	statement	defines	a	loop.		It	takes	a	form	similar	to	IF:

while	(val1	comp-op	val2)

				code	block

endwhile



where	the	code	block	executes	once	every	time	the	comparison	expression	evaluates	to	TRUE;
if	it	is	FALSE,	the	code	block	is	skipped	and	control	passes	to	the	statement	after	the	endwhile.

let	i	=	1 create	variable	and	initialize
while	(i	<	10) compare	variable	to	literal;	if	true,	go	to	next	statement
			echo	Line	@i	

			let	i	=	i	+	1 from	here,	jump	back	to	start	of	loop
endwhile when	comparison	is	false,	jump	to	here

Use	a	CONTINUE	statement	within	a	loop	to	go	to	the	next	iteration,	or	a	BREAK	statement	to
jump	out	and	terminate	the	loop.

Let/Set	statement

Set/Let	statements	take	the	form

set	var	expr

let	var	=	expr

where	var	is	the	name	of	a	new	or	existing	variable,	and	expr	is	an	expression,	one	or	more
components	joined	by	operators:

comp	[op	comp	[...]]

If	expr	is	omitted,	then	the	variable	is	deleted	and	removed	from	further	use	--	let	x=	
undefines	the	variable	x	if	previously	defined.

A	component	is	one	of:

	a	number
an	expression	in	parentheses
a	variable	name,	with	or	without	prefix	@
a	display	string

Op	is	an	arithmetic	operator.		Between	two	numeric	components,	it	can	be	one	of	these	four:

+		-		/		*

Between	strings,	only	the	+	operator	is	used,	and	means	concatenation	of	strings.

Examples:

let	v	=	(2	+	6)	/	12

let	v2	=	v	+	99

set	AllowYardMode	0

let	s	=	"speed	is	"	+	$x_speed

let	myvar	=



Variables	and	Functions

A	variable	is	a	named	value.		You	can	make	up	a	name,	assign	it	a	value,	then	use	the	name	in
place	of	the	value	in	a	script	statement.		This	is	the	key	to	writing	abstract	code	which	can	work
on	different	input	data.

To	create	a	variable	and/or	assign	it	a	value,	you	use	a	LET	or	SET	statement.		To	represent	it
in	a	script	statement,	you	normally*	precede	it	with	"@"	--	a	symbol	you	can	read	as	"contents
of,"	which	identifies	what	follows	as	a	variable	name.

	Example:

let	CruisingSpeed	=	55

...

at	j22

			speed	@CruisingSpeed

*	You	don't	need	to	precede	a	variable	name	with	@	when	you	refer	to	it	in	a	LET	or	SET
statement.		If	you	want	to	embed	a	variable's	contents	into	a	larger	string,	use	@	on	both	ends:

let	s	=	"def"

echo	The	Alphabet:	abc@s@ghi...

As	of	Version	6.3.1,	you	can	edit	a	variable's	value	in	the	Reference	tab	of	Script	Central;	see
Editing	Variables.

A	system	variable	or	function	is	a	value	supplied	by	the	system.		You	call	for	a	system	value
by	giving	a	function	name,	often	followed	by	a	list	of	arguments	in	parentheses.		An	argument
might	be	the	id	of	an	object,	a	keyword	requesting	a	specific	action	or	value,	or	an	input	value
for	a	calculation	or	operation.		Sometimes	you	don't	get	a	value	back,	you	just	call	the	function
to	do	some	work,	using	a	CALL	statement.	

System	function	names	begin	with	"$".		A	list	of	them	is	given	below,	and	also	in	the	Reference
tab	of	Script	Central.

	Examples:

echo	Today's	date	is	$DATE

echo	Name	of	active	layout	is	$LAYOUT(Name)

let	r	=	$RAND(1,100)

echo	A	random	percentage	->	@r

let	storedData	=	$READ("C:\myfile.txt")

let	outputData	=	storedData	+	"additional	info"

call	$WRITE("C:\myfile_new.txt",	@outputData)

A	function	family	is	a	set	of	related	functions	with	the	same	name,	and	a	list	of	arguments
which	usually	includes	the	identifier	of	an	object	and/or	a	keyword	representing	a	specific
value.		Several	function	families	provide	access	to	objects	on	the	layout	--	cars,	trains,	tracks,



junctions,	the	layout	itself	--	while	others	work	with	general	objects,	like	strings	and	files.	

Some	functions	are	"writable,"	meaning	their	values	can	be	changed	in	LET	or	SET
statements.		Writable	functions	are	indicated	by	"r/w"	in	the	Reference	listing	in	Script	Central.

Example:

echo	The	load	in	box	44	is	$CAR(x44,	Loadname)

let	newLoad	=	"Toy	Tractors"

echo	Changing	load	to	@newLoad!

set	$CAR(x44,	Loadname)	=	newLoad

A	local	variable	is	one	which	is	inaccessible	outside	of	a	certain	limited	region	of	code	(or
"scope").		Normally,	when	a	variable	is	defined	and	assigned	a	value,	it	is	"global"	--	it	can	be
referenced	by	any	scripts	or	actions	anywhere.		But	if	it	is	named	in	a	preceding	LOCAL
statement,	then	it	is	known	only	to	the	script	(or	subroutine	or	proc)	where	it	is	defined.	
Example:

*	train	script	1

let	gv	=	"a	global	value"

local	lv

let	lv	=	"a	local	value"

*	train	script	2

echo	global	value	was	defined	as:	@gv

echo	value	local	to	script	1	is	undefined	here:	@lv

An	excellent	discussion	with	detailed	descriptions	of	each	system	function	can	be	found	on	the
web	in	TrainPlayer	6.1	-	Extensions	to	the	Trainplayer	Programming	Language	(TPL).

Subroutines

A	subroutine	is	a	named	body	of	code	stored	in	a	file	outside	a	script.		The	code	can	be
executed	within	the	script	by	inserting	a	CALL	statement	including	the	name	of	the	file.	

To	pass	data	into	and	out	of	the	subroutine,	one	or	more	arguments	may	be	included	in	the
call.		Arguments	are	numbered	from	left	to	right	in	the	call,	and	are	represented	within	the
subroutine	as	placeholders	starting	with	"%".		For	example,	wherever	the	subroutine	contains
"%1",	it	will	be	replaced	by	the	first	argument	in	the	call.

Here	is	a	simple	example	of	a	subroutine	which	takes	a	single	argument.		It	doesn't	do	anything
particularly	useful,	but	the	point	of	making	it	into	a	subroutine	is	that	it	could	be	made	fancier	if
needed.

*	subroutine	sitandwait	<secs> comment	at	first	line	of	subroutine	tells	how	to	call
echo	sitting	for	%1	secs... using	passed	arg	in	a	string
after	0:0:%1 wait	number	of	seconds	given	by	arg	1,	then	return

http://www.trainplayer.com/Features/Scripting6/TPL_Ref_Doc_3.pdf


These	lines	become	a	subroutine	if	stored	as	a	text	file	sitandwait.txt	in	the	TP	Scripts
folder.

A	proc	is	a	type	of	subroutine	which	is	not	defined	in	an	external	file,	but	in	a	section	of	another
script.		Using	proc	and	endproc	statements	within	a	script,	you	define	a	callable	block	of
code	and	give	it	a	name.

proc	sitandwait defines	proc	and	gives	it	a	name
				echo	... content	as	above
				after	0:0:%1 	
endproc ends	definition

This	becomes	callable	once	the	script	containing	it	is	run.		Including	it	within	the	master	script
guarantees	this.

If	either	of	the	above	is	available,	a	script	can	then	say

call	sitandwait	5

to	cause	5	seconds	of	idleness.

Display	Strings

The	term	"display	string"	(DS)	means	a	lengthy	string	for	conveying	information	to	the	user	or	to
a	file.	Each	of	the	following	commands	takes	a	ds	as	argument,	and	all	process	it	in	exactly	the
same	way:

ECHO	ds

NOTE	ds

NOTEBOX	ds

$MSGBOX([type,]	ds)

$WRITE(fname,	ds)

Display	strings:

may	contain	references	to	variables.	User	variables	are	prefixed	by	@,	globals	by	$.
These	are	substituted	by	appropriate	values	before	the	string	is	output.
	may	be	surrounded	by	quotes,	or	not	--	author's	choice.	Quotes	are	removed	before
output.
	may	be	multi-line	text	blocks	containing	returns	and	blank	lines.	A	multi-line	string	must	be
quoted,	and	any	embedded	quotes	must	be	doubled.
	may	be	components	of	LET	statements.

Quotes	in	TPL

Our	general	philosophy	is:	quotes	are	not	required	(except	in	certain	situations	listed	below),
but	may	be	used	if	desired.	Programmers	used	to	formal	languages	tend	to	prefer	quoted
strings.	Thus	either	of	these	is	valid:



echo	this	is	a	string	to	be	output

echo	"this	is	a	string	to	be	output"

In	a	display	string,	variables	are	substituted	whether	or	not	the	string	is	quoted.	Examples:

echo	the	speed	of	the	crossing	train	is	$train($x_train,	speed)

echo	"today	is	$date	and	it	is	already	$time"

Quotes	are	optional	around	most	function	arguments	and	keywords.	Thus	both	of	these	work:

echo	the	speed	is	$train(train66,	speed)

echo	the	speed	is	$train("train66",	"speed")

Where	quotes	are	required:

1.	Around	a	multi-word	command,	registry	setting	name,	or	filename	--	that	is,	any	of	these
which	contains	a	space.	In	a	menu,	this	applies	only	to	a	single	level	of	a	cascading	menu.
Examples:

file	open	"c:\my	file.txt"			<==	filename	with	space

file	"revert	to	saved"							<==	menu	command

set	"Default	Car	Length"	400	<==	reg	setting	name

3.	Around	a	string	containing	a	parsable	character,	where	the	meaning	of	that	depends	on	the
context.	In	a	function	call,	an	unquoted	string	must	not	contain	the	character	")",	because	that
would	terminate	the	call.	In	a	comma-delimited	list,	a	string	must	be	quoted	if	it	contains
comma.	Examples:

call	$write(c:\myfile.txt,	a	string	with	)	paren)			<==	WRONG

call	$write(c:\myfile.txt,	"a	string	with	)	paren")	<==	OK

4.	Around	a	multi-line	text	block.	This	is	the	only	way	to	define	such	a	block,	by	enclosing	it	in
double	quotes	and	including	carriage	returns:

echo	"this	is	a	string

		with	multiple	lines

			and	a	blank	line"

Note	that	if	you	want	the	string	itself	to	include	a	quote,	you	must	double	it:

echo	"string	with	embedded	""	quote"

Table	1.		TPL	Command	Reference

This	table	shows	the	command	vocabulary	as	it	stood	at	some	point	prior	to	release.		For	a
more	up-to-date	listing,	consult	the	Reference	tab	in	Script	Central.		Contents	of	that	tab	can
be	exported	for	printing	if	desired.



Flow	Commands 	
Goto	<label> jump	to	statement	after	given	label	
Autopause	<secs> turn	on	pauses	of	given	duration	during	train	movements
If	(<expr>	<comp-op>	<expr>) compare	two	expressions,	branch	based	on	result
Else begin	alternate	block	after	IF
Elseif		(<expr>	<comp-op>	<expr>) evaluate	alternate	after	IF
Endif end	IF	block
While	(<expr>	<comp-op>	<expr>) compare	two	expressions,	execute	or	skip	next	block	based	on	result
Endwhile end	WHILE	block
Break break	out	of	WHILE	loop
Continue continue	to	next	iteration	of	WHILE	loop
Exit terminate	running	script

Layout	Commands 	
Throw	<jxn>	[<pos>] throw	switch	to	given	position	or	next	available
Rotate	<ttbl>	<jxn>	[CCW] rotate	given	turntable	to	junction,	clockwise	unless	CCW	added
Tablestop stop	turntable	rotation	
Sound	[loop|stop]	<spath> play	or	stop	sound	in	named	wav	file.		If	LOOP	omitted	play	once.

Set	Commands 	
Set	<var>	<expr> set	variable	to	value;	equivalent	to	LET	<var>=<expr>
Reset	<var> reset	registry	variable	to	stored	value
Let	<var>=<expr> set	given	variable	to	value	of	expression;	create	variable	if	needed

Subroutine	Commands 	
Call	<routine>	<arglist> call	given	subroutine	or	proc	and	pass	any	required	arguments
Proc	<routine> begin	definition	of	procedure	of	given	name
Endproc end	procedure	definition
Local	<var[,var...]> declare	local	variables
Return return	from	subroutine	or	proc	to	calling	script

Train	Commands 	
Forward set	direction	to	forward
Reverse set	direction	to	reverse
Speed	<mph> set	speed	to	given	mph;	starts	train	moving	if	stopped
Stop decelerate	to	a	stop
Uncouple	<slot>	OR	<car>	OR	<car><car>	 uncouple	at	given	position,	at	given	car,	or	between	given	cars
Horn	[<msec>] sound	train	horn	for	3	sec	or	given	time	in	millisec

Train	Control	Commands 	
Train	<train> select	given	train	
Load	[Toggle]	[Car/Train/Cut]	<ids>	[<loadname>] load	given	car(s)	with	given	load	or	default
Unload	[Toggle]	[Car/Train/Cut]	<ids> unload	given	car(s)	
Drive	<train> transfer	control	temporarily	to	given	train	
Enddrive transfer	control	back	to	original	train
Start	<train>	[<mph>] start	train	script,	or	start	train	moving	at	5	mph	or	given	speed

User	Interface	Commands 	
Echo	<string> display	given	string	in	schedule	window	
Input	<var>	[<prompt>] set	user	variable	from	input	dialog,	optionally	using	given	prompt
Note	[<string>] display	given	string	in	popup	window;	hide	window	if	no	string
Notebox	[<string>] display	string	in	window	dismissable	with	ESC	or	click

Car	Functions 	



$CAR(label,	ID) numeric	car	id
$CAR(label,	Label) car	label
$CAR(label,	Loaded) 1	if	car	is	loaded,	otherwise	0
$CAR(label,	Loadname) name	of	load	assigned	to	car,	if	any
$CAR(label,	AAR) car	aar	code
$CAR(label,	Note) user-applied	note	on	car
$CAR(label,	Dest) user-	or	ops-applied	destination	tag	on	car
$CAR(label,	Track) track	number	where	car	is	currently	located
$CAR(label,	ShowLabel) 1	to	show,	0	to	hide
$CAR(label,	<any>) custom	property;	set	blank	to	remove
$CAR(label,	Layout) layout	name	where	car	is	located
$CAR(label,	LayoutID) layout	ID	where	car	is	located
$CAR(label,	Class) general	car	class
$CAR(label,	Type) name	of	car	type	within	collection
$CAR(label,	Position) trackno,	dist	to	S	end,	1=>headed	S
$CAR(label,	SortOrder) user-applied	integer	value
$CAR(label,	Train_ID) id	of	owning	train
$CAR(label,	Car_ID) id	of	car
$CAR(label,	Train) name	of	owning	train
$CAR(label,	Consist) one-word	description	of	train	consist
$CAR(label,	ExcludeOps) X	=>	exclude	car	from	switchlists
$CAR(label,	Load) current	load	or	'unloadable'	or	'empty'
$CAR(label,	Location) at	or	near	track	or	station
$CAR(label,	IsSpotted) 1	if	car	is	at	assigned	dest,	otherwise	0
$CAR(label,	PropsStr) prop	string	used	by	scripts

Train	Functions 	
$TRAIN(name,	ID) numeric	train	id
$TRAIN(name,	NCars) number	of	cars	in	the	train
$TRAIN(name,	Car) label	of	car	i,	i	between	0	and	NCars-1
$TRAIN(name,	Name) train	name,	either	user-assigned	or	Train<id>
$TRAIN(name,	Speed) current	speed,	same	as	returned	by	$SPEED
$TRAIN(name,	Direction) F	=	forward,	R	=	reverse,	T	=	toggle
$TRAIN(name,	Length) length	in	cars;	returns	same	value	as	NCars
$TRAIN(name,	Flip) invert	train	on	track
$TRAIN(name,	<any>) custom	property;	set	blank	to	remove
$TRAIN(name,	CarIDs) set	of	car	id's	in	train
$TRAIN(name,	CarLabels) set	of	car	labels	in	train
$TRAIN(name,	Layout) layout	name	where	train	is	located
$TRAIN(name,	LayoutID) layout	ID	where	train	is	located

Layout	Functions 	
$LAYOUT(Name) layout	name
$LAYOUT(LayoutID) layout	id
$LAYOUT(Path) rrw	file	pathname
$LAYOUT(NTrains) number	of	trains	on	the	layout
$LAYOUT(Train) name	of	train	i,	i	between	0	and	NTrains
$LAYOUT(TrackLabels) space-delimited	list	of	all	track	labels
$LAYOUT(JxnLabels) space-delimited	list	of	all	junction	labels
$LAYOUT(ReadOnly) does	rrw	file	open	for	read-only
$LAYOUT(SaveVars) does	saving	to	rrw	file	save	variables
$LAYOUT(IDSet,	type) set	of	id's	of	given	type
$LAYOUT(Description) text	notes	as	shown	in	layout	props	dialog
$LAYOUT(RoadStyleFromGlobals) copy	global	settings	to	layout	roadstyle



$LAYOUT(Active) 1	if	layout	is	active	document	window

Track	Functions 	
$TRACK(id,	OccupiedBy) return	labels	of	cars	on	track
$TRACK(id,	Label) user-applied	label
$TRACK(id,	Length) track	length	in	rru
$SCENERY(id,	Show) show	scenery	object
$SCENERY(id,	Hide) hide	scenery	object
$SCENERY(id,	Toggle) toggle	visibility	of	scenery	object
$SCENERY(id,	IsVisible) 1	if	scenery	object	is	showing,	else	0
$SCENERY(id,	Label) user-applied	label
$STATION(id,	OccupiedBy) return	labels	of	cars	in	station
$STATION(id,	Label) user-applied	label
$TURNTABLE(id,	OccupiedBy) return	labels	of	cars	on	turntable
$TURNTABLE(id,	Track) id	of	bridge	track
$TURNTABLE(id,	AlignedTo) id(s)	of	1	or	2	locked	external	tracks
$TURNTABLE(id,	Label) user-applied	label
$JXN(id,	Label) user-applied	label
$CAPAC(loc,	mode) number	of	car	spaces	at	location;	mode=all/free/occupied

String	Functions 	
$STRING(string,	Length) length	of	string	in	characters
$STRING(string,	Contains,	argument) returns	1	if	string	contains	argument,	0	if	not
$STRING(string,	StartsWith,	argument) returns	1	if	string	starts	with	argument
$STRING(string,	EndsWith,	argument) returns	1	if	string	ends	with	argument
$STRING(string,	NextToken[,	delims]) returns	next	substring,	removes	from	string

File	Functions 	
$FILE(name,	Open) open	named	text	file,	return	id	or	0	if	fail
$FILE(id,	Close) close	file
$FILE(id,	ReadAll) read	contents	and	return	as	string
$FILE(id,	ReadLine) read	next	line;	return	'EOF'	when	done
$FILE(name,	SaveVars) write	all	user	variables	to	named	file
$FILE(name,	ReadVars) read	all	user	variables	from	named	file
$FILE(name,	Exists) 1	if	file	exists,	else	0
$FILE(name,	Delete) 1	if	file	successfully	deleted,	else	0
$FILE(name,	GetNameExt) return	filename+ext	only,	no	path
$FILE(name,	GetDir) return	directory	path,	no	filename

Set	Functions 	
$SET(set,	Add,	value) add	new	value	at	end;	return	new	set
$SET(set,	Contains,	query) 1	if	set	has	member	matching	query,	0	if	not
$SET(set,	ContainsSet,	set2) 1	if	all	mems	of	s2	are	in	this	set,	0	if	not
$SET(set,	Count) number	of	members	in	set
$SET(set,	Dedupe) return	set	without	duplicates
$SET(set,	Difference,	set2) return	set	minus	set2
$SET(set,	EqualSets,	set2) 1	if	sets	are	equal	to	each	other,	0	if	not
$SET(set,	Find,	query) index	of	member	matching	query,	-1	if	none
$SET(set,	Get,	i) member	i	(first	i	=	0)
$SET(set,	Intersection,	set2) return	intersection	of	set	and	set2
$SET(set,	Remove,	i) remove	member	i;	return	new	set
$SET(set,	Sort) return	set	sorted	alphanumerically
$SET(set,	SortRev) return	set	sorted	in	reverse	order



$SET(set,	Union,	set2) return	union	of	set	and	set2
$SET(set,	Randomize) return	set	sorted	in	random	order

$SET(set,	Flatten) return	set	with	subsets	merged	in
	 	
System	Functions 	
$RAND(i1,i2) random	integer	between	i1	and	i2;	defaults	false,100	if	not	specified
$SUBSTR(i1,n,s) substring	of	s	starting	at	i1,	n	chars	long;	if	n	=	-1,	go	to	end
$FINDSTR(sub,s) return	zero-based	position	of	sub	within	s,	or	-1	if	not	found
$SETTING(name) return	named	registry	setting
$RRCLOCK(arg) rrclock	functions:	get,	set	t,	add	t
$READ(f) return	contents	of	text	file	f	as	string
$WRITE(f,[a,]s) write	string	s	to	file	f,	optionally	append;	0	if	fail
$STRLEN(s) return	length	of	s
$MSGBOX([type,]s) show	message	s	with	ok/cancel	or	yes/no	buttons;	return	1=ok/yes	0=no
$VIEW(op,name) get/set	visibility	of	named	window	or	feature;	op=IsVisible,Show,Hide
$SWITCH(j) return	switch	pos	at	j	(0	or	1	standard),	-1	if	j	not	a	switch
$SYSTEM(cmd) execute	system	command	in	command	box
$NOTE(id) get/set	text	of	given	note
$OPS(mode,g.col,qry) get/find	values	from	Ops	Central	grids
$AO_DEV(mode,arg) getset<name>,getvar<name>,agent,y7,upgrade,checkXO,mon1,reset,ccs,gnsl

System	Variables 	
$TIME current	time	of	day	(h:m:s	in	24-hour	format)
$DATE today's	date	(mm/dd/yyyy)
$LAYOUT layout	name
$TRAIN name	of	selected	train
$CAR name	of	selected	car
$SPEED speed	of	train	in	MPH	(KPH	if	metric	settings	in	effect)
$KEY numeric	code	of	last	key	hit	on	keyboard
$X_TRAIN name	of	crossing	train	--	train	owning	calling	script
$X_SPEED speed	of	crossing	train
$X_CAR label	of	crossing	car
$DATADIR TP	application	data	directory	path
$CRASHES count	of	crashes/bounces	since	layout	open	or	last	reset

Wait	Conditions 	
AT	<jxn> lead	car	of	train	crosses	junction
AT	<(t	j	d)> lead	car	of	train	crosses	exact	spot	(dist	d	from	jxn	j	on	track	t)
AT	<h:m[:s]> specified	time	is	shown	on	layout	clock;	h:m	required,	secs	optional
AT	<station> lead	car	of	train	enters	named	station
AFTER	<jxn> last	car	of	train	crosses	junction
AFTER	<(t	j	d)> last	car	of	train	crosses	exact	spot
AFTER	<h:m:s> specified	actual	time	has	elapsed	on	wall	clock
AFTER	<station> last	car	of	train	leaves	station
ON	STOP train	comes	to	a	complete	stop
ON	COUPLE train	couples	with	another	car
ON	THROW	<jxn> specified	switch	is	thrown	by	any	means
ON	TABLESTOP turntable	finishes	rotating
ON	KEY	[<key>] user	presses	any	key	or	specified	key
ON	NOTECLOSE user	closes	notebox	with	key	or	click



			Scheduling

This	chapter	describes	a	couple	of	features	helpful	in	making	up	a	schedule	or	timetable	for	your	railroad.

The	idea	is	this.		Suppose	you	are	making	up	a	timetable	for	the	daily	run	of	a	train	which	goes	from	A	to
B	with	several	stops	in	between.		You	will	need	to	know	the	average	time	it	takes	to	get	from	one	stop	to
the	next.		The	scheduling	features	help	you	with	this,	by	reporting	when	the	train	arrives	and	departs	at
stations	along	the	way.		You	can	use	these	reports	to	calculate	travel	times	for	your	schedule.

In	TrainPlayer,	the	travel	times	are	likely	to	be	in	minutes,	rather	than	hours	as	the	prototype	would	take.	
For	this	reason	there	is	a	scale	clock	--	a	clock	which	runs	faster	than	the	one	on	your	wall,	so	that,	say,
ten	minutes	on	the	layout	equals	an	hour	on	the	railroad.		So	you	can	run	your	simulated	eight-hour	shift	all
the	way	from	A	to	B	and	still	be	done	in	time	for	lunch.

This	chapter	used	to	be	bigger.		With	the	introduction	of	Ops,	the	part	about	Stations	was	removed	and
expanded	into	its	own	chapter.

Clock

Schedule	Window



Clock

When	operating	a	model	railroad,	it	may	take	one	minute	to	travel	from	Cincinnati	to	Columbus.	
Such	time	spans	don't	make	for	very	convincing	schedules.		The	model	railroader's	solution	to
this	is	the	"scale	clock,"	which	runs	at	some	multiple	of	normal	speed.		If	that	multiple	is,	say,	6,
then	it	appears	to	take	6	minutes	to	make	the	trip,	which	is	still	record	time	but	at	least	more
manageable.

TrainPlayer	offers	an	adjustable-speed	railroad-style	scale
clock	in	its	own	dockable,	resizable	window.		You	can	use	it	to
time	your	operations,	or	start	it	and	let	the	program	refer	to	it
as	it	keeps	track	of	your	schedule.

	If	the	clock	is	visible	when	you	open	a	layout,	then	it	will	start
automatically	as	soon	as	any	train	moves.		Or	you	can	start	it	by
hand.

New	in	7.2:	a	digital	clock	face,	with	choice	of	12-	or	24-hour	time
=>

To	operate	the	clock:

1.	 To	show	or	hide	the	clock,	use	Tools	Clock.		If	it	is	visible	when	you	exit	the	program,	it
will	come	up	again	when	you	restart.
	

2.	 To	start	the	clock:	right-click	in	the	clock	window	and	choose	Start	from	the	context	menu.	
The	clock	advances	about	once	every	scale	minute.
	

3.	 To	stop	the	clock:	right-click	and	choose	Stop.
	

4.	 To	reset	the	clock	back	to	its	default	starting	time:	click	Reset.
	

5.	 To	modify	the	starting	time	or	clock	speed,	click	Settings.		This	brings	up	the	Clock
Settings	dialog.
	

6.	 Choose	Digital	display	if	you	prefer	that	to	the	old-style	analog	face.		When	this	option	is	checked,
you	can	also	choose	24-Hour	if	you	prefer	that	style.

	



Schedule	Window

Together	the	station	definitions	and	the	clock	give	the	program	enough	information	to	keep	track
of	train	arrivals	and	departures.		The	Schedule	Window	reports	and	collects	this	data.		It	works
automatically	--	all	you	have	to	do	is	display	the	window	and	then	start	driving.		Once	you	have
driven	your	route	successfully,	the	Schedule	Window	contains	a	schedule	you	can	print	out	and
hang	on	the	wall	for	a	future	operating	session.

The	Schedule	Window	also	serves	as	the	output	window	when	running	scripts.		When	a	script	is
running,	it	can	report	its	activities	in	this	window.		By	default,	the	window	comes	up
automatically	as	soon	as	you	start	playing	a	script.

The	Schedule	Window	also	serves	as	the	place	where	text	switchlist	instructions	are	displayed	after	an
ops	generation.		During	an	ops	session,	you	may	want	to	turn	off	arrival	and	departure	and	script
messages	so	the	switchlist	data	doesn't	scroll	away.

Like	the	clock	window,	the	schedule	window	is	dockable	and	resizable.		Our	preference	is	to
put	the	two	side	by	side	at	the	bottom	of	the	screen,	then	adjust	the	divider	between	them	until
the	clock	window	becomes	square,	like	this:

To	show	or	hide	the	Schedule	Window:	choose	View	Schedule.	

To	clear	the	window:		right-click	in	the	window,	choose	Clear	All.

To	copy	the	window	contents	to	other	programs:		press	and	drag	within	the	window	to
select	the	text	you	want	to	copy,	then	right-click	and	choose	Copy.		The	selected	text	is	copied
to	the	Windows	Clipboard.		It	can	be	pasted	into	Notepad,	Microsoft	Word,	or	any	other
program	which	accepts	text.

To	control	the	output:		the	context	menu	includes	two	checkmark	items	to	specify	what	you
want	to	see	in	the	window:	Show	Stations	and	Show	Script	Output.		Check	or	uncheck	the
type(s)	of	data	you	want.



			Customizing

There	are	many	ways	to	adjust	the	look	and	feel	of	TrainPlayer.		Some	have	been	covered	in
other	chapters;	this	one	describes	more.

Operation	Preferences

Switch	Preferences

General	Preferences

Track	Preferences

Train	Preferences

Style	Preferences

Road	Styles

The	Customize	Dialog

Windows	and	Views



Operation	Preferences

Settings	related	to	train	operation.	Called	from	menu	command	File	>	Preferences.

Speeds:

Maximum	speed
Sets	the	speed	at	the	top	end	of	the	dial.		No	train	can
exceed	this	speed.		Use	the	drop-down	at	the	right	to
choose	whether	speeds	are	displayed	in	miles	or	kilometers
per	hour.

Coupling	speed
Sets	the	speed	below	which	coupling	can	occur.		If	trains
approach	each	other	with	a	relative	speed	below	this	value,
the	couple;	above	this	value,	they	collide	(bounce,	crash,	or
stop).

Options:

Collisions

Determines	what	happens	when	a	train	hits	a	closed	switch,
end	of	track,	or	another	train.		Choose	Bounce	if	you	want
the	train	to	go	into	reverse	and	keep	travelling.		Choose
Crash	if	you	want	the	train	to	stop	and	destruct.		New	in
8.0:	choose	Stop	to	bring	the	train	to	an	immediate	dead
stop.

Re	Crash:	the	destruction	is	temporary.		After	a	crash,	the



train	will	repair	itself	as	soon	as	you	begin	to	move	it.

Crash	severity
Affects	the	amount	of	destruction	upon	crashing.		The
lowest	values	cause	a	bit	of	derailing;	highest	values	cause
cars	to	blow	apart	and	scatter	across	the	landscape.		Has
no	effect	unless	Collisions	is	set	to	Crash.

Acceleration

Sets	the	amount	of	acceleration	/	deceleration	when	trains
start,	stop,	or	change	speed.		A	low	value	reduces	the
effect	and	makes	train	control	more	responsive;	a	high	value
increases	the	effect	so	that	trains	take	longer	to	come	up	to
speed	or	coast	to	a	stop.		Set	the	value	to	zero	to	eliminate
acceleration.

Shift-click	to
uncouple

Affects	what	happens	when	you	point	the	mouse	cursor
between	two	cars	on	the	layout.		With	this	box	unchecked,
the	cursor	changes	to	an	uncouple	icon	and	a	click	causes
the	cars	to	uncouple.		With	the	box	checked,	the	cursor
does	not	change	unless	you	are	pressing	the	shift	key;	this
prevents	accidental	uncouplings.

For	a	picture	of	the	uncouple	icon,	see	Moving	Trains	By
Hand.

Allow	train	drag
Check	this	box	to	enable	trains	to	be	moved	by	hand	(see
link	above).		If	unchecked,	then	pressing	and	dragging	on	a
car	top	has	no	effect.

Hide	X	on	selected
car

Check	this	box	to	cause	the	pink	X	on	top	of	the	selected
car	to	go	away	after	the	number	of	seconds	specified.		If
unchecked,	the	X	stays	visible	until	you	unselect	the	car.

	



Switch	Preferences

Settings	for	switch	display	and	operation	and	for	the	switch	window.	Called	from	menu
command	File	>	Preferences.

Switch	display:

Open	lights
Check	if	you	want	to	see	highlight	squares	on	the	two
tracks	forming	the	open	route	through	a	switch.		The
default	color	is	green,	but	you	can	change	it	using	the	color
button.

Closed	lights
Check	if	you	want	highlights	showing	the	other	track(s)	not
on	the	open	route.		Default	color	is	red,	change	with	color
button.

Highlighting
Color	of	the	highlight	indicating	when	the	mouse	cursor	is
pointing	to	the	frog	(center)	of	a	switch	and	can	be
thrown.		Note:	if	you	are	in	TrackLayer,	this	color	applies
only	when	the	Run	tool	is	active.

Distance	to	frog Distance	in	arbitrary	units	between	the	center	of	the	switch
and	the	open	/	closed	light.



Light	size Size	of	highlight	square	in	arbitrary	units.

Switch	operation:

Open	lights
Check	if	you	want	to	see	highlight	squares	on	the	two
tracks	forming	the	open	route	through	a	switch.		The
default	color	is	green,	but	you	can	change	it	using	the	color
button.

Closed	lights
Check	if	you	want	highlights	showing	the	other	track(s)	not
on	the	open	route.		Default	color	is	red,	change	with	color
button.

Highlighting
Color	of	the	highlight	indicating	when	the	mouse	cursor	is
pointing	to	the	frog	(center)	of	a	switch	and	can	be
thrown.		Note:	if	you	are	in	TrackLayer,	this	color	applies
only	when	the	Run	tool	is	active.

Distance	to	frog Distance	in	arbitrary	units	between	the	center	of	the	switch
and	the	open	/	closed	light.

Light	size Size	of	highlight	square	in	arbitrary	units.

Barrel	through

Check	to	allow	a	train	to	pass	through	a	closed	switch.		If
this	box	is	unchecked,	then	when	a	train	attempts	to	enter
a	switch	from	a	closed	track	(i.e.,	pass	through	a	red
light),	it	collides	--	bounces	or	crashes,	depending	on	the
collision	mode	(see	Operation).

Auto-throw

A	stronger	version	of	Barrel	Through:	allows	a	train	to	pass
through	a	closed	switch,	then	changes	the	switch	to	match
the	route	taken.		This	is	the	default,	and	allows	for	easy	if
non-realistic	operation	--	the	train	meanders	the	layout,
setting	switches	to	follow	the	route	as	it	goes.

Random	throw
Check	to	have	a	random	switch	thrown	every	so	often,
where	the	time	between	throws	is	set	in	the	number	box	to
the	right.		This	is	a	way	to	vary	the	route	if	you	just	want	to
let	the	trains	run.



Switch	Window:

Background Click	to	set	the	background	color	of	the	Switch	Window.

Show	Next	Switch

Check	to	have	the	window	redrawn	every	time	the	train
moves	across	a	switch,	so	it	is	always	showing	the	next
switch	coming	up	along	the	route.		Uncheck	if	you	prefer	to
operate	the	window	manually.		In	either	case,	click	a
switch	on	the	layout	to	reposition	the	window	around	that
area.

	



General	Preferences

Various	program	settings.	Called	from	menu	command	File	>	Preferences.

General	options:

Metric	units
Select	type	of	units	for	dimension	and	speed
displays	throughout	the	program.		Note:	Metric	units
are	turned	on	whenever	you	select	one	of	the	metric
choices	in	the	units	drop-down	in	various	dialogs.

Mouse	wheel	zoom
Check	this	box	if	you	want	the	mouse	wheel	to	zoom
the	layout	in	and	out.		Uncheck	if	you	prefer	to	use
the	wheel	for	default	behavior	(vertical	scrolling).

View	drag	by	hand

Check	if	you	want	to	be	able	to	scroll	the	view	by
dragging	with	the	mouse.		This	feature	only	works
when	the	Run	tool	is	active.		If	the	Run	tool	is	active
and	this	box	is	checked,	then	when	you	press	a
blank	spot	on	the	layout	and	drag,	the	view	scrolls
to	follow.		Note:		dragging	by	hand	cancels	Auto-
Follow.		For	more,	see	Dragging	By	Hand.

Enable	Background	Tiling

Check	to	allow	background	jobs	to	pre-draw	regions
surrounding	the	screen.		Recommended	when
operating	large	scenery-intensive	layouts.	See



Background	Tiling	below.

Options	at	program	startup	/	file	load:

Show	splash	screen Display	the	splash	screen	for	a	few	seconds.		Click
takes	it	down.

Show	open	layout	dialog Bring	up	the	Layout	Chooser.

Show	last	open	layout Automatically	open	the	latest	layout	from	the	Most
Recently	Used	list.

Check	for	program
updates

Check	the	website	to	see	if	a	newer	version	of	the
program	is	available.		If	you	choose	not	to	have	this
done	on	startup,	you	can	do	it	manually	using	Help	>
Check	for	Updates.

Create	new	blank	layout
TrackLayer	only:	create	a	new	layout	on	startup.	
This	is	the	default	behavior.		If	you	do	not	check	this
box,	the	program	will	open	on	an	empty	window	(or
other	content,	depending	on	choices	above).

Auto-save:

Auto-save	creates	a	copy	of	your	layout	periodically,	so	that	in	case	of	program	or	computer	crash,	you
won't	lose	much	work.

To	enable	auto-save:	check	the	box	"Auto-save	every"	and	enter	the	time	between	saves.

After	the	specified	time,	the	program	makes	a	copy	of	your	layout	in	the	system	TEMP	directory,
overwriting	any	previous	copy.		The	name	of	the	file	is	the	same	as	your	layout,	with	"bak"	appended.	
You	see	an	indication	on	the	status	bar	while	the	file	is	being	saved.

To	retrieve	an	auto-saved	layout:	use	the	command	Restore	Backup	on	the	File	menu.		This	opens	a	file
browser	in	the	directory	where	saved	layouts	are	stored.		Choose	the	one	you	want	and	open	it.

Background	Tiling

New	in	Version	6.6	is	a	feature	to	improve	smoothness	in	train	travel.		When	a	moving	train
causes	the	view	to	scroll,	it	is	necessary	to	draw	the	portion	of	the	layout	coming	into	view.	
This	takes	a	bit	of	time,	and	makes	the	train	stop	for	a	moment,	then	lurch	forward	when	the
drawing	is	ready.		Or	it	used	to!		Now	the	lurch	is	gone,	because	the	areas	surrounding	the
screen	are	being	secretly	pre-drawn	in	the	background.



When	the	view	changes	--	due	to	zoom,	scroll,	refresh,	etc.	--	the	visible	portion	on	the	screen
is	redrawn	immediately.		The	new	feature	then	kicks	in,	and	starts	a	task	in	the	background	to
draw	all	the	neighboring	portions	("tiles")	surrounding	the	screen.		By	the	time	the	train	reaches
the	edge,	the	drawing	is	ready	to	scroll	smoothly	into	view.

Background	tiling	can	be	disabled	using	the	checkbox	described	above.		Normally	you	would
leave	it	enabled,	especially	while	operating	around	a	large	layout,	but	you	might	want	to	disable
it	while	building	or	testing.		The	feature	can	cause	a	lot	of	activity	in	the	background,	and	might
lead	to	program	crashes.		Please	let	us	know	if	you	run	into	any	problems.



Track	Preferences

Settings	for	displaying	and	building	track.	Called	from	menu	command	File	>	Preferences.

Note:	as	of	version	6.5,	options	for	display	of	track	and	rails	are	no	longer	in	this	dialog,	but	are
part	of	the	road	style	system;	see	Road	Styles.

Track	label	font.		A	single	font	applies	to	all	track	labels.		Use	the	Font	and	Color	buttons	to
change	it.		The	size	you	specify	is	not	absolute;	it	applies	at	a	normal	zoom	level,	and	the	font
is	scaled	when	you	zoom	in	and	out.

Link	label	font.		Layout	links	are	shown	in	a	special	font;	see	screen	shot	under	Linked
Layouts.		To	adjust	this	font,	select	Link	Labels	from	the	drop-down,	then	set	the	font	and
color.

Check	Track.		Check	to	have	the	track	checker	run	every	time	you	add	or	modify	tracks,	so	if
an	error	occurs	you	will	be	notified	of	it	immediately.		If	this	box	is	checked,	and	an	error	is
detected	while	drawing,	an	alert	appears	describing	the	error.

Snap	options.		These	options	affect	drawing	certain	track	sections	and	circles	in	TrackLayer.	
This	set	of	options	is	dimmed	if	you	are	running	TrainPlayer.

Snap	options	aid	in	creating	precise	layouts	quickly.		Angle	snap	is	for	creating	switches	at	one
of	a	set	of	standard	turnout	angles.		Parallel	snap	is	for	drawing	yards	and	ladders,	placing
switch	points	in	such	a	way	that	parallel	tracks	are	evenly	spaced.		Radius	snap	is	for	drawing
and	editing	circles	with	standard	radii.

Applies	when	the	Track	tool	is	active,	and	you	are	drawing	a
straight	section	with	its	stationary	point	lying	on	another	straight



To	angle

section,	i.e.,	you	are	creating	the	branch	of	a	switch	(see	left
diagram	below).		As	you	drag	the	moving	end	of	one	track,	if	the
angle	between	it	and	the	stationary	track	is	close	to	one	of	the
checkmarked	choices,	the	moving	line	snaps	to	that	angle.		When
snap	occurs,	the	cursor	changes	to	show	the	snapped	angle.

You	may	choose	up	to	four	different	snap	angles:	#4,	#6,	90
degrees,	and/or	one	other	angle	selected	from	the	drop-down;
choices	are	#1,2,3,5,7,8,10,12.		Note:	The	designation	"#N"
means	an	angle	which	deviates	from	linear	by	one	part	in	N.		On	a
calculator,	the	angle	is	the	arctangent	of	1/N.		For	example,	a	#4
angle	is	14.04	degrees.		#1	is	45	degrees.

Angle	snap	choices	are	disregarded	unless	To	Angle	is	checked.	
This	allows	you	to	turn	the	feature	on	and	off	without	losing	your
preferred	set	of	snap	angles.		An	alternative	to	the	To	Angle
check	box	is	the	toggle	Snap	On/Off	on	the	Track	context	menu.

To	parallel

Applies	in	similar	situation	as	angle	snap,	with	one	additional
condition:	the	switch	you	are	creating	must	be	within	a	certain
distance	of	an	adjacent	switch.		This	distance	is	set	in	the	edit	box
to	the	right.

Refer	to	the	right	diagram	below.		When	parallel	snap	is	in	effect,
and	you	start	to	draw	anywhere	near	B,	the	starting	point	snaps
to	exactly	B,	where	the	distance	to	the	neighboring	track	is	as
specified	(default	is	2"	in	HO).		After	the	starting	point	snaps	into
place,	then	angle	snap	will	kick	in	as	you	drag	so	that	the	track	at
B	remains	parallel	to	its	neighbor.

Sometimes	parallel	snap	can	prevent	you	from	creating	a	switch
at	a	desired	place.		When	this	happens,	hold	down	the	Shift	key
as	you	begin	to	draw,	so	you	can	place	the	endpoint	where	you
want,	then	release	Shift	as	you	continue	to	drag	so	angle	snap	will
take	effect.

To	radius

Applies	when	you	are	modifying	the	radius	of	a	circle:	drawing	a
new	circle	with	the	Shift	key	up,	or	editing	a	circle	with	Shift
down.		When	the	radius	is	close	to	one	of	the	checkmarked
choices,	it	snaps	to	the	exact	value.		The	radius	is	displayed	on
the	status	bar	as	you	drag.

You	may	choose	up	to	four	different	snap	radii:	three	standard
choices	and/or	one	other	value	you	specify.		All	these	choices	are
labelled	in	the	selected	units,	using	the	scale	of	the	current	layout
if	one	is	open.		For	example,	the	above	diagram	shows	the



standard	choices	as	18"-24"	in	HO;	if	the	active	layout	were	O,
these	choices	would	be	displayed	as	36"-48."

Units Choose	units	for	display	of	radius	values.		The	choice	made	in	this
drop-down	affects	dimension	displays	throughout	the	program.

							

Snap	examples.		Left:	user	drags	up	and	left	from	the	main	line	at	point	A;	when	the	angle	is
close	enough,	it	snaps	to	exact	#4	and	the	cursor	changes.		Right:	user	drags	left	from	a	point
near	B;	starting	point	snaps	to	the	exact	point	B,	then	angle	snap	takes	effect	so	tracks	remain
parallel.

Any	snap	option	can	be	temporarily	overridden	by	holding	down	the	Shift	key	as	you	drag.		Or
the	entire	set	of	options	can	be	overridden	using	the	Snap	On/Off	command	on	the	Track
context	menu.

	



Train	Preferences

Settings	and	actions	for	trains	and	car	labels.	Called	from	menu	command	File	>	Preferences.

Train	Population	-	Generate	Trains

Click	to	populate	specified	tracks	with	specified	types	of	cars.		Described	under	Generate
Trains.

Delete	All	Trains

Click	to	delete	all	trains	from	the	layout.		An	alert	warns	that	this	operation	is	not	undoable,	and
gives	you	a	chance	to	cancel.		If	you	click	OK,	all	trains	will	be	erased	from	the	layout.	

Note:	if	you	just	want	the	trains	to	be	invisible	but	not	deleted,	click	Trains	on	the	View	Options
toolbar.

Note:	as	an	alternative,	you	can	delete	trains	from	all	or	selected	tracks	using	the	Train
Generator.

Text	Loads	Style

When	a	closed	car	is	carrying	a	load,	the	load	name	is	given	as	text	above	the	car	(side	view)
or	as	a	set	of	red	bars	(top	view).		Here	is	an	example	from	the	Car	Chooser	=>

Two	sizes	of	text	are	used	for	loads:	a	small	blue	font	(top	image	at	right)	and	a	large,
scaleable	font	which	defaults	to	blue	but	can	be	modified	(bottom	image).		The	small	font	is
used	in	(a)	car	chooser,	middle	window	and	preview	top;	(b)	train	menu;	(c)	waybill.		The	large
one	is	used	in	(a)	car	chooser	preview	bottom;	(b)	train	bar;	(c)	car	properties;	(d)	car
collection	properties.		The	large	one	is	the	one	you	can	modify	here:



Font
Click	to	bring	up	the	Font	Selector	dialog.		The	font
size	you	choose	applies	when	the	car	image	is	at	full
size;	when	the	car	size	is	reduced	(e.g.,	when	train
bar	is	resized)	then	the	font	is	scaled	accordingly.

color
button

Click	to	bring	up	a	system	Color	Chooser	to	specify
a	font	color.		The	Font	Selector	offers	you	a	combo
with	choice	of	sixteen	basic	colors	--	if	you	want	any
other	color,	use	the	color	button	instead.

Car	Defaults

These	settings	are	general	preferences	involving	cars.

Collection
Choose	a	default	car	collection	to	be	in	effect	when	you	are
creating	a	new	layout.		See	Default	Cars.		The	types	of	cars
you	select	here	will	be	created	from	tools	on	the	Car	Toolbar.

Class	Names

Choose	a	language	to	be	used	when	naming	car	classes.	
This	is	the	same	choice	you	can	make	in	the	AAR	Car	Types
dialog.		The	language	chosen	here	affects	car	class	names
throughout	the	program,	wherever	car	descriptions	appear
(dialogs,	tooltips).

Car	ID	Label	Style

Settings	in	this	section	are	for	adjusting	the	appearance	of	car-top	labels,	as	described	in	Car
ID	Display.

Font
Click	to	bring	up	the	system	Font	Selector	dialog	to	select	font	style	and	size
to	be	displayed	on	car-top	labels.		Choose	a	font	which	is	not	so	large	that	it
exceeds	the	size	of	the	car	image.

Background
Click	to	bring	up	a	system	Color	Chooser	to	specify	the	background	color
you	want	behind	car	labels.		This	color	is	overridden	when	color	coding	is	in
effect.

Turn	Off
Labels

Check	this	box	if	you	want	car	labels	to	be	hidden	while	cars	are	moving,
then	automatically	displayed	again	on	stop.	



Display
Numeric

Check	to	replace	the	label	with	the	id	tags:	train-dot-car.	(As	for	the	regular
display,	this	applies	only	if	the	car	is	not	displaying	its	Dest.)

Note:	if	the	cars	on	your	layout	do	not	appear	to	match	the	settings	chosen	here,	it	may	be	that
an	ops-related	script	has	changed	them	for	the	duration	of	the	session.		Many	ops	layouts
impose	their	own	colors	using	script	SET	commands.



Style	Preferences

Settings	for	application	style.	Called	from	menu	command	File	>	Preferences.

Application	Style

The	"application	style"	refers	to	the	overall	color	and	design	scheme	used	for	windows,	menus,
toolbars,	and	dialogs.		Choose	one	from	the	drop-down	and	the	screen	changes	immediately,
so	you	can	experiment.		A	dozen	new	styles	were	added	in	Version	8.2	(2022),	including	Scenic
and	several	Office	and	Visual	Studio	styles.		The	"TrainPlayer"	style	is	one	we	developed	to
match	the	brass-and-wood	motif	of	the	program.

Some	styles	have	adjustable	colors	(TrainPlayer	is	one	of	them).		With	one	of	these	styles	in
effect,	you	can	move	the	Hue	and	Saturation	sliders	to	adjust	the	colors	and	brightness	of	the
theme.		There	is	no	recipe	for	doing	this	--	fool	with	it	until	you	get	something	you	like.

Background	Colors

There	are	two	types	of	background	on	the
TrainPlayer	screen.		Choose	your	favorite
colors	for	each	of	these.

Layout	background:		color	of	the	layout
surface	for	a	new	layout	or	one	which	does	not
have	a	background	image.		Default	is	off-white.

To	set	a	different	background	color	for	a
particular	layout,	use	the	Color	button	in	Layout
Properties.



Window	background:		color	surrounding	the	layout	when	it	does	not	fill	the	document	window.	
Default	is	a	light	gold.

To	change	one	of	these	colors,	click	the	appropriate	color	button	in	the	dialog	and	select	from
the	system	color	chooser.

Toolbar	Styles

The	Dynamic	Toolbars	feature	introduced	at	Version	8.2	offers	a	few	style	choices:

Size:	choice	of	size	(S,	M,	L)	for	all	toolbar	buttons.		Default	is	M.		This	value	can	also	be	set
in	Customize	>	Options.

With	text	labels:		turn	on	or	off	text	labels	on	all	toolbars.		Default	is	ON.		This	value	can	also
be	set	on	a	per-toolbar	basis	in	Customize	>	Toolbars.

Dynamic	positioning:	turn	on	or	off	the	automatic	positioning	and	hiding	of	toolbars.		Default
is	ON.		For	details,	see	Dynamic	Toolbars.		Note	that	changing	this	setting	may	or	may	not
cause	an	immediate	change	on	the	screen.



Sound	Preferences

Settings	to	turn	sounds	on	or	off	and	adjust	relative	volumes.	Called	from	menu	command	File
>	Preferences.

Sounds	Relative	Volume:

Numbers	in	this	section	adjust	the	relative	volume	levels	of	the	three	sound	channels:

Running	sounds:	speed-related	engine	sounds	in	one	of	three	categories:	steam,	diesel,
or	electric;	see	Running	Sounds.

Engine	horns:		on-demand	engine	sound	triggered	by	pressing	Horn	button;	see	Engine
Horns.

Layout	sounds:		built-in	sounds	for	coupling,	uncoupling,	switch	throws,	plus	layout
sounds	associated	with	Stations;	see	Station	Sounds.

The	number	for	each	channel	is	a	value	from	0	to	10,	where	0	turns	off	the	channel	completely,
1	is	very	soft,	increasing	to	10,	the	native	volume	of	the	sound	stored	in	the	.wav	file.		Defaults
are	5	for	each	channel.

Sounds	On/Off:

Running	sounds	enabled
Check	to	turn	on	engine	running	sounds.		These
sounds	can	also	be	turned	on	or	off	from	the	layout
context	menu;	see	Running	Sounds.



Layout	sounds	enabled
Check	to	turn	on	all	sounds	except	horns	and
running	sounds.		These	include	switch	throws,
couplings,	sounds	associated	with	stations.



The	Customize	dialog

To	modify	the	commands	on	toolbars,	choose	View	Toolbars	Customize	or	Tools	Customize
to	bring	up	the	Customize	dialog,	shown	below.		You	can	then	use	drag-and-drop	to	set	up	your
toolbars.		As	long	as	the	Customize	dialog	is	on	the	screen,	you	can:

Remove	a	button	from	a	toolbar	by	dragging	it	off	into	space.
	
Add	a	button	to	a	toolbar	by	dragging	it	from	the	Commands	window	(Commands	tab,
shown	below)	to	the	place	you	want	it	on	a	toolbar.		If	the	command	has	no	icon,	the
button	will	be	labelled	with	text.

Drag	the	New	Menu	item	to	create	a	new	drop-down	menu	on	a	toolbar.		Once	the	menu
is	created,	give	it	a	name	and	then	drag	commands	onto	it.

The	Customize	dialog	is	brought	to	you	by	BCGSoft.

For	details	of	the	individual	tabs,	see	separate	pages:

Commands						Toolbars						Keyboard						Menu					Options
	

	

http://www.bcgsoft.com


Windows	and	Views

Some	appearance	features	were	described	in	Adjusting	the	View.		Others	are	available	on	the
Window	menu:

New	Window:		creates	a	new	window	with	a	separate	view	of	the	same	layout.		Views	in
separate	windows	may	be	resized	or	zoomed	independently.		Trains	runs	in	all	visible
views.		
	
Cascade,	Tile	Horizontal,	Tile	Vertical:		rearranges	the	windows	on	the	screen.
	
Window	Manager:		brings	up	a	standard	Windows	dialog	for	selecting	and	arranging
multiple	windows,	shown	below.
	
<Active	Window>:		all	open	windows	are	listed	at	the	bottom	of	the	Window	menu;
choose	one	to	activate	and	bring	it	forward.

An		effective	way	to	view	a	running	railroad	is	to	set	up	one	window	showing	the	overall	layout,
and	another	zoomed	in	and	following	the	train,	as	shown	here:



To	set	up	a	dual	view,	with	a	layout	on	the	screen:

1.	 Choose	Window	New	Window	to	create	a	second	view	of	the	layout.
2.	 In	the	original	view,	use	View	Zoom	In	to	get	a	close	view	of	the	train.		Right-click	the

layout	and	make	sure	Auto-Follow	is	checked.
3.	 Choose	Window	Tile	(pick	a	direction	based	on	the	layout	orientation)	to	arrange	both

windows	together.
4.	 In	the	second	window,	choose	View	Fit	To	Window	so	you	can	see	the	entire	layout	in	it.

The	train	runs	in	both	windows.



Road	Styles

A	road	style	is	a	specification	of	how	track	is	to	be	displayed.		In	TrainPlayer	1.0	(2005),	the
track	was	a	single	1-pixel	brown	line.		Over	time	it	evolved:

track	width	became	adjustable	(2006)
track	did	not	all	have	to	be	the	same	color	(2007)
rails	were	added,	as	a	full	set	of	paired	track	sections	(2008)
roadbed	and	ties	were	added,	as	lots	of	little	scenery	objects
(2010-11)
roadbed,	ties,	and	then	rails	became	drawing	techniques	instead	of
objects	(2013)

In	the	latest	advance	(Version	6.5,	2017),	road	styles	have	become	fully
configurable,	different	styles	can	apply	to	different	areas	of	the	track,
and	all	parts	of	the	system	are	brought	together	and	managed	in	a
single	new	visual	dialog.

About	Road	Styles

Components:	A	road	style	consists	of	four	components,	each	with	its	own	set	of	adjustable
properties:

rails	--	adjustable	thickness,	separation	(gauge),	color
ties	--	adjustable	tie	dimensions,	spacing,	color
roadbed	--	choice	of	solid	color	or	bitmap,	adjustable	width
centerline	--	adjustable	thickness,	color

Each	component	has	an	on/off	setting	indicating	whether	it	is	to	be	visible	in	a	given	style.		For
example,	a	main	line	road	style	might	have	rails	on	ties	on	gravel	roadbed,	where	a	style	for	an
industry	siding	might	have	just	rails,	without	roadbed.

Defaults:	There	are	three	special	road	styles,	all	called	"default,"	meaning	"this	is	what	you	get
if	you	don't	change	it:"

Factory	Default:	a	mainline	style	hard-coded	into	the	program	--	standard-gauge	rail	on
ties	and	wide	gravel	roadbed.		This	is	the	style	you	get	on	a	new	layout	if	you	have	just
installed	the	program.		You	cannot	change	it,	but	you	can	override	it,	or	you	can	reset	back
to	it.
Global	Default:	this	style	is	stored	in	the	registry	settings,	like	other	user	preferences.		In
fact	this	is	the	style	you	get	on	a	new	layout	--	it	starts	out	as	the	factory	default,	but	you
can	change	it	to	whatever	you	like.
Layout	Default:	the	style	attached	to	each	layout,	applying	to	all	track	which	has	not	been
customized.		This	starts	out	as	the	global	default,	but	can	be	changed.		The	layout	default
style	is	saved	with	the	layout.

View	Settings:	Options	on	the	View	Options	toolbar	can	be	used	to	turn	on	or	off	display	of
track,	rails,	ties,	and	roadbed.	These	interact	with	the	road	style	system	in	a	special	way:	when



you	change	a	view	setting,	it	affects	only	track	having	Default	style.		Tracks	with	custom	styles
are	unaffected.

	For	example,	consider	the	above	picture:	if	you	toggled	View	Rails	to	OFF,	rails	would
disappear	from	the	Default	Style	tracks,	but	not	from	the	custom	Siding	Style	or	Rails	Only
sections.

Road-Styling	Your	Layout

To	add	road	styles	to	your	layout,	choose	your	level.

The	minimalist	approach:	do	nothing.		There	is	a	built-in	style	applying	to	all	the	track	on	a
layout.		You	can	turn	it	on	or	off,	all	or	in	parts,	using	menu	commands	or	toolbar	buttons.		If
you	like	the	way	it	looks,	you're	all	set.

With	a	bit	more	work:	modify	the	default	style.		Bring	up	the	Road	Styles	dialog,	tweak	the
settings	until	the	track	looks	the	way	you	like,	click	OK.		All	the	track	will	adopt	the	new	default
style,	and	the	style	will	be	saved	with	the	layout.		If	you	want	all	track	in	the	future	to	look	the
same	way,	set	the	global	default	style	to	to	match.

The	fully-styled	layout:	override	the	default	with	custom	styles	on	portions	of	the	track.	
Design	and	create	a	set	of	named	styles	in	the	Road	Styles	dialog,	then	in	Track	Properties,
apply	them	by	name	to	selected	track.

Some	of	this	can	be	done	with	a	TrainPlayer	license,	some	requires	TrackLayer.		With	TP,	you
can	customize	the	default	layout	style,	but	cannot	add	your	own	custom	styles.		At	either	level
you	can	open	a	fully-styled	layout	created	by	an	author.

Road-Styling	Tutorial

To	demonstrate	the	techniques	of	road-styling,	let's	add	styles	to	a	typical	plain	layout.

1.	Open	layout

Open	the	San	Jose	Central,
found	in	your	Demo	folder.

On	opening,	the	track	is	shown	as
a	thick	white	line	drawn	as	part	of
the	background	image.

2.	Set	up	view

Track	display	is	normally	turned	off
when	you	open	a	layout	with	a
background	image.		To	turn	it	on,	use
toggles	on	the	View	toolbar	to	turn	on
Rails,	Ties,	and	Roadbed.

Note:	these	toggles	are	also	available



on	the	toolbar:	

Suggestion:	while	you're	at	it,	you	might
turn	off	the	display	of	Trains.	These
tend	to	get	in	the	way	during	road-
styling.

3.	Observe
defaults

What	you	now	see	on	the	tracks	is
the	Layout	Default	road	style.

Because	this	layout	had	no
previous	style,	what	you	see	is	the
same	as	the	Global	Default,	which
in	turn	matches	the	factory
settings.

Let's	modify	the	default	style	of
the	layout	without	changing
anything	global.

4.	Bring	up
dialog

Right-click	a	blank	spot	on	the	layout,
choose	Layout	Properties.		Go	to	the
Advanced	tab	and	click	the	Road
Styles	button.

This	brings	up	the	Road	Styles	dialog.

5.	Explore	dialog

The	top	part	of	the	dialog	shows
the	detailed	features	of	the	style.	
Click	the	tabs	on	the	top	to	edit
individual	components	and	turn
them	on	or	off.

The	bottom	part	is	for	managing
the	layout's	list	of	road	styles.	
We'll	get	to	this	shortly.

Feel	free	to	experiment.		If	you
Cancel	the	dialog,	you	haven't
changed	anything.*		Drag	a	corner
of	the	dialog	to	enlarge	it	and	see
the	sample	in	more	detail.

*	With	a	couple	of	exceptions	on
the	Options	menu.

Let's	change	the	default	roadbed.		Go
to	the	Roadbed	tab	and	make	two
changes:



6.		Make
changes

a.		Change	the	Width	to	2".		Click
outside	the	box	to	see	the	roadbed
change	on	the	sample.

b.		Browse	to	a	different	pattern.		Click
the	browse	(...)	button	to	bring	up	the
Scenery	Chooser,	showing	the	folder	of
background	image	patterns.		For	this
tutorial,	choose	Bare	Dirt	and	click	OK.	
Result	should	look	as	shown.

7.	Apply	to
layout

Click	OK	to	take	down	the	Road	Styles
dialog,	then	click	OK	to	take	down
Layout	Properties	and	apply	the
modified	default	style	to	the	layout.

Now	the	entire	layout	has	dirt	roadbed.		

At	this	point	you	might	use	File	>	Save
As	to	keep	what	you've	done	so	far	--
but	be	careful	and	don't	overwrite	the
original.

8.	Choose	track
for	custom	style

Now	let's	make	a	custom	style	for
part	of	the	track.		

A	good	candidate	is	at	center	right
of	the	layout,	where	the	track
crosses	the	roadway,	as	shown	at
right.		We	don't	want	roadbed	on
the	crossing.		

To	accomplish	this,	we	will	need	to
create	a	custom	style	and	apply	it
to	the	portion	of	the	track	which
crosses	the	road.

9.	Create	custom
style

Repeat	step	4	to	bring	up	the	RS
dialog.		Click	the	Options	button,
observe	the	menu,	and	select	Create
New	Style.

This	makes	a	copy	of	the	default	style,
adds	it	to	the	end	of	the	list,	and	gives	it
a	generic	name.

The	style	will	show	thin	rails	only.	
Go	through	the	tabs,	uncheck
Show	for	all	except	Rails.		In	the



10.		Customize
the	style

Rails	tab,	set	the	Weight	to	1.

Enter	a	name	for	the	style	in	the
box	at	the	bottom.		Let's	call	it
Road	Crossing.

Click	OK	to	save	the	new	style.

11.		Select	target
track

Before	we	can	apply	the	new	style	to
the	target	track,	that	track	must	be
isolated	as	a	single	section.		Currently	it
is	part	of	a	large	curve.		To	isolate,	use
the	Track	Edit	tool,	right-click	each	end
of	the	section	where	it	touches	the	road,
and	choose	Split	Track	Here.	

Now	select	the	new	section,	right-click
and	choose	Properties.		This	brings	up
Track	Properties	as	shown.

12.		Apply
custom	style

The	Style	drop-down	shows	the
current	style	for	this	section	to	be
Default.		From	the	menu,	choose
Road	Crossing.

(Note	that	it	is	possible	to	bring	up
the	RS	dialog	from	this	menu,	as
an	alternative	to	step	4.)

13.		Observe
result

Click	OK	or	Apply.		Observe	the	change
in	the	display.

File	>	Save	to	keep	your	work.

	 	 	



			Welcome	to	TrackLayer

TrainPlayer	lets	you	operate	trains	on	prepared	track	plans.		TrackLayer	is	the	program	which
prepares	the	track	plans.		You	can	use	it	to	edit	plans	provided	by	us,	or	draw	your	own	from	a
diagram,	or	just	sketch	some	track	on	a	blank	screen.

The	two	are	actually	the	same	program.		When	the	program	is	in	TrainPlayer	mode,	you	get	a
collection	of	tools	for	building	and	running	trains.		In	TrackLayer	mode,	you	get	one	additional
toolbar,	with	a	half	dozen	tools	for	drawing	and	editing	track,	curves,	switches,	and	turntables.	
Building	and	operating	features	are	fully	integrated	---	as	soon	as	you	have	a	single	piece	of
track	down,	you	can	put	a	train	on	it	and	operate	with	all	the	features	of	TrainPlayer.

The	best	way	to	get	started	with	TrackLayer	is	to	go	through	the	next	chapter,	"Getting
Started,"	and	then	work	your	way	through	the	tutorial	in	the	following	chapter.		The	tutorial
leads	you	through	the	complete	process	of	preparing	a	small	layout.		The	remaining	chapters
go	into	more	detail	on	track-laying	operations.

About	This	Manual

Where	to	Go	for	Help



Starting	TrackLayer

There	is	only	one	program	which	contains	both	TrainPlayer	and	Tracklayer.

To	start	the	program:

Select	TrainPlayer	from	the	Start	menu	under	Programs	>	TrainPlayer,	or	double-click	the
icon	on	your	desktop.		The	splash	screen	and	about	box	will	tell	whether	you	are	running	in
TrainPlayer	or	TrackLayer	mode,	as	determined	from	the	license	key	you	entered.

The	BuildToolbar

The	main	difference	you	see	on	the	screen	when	you	are	in	TrackLayer	mode	is	the	addition	of
the	Build	Toolbar:

Tools	on	the	Build	toolbar	are	as	follows.	

Edit	Track for	selecting,	moving,	deleting	track	or	other	objects

Straight for	drawing	straight	track	sections	and	switches

Circle for	drawing	guide	circles,	used	in	making	curves

Turntable for	drawing	turntables

Station	tool for	drawing	station	areas	(button	hidden	by	default)

Edit	Scn edit	tool	for	working	with	scenery

Scn	Tools show/hide	subtoolbar	of	scenery	tools

The	Blank	Layout

When	TrackLayer	starts,	it	presents	a	default	blank	layout:	4'	x	8',	HO	scale,	with	a	12"	grid:



At	this	point	you	can:

Load	an	image.		If	you	have	a	picture	or	track	plan	you	want	to	work	with,	ignore	the
default	layout	and	instead	load	the	picture.		If	the	image	is	already	in	the	form	of	a
graphics	file,	see	"Loading	an	Image"	in	the	next	section;	otherwise,	see	"Preparing	the
Image"	to	get	the	image	ready	for	TrackLayer	use.
	
Start	drawing.		The	default	4x8	space	is	ready	for	track,	and	useful	for	learning	or
sketching.		If	you	want	to	start	drawing,	you	can	go	to	"Straight	Track	and	Switches."
	
Change	the	size	and	scale.		If	a	4x8	HO	layout	isn't	what	you	have	in	mind,	create	a	new
blank	layout	the	size	and	shape	you	want.		See	"Creating	a	New	Blank	Layout."		Once	you
choose	a	particular	size	and	scale,	that	becomes	the	default	for	all	new	layouts.

	



			TrackLayer	Tutorial

The	BN	Cascade	Mining	Division

This	tutorial	takes	you	through	the	steps	of	preparing	a	layout	for	TrainPlayer	use,	starting	with
a	background	image	file.		We've	chosen	a	simple	one:	Chris	Pedersen’s	BN	Cascade	Mining
Division.	You	can	start	with	the	jpg	file	you	already	have	(look	in	your	chooser	under
Layouts/Demo)or	you	can	download	it	from	the	web.

The	BN	CMD	is	a	small	loop	with	two	major	industries	and	a	future	branch..		Follow	along	in
TrackLayer	and	see	if	you	can	build	it.

Set	up	your	TrackLayer
preferences	first		
Go	to	File\Preferences	\
Track	to	open	that	menu	first
	
Ensure	you	have	activated
“Check	Track”	to	catch	any
mistakes	you	make	while
laying	track
	
If	you	want	specific	switch
types,	then	select	Snap	to
Angle	and	check	the	desired
switch	sizes.	For	your	curves,
select	the	radius	sizes	you
want	to	conform	to	.
	
Press	OK	to	lock	your
choices
Set	the	grid	
	
The	BN	Cascade	Mining	does
not	have	a	grid	overlaid	on	it
but	from	the	notes	about	this
layout,	we	know	it	is	6	feet	by
20	feet	in	HO	scale.
	
So	we	use	File/Open	and
select	New	Layout	and	select
HO	as	the	scale	we	want	to
use	for	our	work
Open	the	image	file	



Use	File	Open	to	open	the
graphics	file.

For	this	tutorial,	use	this	file
from	your
trainplayer\Layouts\Demo
folder:
bn	cascade	mining
division.jpg

The	image	opens,	the	grid
appears	in	a	default	position,
and	the	Edit	Tool		
becomes	active.
Set	the	grid	

Point	to	an	intersection	point
on	the	grid,	press	the	Shift
key	(the	cursor	becomes	a	4-
headed	arrow),	and	drag	until
you	can	see	a	6	x	20	pattern
of	squares.

(Shift-drag	moves	the	grid,
drag	alone	resizes	it.
Dragging	by	an	intersection
point	keeps	the	grid	square.)	
After	adjusting,	use	View	Grid
	 	to	turn	off	the	grid	display.
Place	a	circle	

Choose	the	Circle	Tool	 	.
Place	the	cursor	near	Eagle
Coal,	press	and	drag.	Adjust
until	the	circle	exactly
overlays	the	left-hand	curve,
as	shown.

To	move	rather	than	resize
the	circle,	press	the	shift	key
while	you	drag.



Add	first	tangent	

Choose	the	Straight	Track
Tool	 .	Point	to	the	top	of
the	left-hand	circle	(so	it
highlights),	then	press	and
drag	to	the	right	as	shown.

Note	that	the	straight	section
remains	tangent	to	the	circle
as	you	drag.

	

Add	Second	Tangent

Continuing	with	the	Straight
track	tool,	drag	until	the
moving	end	touches	the	right-
hand	circle	(so	it	highlights),
then	release.

The	straight	snaps	to	be
tangent	to	both	circles.

	
Complete	the	loop	

Repeat	the	above	steps	to
add	a	segment	completing	the
next	portion	of	the	folded
loop.	Press	and	drag	from	the
bottom	of	one	circle	to	the
other	(in	either	direction).

When	you	release,	the	circles
disappear	and	become
curved	track	sections.

If	the	result	doesn't	look	like
this	picture,	use	Edit	Undo	to
go	back	a	step,	then	try
again.	Make	sure	a	circle	is
highlighted	when	you	start	or
end	drawing	each	straight.

	



You	might	use	File	Save	As	to
save	a	copy	of	the	layout	at
this	stage,	and	again	every	so
often	as	you	work.

Adding	a	switch	to	Eagle
Coal	
	
Go	to	File/Preferences	and
study	your	switch	submenu.
	
We	suggest	that	although
your	switches	can	use	any	2
colors	to	indicate	safe
passage,	that	you	consider
only	1	color.	We	prefer	Red
for	passage	denied.
	
If	you	want	to	operate	your
layout	in	a	prototypical
fashion,	then	you	should
remove	ALL	the	check	marks
under	“Operation.”

	

Complete	the	Switch
Placement	

Choose	the	Straight	Track
Tool		 	.	Drag	from	the	top
of	the	circle	over	to	the
outside	edge	of	the	mine
building.

The	little	red	rectangle
indicates	the	switch	has	been
created	and	when	you	zoom
in	closer,	you	will	see	that	the
leg	leading	to	the	mine	is
Closed.

	

Hidden	Tracks

Since	our	track	will	run	under
the	loader	portion	of	the	mine,



we	want	to	hide	that	track	but
we	also	want	to	see	if	there
are	cars	under	the	building.

Draw	a	short	straight
segment	to	the	other	edge	of
the	building.	Next,	select	that
new	section	and	right	click	to
bring	up	the	Track	Properties
dialog.	Select	track	type	as
Hidden	and	also	“cars	as
outline”.	Then	click	OK.

Repeat	this	process	for	the
second	hidden	track.

	

Hidden	Tracks	part	2

If	you	want	to	ensure	a	crisp
clean	line	when	your	hopper
passes	under	the	mine
structure,	then	all	you	need
do	is	add	a	straight	section
along	the	side	of	the	mine
wall.	As	shown	above,	open
the	track	submenu	and	mark
this	new	section	as	a	“tunnel”
piece.
	
With	the	layout	background
image	turned	off,	you	can	see
the	effect	of	this	tunnel
section

	

Another	TrackLayer
Shortcut

The	Track	cursor	tool	can	be



used	after	your	track	has
been	laid	to	either	re-position
a	switch	slightly,	to	smooth
out	some	“kinks”	in	your	track
work	and	also	to	extend	the
length	of	any	siding.

Just	remember	to	position
your	Track	cursor	on	a
junction	point	to	activate	it,
then	drag	that	junction	a	short
ways	or	right	across	your
layout.	

If	something	goes	wrong,	use
Edit	Undo.

	

Track	Work	is	complete!

The	track	is	complete!

Let’s	do	some	tidying	up.	First
we	want	to	change	the	track
color	from	the	highly	visible
Blue	to	a	muted	Gray	to	suit
the	roadbed	and	ties.

Click	on	any	track	segment	to
select	it	and	bring	up	the
Track	main	menu.	Click	on
“Select	All”	to	grab	all	the
track	work..	Then	slide	down
to	Properties	to	bring	up	the
next	submenu	and	choose
your	color.
Save	your	work.

	

Adding	Trains	to	this
Layout	1

This	layout	is	intended	to
represent	the	modern	era.
But	you	may	choose	any
suitable	cars	from	our
collections	which	are	of
interest	to	you.

	



You	can	add	them	individually
or	in	small	groups.	With	your
Edit	Track	tool,	right	click	on
any	track.	From	the	menu
which	appears	,	select	“Add
car	here”	–	“car	chooser”	and
pick	the	cars	from	the
collection	of	your	choice.

Adding	Trains	to	this
Layout	

Alternatively,	you	can	also	use
our	updated	“Train	Generator
to	speed	up	this	process.

Step	1	–	select	the	track
where	you	want	to	place
some	cars	using	the	Track
cursor	to	highlight	your	choice
of	tracks.	
	
Step	2	Bring	up	the	Track
Properties	menu	and	Select
“Generate	Trains”
	
Step	3	–	Decide	which	cars
you	want	and	the	density	of
those	cars	on	the	available
track	and	select	OK.

Finally	select	a	car	collection
as	the	source	for	the
specified	cars.		Click	Go.		

If	you	don't	like	the	results,	do
it	again	--	you	get	a	different
set	of	trains	every	time.

	



Project	Completed 	



Resizing	and	Rescaling

In	a	computer	simulation	of	a	scale	model	of	the	real	world,	the	term	"resize"	can	have	different
meanings.		Until	now,	the	way	to	resize	a	layout	was	to	adjust	the	grid,	changing	the	mapping	of
the	virtual	layout	onto	the	real	one.		For	example	if	you	have	a	4x8	HO	layout,	and	you	drag	the
grid	to	double	the	number	of	squares,	you	end	up	with	an	8x16	version	of	the	same	layout,	as	if
you	somehow	stretched	it	to	take	up	twice	as	much	space	in	your	garage.

TrackLayer	offers	a	dual-purpose	tool	which	gives	two	new	ways	to	resize	your	layout	without
modifying	the	background.		One	rescales	or	moves	the	entire	set	of	track;	the	other	changes
the	size	and	shape	of	the	"benchwork."		In	your	garage,	the	first	method	is	like	replacing	the
HO	track	with	N	--	it	changes	the	overall	size	of	the	track	relative	to	the	scenery.		The	second	is
like	adding	a	shelf	--	it	increases	space	for	track	beyond	existing	scenery.	

Technically	this	means	the	bitmap	size	is	now	independent	of	the	layout	size,	so	the	two	no
longer	need	to	be	the	same	size	and	shape.		This	fixes	a	few	long-standing	problems,	adds
flexibility	in	plan-bashing,	and	solves	some	import	problems	which	arise	when	a	CAD	app
doesn't	generate	an	image	of	the	right	shape.

Resizing	a	layout	to	add	or	subtract	track	space:

1.	 Zoom	out	so	the	entire	layout	is	smaller	than	the	window	on	the	screen.		This	is	not
required,	but	it's	a	good	idea	until	you	get	the	hang	of	resizing.

2.	 Choose	the	command	Tools	>	Resize/Rescale.		

The	first	time	you	choose	this	command,	you	get	an	alert	with	brief	instructions.		This
appears	only	the	first	time	you	activate	the	tool	after	starting	the	program,	so	read	it	the
first	time	it	comes	up.		If	you	want	to	get	rid	of	it	permanently,	check	"do	not	show	again."

Two	rectangular	frames	appear:	a	pink	one	around	the	outer	border	of	the	layout,	and	a
blue	one	surrounding	the	track.	



3.	 Press	and	drag	the	pink	outer	rectangle	by	any	side	or	corner.		The	overall	layout	space
changes	while	the	bitmap	remains	in	position	or	becomes	cropped.		Keep	your	eye	on	the
status	bar,	which	displays	the	size	as	you	drag.

4.	 If	you	make	a	mistake	or	don't	like	the	result,	use	Edit	>	Undo.
5.	 To	dismiss	the	tool,	(a)	press	ESC,	(b)	click	a	spot	inside	the	pink	but	outside	the	blue

rectangle,	or	(c)	choose	a	different	TrackLayer	tool.

Rescaling	or	moving	track	relative	to	the	background:

1.	 Do	steps	1	and	2	as	above.
2.	 Press	and	drag	the	blue	inner	rectangle	by	a	corner	to	resize,	or	by	the	middle	to	move.	

Note:	the	blue	border	cannot	be	dragged	by	a	side.		The	entire	set	of	track	moves	or
rescales	proportionately.

3.	 See	steps	4	and	5	above.	



	



			Turntables	and	Transfer	Tables

The	TrainPlayer	portion	of	the	manual
describes	how	turntables	and	transfer	tables
look	and	behave	(see	Turntables	and	Transfer
Tables).		This	section	describes	how	to	build
them	with	TrackLayer.

A	turntable	consists	of	two	objects:	a	circle
and	a	bridge	track	which	crosses	the	circle
and	passes	through	the	center.		When	you
rotate	the	table	--	by	double-clicking	a	point	on
the	rim,	or	right-clicking	and	choosing	a	Rotate
command	from	the	menu	--	the	bridge	rotates	until	either	end	is	touching	an	end	of	an	external
connecting	track.		At	this	point	it	stops,	and	the	superimposed	endpoints	become	a	single
junction	a	train	can	cross.

An	alternative	to	a	turntable	is	a	transfer	table	--	a	rectangular	bed	with	a	bridge	which	moves	laterally.	
In	this	case,	a	double-click	inside	the	table	area	causes	the	bridge	to	move	slowly	in	the	direction	of	the
click	until	it	locks	onto	the	next	connecting	track.

		

This	section	describes	how	to	build	and	edit	turntables	and	transfer	tables.

Creating	a	Turntable

Creating	a	Transfer	Table



Creating	a	Transfer	Table

A	transfer	table	has	several	moving	parts,	a	combination	of	scenery	and	track.		They	are:

Pit:	the	bed	over	which	the	bridge	moves.		This	is	a	regular	rectangular	scenery	object,	so	can	be
solid	or	filled	with	bitmap	or	pattern.

Rails:	lines	perpendicular	to	the	bridge,	representing	rails	on	which	it	rides.		These	are	non-
functional,	just	for	display.		You	can	change	the	number	of	them	or	remove	them	(default	is	to	show
four	rails).

Bridge:	narrow	rectangular	platform	which	moves	across	the	pit.		You	can	adjust	the	width	(default
is	3"	in	HO).		By	default	the	bridge	is	shown	as	solid	grey,	but	you	can	instead	display	a	scenery
object	if	you	wish.

Bridge	Track:	track	on	which	the	engine	rides.		Sits	on	top	of	the	bridge	and	bisects	it.		This	is	a
normal	section	of	live	track.		In	a	multi-track	table,	the	platform	has	more	than	one	track,	evenly
spaced	and	separated	by	the	distance		specified	for	Snap	to	Parallel	(see	Track	Preferences).

Bridge	Scenery:	an	optional	scenery	object	representing	the	bridge	(not	shown	in	the	above
illustration).		Several	are	available	in	the	scenery	collection,	especially	in	the

hq_details_accessories	folder.		Examples::	 .	

When	a	transfer	table	has	a	bridge	scenery	object	attached	to	it,	the	scenery	moves	along	with	the
platform.		To	attach	bridge	scenery	to	a	turntable	or	transfer	table,	see	below.

There	is	no	special	tool	for	creating	transfer	tables.		You	first	create	a	scenery	object	for	the
pit,	then	convert	it	to	a	transfer	table,	as	described	below.

As	of	Version	6.3,	you	can	create	a	Multi-Track	Transfer	Table,	having	more	than	one	bridge	track	on
the	platform,	as	shown	below.		To	do	this,	create	a	regular	one-track	table	and	then	change	the	number	of
bridge	tracks	on	the	Scenery	Properties	-Transfer	Table	dialog.



To	create	a	transfer	table:

1.	 Choose	the	RectangleTool	Tool	on	the	Scenery	Toolbar:		
2.	 Draw	a	rectangle	for	the	pit	(below	left).		Size,	position,	and	rotate	to	suit	on	the	layout.

3.	 Right-click	the	rectangle	and	choose	Convert	to	Transfer	Table.

						 								
	

This	adds	a	vertical	bridge,	single	bridge	track,	and	rails	(above	right).		The	table	is	now	ready	to
hook	up	and	use.	

4.	 To	add	more	bridge	tracks,	right-click	the	table,	choose	Properties,	and	adjust	the	number	of	bridge
tracks.

5.	 Try	it!		Double-click	anywhere	in	the	pit,	and	the	bridge	will	move.		Double-click	again	to	stop.

To	connect	external	tracks:

The	transfer	table	is	not	useful	unless	it	has	external	tracks	for	entry	and	exit.		An	external	track	must	have
one	endpoint	lying	on	the	edge	of	the	pit,	and	is	normally	perpendicular	to	the	rails.		You	must	construct
the	table	before	drawing	or	attaching	external	tracks	--	that	is,	if	you	already	have	tracks	in	place	and	you



attempt	to	move	a	table	so	that	it	touches	them,	it	won't	work.

Note:	size,	position,	and	rotate	the	table	before	connecting	external	tracks.		These	tracks	do	not	move	if
you	later	decide	to	reposition	the	table.

1.	 Choose	the	Track	tool.	
2.	 Begin	drawing	a	track	section	outside	the	table.		Drag	the	end	until	it	touches	and	highlights	the	table

edge,	as	shown	here	(left).		When	you	let	go,	the	track	snaps	to	perpendicular	(right).

																														

Note	that	the	edge	of	the	table	will	highlight	only	if	you	are	touching	a	serviceable	location.		It	must
be	(a)	on	one	of	the	two	edges	perpendicular	to	the	bridge,	and	(b)	more	than	half	a	bridge	width
from	the	side	of	the	pit.

3.	 Test	your	work!		Double-click	the	pit	on	the	external	track	side,	and	the	bridge	should	move	until	it
locks	onto	the	track.	

To	make	a	cross-over:

If	you	want	the	engine	to	be	able	to	drive	straight	across	the	table,	you
must	take	care	to	make	sure	the	connecting	tracks	are	aligned.		Here's	the
best	way:

1.	 Draw	the	first	track	as	described	above,	to	define	where	you	want	the
cross-over.

2.	 Double-click	to	move	the	bridge	until	it	locks	onto	that	track.
3.	 Draw	the	second	track,	dropping	the	end	onto	the	highlighted	junction

at	the	end	of	the	bridge	track,	as	shown	here:

In	this	case,	it	is	up	to	you	to	make	the	track	perpendicular	to	the	pit.	
When	you	drop	the	end	onto	a	junction,	instead	of	on	the	pit	edge,	it	will	not	snap.		You	may	have	to
adjust	the	far	end	until	all	three	tracks	are	aligned.

4.	 Test.		Put	an	engine	on	one	of	the	track	sections,	and	verify	that	you	can	drive	it	all	the	way	across.



To	decorate	a	transfer	table:

You	can	change	the	appearance	of	a	transfer	table	in	several	ways:

Change	the	pit	color	or	background.		Right-click	the	table	and	choose
Properties	to	see	the	Scenery	Properties	dialog.		You	can	set	the
background	color	or	image	in	this	dialog,	as	described	in	the	Scenery
chapter.	

For	example,	at	left	the	pit	has	the	"ground_concrete_01"	image	from	the
"background"	collection.

Modify	transfer	table	properties.		In	the
Properties	dialog,	when	you	are	editing	a	transfer
table	there	is	a	special	tab	for	this	purpose,	as
shown	at	right.		In	this	tab	you	can	set:

Number	of	guide	rails.		Set	to	zero	to	remove
rails.
Whether	or	not	to	display	the	bridge
track(s).		Normally	you	turn	this	off	when
you	have	a	bridge	scenery	object.
Width	of	the	bridge.		Units	are	those	in	use
throughout	the	program.
The	name	of	a	scenery	object	to	be	used	as
the	bridge.		See	below	for	details.
Number	of	bridge	tracks.		Default	is	1.

Add	a	bridge	scenery	object.		Here's	how:

Note:	These	instructions	apply	to	both	transfer	tables	and	turntables.

1.	 Choose	or	draw	the	object	to	be	used	for	the	bridge.	The	best	source	of	bridge	art	is	in	the
hq_details_accessories	scenery	folder.

2.	 Size	and	rotate	the	bridge	so	it	aligns	with	the	bridge	track	and	is	the	same	size.	as	shown
below.		Then	position	it	right	on	top	of	the	bridge	track.

3.	 Display	properties	of	the	bridge	object	and	note	its	name	(in	this	case,	"Rectangle12").



4.	 Select	the	transfer	table	and	bring	up	its	Properties	dialog,	Transfer	Table	tab.		In	the	case	of	a
turntable,	bring	up	the	Turntable	Properties	dialog.

5.	 In	the	"Bridge	Scenery"	drop-down,	select	the	name	of	the	bridge	object.		(Note:	this	will	not	change
the	display	in	the	properties	dialog.)

6.	 Click	OK	and	you	are	ready	to	go.		Double-click	to	start	up	the	table	movement,	and	the	new	fancy
bridge	will	move	along	with	the	bridge	track.

To	edit	a	transfer	table:

To	move,	resize,	rotate,	or	delete	a	transfer	table,	use	the	Scenery	Edit	tool:	 .		You
manipulate	the	transfer	table	by	working	with	the	pit	as	you	would	work	with	any	other	scenery	object.

If	you	have	a	bridge	scenery	object,	it	is	not	connected	to	the	table	and	will	not	move	or	delete	along	with
the	table.		To	manipulate	both	the	bridge	and	the	table	as	a	single	object,	group	them	using	the	scenery
Group	tool:	



			Scenery	Toolkit

The	Scenery	Toolkit	in	TrainPlayer	is	the	armchair	railroader's	equivalent	of	that	big	box	in	the
basement,	full	of	miniature	trees,	buildings,	bridges,	earth	powders,	paints,	and	other
decorative	whatnot.		In	TrainPlayer,	the	box	has	an	unlimited	quantity,	the	objects	are	thin
(they're	just	top	views),	and	if	you	don't	see	what	you	like,	there	are	tools	for	making	your	own.
It's	quick	and	easy!	With	Scenery	Toolkit	you	can	scenic	an	entire	layout	in	an	evening,	and	not
spill	a	drop	of	Sculptamold	on	the	floor.

This	chapter	describes	how	to	create	scenery	on	your	layout.		The	tutorial	in	this	leads	you
through	the	exercise	of	creating	an	entire	scenic	layout.		For	more	exercise,	try	the	Clappison
Junction	tutorial	on	the	website.

About	Scenery

Tutorial:	Jamestown

Scenery	UI	Devices

Choosing	Scenery

Drawing	Scenery

Editing	Scenery

Animated	Scenery

http://www.trainplayer.com/Features/Scenery/clappison/Clappison.html


About	Scenery

The	Scenery	Toolkit	is	not	really	a	box	of	objects,	it	is	a	full-featured	object-based	drawing
system.		This	page	gives	an	overview	of	the	objects	you	can	create.		The	controls	for	doing	the
drawing	and	styling	are	described	in	the	next	section,	Scenery	UI	Devices.

Scenery	Objects

Shapes.		Scenery	objects	come	in	a	few	basic	shapes	in	two	categories:	linear	(line,	polyline)	and
fillable	(rectangle,	ellipse,	polygon).		Shapes	may	be	rotated	to	any	angle.		Any	shape	may	have	a
string	or	block	of	text	displayed	on	top	of	it.

							

Styles.		Every	object	has	a	Line	Style,	which	applies	to	the	entire	object	(for	a	linear	shape),	or	to
the	outer	border	(fillable	shape).		In	addition,	a	fillable	shape	has	a	Fill	Style,	which	applies	to	its
interior	region.	Any	style	can	be	one	of	(a)	solid	color,	(b)	two-color	hatch	pattern,	(c)	bitmap	(see
below),	or	(d)	no	fill,	i.e.,	transparent.		A	line	style	has	all	this	info	plus	a	thickness,	expressed	in
layout	units.

Default	Styles.		Each	object	has	its	own	style.		In	addition,	there	is	a	set	of	Default	Styles	which
determine	now	newly-created	objects	will	look.		The	three	default	styles	--	Line,	Fill,	and	Text	--
are	edited	in	the	tabs	of	the	Scenery	Styles	dialog.

Layers.	

The	scenery	objects	on	a	layout	reside	in	one	of	two	layers:	Background,	for	benchwork	or	ground-level
scenery	underneath	the	tracks,	vs.	Foreground,	for	structures	and	objects	above	the	ground.	The	layers
are	drawn	and	edited	independently,	so	that	you	can	draw	and	manipulate	foreground	objects	without
accidentally	modifying	the	background	underneath.

With	TrainPlayer	6.2,	you	can	now	easily	move	scenery	objects	between	layers	by	using	a	check
mark	in	Scenery	Properties.	It	is	no	longer	necessary	to	copy	and	paste	to	change	layers.

Polylines	and	Polygons.			A	polyline	is	a	series	of	connected	line	segments.		In	a	polyline	of
two	or	more	segments,	add	one	more	between	the	start	and	end	points	and	you	have	a
closed,	fillable	polygon.		Both	types	(which	we	will	call	"poly	objects")	have:



Two	editing	modes.		Click	to	select	a	poly	object	and	you	see	normal	drag	handles
at	the	corners	of	the	rectangle	occupied	by	the	object.		Click	again	and	the	handles
appear	on	segment	endpoints	--	shared	ones	are	called	vertices	--	which	you	can
move	to	change	the	shape	of	the	figure.

			

Smoothing	at	vertices.		"Smoothing"	means	changing	a	sharp	corner	to	a	smooth
curve	(a	Bezier	curve,	to	be	exact).		You	can	request	to	have	this	done	at	any	or	all
vertices	of	a	poly	object.		An	example	is	shown	in	the	right-hand	vertex	of	the	polyline
at	the	top	of	this	page.

Special	context-menu	commands.		When	you	right-click	a	segment	in	a	poly	object,
the	command	Delete	Polygon	Segment	shows	up	on	the	menu;	choose	it	to	delete
the	clicked	segment.		If	you	do	this	to	a	segment	of	a	polygon,	it	becomes	an
unclosed	polyline.		When	you	right-click	a	polyline,	the	command	Close	Polygon
becomes	available,	to	automatically	connect	the	endpoints	and	create	a	closed
polygon.

Bitmaps.		We	use	the	term	"bitmap	image"	to	refer	to	any	image	coming	from	a
graphics	file	--	bmp,	jpg,	png,	or	other.	The	program	comes	supplied	with	a	large
variety	of	these,	in	two	general	categories:	a	Background	Pattern	is	a	texture
designed	to	be	tiled	and	used	to	cover	an	area,	e.g.,	grass,	water,	gravel;	an	Object
Images	is	a	top-view	of	an	individual	object	on	the	layout	--	building	rooftop,	oil

tank,	tree	--	usually	with	an	irregular	shape	and	a	transparent	background.

Grouped	Objects.		When	creating	a	complex	scenery	object,	it	is	convenient	to	be	able	to	assemble
several	smaller	objects	together	into	a	single	grouped	object.		This	object	behaves	as	a	single	unit
when	moving,	resizing,	or	rotating		For	setting	properties,	usually	it	is	necessary	to	ungroup	the
object	back	into	its	original	parts	--	except	when	applying	a	style	using	the	Painter	tool,	which	can
work	on	individual	group	components.		Grouped	objects	may	be	contained	within	other	grouped
objects.

SCN	Objects.		New	in	6.2	is	the	SCN	object,	a	scenery	object
constructed	from	other	objects.		Like	building	a	structure	from	a	kit,	you
can	assemble	basic	shapes	into	a	complex	object,	give	it	a	name	and	save
it	to	a	file	for	reuse	in	other	layouts.		For	a	concrete	example	(heh),	at
right	is	a	cement	plant	made	of	rectangles	and	circles;	the	full	assembly	is
treated	as	a	single	object,	and	can	be	used	like	any	image-based	object	--
dragged	out	of	the	Scenery	Chooser	onto	a	layout,	resized,	rotated,	etc.	--
or	can	be	modified	to	suit.

The	scenery	libraries	offer	a	mixture	of	SCN	objects	and	bitmap	images.		A	SCN	object	has	this
advantage:	when	you	add	one	to	a	layout,	it	is	added	to	the	layout	scenery,	and	does	not	require	an



external	file.		If	you	save	the	layout	and	send	it	to	a	friend,	the	cement	plant	shows	up	even	if	no	such
object	resides	on	the	recipient's	machine.		The	same	is	not	true	of	bitmap	images,	like	the	tree.

HQ	Scenery	Collection.		Delivered	with	the	program	is	a	new	set	of	folders	containing	high-quality
scenery	--	a	mixture	of	bitmaps	and	SCN	files.

The	hq_background	folder	has	tileable	textures	useful	for	background	areas.		Hq_vegetation	has
bitmaps	of	trees	and	bushes;	copy	and	paste	to	make	forests.	Hq_roof	kit	has	a	collection	of	parts
you	can	use	to	assemble	custom	roof	designs.		Hq_track	roadbed	has	tileable	textures	designed	for
roadbed,	used	not	only	in	scenery	but	also	for	track	roadbed,	as	described	in	Road	Styles.		Other
folders	have	objects	as	named:	details,	accessories,	industrial	buildings,	etc.	--	browse	around	in	the
Scenery	Chooser	and	see	what	you	have.

For	a	lot	more	scenery	images	from	older	collections,	visit	the	Web	tab	in	the	Scenery	Chooser	and
browse	our	online	collections.		You	can	download	and	install	any	of	the	online	folders	into	your
local	set.		Or	you	may	already	have	them	if	you	have	been	running	an	older	version	of	TrainPlayer.



Creating	"Jamestown"

This	tutorial	takes	you	through	the	steps	of	creating	a	brand	new	layout	with	the	Scenery
Toolkit,	starting	with	a	blank	image	file.		We've	chosen	to	design	a	simple	loop	with	some
sidings	for	industries	and	stations.

Follow	along	and	see	if	you	can	build	it.

As	with	all	good	design	concepts,	we	suggest	that	you	start	out	with	a	rough	idea	of	what	you
want	your	finished	layout	to	look	like.	Do	you	want	a	lot	of	scenery	or	do	you	prefer	bustling
industries?		This	planning	stage	will	help	you	decide	what	key	design	elements	you	want	and
where	you	would	like	to	place	them	on	your	layout.

But,	remember,	the	first	goal	of	model	railroading	and	virtual	railroading	is	to	have	FUN!!

Open	to	blank	screen

Use	File	New	to	open	a	new
layout	file.

For	this	tutorial,	select	HO	4x8

The	image	opens,	the	grid
appears	in	a	default	position.

Note	about	Foreground	and
Background	Layers

You	should	always	plan	on
working	the	Background	layer	first
and	try	to	make	it	as	complete	as
possible.



Then	start	to	work	on	the
Foreground	layer	by	adding
buildings,	industries	etc.

When	you	shift	back	to	the
Background	layer	after	working	in
the	Foreground,		all	of	your
images	will	disappear.		Don't
panic,	they	have	just	been
temporarily	suppressed	to	allow
you	to	see	the	Background	layer
more	clearly

Create	your	Background

From	your	Scenery	toolbar,	make
sure	you	are	in	Background	mode
and	that	you	have	selected	the
Rectangle	drawing	tool	as	shown

With	both	Background	and
Rectangle	active,	use	a	left	mouse
click	and	drag	and	draw	a	large
box	across	your	basic	grid	pattern

We	have	used	a	50	RRU	line	for
the	outside	border.		Then	click	on
the	rectangle	to	bring	up	the
submenu.		When	you	choose	–
Load	Bitmap,	it	will	open	to	the
Scenery	chooser	and	you	can
make	your	choice	of	a	background
texture	in	most	cases	from	the
HQ_background	folder

Adding	Grass	-	2	methods

1)	Locate	the	Scenery	Chooser
icon	on	the	Scenery	Toolbar	left
mouse	click	on	it	and	it	will	bring
up	the	main	Scenery	Chooser
window.	This	window	provides	you
with	a	thumbnail	view	of	the	BMP



and	SCN	images.

Scroll	through	the	selections	in
each	folder.

When	you	find	the	image	you
want,	left	mouse	click	on	it	and
drag	it	onto	your	layout	to	be
positioned.	You	will	need	to
manually	adjust	the	selected
image	to	fit	the	shaded	box.

Hint	-	You	will	likely	use	the
Scenery	Chooser	most	frequently
because	it	has	the	handy
thumbnail	sketch!!

2)	Alternatively,	you	can	place
your	cursor	anywhere	inside	the
shaded	area	and	use	a	right
mouse	click	to	bring	up	a
Properties	submenu	-	select
"Bitmap"		

Then	scroll	through	the	folder	to
select	your	choice	of	background
texture.	".		A	double	click	fills	the
rectangular	box	that	you	drew	with
"grass"	.

TIP	1	-	Using	this	method	fills	the
shaded	box	completely

TIP	2	–	to	ensure	that	the	“grass”
looks	more	detailed	and	realistic
make	sure	the	Tile	radio	button	is
selected	as	shown	here.

Reshape	your	Layout

We	want	to	change	the	4	x	8
layout	to	a	shelf	type	with	a
peninsula!		Easy	enough	to	do.
Start	with	your	existing	4	x	8	and
then	turn	on	the	Scenery	Grid	tool



to	assist	in	drawing	a	nice,	straight
peninsula.		Use	the	Line	tool	to
draw	out	the	inside	perimeter.

This	perimeter	is	drawn	in	the
Foreground	of	the	layout	while	the
grass	main	rectangle	is	in	the
Background	view

Since	we	want	the	“inside
polygon”	to	represent	our	floor,	we
select	a	Solid	–	Gray	colored	to	fill
it	.

Note:

To	assist	you	to	see	the	Scenery
Grid,	we	have	set	the	Grass	on
the	Background	tab	to	a	50%
transparency	level	for	the	moment.

	

Moving	from	Foreground	to
Background	layer	is	now	as	easy
as	clicking	a	check	mark,
regardless	of	how	and	where	you
drew	or	placed	your	image

Adding	your	Track	Plan

Now	with	the	shape	of	your	layout
finalized,	it	is	time	to	add	your
track	work	using	the	Track	Layer
tools	covered	in	an	earlier	tutorial.



Here’s	what	our	track	design	looks
like	for	Jamestown

You	can	also	see	that	we	used	the
Track	Grid	tool	to	change	our
layout’s	dimensions	to	9’	x	18’

A	River	Runs	Through	It!!

To	add	a	river,	there	are	2
methods	-	Using	a	“fat	line”	for	a
river		OR	Using	the	Scenery	Line
tool	to	define	a	river	of	varying
widths

The	Fat	Line

For	the	“fat	line”	river,	click	on	the
little	arrow	on	the	Scenery	Line
Tool	to	open	the	Scenery	Styles
menu.

In	the	Background	tab,	we
selected	the	“water3.bmp”	and	in
the	Line	tab,	we	have	set	the	Line
to	“use	Bitmap”	at	a	width	of	300
RRU.	Then	click	OK

Working	with	the	Poly	line	Tool

Refer	to	“Smoothing	Vertexes”
section	of	this	chapter	for	more
details	on	how	to	draw	gentle
curves	along	your	polyline	[use
SHIFT	+	Line	tool	while	drawing]

We	have	selected	the	“river”	by
right	clicking	on	it	with	our	Poly
Line	tool	to	bring	up	the	“grab”
points	and	the	Scenery	Properties
menu.



At	this	point,	you	can		(a)	drag	any
of	the	grab	points	to	change	the
flow	of	the	river,(b)	change	the
width	of	your	polyline	and	/	or	(c)
move	the	river	to	the	Background
layer.	

We	recommend	you	move	the
river	to	the	background	if	you
intend	to	place	a	bridge	over	it	and
you	wish	to	see	the	track	on	the
bridge	itself

Add	a	River	/	Lake	using	the
drawing	tools

This	option	uses	the	Polyline	tool
to	create	a	river	of	varying	widths
or	an	irregularly	shaped	lake	or
waterfront.

Start	with	the	Polyline	tool.		We
prefer	to	use	a	color	which	will	be
easy	to	find	on	screen	while	we
are	drawing	[a	bright	red]	So,	we
open	the	Defaults	for	the	poly	line
tool,	select	a	12	rru	wide,	red
solid	line	and	we	want	to	fill	our
finished	polygon	with
“water3.bmp”	which	we	had	set	on
the	Background	tab.

The	bottom	picture	shows	a
thumbnail	of	what	our	lake	looks
like.	

We	want	to	edit	it	by	removing	the



Red	outline	and	we	also	want	to
place	it	in	the	background	layer.

Hint:		A	good	habit	to	get	into	is	to
Save	your	work	often	in	case
something	unexpected	happens
and	it	will!

Adding	an	industry

We	strongly	recommend	that	you
try	using	any	of	the	SCN	graphics
images	which	are	provided	within
any	of	the	Scenery	folders	with
the	HQ_	prefix.	

Why??

Because	they	can	be	easily
altered	by	ungrouping	the	image
and	adding	or	deleting	some
details,	“re-painting”	roof	tops,
changing	their	size,	shape	and
orientation

But	largely	because	the	quality	of
the	SCN	image	does	NOT
degrade	as	you	Zoom	in	closer	to
the	action

Just	Click	on	the	Scenery	Chooser
to	access	the	library	of	images

Positioning	and	Sizing	an	Industry

Use	a	single	left	mouse	click	to
"activate"	the	control	points	for	the
image.

We	added	a	fuel	dealer	to
Jamestown.	The	image’s	grab



points	are	showing	when	it	is	first
placed	on	your	layout.	The	top	left
hand	control	point	controls	the
rotation	of	the	image	which
allows	you	to	place	it	correctly
with	your	tracks.	

For	Jamestown	where	we	have	a
peninsula	shelf	plan,	we	can	make
it	look	like	we	have	made	industry
fronts	merely	by	using	the
peninsula	to	hide	portions	of	the
industry	from	view.

How	do	you	do	that?

Make	sure	your	peninsula	is	in
your	Foreground	layer	[check	its
properties	settings	by	right	clicking
on	it].	Then	switch	to	the
Background	layer	by	pressing	the
icon	on	your	scenery	toolbar.	

In	the	Background	layer,	place	all
your	industries	for	the	correct
spots.		When	that	is	done,	then
switch	back	to	the	foreground
layer	and	you	will	have	something
like	the	image	on	the	right

You	will	likely	want	to	add	“ground
cover”	around	these	industries.

Use	you	poly	line	tool	set	to	a	red
line	and	a	“gravel”	fill	to	trace	a
“cut	out”	around	the	area	occupied
by	the	industries.

When	you	complete	the	“cut	out”
the	gravel	will	generally	cover	the
industries.	Just	click	on	the	cut	out
to	activate	its	control	points	and
then	from	the	Scenery	toolbar,	use
the	“Send	Back”	prompt	to	send
the	gravel	backward	and	reveal
the	industries.	If	the	gravel	cut	out



“disappears,	just	click	once	to
bring	it	forward	again,	set	it	atop
of	the	grass	image.

Finally,	switch	back	to	the
Foreground	layer	and	watch	the
peninsula	shape	work	its	effect!

Moving	an	Image

If	you	need	to	move	the	industry
image	to	somewhere	else	on	your
layout,	again	use	a	left	mouse
click	to	activate	the	image.		Your
cursor	should	now	change	to	a	4
arrow	head	marker	and	this	will
allow	you	to	move	the	industry
anywhere	you	want	on	your	layout

Naming	your	industry	or	Town

From	your	Scenery	toolbar,
ensure	you	are	in	Foreground
mode;	then	press	the	Text	tool
icon.		Near	your	industry,	do	a	left
	mouse	click	and	drag	to	create	a
new	text	box.

Insert	whatever	name	you	want
for	that	industry.

As	with	other	image	boxes,	you
can	click	on	it	to	move	it	around	to
whatever	position	suits	you.



If	you	want	to	change	the	font	size
and	font	type	and	color	of	your
new	Text	label,	use	a	left	mouse
click	to	highlight	it,	use	a	right
mouse	click	to	open	the	submenu.	
At	the	submenu,	select
Properties/Text	which	will	open
this	new	menu	-------->

You	can	edit	your	original	text	in
the	Text	box.		If	you	click	on	the
Font	prompt,	then	you	can	adjust
both	Font	size	and	Font	type	in	the
next	pop-up	window	.

Font	Color	can	be	changed	in	the
Color	box.

Remember	to	hit	the	Apply	button
to	have	these	changes	reflected	in
your	layout

Using	the	Group	/	Ungroup	feature

There	will	be	situations	where	an
industry	image	you		want	to	use,

Basic	feed	mill	was	created	using	rectangles	and	circle	and
using	the	Group	feature	to	bind	them	together

For	the	spot	where	we	want	this	feed	mill	at	Jamestown,
we	need	to	Flip	it	Horizontally	first,	the	use	the	UnGroup	to
get	at	the	main	subcomponents



but	does	not	fit	the	space	on	the
layout.		Don’t	despair	just	re-
configure	it.	Here's	how	you	will	do
that:

First,	from	the	Scenery	toolbar,
then	use	a	left	mouse	click	with
the	Scenery	Select	tool	to	activate
the	control	points	for	your	image

If	you	need	to	change	something
within	this	group,	just	click	on	it
and	select	the	Ungroup	feature	to
break	the	group	back	into	its
original	smaller	pieces

Study	the	images	on	the	right	to
see	the	various	steps	to	use.

We	then	use	the	Scenery	Cursor	to	grab	the
subcomponents	we	want	to	Group	and	re-position.

Finally,	we	drop	it	into	place,	Group	the	new	Image	again
and	resize	it	by	grabbing	a	control	point	to	reduce	its	size	a
bit.		Done!

Using	the	Send	to	Back	and	Bring	to
Front	Features

There	will	be	times	when	you	will
place	a	factory	too	close	to	some
vegetation	and	it	will	look	wrong.	
You	can	either	choose	to	move
your	trees!!



Or,	you	can	use	these	features	to
change	the	appearance.		Here’s	a
step	by	step	approach.

You	decide	which	looks	best	to
you!

NOTE:

If	the	building	image	is	in	the
Background	layer,	then	you	must
move	your	tree	image(s)	to	the
same	level	IF	you	want	the	shed
roof	higher	than	the	tree	line

Normally	any	images	located	in
the	Foreground	layer	will	cover	all
or	parts	of	any	image	on	the
Background	layer

Here,	the	tree	towers	over	the	pump	shed.		We	want	the
shed	to	be	taller	than	the	tree,	so	we	Ungroup	the	main
feed	mill	image	then	select	the	Shed	and	silo	sub
assembly.		From	the	Scenery	toolbar,	we	select	the	Bring
Forward	feature	and	click	on	it	until	the	shed	roof	is	clearly
above	the	tree

Add	more	scenery	items,	trains	and
enjoy!

Use	Train\	New	Train	to	create	a
train	on	your	layout.		You're	ready
to	begin	operating.

	

	 	

Only	your	imagination	will	limit	the	layout	designs	you	can	now	create	with	TrainPlayer
Scenery	Toolkit!

Look	under	the	Layouts	/	Demo	to	see	and	operate	the	final	version	of	Jamestown.



Scenery	UI	Devices

The	Scenery	Toolkit	involves	a	lot	of	moving	parts.		Here	is	an	illustrated	guide.		Many	are	not
available	without	a	TrackLayer	license.

Scenery	Toolbar

The	Scenery	Toolbar	is	brought	up	by	clicking	Scn	Tools	on	the	Build
Toolbar	=>

Note	that	the	Edit	Scn	button	is	duplicated	on	the	Build	Toolbar.		This	is	for	ease	of	developing
a	layout,	when	working	on	scenery	and	track	at	the	same	time.

Below	is	a	quick	reference	to	the	tools.		For	detailed	instructions	on	how	to	use	them,	see
chapters	Drawing	Scenery	and	Editing	Scenery.

Foregr	Layer to	select	the	foreground	as	the	active	layer	for	drawing	and	editing.	In	this
mode,	background	objects	cannot	be	selected	or	modified.

Backgr	Layer to	select	the	background	as	the	active	layer.	In	this	mode,	foreground
objects	are	hidden	altogether.

Edit	Scn
to	select	and	edit	objects.		Click,	shift-click,	or	press	and	drag	to	select,
unselect,	move,	resize,	or	reshape	objects.		Ctrl-drag	to	duplicate	objects.	
For	details	see	Selecting	Objects.		(Button	is	hidden	by	default	--	use	Add
or	Remove	Buttons.)

Line/Polygon
to	create	a	line,	polyline,	or	polygon.		To	create	a	line	segment,	press	and
drag.		For	a	polyline,	start	or	end	at	an	existing	endpoint	(where	cursor
changes	to	+).		For	a	polygon,	draw	a	polyline	with	a	segment	which	closes
the	figure	(or	use	Close	Polygon	from	the	context	menu).

Rectangle to	create	a	rectangle	object.		Press	to	locate	one	corner,	drag	to	adjust	the
opposite	corner.		Press	Shift	to	restrict	shape	to	square.

Ellipse
to	create	a	circle	or	ellipse.		Press	to	locate	the	center,	drag	to	adjust	the
radius;	press	Shift	while	dragging	to	move	the	center.		For	an	ellipse,
create	a	circle,	then	adjust	the	shape	by	selecting	and	dragging	a	corner.

Text to	create	a	text-only	object.		Drag	a	rectangle	to	indicate	the	location,	then
enter	the	text	when	prompted.

Painter
to	apply	a	chosen	style	to	an	object.		Click	to	activate	the	tool,	then	press
Shift	(cursor	becomes	a	dropper)	to	pick	up	the	color	or	object	style	at	the
cursor,	release	Shift	to	retain	the	style.		Then	click	selected	object(s)	to
apply	that	style.	For	more,	see	Dropper	and	Painter	below.

Arrange Click	to	bring	up	Arrange	subtoolbar	below.



Scenery	Grid to	show	or	hide	the	scenery	drawing	grid.		Snap	is	in	effect	whenever	the
grid	is	on.		To	adjust	grid	properties,	use	File	>	Preferences	>	Scenery.

Scn	Chooser to	bring	up	the	Scenery	Chooser,	for	browsing,	downloading,	and
introducing	scenery	objects	onto	the	layout.

Scn	Styles to	bring	up	Scenery	Styles,	for	setting	default		styles.

		Arrange	subtoolbar	

The	Arrange	Toolbar	is	brought	up	by	clicking	Arrange	on	the	Scenery	Toolbar.		It	applies	to
selected	scenery	objects;	buttons	are	dimmed	if	there	is	no	selection	or	if	the	button	would
have	no	effect.

Bring	Forward to	move	the	selected	object(s)	forward	in	the	display	order,	toward	the	front.
Send	Backward to	move	selected	objects	toward	the	back.
Bring	to	Front to	bring	selected	objects	to	the	front.
Send	to	Back to	move	selected	objects	to	the	back
Group to	group	selected	objects.	Dimmed	unless	multiple	objects	are	selected.

Ungroup to	ungroup	a	grouped	object,	reverting	it	back	into	its	original	components.
Dimmed	unless	at	least	one	grouped	object	is	selected.

Scenery	Context	Menu

Right-click	a	scenery	object	and	you	get	this	context	menu	=>

If	the	right-clicked	object	is	one	of	multiple	selected	objects,	then	the
chosen	command	will	generally	apply	to	all	of	them.		Where	the
description	below	says	"object"	it	means	"all	selected	objects."		

Load	Bitmap... Browse	for	an	image	and	set	as
background	fill	for	the	object 1

Cut,	Copy,	Delete Standard	editing	commands	over	the
selection 2

Select	All Select	all	scenery	objects	in	the	active
layer 	

Flip	Horizontal,	Vertical Invert	object	across	vertical	or	horizontal
axis 	

Style	> 	 10



					Copy Copy	style	of	touched	object	to	internal
clipboard

	

					Paste Paste	previously-copied	style	to	selected
object(s) 	

					Use	As	Default Set	default	fill	and	line	styles	to	match
selected	object 	

Smoothing	> Submenu	(for	polylines	and	polygons
only) 3

						Smooth	This	Vertex Smooth	or	unsmooth	the	right-clicked
vertex 4

						Smooth	All Smooth	at	all	vertices 	
						Unsmooth	All Unsmooth	at	all	vertices 	

						Auto-Smooth Smooth	each	vertex	while	drawing
polyline 5

Save	to	Scn	File... Save	selected	object(s)	to	scn	file 6

Properties... Bring	up	Scenery	Properties	dialog	to
edit	object(s) 	

Convert	to	Transfer
Table

Rectangle	only:	replace	object	with	a
transfer	table 7

Convert	to	Polygon Rectangle	only:	replace	with	a	closed
four-sided	polygon 8

Delete	Polygon	Segment Polyline/polygon	only:	delete	the	right-clicked	segment 9

Close	Polygon Polyline	only:	connect	first	point	with	last
to	form	closed	polygon 	

Start,	Stop	Animation Animated	object	only:	start	or	end
animating	action 	

Notes

1.		Load	Bitmap	is	a	shortcut	for	bringing	up	the	object	properties	dialog,	setting	the
background	type	to	Bitmap,	and	browsing	for	an	image	file.		It	calls	up	the	Scenery	Chooser	in
image	mode,	showing	image	files	only,	no	SCNs.

2.		These	commands	are	also	available	on	the	main	Edit	menu.		Scenery	objects	can	be	copied
from	one	layout	and	pasted	into	another.

3.		The	Smoothing	submenu	appears	only	for	a	polyline	or	polygon	object.		It	affects	vertex
points	(points	shared	between	pairs	of	segments);	a	smoothed	vertex	has	a	curve	fitted
automatically	between	the	two	segments.		For	more,	see	Polygons.

4.		Smooth	This	Vertex	requires	that	the	polygon	be	in	"point	editing	mode,"	where	vertex
points	are	highlighted	instead	of	the	standard	drag	handles;	see	Polygons.

5.		Auto-Smooth	means	that	smoothing	is	applied	whenever	you	draw	two	segments	sharing



an	endpoint.		When	auto-smooth	is	in	effect,	you	see	a	red
construction	arc	as	you	draw	each	segment,	as	shown	here.

6.		When	you	save	selected	objects	to	a	scn	file,	they	become	a
single	unit	you	can	later	drag	onto	a	layout.		You	are	prompted
for	output	filename.		If	you	save	the	file	in	any	folder	under	TP
Scenery,	then	the	new	object	will	show	up	in	that	folder	in	the	Scenery	Chooser.		For	more,	see
SCN	Objects.

7.		Convert	to	Transfer	Table	is	the	way	to	create	a	turntable-like	device	in	a	rectangular
space.		See	Transfer	Tables.

8.		Convert	to	Polygon	creates	a	closed	polygon	in	place	of	a	rectangle.		You	might	do	this	is
to	create	a	trapezoid	or	other	four-sided	figure:	start	with	a	rectangular	polygon	and	adjust
corners.

9.		Delete	Polygon	Segment	removes	a	single	segment	from	a	polyline	or	polygon.		In	the
latter	case,	the	polygon	becomes	unclosed	and	unfilled.

10.		The	Style	submenu	copies	style	information.		Copy	puts	both	fill	and	line	styles	of	the
selected	object	onto	an	internal	clipboard;	Paste	copies	the	styles	from	the	clipboard	to
selected	object(s)	on	this	or	another	layout	(dimmed	if	no	Copy	has	been	performed).		Use	As
Default	changes	the	default	styles	to	match	the	selection	(dimmed	when	the	selection	style
already	matches	the	default).

		Scenery	Chooser

The	Scenery	Chooser	presents	a	gallery	of	scenery	objects	you	can	use	on	your	layout.	
Browse	through	the	new	High-Quality	set	on	your	local	drive	or	through	the	much	larger
collection	on	the	web,	find	the	one	you	want,	and	just	drag	it	into	your	layout.		For	details,	see
Choosing	Scenery.



Scenery	Properties

When	you	right-click	an	object	and	choose	Properties,	it	brings	up	the	Scenery	Properties
dialog,	where	you	can	view	and	edit	the	attributes	of	the	object.		If	there	are	multiple	objects
selected,	you	edit	their	common	attributes	all	at	once.		The	dialog	has	four	tabs,	each
described	on	its	own	page:	General,	Background,	Line,	Text.

The	Scenery	Properties	dialog	is	modeless	--	it	does	not	have	to	be	taken	down	while	you	work



on	the	layout.		If	you	change	properties	in	the	dialog	and	click	OK,	changes	are	immediately
applied	to	the	selected	scenery	on	the	layout.		If	you	modify	the	selected	scenery	on	the	layout,
changes	are	reflected	in	the	dialog.

		Scenery	Styles

The	Scenery	Styles	dialog	is	used	for	setting	default	styles	--	those	which	are	applied
automatically	to	newly-created	objects,	or	applied	manually	by	using	the	Painter	tool.	

This	dialog	has	three	tabs,	so	similar	to	the	tabs	in	Properties	that	they	are	documented	on	the
same	pages:	see	Background,	Line,	Text.

The	Scenery	Styles	dialog	is	modal	--	you	must	click	OK	or	Cancel	before	you	can	go	back	to
working	on	the	layout.		The	Defaults	button	resets	the	current	tab	back	to	factory	default
values.		Changes	you	make	in	Scenery	Styles	do	not	cause	any	visible	change	on	the	layout	or
to	selected	scenery	objects.

	To	bring	up	Scenery	Styles,	click	the	Scn	Styles	button	on	the	Scenery	Toolbar.

		Scenery	Grid	



The	Scenery	Grid	is	an	aid	in	drawing	and	constructing	precise	scenery
shapes.		It	is	a	grid	of	dots.		When	the	grid	is	on	(visible),	most	mouse
movements	snap	to	the	dots.		If	you	are	dragging	an	object	or	a	multiple
selection,	it	is	the	top	left	corner	which	snaps	to	the	nearest	dot.

To	show	or	hide	the	grid,	click	Scenery	Grid	on	the	Scenery	Toolbar.	

The	grid	is	visible	only	when	you	are	using	one	of	the	scenery	tools.	
When	you	change	to	a	track	or	run	tool,	the	scenery	grid	goes	down,	but
its	visibility	is	remembered	--	the	next	time	you	activate	a	scenery	tool	on	this	layout,	the	grid
becomes	visible	if	you	left	it	that	way.

The	size,	spacing,	and	color	of	grid	dots	can	be	modified;	see	Scenery	Preferences.

		Scenery	Painter	and	Dropper

The	dual-function	Painter/Dropper	tool	provides	a	quick	way	to	change	styles	and	colors	of
scenery	objects.		This	feature	was	introduced	in	Version	6,	then	reworked	and	improved	in
8.2.			Here's	how	to	use	this	tool:

1.	 Click	the	Painter	button	to	activate	the	tool.		The	button	is	redrawn	showing	a	color
swatch	=>
and	the	status	bar	shows	this	hint:						

2.	 Press	and	hold	the	Shift	key	and	move	the	cursor	around	the	screen.
The	cursor	changes	to	the	eye-dropper	 and	the	swatch	changes	as	you	move.		When
the	cursor	is	over	a	scenery	object,	the	dropper	picks	up	the	fill	and	line	styles	of	the
object;	otherwise,	it	picks	up	whatever	color	is	under	the	cursor.		The	swatch	changes
accordingly.

3.	 When	the	you	see	what	you	want,	release	the	Shift	key.		This	captures	the	style	or	color,
and	reverts	the	cursor.

4.	 Point	to	a	scenery	object	to	be	restyled.		The	cursor	changes	to	a	paint	can	 .

5.	 Click	to	apply	the	captured	style	or	color	to	the	object.

If	the	dropper	was	loaded	from	another	object,	the	entire	style	is	applied,	including
background	fill,	line	style,	and	line	width.		If	it	was	loaded	with	a	color	only,	then	only	the
background	of	the	target	object	is	changed	--	it	is	set	to	solid	fill	of	the	loaded	color.

Notes:

If	multiple	scenery	objects	are	selected,	clicking	any	of	them	with	the	Painter	tool	will	apply
the	style	to	all	at	once.	



If	the	target	object	is	a	grouped	object,	the	style	is	applied	only	to	the	clicked	component.	

All	Painter	restylings	are	undoable.

If	the	dropper	is	active	and	you	are	positioned	over	a	line	or	polyline	scenery	object,
then	only	the	line	style	is	picked	up,	not	the	background	fill	--	indicated	by	a	hollow
swatch	=>
When	such	a	style	is	applied	to	another	object,	only	the	line	style	of	the	target	object	is
changed.



Choosing	Scenery

TrainPlayer	offers	a	large	and	growing	collection	of	scenery	objects	of	all	types	--	buildings,
trees,	factories,	streets,	vehicles,	background	patterns,	industrial	complexes	--	a	regular
Walthers	catalog	of	goods	you	can	add	to	your	layout.		A	subset	of	these	is	delivered	to	your
disk	when	you	install	the	program.		Many	more	are	available	on	the	web,	easily	downloaded
with	a	few	clicks.

About	the	Scenery	Chooser

Like	the	other	Chooser	dialogs,	the	Scenery	Chooser	is	a	resizable,	three-panel	dialog	with	a
tree	on	the	left,	a	list	in	the	middle,	and	a	preview	panel	on	the	right.		There	are	two	tabs,	one
for	local	scenery	(stored	on	your	disk),	the	other	for	scenery	on	the	web.		See	also	Scenery
Chooser.

The	Scenery	Chooser	is	modeless,	so	you	can	work	on	the	layout	without	taking	it	down.		It
offers	an	easy	drag-and-drop	mechanism	for	adding	scenery	objects	to	the	layout.		Navigate
through	the	collections	using	the	tree,	find	what	you	want,	drag	it	onto	the	layout,	and	adjust	its
size	and	location	to	suit.

To	call	up	the	Scenery	Chooser:	click	the	last	tool	in	the	Scenery	Toolbar	--	 	--	or	use	the	menu
command	Tools	>	Scenery	>	View	Scenery	Chooser.

Using	the	Chooser

To	add	scenery	to	your	layout:

1.		Select	the	layer	you	want	to	work	in,	using	Edit	Foreground	 	or	Edit	Background	 .	
Added	objects	will	go	in	this	layer.

2.		Click	the	Scenery	Chooser	tool	 ,	or	select	Tools	>	Scenery	>	View	Scenery
Chooser	from	the	menu.		This	brings	up	the	Scenery	Chooser:



3.		Click	a	folder	in	the	tree	to	see	its	contents	in	the	middle	pane.

4.		Point	to	the	object	you	want,	press	the	mouse	button,	drag	to	a
location	on	the	layout,	then	release.		The	object	appears	on	the	layout,
possibly	somewhat	resized.

5.		Click	the	object	to	select	it,	so	it	shows	"drag	handles"	on	the	sides
and	corners,	as	shown	here:

To	move	the	object,	press	and	drag	by	the	middle.		To	resize,	drag	one
of	the	handles.		To	rotate,	drag	by	the	handle	at	the	upper	right.		For	more	information,	see
Editing	Scenery.

6.		Repeat	steps	2-5	to	add	more	objects.		When	you	are	finished,	click	Done.

To	add	a	single	scenery	object:

The	drag-and-drop	method	above	works	no	matter	how	many	objects	you	are	adding,	but	if	you
only	want	to	add	one	object,	there	is	an	alternative	method:

Click	to	select	an	object	in	the	middle	pane,	then	click	OK.		The	object	is	deposited	in	the
middle	of	the	layout	window,	and	the	dialog	is	taken	down.

Note:	once	you	have	dragged	an	object	from	the	dialog,	the	OK	button	changes	to	say
"Done"	and	will	not	add	an	object	when	clicked.

What	you	are	creating	on	the	layout	is	a	rectangular	object	with	a	bitmap	fill.		You	could	get	the
same	result	by	creating	a	rectangle	object	and	editing	its	properties.

Downloading	Scenery	from	the	Web

To	see	the	scenery	objects	available	on	the	TrainPlayer	web	site,	click	the	Web	tab.		For
details,	see	Scenery	Web	Chooser.



Objects	you	see	in	these	folders	must	be	installed	to	your	disk	before	you	can	add	them	to	your
layout.		Here's	how:

1.		Click	a	folder	in	the	tree	to	see	its	contents	in	the	middle	pane.		This	may	take	a	minute
--	the	program	has	to	download	the	folder	into	a	temporary	directory	before	it	can	display
the	images.

2.		When	you	find	the	object	or	set	you	want,	click	Install.		This	copies	the	downloaded
files	into	your	Scenery	folder.		It	then	switches	back	to	the	Local	tab	and	selects	the
installed	folder,	so	you	are	ready	to	add	objects	as	described	previously.



Drawing	Scenery

If	you	are	building	a	layout	on	a	plywood	sheet,	you	can	use	the	Scenery	Chooser	to	plop	a	few
buildings	and	trees	on	it	and	you're	set.		But	the	more	serious	layout	will	require	ground	cover,
water,	roads,	and	other	fanciness	which	can	only	be	constructed	by	drawing.		This	section
describes	how	to	draw	your	own	scenery	objects.

Drawing	New	Scenery	Objects

The	general	procedure	for	drawing	a	new	scenery	object	is	as	follows:

1.	 Select	a	layer.		Choose	one:

	Edit	Foreground	Layer	to	create	smaller	objects	in	the	foreground.	
	Edit	Background	Layer	to	create	larger	shapes	behind	the	foreground	objects.

The	layer	you	choose	becomes	the	active	layer,	where	new	objects	will	go.		When	the
foreground	layer	is	active,	background	objects	cannot	be	selected	or	modified;	when	the
background	layer	is	active,	foreground	objects	are	not	displayed	at	all	(but	can	be	made
visible	using	the	View	Options	toolbar).

2.	 Select	a	drawing	tool.		Choose	one:

	Rectangle	to	create	a	rectangular	or	square	object.
	Ellipse	to	create	a	circle	or	ellipse.
	Line/Polygon	to	create	a	line,	a	polyline	(chain	of	line	segments),	or	a	polygon.
	Text	to	create	a	plain	text	label.

3.	 Press	and	drag.		Press	the	left	mouse	button	where	you	want	one	end	or	corner	of	the
object;	drag	and	release	where	you	want	the	opposite	end	or	corner.

If	you	are	using	the	Ellipse	tool,	you	will	be	dragging	a	circle.		Press	the	Shift	key	as
you	drag	if	you	want	to	move	instead	of	resize	the	circle.		To	create	an	ellipse,	you
first	draw	a	circle,	then	adjust	as	described	below.
If	you	are	using	the	Line/Polygon	tool,	you	are	dragging	a	line.		To	create	a	polyline
or	polygon,	the	point	where	you	press	to	start	or	release	to	end	must	coincide	with	the
endpoint	of	another	line	--	wait	until	the	cursor	changes	to	a	+	before	pressing.
If	you	are	using	one	of	the	other	tools,	you	are	dragging	a	rectangle.
If	you	are	using	the	Rectangle	tool,	press	the	Shift	key	while	dragging	to	constrain	the	shape	to
a	square.

4.	 Enter	data	if	prompted.

If	you	are	using	the	Text	tool,	you	are	prompted	to	enter	a	line	of	text.



5.	 Adjust	the	object.		Click	somewhere	in	the	interior	of
the	object	to	select	it,	so	it	shows	"drag	handles"	on
the	sides	and	corners	as	shown	at	right,	then:

Move:		point	to	the	interior	of	the	object	(cursor
changes	to	four-headed	arrow),	press	and	drag	to
move	the	object.
Resize:	point	to	any	drag	handle	except	the	upper
right	(cursor	changes	to	a	double-headed	arrow),
press	and	drag	to	move	that	side	or	corner.		Hold
down	Shift	as	you	drag	to	resize	the	object	without
changing	its	proportions.
Rotate:	point	to	the	upper	right	handle	(cursor
changes	to	a	circle),	press	and	drag	to	rotate	the	object.

6.	 Set	properties.		To	change	the	attributes	of	the	object	--	color,	style,	fill,	text,	etc.	--	point
to	it,	press	the	right	mouse	button,	and	select	Properties	from	the	context	menu	(as
shown	above).		This	brings	up	the	Scenery	Properties	dialog,	described	in	detail	under
Editing	Scenery.

The	style	you	see	before	editing	properties	is	the	default	style	for	the	line,	fill,	and	text.		If
you	want	the	object	to	come	up	with	a	different	style,	edit	the	defaults	in	the	Scenery
Styles	dialog.

Drawing	Polygons

For	most	objects,	a	single	press-and-drag	operation	creates	the	object.		For	polylines	and
polygons,	a	further	steps	are	required,	as	follows:

1.	 Choose	the	Line/Polygon	tool	 .
2.	 Press	and	drag	to	create	a	line	segment.
3.	 With	the	cursor	still	positioned	at	the	end	of	the	first	segment	(cursor	changes	to	+),	press

and	drag	to	create	another	segment.		Since	the	two	segments	share	an	endpoint,	they	are
automatically	fused	to	create	a	single	two-segment	polyline	object.

4.	 Repeat	step	3	to	extend	the	polyline.
5.	 Finally,	for	a	closed	polygon,	draw	a	segment	connecting	the	two	free	ends	of	the	polyline,

forming	a	closed	figure.		The	resulting	polygon	is	automatically	filled	with	the	default
background	color.

As	a	shortcut	for	step	5,	you	can	right-press	on	any	segment	and	choose	Close	Polygon.		This
automatically	adds	the	closing	segment.

It	does	not	matter	in	which	order	or	direction	you	draw	each	segment	--	as	long	as	one	end	or
the	other	coincides	with	the	endpoint	of	another	segment,	they	will	join.

Another	shortcut	for	creating	a	polygon:	create	a	rectangle	with	the	Rectangle	tool,	then	right-press	and
choose	Convert	to	Polygon.		This	results	in	a	four-sided	polygon.



Two	editing	modes.		When	you	select	a	polyline	or	polygon	object,	its	drag	handles	are	on	the
rectangular	space	around	it.		Dragging	by	these	handles	changes	the	overall	size	and	shape	of
the	figure.		To	adjust	the	position	of	a	single	vertex	point,	click	a	second	time	on	the	object	and
change	from	normal	editing	mode	to	Point	Editing	Mode;	drag	handles	now	appear	on	the
vertex	points,	and	can	be	used	to	move	those	points	individually.	

			 Click	repeatedly	to	toggle	between	these	two	editing
modes.

Drawing	Polygons	Using	Track	Tools	(Track	To	Scenery)

An	alternative	method	of	creating	a	polyline	or	polygon	allows	you	to	create	shapes	containing	straight
line	segments	and	circular	arcs,	using	the	track	drawing	tools.		This	feature	is	convenient	for	creating
custom	benchwork	shapes.		To	create	scenery	using	this	method:

1.	 Using	the	Straight	Track	and	other	track	tools,	draw	track	in	the	desired	shape.
2.	 Select	all	the	track	to	be	converted;	use	shift-click	to	add	or	subtract	from	the	selection	as

needed.		When	the	whole	set	is	selected,	right-click	any	selected	section	and	choose
Track	To	Scenery.

The	program	converts	the	selected	track	to	one	or	more	polyline	scenery	objects	in	default
style.		If	the	track	forms	a	closed	figure	(as	shown	in	the	picture)	then	the	resulting	object	will
be	a	closed,	filled	polygon.		Otherwise,	it	will	be	one	or	more	line	or	polyline	objects.		If	more
than	one	polyline	is	created,	all	created	objects	are	grouped	together	into	a	single	object.

The	new	scenery	is	created	in	the	currently-active	layer.		If	you	want	it	to	be	in	a	particular
layer,	choose	that	layer	in	the	scenery	toolbar	before	doing	the	conversion.

After	the	conversion,	the	Scenery	Edit	tool	will	become	active,	and	the	new	scenery	object(s)
will	be	selected.		You	can	then	drag	them	around,	group	them,	restyle,	etc.		The	original	track
will	be	deleted	unless	there	are	any	cars	or	trains	on	it,	in	which	case	it	will	remain	intact.	

The	operation	can	be	undone	using	Edit	>	Undo.	If	a	grouped	object	was	created,	the	undo
has	two	steps:	first	undoes	the	grouping,	second	undoes	the	track->scenery	conversion.	

Creating	Roadbed	Scenery

Roadbed	is	normally	displayed	as	a	track	drawing	style,	as	described	under	Road	Styles.		An



alternative	is	to	create	a	set	of	scenery	objects	to	fit	underneath	the	track.		To	do	this:

1.	 Select	the	track	section(s)	where	you	want	roadbed.
2.	 Right-click	a	selected	track	section	and	choose	Grow	Roadbed	Scenery.

The	program	generates	polygon	scenery	objects	under	all	selected	track	sections,	overlapped
to	look	like	a	continuous	thick	section	of	roadbed.		Style	and	width	are	taken	from	the	Roadbed
choices	under	File	>	Preferences	>	Road.		The	generated	objects	are	regular	scenery,	so	you
can	change	the	style	of	one	or	many	parts	by	selecting	and	editing	as	described	elsewhere	in
this	chapter.

If	you	create	roadbed	as	scenery	instead	of	drawing	it	as	a	track	style,	it	is	more	flexible	in	that
you	can	have	more	than	one	style	on	a	layout,	and	it	need	not	appear	under	all	the	tracks.		The
disadvantage	is	that	if	you	have	a	lot	of	roadbed,	the	large	number	of	scenery	objects	will	be
cumbersome	and	slow	the	program	down.

Creating	SCN	Objects

A	SCN	object	is	a	scenery	object	made	up	of	other	objects,	as	introduced	in	About	SCN
Objects.		These	are	the	key	to	creating	your	own	structures,	trestles,	athletic	fields,	or
whatever	custom	objects	you	require.		For	plenty	of	examples,	look	in	the	Scenery	Chooser	for
.scn	extensions:

To	create	a	SCN	object:

1.	 Use	the	scenery	tools	to	create	your	object,	assembling	and	decorating	the	necessary
shapes,	polygons,	text,	etc.

2.	 Select	the	entire	assembly	and	join	it	into	a	single	grouped	object.
3.	 Right-click	the	grouped	object	and	choose	Save	to	Scn	File.		This	opens	to	the	Scenery

folder,	the	recommended	location	for	saving.
4.	 Give	the	object	a	useful	name	and	click	OK	to	save	it.		Thereafter	it	will	appear	in	your

Scenery	chooser.

Scenery	Convenience	Tools



The	Text	tool	 	creates	a	rectangle	object	with	a	text	string,	no	fill	and	no	border	line.		On
dragging	to	create	a	new	object,	you	are	prompted	to	enter	the	text	string.		Note	that	the
overall	size	of	the	object	is	the	rectangle	you	define	by	drawing;	it	is	not	automatically
adjusted	to	fit	the	text.
The	Scenery	Chooser	 	allows	you	to	drag	in	pre-defined	objects.		These	are	rectangle
objects	with	image	fill,	marked	as	stretch-without-distortion.		The	object	size	is
automatically	adjusted	to	fit	the	image.		See	Choosing	Scenery.

Text	Labelling

When	you	have	completed	placing	scenery	around	your	layout,	you	may	want	to	go	back	and
add	place	names,	track	directions	or	even	building	names	to	your	layout.		For	individual	objects,
you	can	add	a	text	label	via	the	Text	tab	of	Scenery	Properties.		For	other	situations,	you	may
want	a	text	box	separate	from	any	specific	object.		For	example:

																						

To	create	a	label,	select	the	Text	tool	 .		Press	and	drag	a	box	in	the	area	where	you	want	to
place	your	text.		When	you	release	the	button,	a	prompt	dialog	appears:

Enter	the	text	and	click	OK.		The	label	appears	on	the	layout.

Click	on	the	text	to	select	the	object,	so	you	can	reposition,	rotate,	or	adjust	properties	of	the
label.		Note	that	the	font	size	rescales	as	you	zoom	the	layout,	but	not	when	you	resize	the	text
scenery	box.





Editing	Scenery

Drawing	or	choosing	scenery	is	the	equivalent	of	taking	a	pre-built	structure	out	of	the	box.	
Editing	is	the	rest	of	the	job	--	placing	it	where	you	want,	making	it	the	right	size	and	shape,
painting,	labelling,	and	adding	trim.		This	section	describes	how	to	edit	scenery	objects,
whether	drawn	by	hand	or	dragged	in	from	the	chooser.

About	Editing	Scenery

Most	editing	is	done	using	Scenery	Select	tool,	the	green	arrow	 	at	the	end	of	the	toolbar.		With
this	tool	active,	you	can	click	on	any	type	of	scenery	object	to	select	or	modify	it.		As	a
convenience,	you	can	edit	some	objects	when	using	other	tools:		when	using	the	Rectangle	tool,
you	can	edit	rectangle	objects;	the	Ellipse	tool	can	edit	ellipses;	and	the	Line/Polygon	tool	can
edit	linear	or	polygon	objects.

Selecting	Objects

Before	you	can	work	with	a	scenery	object,	you	must	select	it.		A	selected
object	is	drawn	with	"drag	handles,"	as	shown	at	right	--	one	on	each	corner,
and	one	in	the	midpoint	of	each	edge.	

To	select	a	single	object:		click	anywhere	in	the	interior	of	the	object.	
To	unselect,	click	outside	the	object.
To	select	multiple	objects:		(a)	hold	the	Shift	key	down	while	clicking	to	select	an	object.	
This	will	add	the	object	to	the	selection,	or	remove	it	if	it	is	already	selected;	or	(b)	use	the
Scenery	Select	tool	 	and	drag	a	rectangle	around	the	objects	you	want	to	select.		Press
Shift	to	add	the	surrounded	objects	to	the	selection.

Standard	Editing	Operations

As	with	just	about	any	selection	in	any	Windows	program:

To	delete	selected	object(s):	choose	Edit	Clear	from	the	main	menu,	or	press	Del.
To	copy	selected	object(s)	to	the	Clipboard:	choose	Edit	Copy	from	the	main	menu;	or
right-click	a	selected	object	and	choose	Copy;	or	press	Ctrl-C.		A	copy	of	the	selected
object(s)	is	made	on	the	Windows	Clipboard.		If	you	choose	Cut	(Ctrl-X)	instead	of	Copy,
the	objects	are	copied	and	then	deleted.
To	paste	objects	from	the	Clipboard:	choose	Edit	Paste,	or	press	Ctrl-V.		Objects
previously	copied	to	the	Clipboard	are	deposited	at	the	upper	left	of	the	screen,	selected
and	ready	to	move	into	position.
To	undo	an	editing	operation:	after	any	move,	resize,	rotation,	property	change,	or	other



modification	of	selected	objects,	choose	Edit	Undo	or	press	Ctrl-Z	to	revert	back	to	the
state	before	the	change.
To	redo	an	undone	operation:	after	an	Undo,	choose	Edit	Redo	or	press	Ctrl-Y	to	undo
the	undo	and	revert	back	to	the	changed	state.

Moving	and	Resizing

Once	one	or	more	objects	is	selected:

To	move	the	selected	object(s):	press	the	interior	of	any	selected	object	(the	cursor
changes	to	a	four-headed	arrow)	and	drag.		All	selected	objects	will	move	simultaneously.
To	resize	a	single	object:	press	a	drag	handle	on	any	side	or	corner	(cursor	changes	to	a
two-headed	arrow)	and	drag.		The	side	or	corner	will	move	relative	to	the	rest	of	the
object.		Note:	this	does	not	work	if	you	are	pointing	to	the	upper	right	corner	--	that	one
does	rotation,	described	below.		Note	that	the	orientation	of	the	two-headed	cursor	may
not	be	correct	if	the	object	has	been	rotated.
To	resize	multiple	objects:	if	you	want	to	change	the	size	or	shape	of	several	objects	at
once,	you	must	first	group	them,	as	described	below.

Rotating

If	an	object	is	selected:

To	rotate	the	selected	object:	point	to	the	upper	right	corner	of	the
object	(cursor	changes	to	a	circle)	and	drag.		The	object	will	rotate
around	its	center.		(Once	the	object	has	been	rotated,	these	instructions	may	not	be	strictly
correct,	because	the	draggable	corner	may	no	longer	be	in	the	upper	right.)
To	rotate	several	objects:	the	way	to	rotate	more	than	one	object	at	a	time	is	to	group
them,	as	described	below.		A	grouped	object	can	be	rotated	the	same	way	as	any	other
single	object.		The	picture	above	shows	rotating	a	grouped	object.

An	alternative	way	of	rotating	an	object	is	to	type	an	angle	into	the	properties	dialog;	see
Editing	Properties	below.

Flipping

If	you	find	a	right-handed	widget	in	the	scenery	catalog,	but	you	need	a	left-handed	one,	you	can	flip	it.

1.	Use	the	Scenery	Edit	tool.

2.	Right-click	an	object	and	choose	Flip	Horizontal	or	Flip	Vertical.



The	object	is	inverted	across	the	appropriate	axis.	If	multiple	objects	are	selected,	each	flips	on	its	own
individual	axis,	but	if	they	are	grouped,	the	flip	is	on	the	group's	axis.	Flipping	an	object	with	a	non-zero
angle	of	rotation	will	change	its	rotation	angle.	The	operation	is	reversible	with	Edit	>	Undo/Redo.	If	the
object	has	a	bitmap	image,	the	image	is	flipped	in	memory,	without	modifying	the	image	file.

Grouping	and	Ungrouping

Some	operations,	such	as	moving	or	setting	properties,	work	on	several	selected	objects	at
once.		Other	operations,	such	as	resizing	or	rotating,	work	only	on	a	single	object.		Grouping	is
a	way	of	turning	several	objects	into	a	single	one,	so	the	latter	type	of	operation	can	be
performed	on	the	group.

To	group	two	or	more	objects:	select	at	least	two	objects	by	shift-clicking	or	using	the
Scenery	Edit	tool,	then	click	Group	 .		The	selected	objects	become	a	single	grouped
object,	with	a	single	set	of	drag	handles,	which	can	be	manipulated	the	same	way	as	any
other	single	object.		Note	that	the	Group	tool	is	dimmed	unless	you	have	at	least	two
objects	selected.
To	ungroup	a	grouped	object:	select	at	least	one	grouped	object,	then	click	Ungroup	
.		The	grouped	object	reverts	to	a	set	of	individual	objects.

Grouping	can	go	more	than	one	level	deep,	that	is,	a	grouped	object	may	contain	other
grouped	objects.		In	this	case	you	have	to	ungroup	more	than	once	to	go	all	the	way	back	to
the	initial	separate	objects.

Changing	Display	Order

If	multiple	objects	overlap	on	the	layout,	two	factors	determine	which	one	appears	in	front:	(a)
all	objects	in	the	background	layer	are	behind	all	objects	in	the	foreground,	and	(b)	within	a
layer,	objects	are	drawn	based	on	their	semi-arbitrary	positions	in	a	list.		This	order	may	be
changed	using	special	editing	commands:

To	move	an	obscured	object	in	front	of	its	neighbors:	select	the	object	and	choose
Bring	to	Front	 .		This	changes	the	order	of	objects	so	the	selected	one	comes	all	the
way	to	the	front.		Use	Bring	Forward	 	to	bring	the	selected	object(s)	one	step	closer	to



the	front.
To	move	a	front	object	behind	its	neighbors:	select	the	object	and	choose	Send	to
Back	 .		This	moves	the	selected	object	all	the	way	to	the	back.		Use	Send	Backward	
to	go	one	step	backward.

You	can	use	these	commands	on	multiple	selected	objects,	in	which	case	all	of	them	will	be
moved	up	or	down	relative	to	the	unselected	neighbors.

These	features	come	in	handy	when	you're	adding	details	like	sidewalks,	vegetation	etc.	The
images	below	show	a	concrete	driveway	being	added	to	the	scene.		In	the	left	image,	the
driveway	is	on	top.	sending	it	to	the	back	gives	the	image	on	the	right.

																		

Another	way	of	changing	the	display	order	of	objects	is	to	move	them	from	one	layer	to
another.		For	example,	moving	an	object	from	the	foreground	to	the	background	will	cause	it	to
be	drawn	behind	all	foreground	objects.

To	move	an	object	from	one	layer	to	another:	select	the	object	and	cut	it	to	the
clipboard,	using	Edit	Cut	or	Ctrl-X;	activate	the	alternate	layer,	using	the	Background
Layer	 	or	Foreground	Layer	 	tools;	then	paste,	using	Edit	Paste	or	Ctrl-V.
An	alternate	way	of	changing	the	layer	of	a	scenery	object	is	to	use	the	Foreground	checkbox	in
General	Scenery	Properties.

Editing	Scenery	Properties

In	case	you	don't	want	all	your	scenery	objects	to	be	plain
yellow,	you	will	need	to	learn	about	the	Scenery	Properties
dialog.		This	is	a	dialog	with	four	tabs,	used	to	modify	the
properties	of	one	or	more	objects.		Each	tab	has	its	own	help
page,	linked	from	the	Help	button	on	each	tab.		For	general	info,
see	Scenery	Properties;	for	detailed	instructions	on	each	tab,
see:

General	Scenery	Properties
Background	Scenery	Properties



Line	Scenery	Properties
Text	Scenery	Properties

The	easy	way	to	bring	up	the	appropriate	page	is	to	click	the	Help	button	on	the	dialog.

The	Scenery	Properties	dialog	has	a	preview	pane,	showing	a
picture	of	the	selected	object(s)	with	changes	as	they	are	being
applied.		The	changes	do	not	affect	the	objects	on	the	layout	until
you	click	OK	or	Apply.

To	change	the	properties	of	one	or	more	objects:

1.	 Select	the	object(s).
2.	 Right-click	a	selected	object	and	choose	Properties	(as

shown	above).		This	brings	up	the	Scenery	Properties	dialog.
3.	 Change	values	in	the	dialog	as	desired.		Refer	to	the	above	help	pages	for	details.		A

sample	drawing	of	the	object(s)	shows	how	the	changes	will	look.
4.	 Click	Apply	to	apply	the	changes	to	the	selected	object(s)	without	taking	down	the	dialog,

or	OK	to	apply	the	changes	and	dismiss	the	dialog,	or	Cancel	to	dismiss	the	dialog	without
applying	the	changes.

Any	changes	made	in	the	Scenery	Properties	dialog	can	be	undone	using	Edit	Undo.

Setting	Scenery	Styles

There	are	several	ways	to	apply	styles	to	scenery	objects:

Using	the	Scenery	Properties	dialog	as	described	above.		This	is	the	most	complete
method,	giving	access	to	all	the	details	of	all	types	of	style.

Using	the	Painter	tool.		This	is	a	quick	way	to	apply	a	style	to	several	objects	or
components	of	a	grouped	object.		With	this	tool	active,	clicking	on	a	fillable	object	sets	its
fill	style	to	the	default;	clicking	on	a	line	object	sets	its	line	style.

Using	commands	on	the	Scenery	Context
Menu.		These	commands	apply	default	fill	or
line	styles,	or	allow	you	to	redefine	the
defaults	from	the	selected	object.

	



Animated	Scenery

Animated	images	in	TrainPlayer	are	little	movies	you	can	place	around	your	layout.	These	can
be	made	to	play	continuously,	or	on	demand,	or	automatically	whenever	a	train	passes	a	given
spot.	You	can	choose	from	a	supplied	collection	of	animations	(small	but	growing),	or	find	many
more	by	searching	the	web,	or	create	them	in	your	favorite	paint	program.	They	can	be
connected	with	sounds,	so	that,	say,	a	crossing	signal	will	both	move	and	clang	as	the	train
passes	by.

To	see	animations	in	action,	check	out	this	video:	animation	demo

About	Animated	Images

An	animated	image	is	a	new	type	of	scenery	object.	It	can	be	moved,	resized,	rotated,	and
styled	just	like	any	other,	but	it	has	a	special	type	of	background	consisting	of	a	series	of
frames,	each	with	its	own	image	and	duration.	These	are	in	one	of	two	formats:

Animated	gif:	the	well-known	animation	files	you	see	all	over	the	web.		These	can	be	loaded
directly	into	scenery	objects	in	TrainPlayer.

Image	sequence	/	ANM	file:	a	series	of	separate	files	for	each	image,	plus	a	text	file	with
extension	".anm,"	listing	the	frames	and	durations.	The	image	files	may	be	in	any	popular
graphics	format	--	bmp,	png,	jpg,	gif	--	and	the	simple	text	file	can	be	created	by	the	program
or	by	hand.	This	scheme	was	designed	to	make	it	easy	for	users	to	create	their	own
animations.

Because	animated	images	are	tied	to	scenery,	creating	and	manipulating	them	requires
TrackLayer	with	Scenery	Toolkit.		Viewing	and	playing	them	in	an	existing	layout	can	be	done	in
TrainPlayer	[except:	in	the	current	version,	you	cannot	start	or	stop	animation	if	you	don't	have
access	to	the	scenery	toolbar.]

Triggers:		events	which	cause	animations	to	start	and	stop.	We	have	in	mind	a	variety	of	these,
but	for	the	time	being	there	are	only	two:

Station	trigger:	animation	starts	when	the	lead	car	of	a	train	(any	train)	enters	a	given
station,	and	stops	when	the	last	car	leaves.		This	is	the	same	scheme	which	controls
sounds	attached	to	stations,	so	if	you	want	a	sound	to	play	at	the	same	time	the	animation
moves,	use	a	station	trigger	on	the	animation,	and	specify	a	sound	on	the	same	station.

Junction	trigger:		animation	starts	when	the	lead	car	of	a	train	crosses	a	given	junction,
and	ends	when	the	last	car	crosses	it.

Triggers	are	specified	using	the	Scenery	Properties	Animation	tab,	as	described	below.

http://www.trainplayer.com/misc/AnimationDemo/AnimationDemo.html


Adding	Animation	to	Your	Layout

There	are	two	ways	to	add	animated	images	to	your	layout:	from	the	Scenery	Chooser,	or	via
Load	Bitmap.		The	first	is	easier,	the	second	more	flexible.

Using	the	Scenery	Chooser

The	initial	release	of	this	feature	comes	with	a	small	set	of	sample	animations	in	both	gif	and
anm	formats.	More	will	become	available	over	time	in	the	web	scenery	collections.		To	add	one
of	these	to	your	layout:

1.		Bring	up	the	Scenery	Chooser	using	Tools	>	Scenery	>	View	Scenery	Chooser	or	the
button	on	the	scenery	toolbar.

2.		Click	to	open	the	new	animations	folder.	(If	you	don't	see	it,	try	right-clicking	the	Scenery
folder	and	choosing	Refresh.)

3.		Press	an	image	and	drag	onto	the	layout.		That's	it	--	it	starts	playing	immediately.		(To	stop,
use	the	Scenery	Edit	tool,	right-click	and	choose	Stop	Animation.)

Confession:	most	of	the	animations	in	our	sample	set	came	from	the	Microsoft	Office	Online
clip-art	collection.		There	do	not	appear	to	be	restrictions	on	distributing	these,	unless	we
missed	some	fine	print.

Using	Load	Bitmap

The	alternative	to	loading	an	image	from	the	chooser	is	to	create	the	scenery	object	first	and
then	attach	the	image.		The	procedure	is	the	same	as	when	adding	a	non-animated	image,	as
follows:

1.		Select	the	Rectangle	tool	on	the	scenery	toolbar,	and	drag	to	create	a	rectangle	where	you
want	the	animated	image.		By	default	this	gets	a	beige	background.

2.	Select	the	Scenery	Edit	tool	(green	arrow),	right-click	the	new	rectangle	and	choose	Load
Bitmap.		You	get	a	standard	file	dialog.



This	is	the	same	dialog	you	use	for	static	background	images.		It	is	still	used	for	that,	but	now
supports	three	more	types	of	input:

a.	Browse	to	an	anm	file	--	the	program	will	create	an	animated	image.

b.	Browse	to	a	gif	file	--	the	program	will	examine	it	and	decide	whether	to	create	an
animated	or	static	image.

c.	Browse	to	the	first	of	a	series	of	images	--	the	program	will	create	an	animation	and
anm	file	automatically.		This	process	is	described	in	detail	below.

Once	you	successfully	load	an	animated	image,	you	get	an	alert	confirming	the	import	and
reporting	the	number	of	frames.

An	animated	image	created	using	Load	Bitmap	does	not	automatically	start	playing	upon
creation.		To	start	it,	use	the	Scenery	Edit	tool,	right-click	the	image	and	choose	Start
Animation.

Working	with	Animated	Images

Animated	images	work	basically	like	other	scenery	objects.	

To	manipulate:		Use	the	Scenery	Edit	tool	(green	arrow	on	the	scenery
toolbar),	click	to	select	an	image,	then	you	can	move,	resize,	rotate,	and
restyle	it	as	usual.		It	keeps	animating	as	you	move	it	around.

By	default,	an	animated	image	has	its	proportions	locked,	so	resizing	the
image	will	not	distort	it.		To	rotate	an	image,	drag	the	handle	at	its	upper
right.

To	stop	or	start	animation:	select	the	Scenery	Edit	tool,	right-click	the	image	and	choose
Stop	Animation	or	Start	Animation,	as	shown	==>

Once	you	start	an	object	moving,	it	keeps	going	until	you	stop	it,	or	until	a	trigger	event	causes
it	to	stop.		If	you	save	the	layout	while	the	object	is	animating,	it	will	come	back	that	way	the
next	time	you	open	the	layout.

To	set	object	properties:	select,	right-click	and	choose	Properties.		Most	properties	of
standard	scenery	objects	apply	to	animated	ones.

To	trigger	animation	on	train	moves:	see	the	following	section.

Animated	Image	Properties

To	view	or	adjust	properties	of	an	animated	image,	right-click	on	it	(using	the	Scenery	Edit	tool)
and	choose	Properties.		The	Scenery	Properties	dialog	appears,	showing	the	new	Animation
tab.



This	dialog	is	modeless	--	it	remains	up	while	you	work	on	the	layout.		You	can	select	different
objects	on	the	layout	and	adjust	their	properties	one	at	a	time,	or	shift-click	to	select	multiple
objects	and	set	all	their	common	properties	at	once.

Controls	on	the	Animation	tab:

Type:	Animated	gif	file	vs	Image	series/anm	file.		This	is	read-only	--	you	can't	change	the
type	in	this	dialog.

Frames:	number	of	frames	in	the	animation.		Read-only.

Frames	button:		click	to	bring	up	the	Frames	dialog,	showing	filenames	and	durations	in	a
little	grid:

If	the	animation	type	is	anm,	then	you	can	edit	the	values	in	this	grid;	for	animated	gifs,	the
data	is	uneditable	[in	fact,	for	the	time	being,	the	Frames	button	does	nothing	at	all	if	you
are	dealing	with	gif	rather	than	anm].

Times	are	in	milliseconds.		Filenames	can	be	changed	--	they	need	not	be	numbered
sequentially	once	they	have	been	listed	in	an	anm	file	--	but	they	must	exist	and	all	be	in	the
same	folder	as	the	anm	file.

This	dialog	appears	automatically	whenever	you	import	a	sequence	of	image	files.



Playing:		check	or	uncheck	to	start	or	stop	animation.		The	setting	does	not	take	effect
until	the	dialog	comes	down.

Play	once:		check	if	you	want	the	animation	sequence	to	play	once	and	then	stop,	instead
of	repeating	continuously.		This	applies	whether	you	start	the	animation	manually	from	the
context	menu	or	automatically	based	on	a	trigger.

Rewind	after	play:		check	if	you	want	the	image	to	revert	to	its	first	frame	after	every
play.		If	you	do	not	check	this	box,	then	stopping	the	animation	will	freeze	it,	and	starting	it
later	will	pick	up	where	it	left	off.		[Note:	due	to	a	bug	in	the	current	version,	you	may	need
a	View	Refresh	to	update	the	image	so	it	will	go	back	to	its	first	frame.]

Trigger	type	drop-down:		choose	a	trigger	action,	or	None.		At	the	moment	there	are	two
actions	available:	when	a	train	passes	through	a	station,	or	when	it	crosses	a	junction.

Trigger	id	drop-down:		choose	the	station	name	or	junction	id	where	animation	is	to	start
and	stop.		The	drop-down	shows	either	station	names	or	junction	numbers,	depending	on
the	trigger	type	choice.

Preview	window:		shows	a	thumbnail	of	the	selected	image.		For	the	moment,	the
preview	is	static	and	does	not	move,	but	this	may	change	in	a	future	version.

Normally	in	the	Background	tab	of	Scenery	Properties,	you	can	choose	a	different	image	for	a
scenery	object.		However,	what	you	cannot	do	is	change	the	background	from	static	to
animated,	or	vice-versa.		If	you	try	this,	an	alert	tells	you	it	is	not	allowed.

Creating	Your	Own	Animations

If	you	want	to	create	your	own	animations,	one	method	is	to	obtain	a	program	capable	of
making	animated	gifs.		Many	such	programs	are	available	--	Adobe	ImageReady,	CyD	GIF
Studio,	Microsoft	GIF	Animator,	several	shareware	titles	--	but	TrainPlayer	offers	an	easier
way:	create	a	series	of	images,	give	them	suitable	filenames,	and	import	them	with	one	click
into	a	single	object.

A	series	of	images	is	a	set	of	files	in	the	same	folder	with	names	ending	in	underscore,	then
sequential	numbers	starting	with	1;	e.g.,	flagman_1.png,	flagman_2.png,	flagman_3.png.
Using	Load	Bitmap,	if	you	browse	to	a	file	whose	name	ends	with	"_1,"	and	there	are	other
files	with	the	same	name	but	different	numbers,	the	program	will	prompt	and	ask	if	you	wish	to
create	an	animated	image	from	the	series,	like	this:

Click	Yes,	and	the	program	will	create	a	file	with	the	name	of	the	series	and	extension.anm



(e.g.,	flagman.anm),	then	load	it	into	the	scenery	object.

When	you	create	an	animated	image	from	a	series	of	files,	the	Frames	dialog	(shown	above)
comes	up	so	you	can	set	the	frame	timings.		By	default,	all	are	set	to	100	ms.

After	a	successful	load,	an	alert	informs	you	of	the	number	of	frames,	and	the	output	anm
filename	if	applicable:

If	you	create	an	anm	file	from	a	series	of	images,	and	want	it	to	appear	in	your	Scenery
Chooser,	copy	the	anm	file	and	all	the	component	image	files	to	your	Scenery\animation	folder.	
Note	that	the	chooser	will	display	only	the	anm	file,	not	any	of	its	components.

If	you	create	an	animation	sequence	and	want	to	send	it	to	us	or	to	a	friend,	zip	the	entire	set
of	images,	along	with	the	anm	file,	and	send	the	zip.

If	you	have	an	animated	gif,	and	you	want	to	modify	it,	you	will	need	to	split	it	into	separate
frame	files.	TrainPlayer	has	the	ability	to	do	this;	in	fact,	it	does	this	job	whenever	you	read	in
an	animated	gif	--	the	gif	is	split	into	frames,	which	are	saved	in	your	Windows	Temp	directory.	
You	can	capture	these	and	use	them	to	make	your	own	animation	sequence.		For	details,	send
e-mail	and	request	information.



			Modular	Railroading

If	you've	been	to	a	train	show	and	seen	a	miniature	hundred-car	coal	train	winding	along	what	appeared	to
be	miles	of	track,	then	no	doubt	you've	seen	modular	railroading	in	action.		It's	a	way	of	creating	a
huge	layout	in	a	short	time,	often		for	a	temporary	display.		You	get	a	bunch	of	railroaders	to
each	bring	a	section,	then	you	arrange	them	on	the	show	floor	and	hook	them	together	with
sections	of	track,	so	trains	can	run	from	one	end	to	the	other,	or	around	a	giant	loop.	

Modular	Railroading	in	TrainPlayer	provides	tools	for	building	virtual	modules,	arranging	them	in
patterns,	and	automatically	hooking	them	together	so	you	can	test	drive	the	overall	layout.		The	arranging
is	done	by	drag	and	drop,	and	the	hookup	is	a	one-click	operation,	so	it's	easy	to	experiment	with	different
patterns.		TrainPlayer	provides	a	large	library	of	pre-built	modules,	including	all	types	of	corner,
junction,	yard	modules,	scenic	run-throughs,	and	lots	of	interesting	plans	you	can	use	as	the	basis	for	your
own	designs.

The	majority	of	modular	railroading	is	done	in	N	scale,	according	to	standards	from	the	NTRAK	Modular
Railroading	Society,	but	there	are	also	a	growing	number	of	HO	module	clubs	using	similar	standards.	
TrainPlayer	supports	modules	in	any	scale,	and	provides	pre-designed	units	for	both	N	and	HO.

For	a	quick	start,	skip	the	reading	matter	and	try	the	tutorial.

About	Modules

About	Modular	Layouts

Modular	Layout	Tutorial

Building	a	Modular	Layout

Building	a	Module

The	Module	Manager

Module	Manager	Settings

http://www.ntrak.org/


About	Modules

In	principle,	any	layout	can	be	used	as	a	module,	in	the	sense	that	it	can	be	brought	into	the	Module
Manager	and	strung	together	with	others.		However,	this	only	makes	sense	if	the	a	layout	is	constructed	in
such	a	way	that	it	can	hook	to	a	neighbor	for	continuous	running.		We	use	the	term	module	to	refer	to	a
layout	constructed	in	this	way.		In	the	Layout	Chooser,	all	layouts	under	the	Modules	folder	are	in	this
category.

Module	Standards

Every	module	must	have	sections	of	straight	track	ending	at	certain	positions	near	the	layout	edges.		These
positions	are	called	connection	points.	

The	numbers	and	positions	of	connection	points	on	a	module	depend	on	a	scale-specific	body	of
standards,	of	which	there	are	several.		The	most	popular	modules	are	N	scale,	based	on	standards
published	by	the	NTrak	Modular	Railroading	Society.		HO	scale	standards	are	less	universal;	ours	are
based	on	HOTrak	as	published	by	the	Ottawa	Valley	club.		In	TrackLayer,	you	can	build	modules	in	any
scale,	based	on	standards	of	your	own	invention,	but	all	the	layouts	in	the	collections	are	either	NTrak	or
HO.

A	module	is	designed	to	be	oriented	a	certain	way.		The	front	is	the	edge	closest	to	the	viewer;	in	the
diagrams	below	this	is	at	the	bottom.		The	track	closest	to	the	front	is	the	main	line,	which	generally	runs
uninterrupted	around	the	entire	layout.		For	full	details	about	the	the	ordering,	positioning,	and	labelling	of
tracks,	see	Building	a	Module.

Sizes	of	modules	vary	but	are	not	random.		The	typical	NTrak	straight	module	is	2	feet	deep	and	4,	6,	or	8
feet	wide.		The	depth	may	vary	--	an	extension	may	be	added	to	front	or	back	--	but	if	the	widths	were	to
vary,	it	would	become	impossible	to	arrange	a	series	of	modules	into	a	seamless	loop.		And	if	the	width
were	much	bigger	than	8	feet,	you'd	never	get	the	thing	in	the	truck.

Module	Types

Straight Corner Junction

A	straight	module	has	connection	points	on	opposite	edges	of	a	rectangle.		You	can	join	another	module
on	either	side.		The	main	line	is	in	front,	and	generally	goes	straight	across.

A	corner	module	has	connection	points	on	adjacent	sides	of	a	square,	with	curved	track	between.		When
you	join	two	modules	onto	a	corner,	they	form	a	90-degree	angle.		Only	the	outer	tracks	proceed	through	a
corner	module.	

	An	inside	corner	module	is	an	inverted	corner	which	introduces	a	turn	in	the	opposite	direction.		Inside
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corner	modules	are	not	common.

A	junction	module	has	four	sets	of	connection	points	on	three	sides	of	a	rectangle,	in	a	back-to-back
corner	arrangement.		You	can	join	up	to	four	other	modules	to	a	junction	--	one	on	each	side,	two	at	the
top	(i.e.,	with	reference	to	the	above	diagram).		Switches	in	the	track	provide	a	choice	of	travel	directions
for	a	train	going	through	a	junction	--	it	can	go	straight	across	on	the	main	line,	or	make	a	90-degree	turn
into	a	branch,	another	chain	of	modules.		This	picture	shows	a	junction	module	with	all	its	connection
points	hooked	up:

Junction	modules	allow	a	variety	of	show-floor	arrangements.		Without	them,	you	can	set	up	only	chains
and	loops.		Using	junctions,	you	can	create	spidery	patterns	with	multiple	loops	and	chains,	all	connected.

					

Scenic	Modules

Each	module	is	a	TrainPlayer	layout,	so	it	can	be	decorated	in	the	usual	ways:	by	adding	a	bitmap
background,	or	by	adding	scenery	with	the	Scenery	Toolkit.		When	a	module	is	fused	into	a	layout,	any
scenery	objects	it	has	are	carried	along	with	it.		If	it	has	a	bitmap	background,	on	fusing	this	is	converted
to	a	rectangular	scenery	object	the	same	size	as	the	module.

Here	are	some	examples	of	scenic	modules	our	layout	artists	have	designed.		You	can	find	these	and	many
more	in	the	web	layout	collections.



								

									

		



About	Modular	Layouts

Modular	Layout	is	the	term	for	a	layout	built	from	a	series	of	modules	--	fully	assembled,	electrically
connected,	and	ready	to	run.		In	TrainPlayer,	a	modular	layout	is	any	layout	built	using	the	Module
Manager.

Modular	Layout	Features

In	most	ways,	a	modular	layout	is	like	any	other	TrainPlayer	layout.		It	consists	of	a	single	set	of	track,
scenery	objects,	stations,	and	so	on.		However,	it	also	has	some	special	features:

A	set	of	modules.		The	information	supplied	in	the	Module	Manager	is	attached	to	a	modular	layout
and	is	saved	with	it.		This	includes	filenames	of	the	modules	and	their	positional	arrangement.		One
way	you	can	tell	if	you	are	working	with	a	modular	layout	is	to	bring	up	the	Module	Manager	--	if
the	layout	has	module	data,	you	will	see	it.

Special	scenery	objects.		The	default	display	of	a	modular	layout	has	(a)	heavy	grey	lines	outlining
each	module,	(b)	large	orange	text	labels	showing	module	names,	and	(c)	rectangular	objects	with
background	images	or	colors	for	modules	which	have	them.		All	of	these	are	scenery	objects	created
during	the	assembly	process.		They	reside	in	the	background	scenery	layer,	and	can	be	edited	when
that	layer	is	active.		You	can	change	the	styles	and	colors	of	these	objects	--	or	get	rid	of	them	--
using	the	Module	Manager	Settings	dialog.

No	background	image.		A	modular	layout	does	not	have	a	single	bitmap	background	image.	
Instead,	if	there	is	a	background	image	behind	any	module,	it	becomes	a	scenery	object	in	the
modular	layout.

Modular	Layout	Files

A	modular	layout	is	stored	in	an	rrw	file,	like	any	other	layout,	but	with	an	additional	section	containing
module	information.		This	section	contains	sequence	and	position	information	about	the	modules.		It	does
not	contain	the	modules	themselves,	but	filenames	pointing	to	them.

When	you	open	a	modular	layout	file,	it	displays	the	full	layout.		If	you	bring	up	Module	Manager,	it
displays	the	assembly,	based	on	information	stored	in	the	rrw	file.		If	you	then	click	OK,	each	module	is



reloaded	from	its	stored	pathname,	and	a	new	modular	layout	is	created	from	them.		This	is	a	one-way
operation	--	modules	are	read-only,	not	dynamically	linked.		So:

If	you	make	changes	to	a	module,	the	changes	are	not	reflected	in	the	modular	layout.		Changes	will
be	seen	only	if	the	layout	is	rebuilt	from	its	assembly.

If	you	make	changes	to	a	modular	layout,	they	are	not	reflected	in	the	associated	modules.		There	is
no	way	to	transfer	changes	made	in	the	overall	layout	back	into	the	source	modules,	except	by
copying	and	pasting	between	layouts.

If	you	move	or	rename	the	modular	layout	or	any	of	its	module	files,	the	layout	might	lose	them	and
be	unable	to	rebuild.

If	you	want	to	send	the	layout	to	a	friend,	you	should	supply	the	module	files	along	with	the	main
layout	rrw.

In	short,	modules	are	external	files,	like	homemade	scenery	objects	or	linked	layouts.		Techniques	for
dealing	with	external	files	are	given	in	the	Publishing	chapter.



Tutorial:	A	Loop	of	Modules

This	exercise	demonstrates	most	of	the	features	of	the	modular	railroading	system.		In	it,	we	will	build	a
large	loop	layout	from	a	set	of	basic	component	modules.		The	result	will	not	lead	to	very	interesting
operation,	but	you	can	run	trains	around	it.

1.		Start	with	a	blank	layout	or	no	layout.		If	you	start
with	an	existing	layout,	a	new	blank	one	will	be
created	automatically.

	

2.		Choose	Module	Manager	from	the	File	menu.	
This	brings	up	the	Module	Manager	with	a	blank
workspace.

3.		Click	Add...		This	brings	up	the	Layout	Chooser.	
By	default,	it	opens	to	the	NTrak	Components	folder.

4.		Position	the	two	windows	side	by	side	so	you	can
work	with	both	together. 	

5.		Click	in	the	Layout	Chooser	to	select	NT	6-foot,	a
plain	N-scale	module	template	six	feet	long. 	



6.		Press	the	selected	row	and	drag	it	into	the	Module
Manager	workspace.		It	appears	as	a	framed	rectangle
filling	most	of	the	workspace,	with	a	label	showing	it
as	module	#1	in	the	assembly.

7.		In	the	Layout	Chooser,	click	to	select	NT	4-foot.

8.		Press	and	drag	the	selected	row	into	the	Module
Manager.		Keep	the	mouse	button	down	for	the	next
step.

	

9.		Position	to	the	right-hand	edge	of	the	6-foot
module,	until	you	see	a	narrow	highlight	box.

10.		Release	the	mouse	button.		You	now	have	two
modules	joined	end	to	end.

11.		Drag	in	the	NTrak	4-foot	corner	and	drop	it	at
the	right-hand	edge	of	the	assembly.

12.		Drag	in	another	NT	4-foot	and	drop	it	on	the	top
edge	of	the	corner	module.		In	this	case	the	right-hand
edge	does	not	highlight;	instead,	the	highlight	is	at	the
top,	as	you	might	expect.



13.		Continue	in	this	fashion,	adding	in	order:	4-foot
corner,	NT	10-foot,	4-foot	corner,	NT	4-foot,	and
4-foot	corner.		The	result	is	a	closed	loop.

14.		For	educational	purposes,	try	a	rearrangement.	
Press	on	the	middle	of	module	#1	and	begin	to	drag.	
It	becomes	hatched.	

15.		Drag	to	the	edge	between	#2	and	the	corner	(#3)
and	let	go.		The	result	is	a	swapping	of	the	two
straight	modules.

16.		Now	you're	ready	to	turn	the	assembly	into	a
layout.		Click	OK.		The	Module	Manager	is
dismissed,	and	the	assembled	modular	layout
displayed.



17.		Add	a	train	and	run	it	around,	to	convince
yourself	that	the	track	is	continuous.

18.		Save	the	modular	layout	using	File	>	Save	As.	
Do	not	save	it	into	the	Modules	folder	--	it	is	a	full
layout,	not	a	module.		Save	it	where	you	keep	other
user-built	layouts.		

For	this	tutorial	just	give	it	a	name,	and	it	will	go
directly	under	Layouts.

19.		Close	the	layout.		Reopen	it	from	either	the
Layout	Chooser	or	the	File	menu	(at	the	top	of	the
recently-used	list).		Choose	File	>	Module	Manager
to	convince	yourself	that	you	can	get	back	the
modules	and	continue	to	work	with	the	assembly.

	



Building	a	Modular	Layout

This	section	describes	the	basic	steps	for	building	a	layout	from	modules,	and	gives	information	about
how	the	process	works.

How	to	Create	a	Modular	Layout

Creating	a	modular	layout	involves	three	basic	steps:

1.	 Prepare	modules.		If	you	are	a	member	of	a	club,	and	you	have	your	own	module,	spend	a	pleasant
evening	working	up	a	TrainPlayer	version	of	it	to	add	to	your	collection	of	modules.		If	not,	you	can
skip	this	step	and	choose	modules	from	our	large	and	growing	collections	of	templates	and	samples.

2.	 Assemble.		Bring	up	the	Module	Manager,	introduce	modules	one	at	a	time,	and	arrange	them	in
chains,	loops,	or	more	complex	patterns.		It's	fun	and	easy.		Arrangement	is	done	by	drag	and	drop,
and	the	program	takes	care	of	aligning	and	snapping	the	modules	together	so	they	will	hook	up
correctly.

3.	 Fuse.		This	is	the	easiest	step	for	you:	just	click	OK.		The	Module	Manager	does	the	work	--	loads
in	each	module,	positions	it,	and	fuses	it	to	its	neighbors	by	adding	short	sections	of	track.		The	result
is	a	finished	layout,	ready	to	add	trains	and	run.		If	you're	interested	in	the	details	of	this	process,	see
the	next	section.

Once	you	have	created	a	modular	layout,	you	can	save	it	to	a	file	as	with	any	other	layout.		However,	it	is
not	fully	self-contained,	so	you	need	to	exercise	caution	before	moving	it	or	sending	it	to	someone	else.	
See	the	section	about	modular	layout	files	below.

The	Module	Fusing	Process

In	the	real	world,	modules	are	scooted	around	on	the	show	floor	until	their	connection	points	line	up,	then
short	segments	of	track	are	added	to	connect	them.		In	TrainPlayer,	the	Module	Manager	does	this
automatically,	in	a	process	called	fusing.		Fusing	one	module	to	another	involves	several	steps:

1.	 Locating	the	connection	points.		The	program	searches	a	narrow	stripe	along	the	edge	of	each
layout	for	any	junctions	at	the	ends	of	straight	track	segments.

2.	 Aligning	the	modules.		A	specific	connection	point	on	each	edge	--	the	one	closest	to	the	front	of	the
module	--	is	designated	as	the	registration	point.		The	two	modules	are	adjusted	front	to	back	until
their	registration	points	line	up.

3.	 Introducing	gaps.		If	the	connection	points	on	a	module	are	at	the	very	edge,	then	there	will	be	no
room	to	insert	connecting	track.		The	program	detects	this	situation,	and	backs	the	connection	point
junctions	a	little	ways	from	the	edge.

4.	 Adding	connecting	tracks.		Wherever	a	connection	point	on	one	module	has	a	partner	at	the	same
position	on	the	other,	a	segment	of	straight	track	is	added	between	the	two	points.

5.	 Detecting	loop	closures.		After	fusing	one	end	of	a	module,	the	program	looks	at	the	other	end	to	see



if	it	is	touching	any	other	module.		If	so,	it	means	there	is	a	loop,	and	one	more	fusion	will	be
required	to	finish	the	job.

The	overall	process	of	building	a	modular	layout	is	a	matter	of	marching	down	the	list	of	modules,	fusing
each	to	the	next,	closing	loops	when	necessary.



Building	a	Module

The	general	procedure	for	constructing	your	own	virtual	module	is	the	same	as	for	building	any	layout	in
TrackLayer.		You	can	start	from	scratch,	draw	your	track	plan,	and	carefully	make	sure	it	conforms	to
specs.		Or	you	can	take	an	easier	and	more	reliable	approach:	start	from	a	preconfigured	plan	or	template
and	modify	to	suit.		This	is	the	method	our	artists	used	to	create	the	scenic	layouts	already	available.

Module	Starting	Points

From	an	existing	physical	module.		If	you	already	have	a	real	module	you	take	to	shows,	to	work
with	it	in	Module	Manager	you	will	need	to	construct	a	virtual	replica	of	it	using	TrackLayer.		First
you	will	need	to	convey	the	track	plan	to	electronic	media	--	for	example	by	taking	a	scan	of	an
overhead	photo	--	then	"trace	over"	it,	applying	track.		This	process	is	described	in	the	Getting
Started	chapter	of	the	TrackLayer	manual.		The	procedure	is	the	same	whether	you	are	creating	a
module	or	a	regular	stand-alone	layout.

From	a	sample	plan.		We	provide	a	generous	collection	of	NTrak	and	HO	sample	modules,	some
just	track	plans,	others	with	structures	and	scenery.		The	set	you	get	installed	with	the	product	is
small;	the	rest	are	found	in	the	Web	tab	of	your	Layout	Chooser,	under	the	Modules	folder.		You	can
add	or	remove	track	or	scenery	or	otherwise	modify	as	desired.

From	a	template.		In	the	Components	folders	under	Modules\[HO	or	NTrak]	you	will	find	a	series
of	bare-bones	module	templates	of	various	sizes.		Here	for	example	is	a	picture	of	the	two-foot
NTrak	template:

										

Each	NTrak	template	comes	with	five	tracks	going	all	the	way	across	(HO	templates	have	three).	
These	tracks	form	different	railroad	lines	running	around	the	layout.		Each	is	labelled	according	to
its	purpose,	as	follows:

ML1	=	main	line	1,	4"	back	from	the	front	of	the	module.		This	is	the	track	which	is	used	to
align	a	module	with	its	neighbors,	so	it	must	be	present	and	correctly	positioned.		Normally	the
main	line	goes	straight	across	each	module	and	all	the	way	around	the	layout.



ML2	=	main	line	2,	5.5"	back.

BL1	=	branch	line	1,	7"	back.

BL2	=	branch	line	2,	11"	back.

M	=	mountain	line,	14"	back.

For	HO	modules,	only	ML1,	ML2,	and	BL	are	present	(at	4",	7",	and	14"	from	the	front).

The	picture	shows	how	you	can	remove	the	inner	tracks	and	just	leave	the	connecting	stubs.		Using
the	Track	edit	tool,	drag	a	selection	rectangle	so	it	surrounds	the	middle	portions	of	all	five	lines	(as
shown),	then	press	Del.		This	leaves	short	stubs	on	the	sides,	which	you	can	connect	with	your	own
trackage.

	The	labels	on	the	tracks	are	scenery	objects.		If	you	want	to	get	rid	of	them,	use	the	Scenery	Edit
tool.

From	an	existing	layout.		You	can	start	with	just	about	any	layout	and	convert	it	into	a	module,	as
long	as	you	can	add	connecting	tracks	at	the	side	edges	and	tie	them	somehow	into	the	existing	track.	
To	make	room	for	the	connectors,	it	may	be	necessary	to	resize	the	layout	using	the	Resize/Rescale
tool.	

Here	is	an	example	in	which	the	Custer	&	Front	Range	has	been	enlarged	and	modified	to	work	as	an
NTrak	module.		Connecting	tracks	were	copied	from	a	template	and	pasted	into	the	enlarged	side
areas,	then	connecting	tracks	(shown	in	red)	were	added	by	hand.

From	scratch.		Even	if	you	start	with	a	blank	layout,	TrackLayer	provides	assistance	in	creating
modules.		Choose	File	>	New	to	bring	up	the	New	Layout	dialog.		Choose	one	of	the	standard	NTrak
sizes	from	the	Size	drop-down.		If	"Add	connectors"	is	checked,	then	the	new	layout	will	be	created
with	stubs	on	each	side,	appropriately	positioned	as	shown	below.



This	feature	is	available	only	for	NTrak	modules,	not	HO	or	other	scales.

Module	Orientation

The	Module	Manager	requires	module	layouts	to	be	oriented	in	specific	ways,	as	shown	in	the	following
table.	

Straight Main	line	across	bottom

Corner Main	line	from	lower	left	to	upper
right

Inside	Corner Main	line	from	upper	left	to	lower
right

Junction Main	line	across	bottom,	switchable
to	alternate	main	on	each	end

Whatever	method	you	use	to	create	a	module,	make	sure	it	is	oriented	as	shown	here.		Do	not	use	View
Rotate	or	other	means	to	reorient	it,	or	the	Module	Manager	will	not	interpret	it	correctly.

Module	Tags

The	program	is	not	(yet)	smart	enough	to	look	at	a	layout	and	determine	that	it	is	a	module.		It	is	up	to	the
creator	of	the	module	to	supply	this	information.		This	is	done	by	selecting	a	tag	from	a	drop-down	menu
in	the	Layout	Properties	dialog:



If	you	are	creating	a	layout	to	be	used	as	a	module,	select	the	appropriate	tag.		This	will	inform	the
Module	Manager	how	to	interpret	the	layout.		This	is	not	vital	for	a	straight	module,	but	corners	and
junctions	must	be	tagged	or	they	will	not	work.



The	Module	Manager

The	Module	Manager	is	a	dialog	for	organizing	and	assembling	modules	into	modular	layouts.		Called
from	the	menu	command	File	>	Module	Manager.

The	process	you	carry	out	in	the	Module	Manager	is	called	assembly.		It's	like	sliding	dominoes	around
on	a	table:	you	position	them	end	to	end,	using	special	corner	and	junction	units	to	make	turns.		They	can
only	fit	together	in	certain	ways,	so	they	are	like	magnets	--	you	drop	them	roughly	into	position,	and	the
program	snaps	them	into	place.	

The	dialog	is	operated	mostly	by	drag	and	drop.		To	build	a	modular	layout,	you	introduce	modules	by
dragging	them	in	from	other	windows--	Layout	Chooser	or	Windows	Explorer	--	then	you	rearrange	or
delete	them	by	dragging,	or	change	the	sequence	by	moving	rows	up	and	down	in	a	list.		Once	you	have	an
assembly	you	like,	click	OK,	and	the	program	automatically	creates	the	full	modular	layout.		It	reads	in
the	track	and	scenery	of	each	module,	positions	them	according	to	your	assembly,	automatically	adds	little
track	sections	between	modules,	and	presents	you	with	a	complete	layout,	ready	to	add	trains	and	run.	

Tour	of	the	Module	Manager

The	Module	Manager	is	a	resizable	dialog	with	several	components,	as	shown	in	this	annotated	screen
shot:

The	upper	half	of	the	dialog	is	the	workspace	where	modules	are	schematically	displayed	and



manipulated.		The	workspace	starts	out	empty;	this	example	shows	an	assembly	in	progress	with	three
straight	modules	and	one	corner	module.		Modules	are	by	default	displayed	as	filled	rectangles	with
numeric	labels.		Corners	are	shown	as	squares,	with	45-degree	cutoff	lines	suggesting	the	typical	shape	of
an	actual	unit.

Along	one	edge	of	the	each	module	is	the	front	track,	a	line	approximating	the	route	of	the	main	track
going	around	the	assembly.		In	a	train	show,	viewers	stand	on	this	side	of	the	layout.

Beneath	the	workspace	is	the	module	list,	a	list	box	showing	the	sequence	of	modules	with	their	details.	
Each	row	begins	with	a	number	which	corresponds	to	a	labelled	module	in	the	assembly.	

The	highlighted	row	in	the	list	shows	the	selected	module.		This	one	is	shown	in	the	workspace	with	a
pink	frame.		You	can	select	a	module	by	clicking	on	it	in	the	workspace,	or	by	clicking	its	row	in	the	list
box.

Buttons	around	the	module	list	are	for	editing	the	assembly	and	modifying	its	properties,	as	described
below.

Adding	Modules	to	the	Assembly

To	begin	creating	an	assembly:

1.		Click	Add...	to	bring	up	the	Layout	Chooser.	

2.		Navigate	to	a	Modules	folder	if	necessary.		By	default	the	chooser	comes	up	pointing	to	the	NTrak
Components	folder.

3.		Choose	a	layout	to	be	the	base	module.		This	just	means	all	other	modules	will	be	positioned	relative
to	it	--	the	base	retains	its	orientation	as	others	are	moved	around.

4.		Press	on	the	selected	layout,	drag	it	off	the	Layout	Chooser	list,	and	drop	it	into	the	Module	Manager
window.		When	you	let	go,	the	module	is	displayed	in	standard	orientation,	filling	the	window.

5.		Choose	a	second	module	and	drag	it	into	the	MM.		You	can	drop	it	on	either	end	of	the	existing
module,	as	indicated	by	red	highlights	which	show	up	while	you	are	dragging	(see	left	image	below).		Let
go	while	a	highlight	is	showing,	and	the	incoming	module	will	snap	onto	the	existing	one.



				 				 				

6.		Continue	dragging	modules	in	to	build	the	assembly.		Additional
modules	can	be	dropped	onto	either	end	of	the	chain,	or	in	between	two
linked	modules	--	wherever	the	highlight	shows	up.

7.		To	replace	a	module,	drag	another	one	onto	the	center	of	it.		In	this
case	the	highlight	is	a	red	X	(above	right),	indicating	that	the	incoming
module	will	replace	the	existing	one.

8.		To	make	a	turn,	add	a	corner	module.

9.		To	make	a	loop,	add	four	corners,	and	the	right	number	of	modules	in
between	so	that	the	ends	just	meet.

Dragging	Modules	from	Windows	Explorer

An	alternative	method	of	adding	modules	to	the	Module	Manager	is	to	drag	them	from	Windows	Explorer
instead	of	the	Layout	Chooser.		To	do	this:

	1.		With	TrainPlayer	running	and	the	Module	Manager	visible,	bring	up	Windows	Explorer	(Start	>	All
Programs	>	Accessories).	Navigate	to	a	folder	of	module	layouts.

2.		Choose	a	module	layout	and	drag	it	into	the	MM	window.		Highlighting	and	locations	of	attachment	are
the	same	as	described	above.

Be	sure	to	choose	a	file	with	extension	.rrw.		If	you	drag	the	wrong	type	of	file,	nothing	will	happen	when
you	drop	it.

Rearranging	Modules



Once	you	have	more	than	one	module	in	the	Module	Manager	window,	you	can	move	them	around	or
delete	them	by	drag	and	drop,	or	by	rearranging	rows	in	the	list	box.		After	any	such	operation,	the	overall
assembly	is	reconfigured	to	reflect	the	change.

By	drag	and	drop:

1.	 Position	the	cursor	over	the	middle	of	a	module,	press	the	left	button,	and	begin	to	drag.		The	module
takes	on	a	hatched	pattern,	meaning	it	is	"on	the	move."	

1.	 Drag	to	any	of	the	locations	indicated	above	--	to	the	edge	of	a	module,	on	top	of	a	module	--	and	let
go.		The	module	is	moved	from	its	original	location	to	the	new	one.

2.	 To	remove	a	module	from	the	assembly:	drag	the	module	and	release	it	on	an	empty	space,	where
nothing	is	highlighted,	i.e.,	drag	it	out	of	the	assembly	onto	the	floor.

By	list	box:

1.	 Select	a	module	by	clicking	on	it	in	the	workspace,	or	by	clicking	a	row	in	the	list	box.		The	module
is	highlighted	with	a	colored	frame,	and	the	selected	row	is	highlighted	in	the	list	box.

2.	 Click	the	up	or	down	arrow	to	the	right	of	the	list	box	(labelled	"move	selected"	above).		The
module	will	trade	places	with	the	one	immediately	above	or	below	it	in	the	list.

3.	 To	remove	a	module:	click	Remove.		The	selected	module	will	be	removed	from	the	assembly.

Zooming	Modules

By	default,	the	Module	Manager	displays	the	entire	assembly,	regardless	of	how	large	it	becomes.		You
can	enlarge	or	maximize	the	window,	but	for	very	large	assemblies	this	may	not	be	enough,	and	you	may
want	to	zoom	in	for	a	closer	look.		This	is	the	purpose	of	the	zoom	controls	at	the	lower	right	of	the
dialog.

To	enlarge	the	view:	click	the	up	arrow.		Each	click	zooms	in	by	a	fixed	amount.		There	is	a	limit	--	you
can't	zoom	so	far	that	the	module	edges	disappear;	the	up	arrow	is	dimmed	when	you	reach	the	limit.	
When	the	view	is	enlarged,	scrollbars	appear	so	you	can	move	around.

To	shrink	the	view:	click	the	down	arrow.		Each	click	reduces	by	a	fixed	amount,	until	the	assembly	goes
to	a	fixed	minimum	size.

To	restore	to	normal	fit-to-window	mode:	click	Fit.		This	resizes	the	assembly	to	fit	in	the	window.

Settings

The	Settings	button	at	the	bottom	of	the	dialog	brings	up	the	Module	Manager	Settings	dialog.		This



allows	you	to	set	display	features	applying	to	the	Module	Manager	and	to	the	resulting	modular	layouts.



Module	Manager	Settings

Sets	display	properties	in	the	Module	Manager	and	in	layouts	created	by	it.		Called	from	the
Settings	button	on	the	Module	Manager	dialog.

													

In	this	dialog	you	can	adjust	most	elements	of	the	display	in	the	Module	Manager,	and	some	module-
related	ones	in	the	assembled	layout.			The	drop-down	menu	at	the	top	gives	you	a	choice	of	display
elements;	you	choose	one,	then	specify	whether	you	want	it	visible,	and	set	its	color,	font,	and	line	width,
or	whichever	apply.

Choices	you	make	in	this	dialog	apply	immediately	in	the	Module	Manager	window,	so	you	can
experiment	with	different	options	and	see	what	they	do.		(This	does	not	apply	to	items	with	"in	Assembly"
in	the	name	--	these	do	not	apply	until	you	click	OK	to	leave	the	Module	Manager	to	create	the	assembled
layout.)		If	you	Cancel	out	of	this	dialog,	the	Module	Manager	display	reverts	to	its	previous	state.

Module	Manager	Settings	dialog	controls

Item
Select	a	feature	of	the	display	to	be	edited.		The	full	list	of
features	is	shown	in	the	screen	shot	above;	where	these	features
appear	in	the	display	is	shown	in	pictures	below.		Settings	in	this
section	of	the	dialog	apply	only	to	the	selected	feature.

Show	this Check	this	box	if	you	want	the	selected	item	to	appear	in	the
display.		Applies	to	all	items	except	Floor.

Color Click	to	choose	a	color	for	the	selected	item.		Applies	to	all	items
except	Background	in	Assembly.

Click	to	specify	a	font	for	the	selected	item.		Applies	only	to



Font Module	Label	and	Label	in	Assembly.

Line	Width
Choose	a	line	width	in	pixels	for	the	selected	item,	where	zero
means	thinnest	possible.		Applies	to	Module	Frame,	Module
Highlight,	Track	Line,	and	Frame	in	Assembly.

Load

Click	to	retrieve	an	assembly	previously	saved	as	a	Module
Definition	(MDEF)	file.	For	information	about	MDEF	files,	see
below.

Warning!			Loading	an	MDEF	file	replaces	the	current	contents	of
the	manager,	without	asking	if	you	want	to	save	it	first.

Save Click	to	save	the	current	assembly	to	MDEF,	for	later	reuse.		See
below.

Reset	This Reset	the	current	display	item	to	factory	settings.		Changes	do
not	become	permanent	until	you	click	OK.

Reset	All Reset	all	display	items	to	factory	settings.		Changes	do	not
become	permanent	until	you	click	OK.

OK,	Cancel
Click	OK	to	retain	the	current	settings	and	make	them
permanent.		Click	Cancel	to	revert	to	settings	in	effect	before	the
dialog	came	up.

Module	Definition	(MDEF)	files

Module	definition	files	provide	a	lightweight,	convenient	way	to	avoid	having	to	rebuild	the	same
assembly	more	than	once.		A	file	with	extension	MDEF	is	a	simple	xml	file,	readable	in	Notepad,	which
contains	a	list	of	the	current	set	of	modules	and	their	arrangement	--	basically	the	same	information	you
see	in	the	Module	Manager	listbox.	

If	you	have	an	arrangement	you	might	want	to	reuse,	save	it	to	an	MDEF	file.		Later	you	can	load	it	and	get
back	the	same	arrangement.

MDEF	files	are	not	designed	to	be	portable	or	exportable.		They	contain	pathnames	pointing	to	the
individual	module	files.		If	you	move	or	rename	any	of	these,	the	mdef	may	not	load	correctly.

For	convenience,	you	can	load	an	mdef	file	by	dragging	it	from	Windows	Explorer	directly	into	the
manager	workspace.		The	incoming	file	replaces	the	current	contents	of	the	window.

Module	Display	Items

Features	of	the	display	which	have	user-settable	properties	are	indicated	in	the	following	screen	shots.	
Those	with	"in	Assembly"	in	the	name	refer	to	features	of	the	assembled	layout,	others	to	the	assembly	as
it	appears	in	the	Module	Manager.



"Background	in	Assembly"	is	not	shown	in	these	shots	--	this	turns	on	or	off	any	background	images	or
solid-color	backgrounds	in	the	individual	modules.



Importing	CAD	Layouts

To	convert	a	layout	created	in	a	CAD	program,	you	must	be	running	TrackLayer	--	the	import
feature	is	not	available	in	TrainPlayer.		Details	of	the	import	process	vary	depending	on	the
input.

As	of	Version	8.0.1,	we	no	longer	support	importing	any	format	except	AnyRail.

Importing	from	AnyRail

To	convert	from	AnyRail,	you	must	have	an	installed	copy	of	AnyRail	3.11	or	above.		You	will
need	to	export	the	layout	from	AnyRail	before	you	can	import	it	into	Tracklayer.

To	import	from	AR:

1.	 Start	AnyRail	and	open	the	layout	to	be	converted.
2.	 Choose	File	>	Export	as	TrainPlayer.		(If	you	do	not	see	this	command	on	the	File	menu,

see	notes	below).		Choose	an	output	file	name.		You	are	actually	saving	two	files,	one	a
file	with	extension	xml	containing	the	data,	the	other	a	jpg	of	the	graphics.

http://www.anyrail.com/index_en.html


3.	 Start	TrackLayer	and	choose	File	>	Import	AnyRail.		Open	the	xml	just	created.
4.	 The	import	proceeds,	with	a	progress	bar	displaying	status.		On	completion,	the	layout	is

ready	to	test	and	run.
5.	 Save	the	converted	layout	as	rrw	file.	

Notes

1.	 A	common	problem	in	a	converted	layout	is	gaps	in	the	track,	where	the	train	crashes	or
bounces	instead	of	rolling	on	through.		Usually	this	means	the	track	sections	were	not
connected	in	the	input	file.		To	fix	it,	drag	one	of	the	disconnected	junctions	on	top	of	the
other,	so	they	fuse	and	become	a	single	junction.

2.	 If	turnouts	or	slipswitches	do	not	work	properly,	it	is	likely	to	be	due	to	errors	in	the
conversion.		Please	report	it.

	



Map	View

Map	View	is	a	miniature	track-only	view	of	the	entire	layout,	showing	the	locations	of	chosen
cars	and	tracks.		It	has	a	draggable	box	showing	what	part	of	the	layout	is	currently	on	view,
plus	tooltips	and	destination	arrows	which	pop	up	as	you	hover.		Map	View	is	a	convenient	tool
for	finding	your	way	around	a	large,	unfamiliar	layout,	and	for	seeing	at	a	glance	what	ops	jobs
need	doing.

Map	View	Features

Dockable	Window.		Map	View	is	a	dockable,	resizable	window.		Drag	by	its	header	to	dock	or
undock,	or	by	a	side	or	corner	to	resize.

View	Box.		A	blue	box	on	the	map	shows	what	portion	of	the	layout	is	visible
in	the	layout	window.		Press	and	drag	this	box,	and	it	causes	the	view	to
scroll;	or	scroll	the	view,	and	it	causes	the	box	to	move.

Map	View	Context	Menu.		Right-click	anywhere	on	the	map	to	bring	up	the
context	menu	shown	at	right.		It	has	a	two	sets	of	checkable	items	indicating
what	you	would	like	to	see	on	the	map:

Cars	(shown	as	colored	squares):	Spotted	=	those	already	parked	at
their	destinations;	Unspotted	=	remaining	to	be	moved	for	the	current
switchlist;	Engines	=	engines	only,	no	tenders.		(Note	that	if	a	switchlist	is
in	progress,	the	Active	Engine	is	shown	in	a	special	color.		Also	note	that
the	currently-selected	car	is	shown	with	an	X.)
	
Locations	(colored	triangles):	Industries,	Yards,	Staging,	or	Interchanges.		Each	triangle
is	located	at	the	center	of	a	rectangle	enclosing	the	tracks	at	that	location.
Links	(colored	diamonds):	tracks	linked	to	external	layouts.		See	Linked	Layouts.

A	third	set	of	items	turn	on	or	off	map	features:



Legend:	check	to	display	a	little	table	showing	what	symbols	are	on	display	and	how	many
of	each.		The	legend	is	anchored	to	the	bottom	right	corner	of	the	map	window.
	
Tooltips:	check	to	enable	tooltips	as	you	hover	over	car	or	location	symbols.
	
Dest	Arrows:	check	to	affect	behavior	when	you	hover	over	a	car:	if	the	car	is	unspotted,
an	arrow	appears,	pointing	to	the	car's	next	destination.

Zoom	To	Cursor.		Right-press	any	spot	on	the	map	and	choose	Zoom	To	Cursor.		The	view
in	the	layout	window	scrolls	to	the	indicated	position.		(It	doesn't	actually	change	the	zoom
level).		This	is	an	alternative	to	dragging	the	view	box	across	the	map.

Settings.		Brings	up	the	Map	View	Settings	dialog,	where	you	can	change	colors	and	line
widths.		Click	Defaults	to	revert	to	factory	settings.

Click	any	of	the	four	color	buttons	to	bring	up	the	Color	Chooser.		Individual	marker	colors	may
be	set	by	choosing	a	type	from	the	drop-down,	then	setting	the	color	for	that	type.



The	Train	Window

This	page	is	obsolete.		The	Train	Window	is	now	described	under	Train	Control	Bar.



Yard	Mode

Yard	sessions	are	easy	in	TrainPlayer!		When	you're	operating	in	"yard	mode,"	rotating	the
speed	dial	controls	both	the	speed	and	the	direction.		Thanks	to	our	users	for	suggesting	this
handy	feature.

To	enable	yard	mode:	right-click	the	Control	Panel	and	check	"Enable	yard	mode."		Or	use
the	command	Enable	Yard	Mode	on	the	Tools	menu,	or	click	the	Y	button	on	the	toolbar	 .

When	yard	mode	is	enabled,	a	brass	Y	appears	in	the	upper	right	of	the	control	panel,	as
shown	in	the	illustration	at	right.

To	use	Yard	Mode	with	the	speed	dial:

1.	 Rotate	the	speed	knob	counterclockwise,	so	it	goes	past	the	zero	point	at	around	7:00.

2.	 The	train	stops	and	goes	into	reverse.	Speed	remains	zero	until	you	rotate	past	the	stop
button	at	6:00.

If	the	train	is	already	in	reverse	when	you	rotate	into	yard	mode,	it	stays	in	reverse.

3.	 Continue	to	rotate	counterclockwise.		The	train	speed	increases	in	the	usual	way	--	slowly
at	first	--	as	the	train	moves	in	reverse.		You	can	rotate	all	the	way	around	to	maximum
reverse	speed	at	the	7:00	position.

4.	 While	yard	mode	is	in	effect,	the	stop	button	flashes.

5.	 To	end	yard	mode:	(a)	rotate	back	clockwise	past	the	starting	point,	or	(b)	click	the	stop
button,	which	immediately	stops	the	train	and	returns	to	normal	mode.

To	use	Yard	Mode	with	the	speed	slider:

When	yard	mode	is	enabled,	the	speed	slider	divides	into	two	sections,	as	shown	here:

Normal		 							

Yard							

In	normal	operation,	zero	speed	is	at	the	left;	moving	to	the	right	increases	speed.		In	yard
mode,	zero	is	in	the	middle;	moving	to	the	right	increases	speed,	while	moving	to	the	left
begins	yard	mode	and	switches	into	reverse.

To	disable	yard	mode:	click	the	brass	Y	on	the	control	panel,	or	click	the	toolbar	button	 ,	or
uncheck	"Enable	yard	mode"	on	the	context	menu.



Car	Data	Properties

For	viewing	and	editing	properties	of	the	selected	car.	Called	from	Properties	on	the	Car
context	menu.		See	also	About	the	Properties	Dialog.

			

As	of	version	6.6,	car	properties	are	split	between	two	tabs:	Car	and	Car	Data	(this	one).		The	Car	Data
tab	handles	certain	text	fields	and	load	information.		It	is	specifically	designed	to	make	it	easy	for	a	script
author	to	click	around	the	layout,	assigning	script-related	data	to	cars.

To	make	text	editing	easier,	the	text	in	the	data	boxes	in	this	tab	are	displayed	in	fixed	(Courier)
font.		The	size	of	the	font	is	shared	among	several	windows,	and	can	be	adjusted	in	the	Script
Central	Settings	tab.

Dialog	data	on	the	Car	Data	tab:

Images same	as	in	Car	tab

Text The	text	just	below	the	side	view	shows	car	label	and	car	type	name.		The	label	can	be	edited	in
the	Car	tab.

Load Name	of	load	assigned	to	car.		Choose	a	different	load	by	name	from	the	drop-down,	or	select
Load	Chooser	from	top	of	list.		This	item	is	dimmed	if	car	is	unloadable	(engine,	tender).

Note
An	optional	string	of	information	attached	to	the	car.		A	car	note	may	be	used	to	keep	track	of	a
car's	home	location,	reporting	marks,	etc.		It	has	specific	uses	in	Advanced	Ops.		For	more,	see
Car	Notes.

AA/o AAR	Override:	a	user-supplied	AAR	code	which	replaces	the	one	assigned	at	the	car	factory.	
For	more	information,	see	AAR	Override.

Props A	second	optional	string	attached	to	a	car,	accessible	via	$CAR	function;	see	Car	PropStr.

Dest User-supplied	short	text	string	indicating	car's	current	destination,	normally	matching	a	track	label
on	the	layout.		For	more,	see	Car	Dests.

Loaded Check	indicating	whether	car	is	loaded.		Clicking	this	box	changes	the	load	status	of	the	car	and
updates	the	picture	to	show	or	hide	the	load.		Checkbox	is	dimmed	if	car	is	unloadable.

Excluded	/ If	checked,	this	car	is	marked	"XO,"	meaning	not	available	for	use	in	regular	ops.		For	discussion,



ops see	XO	Cars.



Stations

In	TrainPlayer,	a	"station"	is	a	named	location	on	the	layout.		It	may	represent	a	terminal,
loading	dock,	warehouse,	yard,	city,	or	any	place	a	train	might	stop	to	interchange	passengers
or	goods.		By	defining	stations	on	the	layout,	you	give	the	program	a	way	to	keep	track	of
where	a	train	has	travelled.

Stations	were	introduced	in	an	early	version	of	TrainPlayer.		As	of	Version	7,	they	are	phased
out	as	the	method	of	identifying	locations	for	ops	or	scripting;	now	track	labels	are	used	for
these	purposes.		However,	stations	still	have	uses	--	scheduling,	site-specific	sounds	--	so	they
are	still	part	of	the	program.

A	station	is	represented	on	the	layout	as	a	rectangular	area,	with	a	dashed	blue	outline	and	one
or	two	lines	of	text.		Stations	are	visible	only	(a)	when	you	are	using	the	Station	tool,	or	(b)
when	you	choose	View	Stations.

Stations	may	have	sounds	attached	to	them.		The	sound	will	play	whenever	a	train	goes
through	the	station.		Available	sounds	include		farm	noises,	traffic,	crossing	bells,	running	water,
and	many	others,	or	you	can	supply	your	own.

Creating	a	Station

1.		Click	to	select	the	Station	tool	 	on	the	main	toolbar,	or	choose	Tools	Stations.		If	there	are
stations	defined	on	the	layout,	selecting	this	tool	causes	them	to	become	visible	as	dashed	blue
rectangles	with	names:



2.		To	create	a	new	station:	press	and	drag	to	form	a	rectangle	around	the	desired	station
area.		This	must	enclose	some	section	of	track,	or	it	will	be	disregarded.

3.		When	you	release	the	mouse	button,	the	Station	Properties	dialog	comes	up	so	you	can
supply	a	name	and	other	information	for	the	new	station.		Enter	a	name	and	click	OK,	or	click
Cancel	to	abort	creating	the	station.

To	modify	a	station:

To	change	a	station's	name:	position	the	cursor	on	one	edge	of	the	station's	rectangle	so	it
highlights,	right-click	and	choose	Station	Properties.		You	are	prompted	to	enter	a	new	name.

To	change	size,	shape,	or	position:	position	at	a	side	or	corner	of	a	station,	then	press	and
drag.

To	delete	a	station:	

Position	the	cursor	on	one	edge	of	the	station's	rectangle	so	it	highlights,	then	press	the	Del
key.

To	define	a	sound	at	a	station:	

Right-click	the	station	and	choose	Station	Properties.		Click	the	browser	button	(...),	and	you
are	presented	with	the	Sound	Chooser	dialog.

Choose	a	sound	from	the	list.		Click	the	preview	window	to	hear	the	sound.		If	you	like	it,	click
OK	and	it	will	become	the	station	sound,	played	once	whenever	a	train	arrives	at	the	station.	
See	also	Station	Sounds.



Station	Properties

The	Station	Properties	dialog	is	where	you	define	a	station.		To	bring	it	up,	(a)	activate	the
Station	tool	so	that	stations	are	visible,	(b)	right-click	a	station	border	and	choose	Properties.

As	of	Version	7,	stations	are	no	longer	used	in	Ops,	but	they	can	be	converted	for	such	use.	
See	Locations.

Dialog	controls:

Station	Name:		A	name	to	identify	the	station.

You	can	give	a	station	any	name	you	like,	but	it	should	be	unique	on	this	layout.

Station	Sound:		Sound	to	be	played	when	a	train	enters	the	station	area.		The	sound	begins
playing	when	the	first	car	crosses	the	station	boundary,	stops	when	the	last	car	exits.	

To	choose	a	sound,	click	the	Browse	button	to	call	up	the	Sound	Chooser.		To	remove	the
sound,	erase	the	contents	of	the	edit	box.

Station	sounds	are	Layout	Sounds.		All	such	sounds	can	be	turned	on	or	off	with	a	checkbox	in
Sound	Preferences.

Style:	brings	up	the	Station	Style	dialog,	where	you	can	specify	colors	of	station	text	and
outlines.	



			Getting	Started

Where	you	start	with	TrackLayer	depends	on	what	you	have	to	start	with.		If	you	have	a	picture
of	a	track	plan	--	from	a	book	or	magazine,	web	site,	CAD	program,	or	a	sketch	on	a	piece	of
paper	--	then	you're	the	user	TrackLayer	was	designed	to	accommodate.		Most	of	the	features
of	the	program	are	aimed	at	tracing	over	a	diagram,	applying	track	where	lines	are	already	laid
out.

If	you	don't	have	a	diagram,	you	can	draw	a	plan	by	hand	on	a	blank	tabletop.		If	a	rectangular
space	will	do,	choose	the	size	and	scale	you	want	and	you're	ready	to	lay	track.		If	you	are
designing	for	an	L-	or	odd-shaped	space,	you	might	consider	using	a	drawing	program	to	make
a	scale	drawing	of	the	space	outline,	as	background	for	sketching	track.

Starting	TrackLayer

Layout	and	Image	Files

The	Overall	Process

What's	Next:

Try	your	hand	at	creating	a	small	layout,	the	BN	Cascade	Mining	Division,	in	the
tutorial.



Layout	and	Image	Files

		About	Layout	Files

A	layout	for	use	in	TrainPlayer	consists	of	one	or	two	files:

The	layout	file	(extension	.rrw).		The	layout	file	contains	the	definitions	of	all	tracks,	trains,
stations,	and	every	other	object	and	bit	of	data	about	the	layout.	

See	for	yourself	--	an	rrw	file	is	plain	text	in	xml	format,	so	you	can	open	it	with	Notepad	or	any
text	editor.		You	can	change	its	extension	to	.xml	and	double-click	--	it	will	open	in	your	browser
in	collapsible	outline	form.

The	image	file	(extension	.jpg,	.bmp,	.png,	.gif,	.tpg).		The	image	file	contains	the
background	graphics	--	scenery,	text,	and	track	lines	in	a	picture	of	the	track	plan.

Not	all	layouts	have	image	files	--	in	fact,	not	many	do*.		In	the	old	days	it	was	typical	to	start
with	an	image	of	a	track	plan	and	add	track	on	top.		Now,	with	built-in	scenery	tools,	a
complete	layout	can	be	developed	with	no	image	file,	and	most	of	our	latest	downloadable
layouts	consist	of	rrw	file	only.		For	this	reason,	we've	removed	from	this	section	a	batch	of	old
instructions	on	dealing	with	image	files.

It	is	still	possible	to	create	a	layout	starting	with	an	image	file	--	simply	choose	a	graphics	file
(one	of	the	above	extensions)	from	the	File	Open	dialog.		This	opens	the	image	so	you	can
begin	adding	track,	and	later	save	as	rrw.

*	Exception:	importing	a	layout	from	AnyRail	produces	an	image	file,	which	shows	the	AR	image
underneath	the	TP	track.

Creating	a	New	Blank	Layout

If	you	don't	have	an	image	and	just	want	to	sketch	track	on	a	blank	screen,	start	by	creating	a
space	with	the	dimensions	you	have	in	mind.

1.	 Choose	File	New.	The	New	Layout	dialog	appears:



	
2.	 If	you	want	a	layout	of	standard	size	and	dimensions,	try	the	Size	drop-down	and	see	if

your	choice	is	there.		The	program	offers	a	collection	of	standard	layout	arrangements,
including	various	NTrak	modules.		If	you	choose	one	of	the	standard	sizes,	you	can	skip	the
rest	of	this	section	and	just	click	OK.
	
OR:
	

3.	 Choose	the	scale	you	want	in	the	Scale	drop-down,	and	enter	the	dimensions	you	want	in
the	Height	and	Width	boxes.		Click	OK	to	dismiss	the	dialog	and	create	the	new	drawing
space.
	
You	can	select	the	units	you	want	to	use	for	display	and	data	entry,	using	the	drop-down	at
the	right.		Units	you	select	in	this	drop-down	will	become	the	defaults	throughout	the
program.

	



The	Overall	Process

	

Here	are	the	basic	steps	in	preparing	a	layout	for	TrainPlayer	use.		All	are	described	in
more	detail	throughout	the	manual.

1.		Prepare	the	image

If	you're	starting	with	a	picture	of	a	track	plan,	you'll	need	to	turn	it	into	a	graphics	file	on
your	computer.		If	the	image	is	on	paper,	you'll	need	to	scan	and	crop	it;	if	on	a	website,
download	it;	if	in	a	CAD	program,	export	it.		The	result	needs	to	be	a	high-resolution
graphics	file	in	any	of	several	standard	formats.

You	don't	actually	need	a	background	image.		You	can	start	with	a	blank	screen	and	just
lay	track	freehand.

2.		Adjust	the	grid

To	create	an	accurate	layout,	you	need	to	establish	the	relationship	between	the	image	on
your	screen	and	the	real-world	dimensions	on	the	layout.		You	do	this	by	adjusting	the
TrackLayer	grid.		The	grid	is	defined	in	real-world	units	--	in	HO,	for	example,	grid	lines	are
defined	to	be	12"	apart	--	so	when	you	overlay	the	grid	on	the	image,	you	tell	TrackLayer
all	it	needs	to	know	about	layout	size	and	dimensions	in	any	scale.

Many	published	layouts	have	grid	lines	included	in	the	image.		Adjusting	the	grid	in
TrackLayer	is	a	matter	of	dragging	it	with	the	mouse	until	it	matches	the	one	on	the
background.

3.		Draw	curves	and	turntables

Curves	and	turntables	are	a	little	tricky	to	create,	more	so	when	working	in	an	area	already
crowded	with	track.		Therefore	the	experienced	track	layer	draws	these	items	first.

4.		Draw	straight	track	and	switches

Drawing	straight	track	is	easy	--	you	just	trace	over	the	lines	on	the	image	with	a	series	of
connected	line	segments.		Switches	are	created	automatically	whenever	three	or	more
segments	come	together.

5.		Add	special	features

Most	layouts	have	sections	of	track	hidden	in	tunnels	or	underneath	the	layout.		You	can
mark	these	sections	in	TrackLayer	so	that	when	trains	pass	over	them,	they	appear
hidden.		Or	you	can	mark	a	section	of	track	as	"tunnel,"	so	that	a	train	entering	at	one	end
immediately	emerges	at	the	other.

6.		Debug



TrackLayer	provides	tools	for	checking	your	work.		Diagnostics	can	spot	overlapping
junctions,	zero-length	tracks,	and	other	problems,	so	that	you	can	fix	them	before	anyone
derails.

7.		Annotate	and	save

Give	the	layout	a	name,	add	descriptive	or	historical	comments	and	credit	to	the	designer,
then	save	the	file,	and	you're	ready	to	run.	

8.		Add	trains	and	enjoy

Actually	you	can	add	trains	at	any	point	during	the	building	process,	and	drive	them	over
whatever	track	is	available.

	



			Dimensions

The	first	part	of	the	process	of	developing	a	layout	in	TrackLayer	is	to	specify	its
size	and	dimensions.		This	is	done	by	overlaying	the	image	with	a	grid	of	standard
size,	as	described	in	this	chapter.

For	background	on	layout	dimensions	and	scaling,	see	About	Sizes	and	Scales	in
the	TrainPlayer	part	of	the	manual.

About	the	Grid

Adjusting	the	Grid

Resizing	and	Rescaling



About	the	Grid

The	grid	in	TrainPlayer	is	an	adjustable,	scale-independent	measuring	device,
showing	the	relation	between	distances	on	the	screen	and	those	on	a	real-world
layout.	It	is	based	on	the	scheme	described	in	101	Track	Plans,	in	which	any
plan	can	be	used	for	any	modelling	scale.	In	TrainPlayer,	the	concept	is	the
same,	but	details	are	adjusted	for	more	accuracy;	see	About	Sizes	and	Scales.

To	turn	the	grid	display	on	or	off,	use	the	Track	Grid	button	on	the	View
subtoolbar	=>	

If	you	are	creating	a	new	layout	by	drawing	track	on	top	of	a	pre-drawn	image,	you	will	need	to
specify	the	real-world	dimensions	of	the	image.		This	is	done	as	described	in	Adjusting	the
Grid.



Adjusting	the	Grid

These	instructions	apply	to	the	TrackLayer	user	who	is	creating	a	layout	based	on	a	pre-drawn
image.		To	specify	how	the	image	maps	to	real-world	dimensions,	you	adjust	the	spacing
between	grid	lines.		If	the	plan	has	a	drawn	grid	(e.g.,	any	of	the	101	Track	Plans),	you	will
need	to	adjust	the	TP	grid	to	match	it;	if	not,	you	resize	the	grid	until	the	overall	dimensions	of
the	layout	are	what	you	want.

The	grid	has	an	anchor	point	which	stays	put	as	you	drag.		This	point	is	at	the	intersection	of
two	red	grid	lines,	initially	at	the	upper	left	of	the	layout.

To	adjust	the	grid:

1.	 Turn	on	grid	display	if	necessary.		Use	the	Track	Grid	button	on	the	View	subtoolbar.
2.	 Select	the	Track	Edit	tool	on	the	Build	toolbar.
3.	 Point	to	a	grid	line	or	intersection	point,	press	and	drag.		This	resizes	the	grid	relative	to

the	anchor	point.
4.	 	If	you	are	dragging	a	corner,	grid	squares	remain	square;	dragging	a	line	generates	a

non-square	grid.
5.	 If	you	press	Shift	while	dragging,	the	entire	grid	shifts,	including	the	anchor	point.		This	is

helpful	if	you	are	trying	to	overlay	a	drawn	grid.
6.	 To	check	the	dimensions	after	adjusting:	right-click	and	choose	Properties,	and	check	the

overall	dimensions.

Overlaying	the	TP	grid	on	a	printed	plan Overall	size	changes,	as	shown	in
Properties



			Straight	Track	and	Switches

The	electronic	track	on	a	TrainPlayer	layout	is	like	sectional	track	from	the	hobby	shop.		It
consists	of	an	interconnected	set	of	line	segments,	mostly	straight	but	some	curved.		The	point
where	two	segments	join	together	is	a	"junction,"	and	the	train	rolls	right	across	it.		The	point
where	three	or	more	segments	meet	is	a	"switch,"	which	you	can	"throw"	to	choose	between
alternate	routes.

Unlike	sectional	track,	TrainPlayer	track	segments
can	be	any	length,	and	joined	at	any	angle.		Switches	can	have	any	number	of	branches.		Track
segments	can	have	special	properties,	like	the	ability	to	hide	the	train,	or	cause	it	to	jump
instantly	from	one	end	to	the	other.		And,	of	course,	TrainPlayer	track	never	needs	cleaning.

Straight	track	is	easy	to	work	with	--	you	just	draw	a	series	of	line	segments,	and	you're	ready
to	drive	trains.		Draw	three	or	more	tracks	to	the	same	point	and	you	automatically	get	a
working	switch.		Since	you	can	draw	any	curve	as	a	series	of	short	straight	segments,	it	is
possible	to	build	the	entire	layout	using	nothing	but	straight	track,	but	you'll	get	better	results	if
you	take	the	trouble	to	learn	about	curves	too.

Before	you	work	on	a	real	layout,	we	suggest	you	start	with	a	blank	screen	and	learn	some	of
the	basic	drawing	operations.		The	tool	you	use	most	in	TrackLayer	is	the	Straight	Track	tool		
,	used	for	creating	straight	track	segments	and	switches.		Since	curves	can	be	represented

by	a	series	of	short	segments,	you	can	build	the	entire	layout	with	the	Straight	Track	tool,
although	you'll	get	better	results	if	you	learn	to	make	curves	as	described	in	the	next	chapter.	
In	this	chapter	we	describe	how	to	create	straight	track.

Drawing	Straight	Track	and	Switches

Editing	Track

Special	Track



Drawing	Straight	Track	and	Switches

To	draw	straight	track:

1.	 Choose	the	Straight	Track	tool		 .
2.	 Press	the	mouse	button	where	you	want	one	end	of	a	track	segment.
3.	 Drag	to	where	you	want	the	other	end,	release	the	button.

You	have	a	point-to-point	railroad!		If	you	wanted	to,	you	could	add	a	train	and	start
operating.

Note:	if	you	want	a	perfectly	horizontal	or	vertical	track,	press	Ctrl	as	you	drag.		See
below	for	details.

4.	 Position	the	cursor	on	one	endpoint,	so	it	highlights	with	a	little	green	square	(see	picture
above	right).

5.	 Press	and	drag.
	

You	now	have	a	continuous	section	of	road	with	a	bend	in	the	middle.

6.	 And	so	on.		You	can	draw	segments	in	any	order	and	any	direction	--	they'll	join	together
as	long	as	the	highlight	square	is	showing	when	you	press	or	release	the	mouse	button.

To	draw	a	switch:

A	switch	is	automatically	created	whenever	three	tracks
join.		This	happens	when	you	begin	or	end	drawing	a
segment	at	either	an	existing	junction	or	a	point	along	an
existing	track.	

To	draw	the	switch	shown	here:

1.	 Draw	the	mainline	in	two	segments,	A-B	and	B-C.
2.	 Draw	the	branch	in	either	direction,	B-D	or	D-B.		Junction	B	highlights	when	you	begin	or

end	drawing	the	branch.



OR:

1.	 Draw	the	mainline	in	one	segment,	A-C.
2.	 Draw	the	branch	in	either	direction,	B-D	or	D-B.		The	track	segment	AC	highlights	when

you	begin	or	end	at	B.		Junction	B	is	created	by	this	operation,	chopping	AC	into	two	parts.

As	soon	as	you	release	the	mouse	button	using	either	method,	the	switch	is	created	and	the
stop/go	lights	appear.		You	can	test	the	switch	by	clicking	at	B.

To	draw	a	multi-way	switch:

Simply	draw	more	than	three	segments	to	a	switch.	
Whenever	more	than	three	segments	join,	a	multi-way	switch
is	formed	with	more	than	two	routes	through	it.		Each	throw
opens	a	different	route.

In	this	picture,	the	current	open	route	is	A-B-D.		The	first	throw	opens	route	A-B-C;	the	second,
E-B-D;	the	third	goes	back	to	A-B-D.

To	draw	a	crossing:

Draw	tracks	which	cross	but	do	not	join.		In	this	example,	AB	and
DC	cross	each	other,	but	there	is	no	junction	in	common,	so	trains
cannot	go	from	one	track	to	the	other.

Track	Snap

Snap	features	assist	you	in	drawing	precise	switches	and	curves.

Snap	takes	effect	only	when	you	are	drawing	new	track,	not	editing	or	moving	existing
sections.		By	default	it	is	disabled,	as	it	tends	to	get	in	the	way	when	you	are	tracing	over	an
existing	plan.		But	when	you	are	drawing	a	new	layout	from	scratch,	it	is	invaluable.		Enable	it
as	follows:



1.	 Set	up	your	choices	in	Track	Preferences.		Here	you	specify	what	sorts	of	snap	you	wish
to	enable,	and	at	what	angles	or	radii,	as	shown	above	left.

2.	 Use	the	Track	or	Circle	tool.		Snap	does	not	apply	when	using	other	tools.

3.	 Use	the	Snap	Disable/Enable	command	on	the	layout	context	menu	(above	right)	to	turn
snap	off	and	on	as	needed	while	drawing.	

4.	 When	angle	or	parallel	snap	is	in	effect,	you	can	disable	it	temporarily	by	pressing	Shift	as
you	draw.

There	are	three	kinds	of	snap:

To	angle:	applies	when	you	are	creating	a	new	switch.		Restricts	the	switch	angle	to	one
of	up	to	four	choices.

Refer	to	the	diagram	above.		After	you	have	drawn	section	AC	and	want	to	create	a	switch
at	B,	angle	snap	takes	effect	when	you	press	at	B	and	drag	toward	D	(but	not	if	you	drag
from	D	toward	B).		As	you	drag,	when	the	angle	DBC	gets	close	to	one	of	the	predefined
values,	it	snaps	to	that	angle.

Switch	angles	are	given	not	in	degrees	or	radians,	but	as	integers.		The	integer	indicates
the	slope,	or	ratio	of	"rise	over	run"	between	diverging	tracks.		For	example,	at	a	#4
switch,	the	tracks	are	one	unit	apart	at	a	distance	of	four	units	from	the	frog.

To	parallel:	applies	when	you	are	creating	a	new	switch	in	the	vicinity	of	another.	
Restricts	the	distance	between	parallel	tracks	to	a	specific	value.

Parallel	snap	is	designed	for	creating	ladder	tracks,	such	as	those	shown	in	the	diagram
above.		Once	you	have	drawn	the	base	section	and	the	branch,	you	create	each	ladder
track	by	pressing	on	the	branch	and	dragging	away	from	it.		When	parallel	snap	is	in
effect,	the	starting	endpoint	of	a	new	track	is	not	exactly	where	you	press,	but	snapped	to
a	nearby	point	such	that	the	distance	between	the	new	track	and	its	neighbor	is	a	fixed
value	(default	is	2"	in	HO).

To	radius:	applies	when	you	are	creating	a	circle.		Restricts	the	radius	to	one	of	up	to	four
choices.

When	you	are	using	the	Circle	tool,	and	dragging	without	the	shift	key	pressed,	then	you
are	adjusting	the	radius	of	a	circle	as	you	drag.		When	radius	snap	is	in	effect,	if	the	radius
is	near	one	of	the	predefined	values,	it	snaps	to	that	value.		

More	details	about	snap	features	are	given	in	Track	Preferences.

Drawing	Straight	Horizontal/Vertical	Track

To	draw	perfectly	horizontal	or	vertical	track	when	using	the	Straight	Track	tool,	hold	down
CTRL	as	you	drag.		This	restricts	the	line	to	one	direction	or	the	other,	depending	on	the



direction	you	are	dragging.		(Be	sure	to	keep	Ctrl	pressed	until	after	you	release	the	mouse
button.)

As	mentioned	above,	pressing	SHIFT	as	you	drag	is	a	way	to	temporarily	avoid	angle	and	other
snap	actions.		As	a	reminder,	as	soon	as	you	press	the	mouse	button	you	get	a	message	on
the	status	bar:	

	

Track	Coloring

To	color	track,	create	a	road	style	and	apply	it	to	the	track.		See	Road	Styles.	

	

	

	



Editing	Track

If	you've	drawn	some	track	and	want	to	make	changes,	there	are	several	choices.		You	can
correct	a	mistake	by	undoing	it.		You	can	delete	a	single	track	object	--	track	segment,	curve,
circle,	turntable	--	by	point-and-press,	or	you	can	select	several	and	delete	them	all	at	once.	
You	can	move	or	resize	track	objects,	or	copy	them	from	one	place	and	paste	them	into
another.

Once	a	network	of	track	is	laid	and	interconnected,	it's	a	little	tricky	to	move	it	around	without
fouling	something	up.		This	is	especially	true	where	curves	are	involved	--	the	program	attempts
to	keep	straight	segments	tangent	to	their	curve	arcs,	and	this	can	restrict	movement.

Undo/Redo

If	you	make	a	mistake,	the	easiest	and	safest	way	to	fix	it	is	to	immediately	undo	it.		To	undo
the	latest	drawing	or	editing	operation:

1.	 Choose	Edit	Undo	<,	or	press	Ctrl-Z.		The	last	operation	is	undone,	and	the	layout	reverts
back	to	its	previous	state.		The	menu	command	includes	the	type	of	operation	which	will	be
undone,	e.g.,	Undo	New	Track.

2.	 You	can	use	the	command	repeatedly	to	undo	earlier	operations.		There	is	no	limit	on	the
number	of	undo's	--	you	can	go	all	the	way	back	to	the	blank	screen	or	the	file	you	started
with.

3.	 If	you	change	your	mind,	use	Edit	Redo	(Ctrl-Y)	to	undo	the	last	undo.

Undoable	operations	include	deleting,	adding,	or	moving	track,	circles,	stations,	or	turntables,
and	changing	most	track	properties.		Train	moves	are	not	undoable,	nor	changes	made	in	the
Properties	dialog.

Deleting	objects

You	can	delete	a	single	object	--	track	segment,	circle,	or	turntable	--	by	point-and-press,	as
follows:

1.	 Choose	the	Track	tool	 	or	the	Edit	tool	 .
2.	 Position	the	cursor	on	the	segment	or	object	to	be	deleted,	so	it	highlights	(see	A).		On	a

circle	or	turntable,	point	to	a	spot	on	the	circumference	of	the	circle.
3.	 Press	the	Del	key,	or	right-click	and	choose	Delete,	Delete	Track,	or	Edit	Cut	from	the

context	menu.		Note	that	context	menus	differ	depending	on	what	type	of	object	is
highlighted.



When	you	delete	a	turntable	or	its	bridge	track,	both	the	circle	and	the	track	are	deleted.

To	delete	multiple	tracks	or	objects:

1.	 Select	the	objects	as	described	below.
2.	 Delete	with	the	Del	key	or	a	menu	command,	as	in	step	3	above.

Selecting	objects

To	move	or	delete	a	collection	of	objects,	you	must	first	select	the	ones	to	be	modified.		You
can	choose	them	one	at	a	time,	or	several	at	once	by	dragging	a	selection	box.

To	select	individual	objects:

1.	 Choose	the	Edit	tool	 .
2.	 Click	a	track	segment,	circle,	or	turntable.		The	object	is	selected,	and	turns	navy	blue.
3.	 To	select	another	object,	press	Shift	and	click	the	object.
4.	 To	unselect	a	selected	object,	press	Shift	and	click	the	object.

To	unselect	all	objects:		click	an	empty	spot	on	the	layout.

To	select	all	objects:	choose	Edit	Select	All	or	press	Ctrl-A.

To	select	all	objects	in	a	given	region:

1.	 Choose	the	Edit	tool	 .
2.	 Press	and	drag	to	form	a	selection	rectangle	(see	B).		Any	track	or	object	intersecting	the

rectangle	is	highlighted	in	green.		It	is	not	necessary	for	the	track	or	object	to	be
completely	enclosed	by	the	rectangle.

3.	 Release.		Highlighted	track	becomes	selected	(see	C).



If	you	hold	down	the	shift	key	while	dragging,	the	newly-selected	items	will	add	to	the
previous	selection.

Moving	objects

Once	a	network	of	track	is	laid	and	interconnected,	it's	a	little	tricky	to	move	it	around	without
fouling	something	up.		One	simple	and	safe	operation	is	to	move	a	track	endpoint	or	junction.

To	move	a	track	endpoint	(shown	in	D):

1.	 Choose	the	Edit	tool	 .
2.	 Position	the	cursor	over	the	endpoint	you	want	to	move,	so	you	see	the	green	highlight

square.
3.	 Press	and	drag.		The	endpoint	moves,	the	other	end	remains	anchored.

To	move	a	junction	or	switch	(shown	in	E):

1.	 Choose	the	Edit	tool	 .
2.	 Position	the	cursor	over	the	junction	or	switch	you	want	to	move,	so	you	see	the	green

highlight	square.
3.	 Press	and	drag.		The	junction	or	switch	moves,	the	other	ends	of	all	attached	tracks

remain	anchored.

To	move	a	collection	of	track	and/or	other	objects	(shown	in	F):

1.	 Select	the	tracks	and	objects	to	be	moved,	by	shift-clicking	or	dragging	a	selection
rectangle.

2.	 Point	to	any	of	the	selected	tracks	or	objects,	press	and	drag.



All	selected	tracks	and	objects	move	as	a	unit.		Attached	tracks	which	are	not	selected	are
repositioned	so	as	to	remain	attached.

In	this	example,	five	segments	in	a	yard	are	all	being	moved	at	once.		One	end	of	the	yard
lead	track	remains	fixed,	the	other	end	moves	with	the	selection.		The	resulting	angles	are
not	train-friendly.

Copy/Paste

Selected	objects	--	tracks,	circles,	turntables	--	may	be	copied	to	the	TrainPlayer	clipboard	and
then	pasted	elsewhere	on	the	layout	or	in	another	layout.		These	objects	cannot	be	pasted	into
other	programs.

To	copy	a	collection	of	objects:

1.	 Select	the	objects	as	described	previously.
2.	 Right-click	any	object	and	choose	Copy,	or	choose	Edit	Copy	from	the	main	menu,	or

press	Ctrl-C.		The	objects	are	copied	to	the	clipboard.

To	paste	copied	objects:

1.	 Choose	Edit	Paste	from	the	main	menu,	or	press	Ctrl-V.		Objects	on	the	clipboard	are
added	to	the	layout	in	the	upper	left	corner,	and	are	selected	so	that	you	can	drag	them
into	position.

Pasted	objects	do	not	automatically	connect	to	existing	track,	even	if	you	position	them	so
it	looks	like	they	should.		To	connect	pasted	track	with	existing	track,	you	can	delete	and
redraw	a	segment,	or	you	can	drag	one	junction	on	top	of	another	and	they	will	"fuse."

Track	Transform,	Rotate,	Flip

A	selection	of	track	can	be	rotated	by	an	arbitrary	angle,	or	flipped	horizontally	or	vertically.

To	rotate	or	flip	track:

1.	 Select	one	or	more	track	sections.		To	select	an	entire	area	(such	as	a	yard),	you	can	start
by	dragging	a	selection	rectangle	around	the	area,	then	shift-click	to	include	or	exclude
individual	sections.



2.	 Right-click	a	selected	section	and	choose	a	Transform	Selection	command,	Flip	or
Rotate.	

					

To	rotate	by	an	arbitrary	angle,	choose	Rotate...	and	enter	an	angle	in	the	dialog.		A
positive	value	rotates	clockwise.

The	selected	tracks	are	rotated	or	flipped	about	the	center	of	the	rectangle	enclosing	the
selection.		If	there	are	adjacent	unselected	tracks,	these	will	be	reoriented	as	necessary	to
remain	connected.		For	example,	here	is	a	rotation	of	-10	degrees	on	a	selected	yard:

Junctions	shown	in	red	remain	fixed,	while	those	touching	the	selected	tracks	move.

Transform	Selection	is	undoable,	so	you	can	experiment	with	it,	then	undo,	and	nothing	will	be
harmed.

Ties	and	Roadbed

If	you	want	to	add	ties	and/or	roadbed	to	your	track,	see	Road	Styles.



Special	Track

Once	you	have	some	track	down,	you	can	mark	sections	of	it	to	have	special	properties.		A
section	can	be	marked	as:

Hidden	track.		When	a	train	passes	over	a	section	marked	Hidden,	the	cars	become	thin
outlines.		This	simulates	passing	through	a	tunnel	or	a	section	of	track	underneath	the
layout.		Hidden	track	is	shown	on	the	layout	as	dashed	lines.		You	specify	this	type	by
choosing	Hidden	>	With	Car	Outlines	from	the	track	context	menu.

Hidden	track	with	hidden	cars.		If	you	choose	Hidden	>	No	Car	Outlines,	then	cars	disappear
completely	when	they	pass	over	this	section	of	hidden	track.

Tunnel	track.		When	a	train	enters	one	end	of	a	section	of	tunnel	track,	it	"tunnels	through"
and	immediately	begins	to	emerge	at	the	other	end.		Tunnel	track	is	used	when	the	layout
has	multiple	images,	for	example	a	separate	picture	for	upper	and	lower	levels.		As	soon
as	the	train	leaves	the	upper	level	diagram,	it	appears	at	the	corresponding	place	on	the
lower	level	diagram,	as	long	as	the	exit	and	entry	points	are	connected	by	a	length	of
tunnel	track.		Tunnel	track	is	shown	on	the	layout	as	light	grey	lines,	visible	only	when	the
Track	Tool	is	in	use.

This	illustration	shows	tunnel	track	(hard	to	see)	connecting	levels	of	the	helix	in	John
Armstrong's	Southern	Pacific	Shasta	Division,	from	Model	Railroader,	Apr	2005:

	

Tunnel	track	is	also	used	to	specify	"clipping	regions."		See	details	below.

Untouchable	track.		When	track	is	marked	Untouchable,	it	becomes	like	the	background	-
-	it	cannot	be	selected	or	moved	or	highlighted.		This	is	an	advanced	feature.		Untouchable
track	is	used	for	building	helices	or	other	constructions	requiring	curves	right	on	top	of	each
other;	for	a	step-by-step	procedure,	see	Helices.



Linked	track.		You	can	mark	a	stub	section	of	track	as	"linked,"	and	connect	it	to	another
layout.		When	the	train	reaches	that	stub,	it	"jumps"	to	the	other	layout	and	continues	on	its
way.		Details	below.

No	ties	or	roadbed.		Track	with	this	mark	are	excluded	when	displaying	ties	or	roadbed.	

Double	track.		Choose	a	set	of	tracks	and	clone	them	to	get	parallel	double	track.		See	Double	Track
below.

Overpass	track.		This	track	sits	on	top	of	all	others,	and	hides	trains	passing	beneath.		See
Overpass	Track	below.

Split	Track	Here

For	various	reasons,	the	you	sometimes	need	to	introduce	a	junction	into	a	straight	or	curved	section	of
track.	In	the	past	this	was	done	as	described	under	Isolating	Track	below;	as	of	v.	5.3	it	can	be	done
directly,	like	this:

1.	Use	the	Track	Edit	tool.

2.	Right-click	a	point	along	a	track	where	you	want	to	create	a	junction,	and	choose	Split	Track	Here.

The	track	is	split	and	a	junction	created	at	the	indicated	point.	There	is	no	immediate	visible	evidence	of
this,	but	you'll	see	the	new	junction	if	you	hover	over	it.	The	operation	is	undoable.	Works	on	both
straights	and	curves.

Isolating	Track

Most	of	these	properties	can	be	applied	only	to	one	or	more	complete	segments	of	track.		To
apply	a	property	to	a	portion	of	a	track	segment	or	curve,	you	must	first	isolate	that	portion	by
chopping	it	out.

Note:	while	these	instructions	are	still	valid,	most	steps	are	obsolete.		You	no	longer	need	to	introduce	a
temporary	track	in	order	to	split	a	segment;	instead,	use	Split	Track	Here.

To	isolate	a	section	of	track:

Say	you	want	to	isolate	the	portion	of	this	curve
between	the	hash	marks.		You	can	see	the	full



extent	of	the	original	curve	by	highlighting	it.

Use	the	Track	tool	 	for	this	procedure.

1.		Draw	a	straight	segment	touching	the	curve
where	you	want	the	first	chop	point.	

2.		When	you	release,	a	switch	is	formed.

3.		Repeat,	drawing	another	segment	at	the
other	chop	point.

4.		Point	to	one	segment	and	press	Del.		The
segment	and	switch	disappear.	

5.		Repeat	for	the	other	segment.

6.		A	small	portion	of	the	original	curve	is	now
isolated	between	two	new	junctions.



Modifying	Track

1.	 If	necessary,	isolate	the	segment	of	track	to	be	hidden.		This	is	not	necessary	if	you	want
to	hide	one	or	more	entire	segments.

2.	 Point	to	the	segment	to	be	hidden,	so	it	highlights,	then	press	the	right	mouse	button.
3.	 Choose	Hidden	from	the	context	menu.

							

The	track	is	redrawn	as	a	dashed	line.		Trains	passing	over	this	dashed
section	will	appear	hidden.

To	create	a	section	of	tunnel	track:		the	procedure	is	the	same:	draw
the	track	or	isolate	it,	right-press	and	choose	Tunnel.		When	a
contiguous	series	of	track	segments	are	marked	Tunnel,	the	train
hyperspaces	across	all	of	them	at	once.

To	mark	a	section	of	track	untouchable:		same	procedure	again.		Be	careful	when	you	use
this	feature!		Once	a	section	is	marked	untouchable,	you	can	no	longer	select	it,	move	it,	delete
it,	create	a	switch	or	junction	in	it,	change	its	properties,	or	connect	any	other	track	to	it	--	it
becomes	dead.		Make	sure	the	track	is	fully	connected	and	its	properties	set	before	you	mark
it	untouchable.

To	reenable	an	untouchable	section:	right-press	any	track	and	choose	All	Retouchable.		This
reverts	all	untouchable	track	to	its	normal	state.

Clipping	Regions

Hidden	track	works	fine	for	long	tunnels,	but	for	short	sections	going	beneath	underpasses	or
behind	scenery,	a	better	scheme	is	required.		In	TrainPlayer,	tricks	involving	track	marked
Tunnel	are	used	to	hide	specific	areas.

Note:	as	of	Version	7.1,	you	may	be	able	to	skip	this	section.		If	what	you	are	trying	to	do	is	create	an
overpass,	you	can	now	do	it	with	one	checkbox	--	see	Overpass	Track	below.



These	tricks	can	be	used	to	indicate	clip	angles	at	tunnel	portals,	or	to	define	regions	of
invisibility.

Tunnel	portal	clipping:
where	the	train	is	moving
between	hidden	and	normal
track,	and	needs	to	be
clipped	to	a	specific	angle.

For	this	effect,	draw	a
section	of	Tunnel	track
passing	over	the	junction
between	hidden	and	normal
track.		This	section	defines
the	clip	angle.

The	tunnel	track	section
must	not	be	connected	to
anything	else,	must	not
form	a	switch	with	the	track
it	crosses,	and	must	pass
directly	over	the	hidden-to-
normal	junction.

										

Overpass	clipping:	where
the	train	is	to	be	completely
hidden	as	it	passes	through
a	given	region.

For	this	effect,	draw	a
"clipping	box"	surrounding
each	area	to	be	hidden.

A	box	must	consist	of
exactly	four	connected



track	segments,	all	marked
Tunnel.

As	a	shortcut,	you	can
shift-click	to	select	all
segments	at	once,	then
point	to	any	one	and
choose	Tunnel	from	the
context	menu.

Boxes	appear	as	dotted
gray	lines,	shown	only
when	Track	or	Edit	tool	is
active.	

When	trains	pass,	the
portion	within	each	clip	box
is	completely	hidden.

Over-underpass	regions:
where	trains	going
underneath	are	to	hide,
trains	on	top	to	remain
visible.

For	this	effect,	first	draw	a
clipping	box	as	above,
defining	the	hidden	region.

Then	identify	the	track(s)	to
be	on	top,	where	trains	are
to	remain	visible.		To	do
this,	introduce	a	junction
where	any	top	track
crosses	the	clip	box



boundary.

Best	procedure	is:	(a)	mark
the	tunnel	track	as
Untouchable;	(b)	draw	a
temporary	segment	to	the
point	where	you	want	the
junction;	(c)	delete	the
segment.

This	junction	serves	no
purpose	except	to	flag	a
track	as	being	on	top.		All
other	track	"electrically
connected"	to	the	junction	is
also	on	top.

Trains	passing	on	top
tracks	remain	visible,	while
those	on	non-top	tracks	are
clipped.

Linked	Layouts

It	is	possible	to	set	up	a	link	between	two	layouts	such	that	when	a	train	drives	off	of	one,	it	lands	on	the
other.	Pick	any	stub	or	siding,	specify	a	target	layout	or	remote	track,	drive	off	the	siding,	and	poof!	the
scene	changes	and	you	are	running	the	same	train	in	a	different	place.		Great	for	connections	between
multi-level	layouts,	N-Trak	modules,	or	just	cruising	randomly	through	your	layout	collection.

This	feature	was	introduced	in	version	2.1	(2005)	and	not	improved	until	8.1	(2021),	when	it	was
extensively	reworked	to	offer	these	improvements:

A	train	in	the	process	of	jumping	from	one	layout	is	no	longer	in	a	fragile	state	--	it	can	couple	or
uncouple	anywhere	on	either	layout
A	train	can	be	hand-dragged	across	a	link	--	push	one	end	across,	then	grab	the	other	end	and	pull
Cars	and	trains	crossing	to	a	new	layout	are	automatically	renumbered	as	necessary	to	prevent
duplicate	ids
Focus	remains	with	the	selected	train	and	its	window	as	it	moves	between	layouts
Images	are	clipped	for	smoother	appearance	during	jumps
A	link	need	not	go	to	a	different	layout,	but	instead	may	land	on	another	track	on	the	same	layout
Various	enhancements	allow	scripts	to	work	in	multi-layout	systems



The	dialog	for	configuring	links	is	improved,	and	now	available	from	Track	Properties

A	detailed	description	of	the	new	8.1	features	is	given	in	the	PDF	document	on	the	web:	Introduction	to
Linked	Layouts.	That	document	includes	instructions	for	creating	multi-layout	scripts.

To	link	layouts:

1.	 Choose	the	jumping	off	point.		This	must	be	a	"stub"	track,	one	with	no	connections	on	one
end	(e.g.	a	siding	or	yard	track).		When	the	train	reaches	the	end	of	this	track,	it	will	begin
its	jump	to	the	linked	layout.

				

2.	 With	the	Edit	or	Track	tool	selected,	right-click	the	track	section	and	choose	Advanced	>
Link	to	Layout.		(Alternatively,	choose	Properties,	then	click	the	Link	button	--	see	Track
Properties).		The	Layout	Link	dialog	appears.

3.	 Choose	the	target	layout.		In	the	Link	to	document	box,	enter	the	path	to	a	layout	file,	or
use	the	Browse	button	to	navigate	to	one.		Or,	if	the	layout	is	already	open	in	another
window,	choose	it	from	the	drop-down	menu.		Choose	Self	Link	from	the	drop-down	if	you
want	to	link	the	selected	track	to	another	on	the	same	layout.

4.	 Assign	a	"Link	ID."		The	Link	ID	is	a	label	used	to	connect	this	track	to	a	specific	track	on
the	target	layout.		In	the	example,	this	particular	jump-off	point	is	called	A.		When	the	train
jumps	from	this	point	onto	the	target	layout,	if	it	finds	a	linked	track	called	A,	it	will	land
there.		If	it	does	not	find	a	matching	label,	it	will	jump	to	an	arbitrary	place.		Thus,	in	order
to	set	up	a	precise	jump,	you	will	need	to	follow	this	same	procedure	on	both	layouts.

5.	 Click	OK,	and	the	link	is	set	up.		The	link	label	is	displayed	on	the	track	as	a	boxed	letter
(shown	at	right),	and	the	track	tooltip	gives	the	link	label	and	target.

Note:	layout	links	are	also	shown	by	special	symbols	in	Map	View.

https://trainplayer.com/Features/Version81/LinkedLayouts.pdf


6.	 Drive	(or	hand-drag)	a	train	onto	the	linked	track,	and
keep	going	as	if	you	were	driving	right	past	the	stub.	
The	train	will	begin	the	jump.	The	target	layout	will	be
automatically	opened	if	necessary,	and	will	be	brought
to	the	front	and	activated	(assuming	the	jumping	train	is
selected);	cars	will	be	renumbered	if	necessary	and
moved	to	a	new	train	on	the	target	layout.

7.	 While	the	train	is	jumping,	you	may	change	its	speed	or
direction,	and	both	parts	will	move	together.

To	unlink:

1.	 Right-click	a	linked	track	section,	toggle	Advanced	>	Link	to	Layout	to	uncheck	it.	
Alternatively,	uncheck	the	Link	box	in	Track	Properties.

Double	Track

If	you've	ever	tried	to	create	a	length	of	parallel	double	track	--say	for	a	passing	track	or	a	double-track
section	of	main	line	--	you	know	it's	not	easy,	especially	if	curves	are	involved.	Now	a	feature	introduced
inTrackLayer	5.3	does	the	engineering	for	you.	Here's	how	to	use	it:

1.	Use	the	Track	Edit	tool.	Click	or	shift-click	to	select	one	or	more	track	segments,	defining	the	stretch
you	want	to	double.

2.	Right-click	any	selected	track	and	choose	Make	Double	Track.

The	entire	selection	splits	in	two,	joined	at	the	ends	by	Y	switches:

										 ==>



While	doubling	works	over	an	arbitrary	selection,	for	best	results	you	should	be	careful	to	select	a
contiguous	set	of	tracks	between	two	well-chosen	endpoints,	with	no	switches	in	the	selection.	If	you	try
it	and	don't	like	the	results,	use	Edit	>	Undo.

The	distance	between	parallel	tracks	is	taken	from	the	default	layout	road	style	rail	separation;	see	Road
Styles.

Note:	Make	Double	Track	is	dimmed	unless	you	have	already	selected	some	track,	i.e.,	turned	it	blue.		It
won't	work	just	to	point	at	a	track	and	press	the	right	mouse	button.

Overpass	Track

As	of	Version	7.1,	you	can	with	one	click	designate	a	length	of	track	as	"overpass."		This	means:

the	overpass	track	and	its	roadbed,	ties,	and	rails	are	drawn	on	top	of	any	other	track	or	scenery

trains	passing	on	top	of	the	overpass	are	fully	visible*

trains	passing	below	the	overpass	are	hidden	as	they	go	under

*	Or	not.		Overpass	track	is	subject	to	the	same	visibility	properties	as	normal	track.		You	can	for
example	make	an	overpass	be	hidden	track	with	cars	invisible.

To	turn	a	section	of	track	into	overpass,	just	select	the	track	and	apply	the	Overpass	checkbox	in	Track
Properties.		You	do	not	need	to	define	a	road	style	or	set	up	clip	boxes.		If	you	wish	you	can	provide	a
RoadStyle	with	a	custom	trackbed	to	represent	the	Overpass	deck	but	this	is	not	essential.



Note:	using	overpass	track	is	the	best	way	to	create	a	turntable	bridge.		Mark	as	Overpass	the	bridge	track
and	a	short	segment	on	each	external	connection,	as	shown	below.		Then	you	can	(a)	attach	a	scenery
object	on	the	bridge	(see	Bridge	Scenery	on	the	Transfer	Table	page);	or	(b)	create	a	special	road	style	to
represent	the	bridge	(see	Road	Styles).		Either	way,	the	train	stays	on	top.



Track	Properties

Properties	of	the	selected	or	right-clicked	track	section(s).	Called	from	Properties	on	the	Track
context	menu.

The	Track	Properties	dialog	shows	properties	of	one	or	more	sections	of	straight	or	curved
track.		It	allows	you	to	override	general	track	style	preferences	and	apply	different	styles	to
particular	sections.		This	dialog	does	not	apply	to	circles	or	turntables.

This	dialog	is	modeless	--	it	remains	up	while	you	click	around	the	layout.		When	you	change
the	selected	track,	the	properties	of	the	new	selection	are	displayed	and	can	be	modified
without	dismissing	the	dialog.

Dialog	controls:

ID	/	type
Track	section	integer	ID	and	track	type	(Straight	or	Curve).		Read-only.		If
multiple	sections	are	selected,	the	ID	field	displays	a	list	of	id's,	the	type	field
a	mixture	of	types	if	applicable.

Length	/	Radius Length	of	track	section,	with	radius	if	curve.		For	multiple	selections,	no	value
is	shown	unless	it	is	the	same	for	all	selected	sections.		Read-only.

Jxns IDs	of	junctions	at	each	end	of	track	(single	selection	only)

Label A	user-supplied	string	of	text	for	identifying	the	track	section;	see	below.

Hide	Label Check	this	box	to	prevent	displaying	label	on	track.

Style
Name	of	the	road	style	attached	to	selected	track.		First	choice	is	always
Default,	last	calls	up	Road	Styles	dialog;	in	between	are	names	of	custom
styles.		See	Road	Styles.



Untouchable

Untouchable	marks	the	selected	section	as	inert	so	it	cannot	be	modified	by
any	track	tools.	This	can	also	be	set	using	the	Untouchable	command	on
the	Track	context	menu.		To	restore	an	untouchable	track	to	normal,	use	the
checkbox	in	this	dialog	(to	restore	the	selected	track)	or	choose	All
Retouchable	from	the	context	menu	(to	restore	all	untouchable	track).

Overpass Check	this	box	to	make	the	selected	track(s)	into	overpasses,	on	top	of	other
tracks	and	trains.		See	Overpass	Track.

Link
A	check	means	this	track	is	linked	to	another	track,	on	this	or	another	layout.	
If	checked,	click	the	more	button	(...)	to	create	or	configure	the	link	in	the
Layout	Link	dialog.

Units Units	of	length	and	radius.		Changes	to	this	combo	affect	Units	combos	in
other	dialogs.

Visibility
Normal,	hidden,	or	tunnel.		You	can	see	and	change	the	type	of	the	selected
section(s)	here	in	this	dialog;	alternatively,	use	Hidden	or	Tunnel
commands	on	the	Track	context	menu.

On	HIdden	Track
If	Hidden	is	chosen	as	the	track	type,	then	this	radio	specifies	how	cars	are
to	be	displayed	as	they	go	over	the	hidden	track:	(a)	outlined	=	thin	black
lines	outline	the	car	tops;	(b)	invisible	=	cars	are	completely	hidden;	(c)
visible	=	cars	are	drawn	normally.

Track	and	Junction	Labels

You	may	attach	a	string	of	text	to	a	track	section	or	junction,	as	a	way	of	identifying	that
location.		The	label	can	be	referenced	in	scripts	or	used	in	certain	dialogs	as	a	way	of	locating
the	track	or	junction.		It	is	typically	used	in	conjunction	with	the	car	Dest	property	to	indicate
where	a	car	is	to	be	spotted.

A	track	label	is	normally	displayed	at	the	center	of	the	track	section.		Font	and	color	can	be	set
in	Track	Preferences	.		Display	of	the	label	can	be	suppressed	using	the	Hide	Label	checkbox.

To	label	a	track	section	by	hand,	right-click	it,	choose	Properties,	and	enter	a	string	in	the	Label
box

You	cannot	provide	a	junction	label	by	hand.		This	is	only	done	via	script	functions	(using
$TRACK,	$JXN,	$TURNTABLE	families).

When	you	supply	a	label	for	a	track	or	junction,	you	can	use	the	Highlight	Track	dialog	to	locate
that	object	by	label.



			Curved	Track

All	curves	in	TrackLayer	are	circular	--	if	you	want	splines	or	spiral	easements,	you	will	have	to
draw	them	by	hand	using	short	straight	segments.

A	curve	is	created	by	three	objects:	a	circle	and	two	"legs,"
like	a	horseshoe.		The	circle	establishes	the	radius	and
position	of	the	curve,	while	the	legs	establish	the	end	points
and	the	approach	tracks.

TrackLayer	goes	to	some	trouble	to	help	you	make	nice
curves.		The	program	keeps	the	leg	segments	exactly
tangent	to	the	circles,	both	when	drawing	and	editing.	

This	chapter	describes	how	to	draw	and	edit	curves	and
circles.

Drawing	a	Curve

Editing	a	Curve

Loops	and	S-Curves

Helices



Drawing	Curves

To	draw	a	curve,	first	you	place	the	circle,	then	attach	the	legs.		If	you	do	this	right,	the	circle
disappears	and	a	curved	track	is	generated	between	the	leg	segments.

To	draw	the	circle:

1.	 Choose	the	Circle	tool		 .
2.	 Press	the	mouse	button	near	where	you	want	the

center	of	the	circle.
3.	 Drag	to	adjust	the	circle's	radius.
4.	 To	move	the	circle	instead	of	resizing	it,	press	the

Shift	key	as	you	drag.
5.	 Continue	dragging,	toggling	the	shift	key	as

necessary,	until	the	circle	is	where	you	want	it;	then	release.

Note:	in	version	3.1	you	can	have	the	radius	snap	to	a	specific	value	as	you	drag;	see
Track	Preferences.

To	draw	the	first	leg:

1.	 Choose	the	Straight	Track	tool		 .
2.	 Position	the	cursor	on	the	circle	where	you	want	the	leg	to	join

the	curve.		The	circle	highlights.
3.	 While	the	circle	is	highlighted,	press	the	mouse	button.
4.	 Drag	to	where	you	want	the	other	end	of	the	leg.		While	you

drag	one	end,	the	other	end	adjusts	automatically	to	remain
tangent	to	the	circle.

You	can	draw	a	leg	in	either	direction,	either	starting	on	the	circle	or	ending	on	it.		Just	be	sure
that	before	you	press	or	release	the	mouse	button,	the	circle	is	highlighted	so	the	segment	will
connect.

To	complete	the	curve:

Draw	the	second	leg	as	you	did	the	first.	
This	time,	when	you	release	the	mouse
button,	the	circle	disappears	and	the	arc
section	between	the	two	legs	becomes	a
curve.	

When	the	train	comes	down	one	leg,	it	will
go	smoothly	into	and	around	the	curve	and
exit	on	the	other	leg.

Notes

All	curves	must	be	horseshoes.		That	is,	if	you	go	clockwise	from	leg	A	onto	the	curve,



then	you	must	also	go	clockwise	from	the	curve	onto	B.		In
other	words,	when	you	draw	the	second	segment,	don't
orient	it	backwards,	as	in	the	picture	at	right.

Avoid	crowds.		If	you	are	working	in	a	crowded	area,	and	a
track	end	happens	to	lie	near	the	rim	of	a	circle,	then	as	soon
as	you	draw	the	first	leg	to	that	circle,	it	will	automatically	form
a	curve	with	that	track	end.	

In	the	picture	at	right,	when	you	draw	the	tangent	segment	at	the
top	(green),	the	curve	will	automatically	connect	to	the	track	end
at	A,	whether	you	meant	it	to	or	not.

If	this	happens,	Undo	and	try	a	different	approach:	draw	the	other	leg	first,	or	temporarily
move	the	offending	track	end	away	from	the	circle.

Watch	the	highlights.		If	the	curve	doesn't	form	automatically	after	you	release	the
second	leg,	it	probably	means	you	didn't	get	one	leg	close	enough	to	the	circle.		Be	sure
the	circle	is	highlighted	when	you	start	or	end	drawing	the	leg	segment.,



Editing	a	Curve

Editing	curved	track	is	like	editing	straight,	except	a	little	trickier.		When	you	move	a	curve,	or	a
straight	track	tangent	to	a	curve,	the	program	adjusts	connections	points	as	you	drag	so	as	to
maintain	tangency.		If	a	curve	is	tied	into	a	network	of	straight	sections,	this	can	cause	quite	a
bit	of	movement,	and	if	you	attempt	to	move	a	curve	too	far,	track	can	become	tangled.

To	move	a	curve:

1.	 Choose	the	Edit	tool	 .
2.	 Click	to	select	the	curve	to	be	moved	(shown	at	left).		The	curve	turns	blue.

					 			

3.	 Press	and	drag	carefully.		As	you	drag,	attached	straight	sections,	and	curves	on	the	far
ends	of	those,	are	automatically	adjusted	(see	above	center).		If	you	drag	too	far,	some
curves	may	not	be	able	to	stay	tangent,	and	you	can	end	up	with	a	spiral	(above	right).		If
this	happens,	Edit	Undo	and	try	again.

Because	of	the	requirement	that	curves	remain	tangent,	you	cannot	drag	a
junction	which	joins	a	curve	and	a	straight.		In	the	diagram	at	left,	dragging
the	highlighted	point	has	no	effect,	because	anywhere	you	try	to	drag	it	will
cause	the	tangency	to	break.

	

	



Loops	and	S-Curves

You	don't	have	to	draw	curves	one	at	a	time.		Some	constructs,	like	loops	and	S-curves,	work
better	if	you	draw	more	than	one	circle	before	you	add	the	straights.

To	draw	a	loop:

1.		Draw	two	circles.

Use	the	Circle	tool		 .		Remember:	use
the	shift	key	to	move,	unshift	to	resize.

2.		Begin	on	either	circle	and	drag	a
tangent	to	the	other.

3.		Release	when	the	destination	circle	is
highlighted.

4.		Repeat	the	procedure	on	the	other	side
of	the	loop.

5.		When	you	release	the	second	tangent,



both	circles	become	curves,	and	the	loop
is	complete.

	

To	draw	an	S-curve:

1.		Draw	two	circles.		Leave	a	little	space
between	them.

2.		Begin	a	tangent	on	the	inside	edge	of
one	circle.

3.		Drag	to	the	inside	edge	of	the	other
circle.		Release	when	the	destination	circle
is	highlighted.

4.		Draw	an	outer	tangent.		This	completes
one	curve	and	removes	one	circle.



5.		Draw	the	other	outer	tangent.		This
completes	the	other	curve	and	removes	the
other	circle.

6.		The	completed	S.

	

	

	

	

	

	



Helices

A	helix	is	a	device	for	moving	a	train	between	levels	of	a	multi-level	layout.	
The	train	enters	at	one	level,	changes	altitude	gradually	as	it	proceeds	up	or
down	a	series	of	loops,	and	emerges	at	another	level.

Many	modern	track	plans	and	club	layouts	have	helices.		For	an	elegant
example,	see	John	Armstrong's	Southern	Pacific	Lines	Shasta	Division,
featured	in	Model	Railroader,	April	2005.

It	takes	some	effort	to	draw	a	helix	in	TrackLayer,	but	it's	worth	it.		When	a
train	enters	the	helix	and	climbs	it	in	a	series	of	slow	loops,	it	comes	to	life
and	makes	sense	out	of	that	bundle	of	looped	wires	on	the	track	plan.

Drawing	a	Helix

Draw	a	helix	by	starting	at	the	bottom,	with	the	lower	approach	track	and	the	lowest	loop.	
Proceed	upwards,	adding	and	connecting	new	loops	right	on	top	of	the	lower	ones.	

To	do	this	requires	a	special	device,	because	normally	if	you	put	circles	on	top	of	each	other,
then	when	you	try	to	add	tangents,	they	won't	snap	to	the	right	places.		The	secret	is	to	mark
track	as	"untouchable."		Once	a	loop	is	in	place,	you	can	mark	it	so	it	will	not	be	affected	when
you	add	the	next	loop.		As	you	draw	each	loop,	you	leave	a	little	"handle"	sticking	out	so	you
can	connect	it	to	the	next	loop.

In	this	example,	we	will	construct	a	circular	two-loop	helix,	with	the	lower	approach	from	the
northwest	and	the	upper	exit	to	the	northeast.	
	

1.		Draw	a	circle	(Circle	tool		 ).

2.		Draw	the	lower	approach	track	(Track	tool		 ).



3.		Draw	a	short	straight	segment	at	the	top	of	the
circle.		This	completes	a	large	curve,	and	serves	as
a	handle	to	connect	to	the	next	loop.

4.		Mark	the	curve	"untouchable."		Right-click	on	the
curve	so	it	highlights	as	shown,	and	choose
Untouchable.

This	causes	the	curve	to	become	unresponsive:	it	will
not	highlight,	you	cannot	connect	track	to	it,	and
most	important,	tangents	you	create	on	the	next	loop
will	not	snap	to	it.

Before	you	mark	the	curve	untouchable,	you	might
want	to	mark	it	Hidden.		See	notes	below.

5.		Draw	a	circle	for	the	second	loop	(Circle	tool		
).		Start	at	the	center	of	the	first	circle,	and	drag	until
the	circle	is	superimposed	on	the	first	one.

This	illustration	shows	the	drag	in	process,	not	quite
finished.

6.		This	shows	the	second	circle	in	place.

7.		Draw	a	short	segment	to	connect	the	second
loop	to	the	first.		Begin	by	highlighting	the	circle	as
shown...



8.		...and	connect	to	the	handle	drawn	in	step	3.

Don't	worry	about	the	kink	in	the	track,	you'll	fix	it
shortly.		You	now	have	the	first	leg	of	the	second
curve.

9.		Draw	the	other	leg	of	the	curve.		Begin	on	the
circle	at	about	the	same	place	as	in	step	3...

10.		...and	drag	to	form	a	new	handle,	near	(but	not
right	on	top	of)	the	first.

11.		You	now	have	one	complete	but	kinked	loop,
and	another	almost-complete	loop	with	handle.

12.		Fix	the	kink.		Use	the	Edit	tool	 .	Point	to	the
junction	so	it	highlights	as	shown,	press	and	drag	to
move	it	into	position.

13.		Release	when	the	junction	is	on	the	circle.



14.		And	so	on.		Mark	the	second	curve	untouchable.

15.		Draw	the	next	circle.

16.		Draw	the	segment	to	connect	to	the	previous
handle.

17.		Release	when	connected.

18.		Draw	the	upper	approach	track,	tangent	to	the
topmost	circle.



19.		Fix	the	kink	in	the	previous	layer.

Be	careful	when	moving	this	junction	that	it	does	not
land	on	top	of	the	earlier	one,	i.e.,	do	not	release
where	you	see	a	green	highlight	square.

20.		And	you're	done.

21.		Test	the	helix.		Add	a	loco	on	one	of	the
approach	tracks,	give	it	some	speed,	and	watch	the
show.		It	should	make	two	complete	loops	around
before	exiting.

Notes

For	best	appearance,	the	train	should	hide	as	it	goes	around	the	lower	loops,	and	appear
when	it	gets	to	the	top	one.		You	can	arrange	this	by	marking	track	as	hidden,	starting	with
the	lowest	loop	and	continuing	until	the	top	loop.		Mark	each	track	as	you	add	it,	and	be
sure	to	apply	the	hidden	mark	before	you	mark	a	track	untouchable,	otherwise	you	won't
be	able	to.

In	the	above	example,	tracks	added	in	each	of	the	following	steps	should	be	marked
hidden	before	going	on	to	the	next	step:	3,	4,	8,	10.

If	you	mark	a	track	untouchable	by	mistake,	you	can	no	longer	select	it	so	you	can't
unmark	it.		Instead,	choose	All	Retouchable	from	the	track	context	menu.		All	untouchable
tracks	become	unmarked	and	touchable.

	



Creating	a	Turntable

Turntables	are	a	little	tricky	to	get	right,	because	the	connecting	tracks	have	to	be	laid
precisely.		The	program	helps	by	snapping	objects	into	position,	but	can	have	trouble	in
crowded	areas.		When	you're	working	in	an	area	with	a	turntable,	it	works	best	to	construct	the
turntable	first,	before	adding	the	surrounding	track.		First,	zoom	in	so	you	have	room	to	work,
and	so	junctions	and	tracks	don't	overlap.

There	is	a	special	tool	for	creating	turntables.		It	works	just	like	the	Circle	Tool,	except	that
after	you	size	and	position	the	circle,	it	automatically	adds	a	bridge	track	and	makes	a	working
turntable.

Two	tips	about	creating	turntables:	(1)	draw	the	circle	first,	before	adding	the	connecting
tracks,	and	(2)	make	sure	either	the	circle	or	an	end	of	the	bridge	track	is	highlighted	when	you
start	or	end	drawing	a	connecting	track.		If	the	track	doesn't	snap	to	have	one	endpoint	exactly
on	the	circle,	the	turntable	won't	work.

If	you	encounter	problems	with	turntables	in	published	layouts,	see	Repairing	a	broken	turntable
below.

To	create	a	turntable:

1.	 Choose	the	Turntable	Tool		 	or	Tools	>	Turntable	from	the	menu.

2.	 Draw	the	circle.		Point	to	the	center,	press	and	drag	to	the	desired	radius.	
Press	the	shift	key	to	move	the	circle	instead	of	resizing	it.

3.	 When	you	release	the	mouse	button,	the	bridge	track	appears	automatically,
oriented	at	a	random	angle.		The	Turntable	Tool	is	automatically	deselected	and	the	Track
Tool	selected	instead.

4.	 Draw	a	connecting	track.		Start	where	you	want	the	far	end	of	the	track,
press	and	drag	in	toward	the	circle.		When	the	circle	highlights,	release.		(You	can	do	this
in	the	other	direction	if	you	prefer:	start	by	highlighting	the	circle,	then	draw	outwards.)

5.	 When	you	release,	the	connecting	track	snaps	to	be	perpendicular	to	the
circle	rim.



6.	 Test.		Double-click	anywhere	on	the	rim	of	the	circle.		The	table	should
rotate	until	the	bridge	track	is	aligned	with	the	connector,	then	stop.		(If	the	table	just	keeps
rotating,	double-click	the	rim	again	to	stop	it,	then	see	Repairing	below.)

To	make	a	cross-over:

If	you	want	the	engine	to	be	able	to	drive	straight	across	the	turntable,	you	must	take	care
to	make	sure	the	connecting	tracks	are	aligned.		Here's	the	best	way:

1.	 Draw	the	first	connector,	as	in	steps	4-5	above.
2.	 Rotate	the	table	until	it	stops	in	the	aligned	position,	as	in	step	6.

3.	 Point	to	the	free	end	of	the	bridge	track,	so	it	highlights	with	a	green
square.		(When	you	are	pointing	to	the	bridge	track	end,	only	the	track	end	highlights,	not
the	circle.)

4.	 Press	and	drag	outwards	to	form	the	second	connector.		You	will	have
to	eyeball	where	to	drop	the	track	end	so	that	it	aligns	with	the	bridge	--	in	this	case	the
program	does	not	help.	

You	can	draw	the	other	direction	if	you	prefer,	starting	at	the	far	end	and	dragging	in
toward	the	circle.		Just	make	sure	the	bridge	end	and	not	the	circle	is	highlighted	when	you
press	or	release.

To	move	or	resize	a	turntable:

1.	 Choose	the	Edit	Tool	 .

2.	 Click	any	point	on	the	rim	of	the	turntable	or	the	bridge	track.		Both	are
selected	and	colored	dark	blue.

3.	 Press	the	rim	of	the	circle	and	drag.		Both	the	circle	and	the	bridge	track	move	together.
4.	 Press	the	shift	key	while	dragging	to	resize	instead	of	move.

Note	that	when	you	are	editing,	the	shift	key	behaves	opposite	to	the	way	it	works	when
creating	a	new	circle	or	turntable.	When	dragging	a	selected	circle	or	turntable	without



shift,	it	moves	as	a	rigid	unit;	with	shift,	it	resizes,	and	also	allows	you	to	reorient	the
bridge	as	you	drag.

To	delete	a	turntable:

1.	 Choose	the	Edit	Tool	 .
2.	 Point	to	the	rim	of	the	turntable,	so	the	circle	highlights.
3.	 Press	the	Del	key.

You	can	also	delete	a	turntable	by	selecting	it	or	including	it	in	a	set	of	selected	objects,
then	using	Edit	Delete	or	Edit	Cut.

Turntable	Properties

Right-click	on	the	rim	of	a	turntable,	choose	Properties,	and	you	get	this	little	dialog:

This	gives	you	the	turntable	ID	and	radius	in	your	choice	of	units.		The	Attach	Scenery	drop-down
lets	you	connect	a	scenery	object	to	rotate	along	with	the	bridge	track.		See	Bridge	Scenery	in	the
Transfer	Table	chapter.

Repairing	a	broken	turntable

If	you	spend	any	time	with	the	track	plans	having	turntables,	you	are	likely	to	encounter
some	which	need	repair.		The	most	common	problem	is	that	rotation	doesn't	stop	where	it
should	--	the	bridge	comes	to	a	connector	and	just	rolls	right	on	by.		This	usually	means	the
connector	is	not	positioned	right.

The	most	common	breakage	is	when	the	connector	is	not	quite	touching	the
circle.		To	repair:

1.	 Choose	the	Edit	Tool	 .



2.	 Point	to	the	end	of	the	connecting	track	closest	to	the	circle,	so	it	highlights
with	a	green	square.

3.	 Press	and	drag	until	the	circle	highlights,	then	release.

4.	 On	release,	the	connector	snaps	perpendicular	to	the	rim.	
	

5.	 Test	the	turntable.		Should	work	now.

Other	problems	are	harder	to	correct.		You	may	find	a	phantom	junction	along	the	rim	of	a
turntable	--	you	see	a	green	highlight	square	where	there	is	no	track	--	or	other	problems.	
In	most	cases	the	best	course	of	action	is	to	delete	the	turntable	and	all	connecting	tracks,
and	start	over.



			Advanced	Topics

After	you've	got	the	hang	of	drawing	layouts,	you	should	check	them	for	errors,	and	take	some
final	steps	if	you	want	your	layout	to	be	used	by	others.		This	chapter	explains	how.

Debugging	and	Repairing

Publishing	Your	Layout

Importing	CAD	Layouts



Debugging	and	Repairing

Preparing	a	layout	in	TrackLayer	is	a	many-step	process	fraught	with	possibilities	for	error.	
This	section	gives	some	tips	for	avoiding	errors	and	describes	tools	to	help	you	spot	and
correct	them.

Zoom	in

Work	on	one	section	of	the	layout	at	a	time.		Zoom	in	so	you
have	room	to	work.	

You	can	draw	tracks	out	to	the	edges	of	the	window,	then
when	you	scroll	over	to	work	on	the	next	section,	hook	up	or
move	the	disconnected	track	ends.

Inspect	visually

When	you	are	working	in	a	crowded	area,	it's	easy	to	forget	a
crossover	or	siding,	and	it's	not	easy	to	tell	you've	done	it.	
Here	are	two	ways	to	check	for	missing	track:

Mouse	over.		With	the	Track	tool	 	or	the	Edit	tool	
active,	when	you	move	the	cursor	over	a	section	of	track,	it
highlights	in	green	and	stands	out	against	the	background.	
This	makes	it	easy	to	tell	where	there	is	a	background	line
with	no	track	on	it.
	
Flash	the	background.		In	the	picture	at	right,	there	is	a	crossover	missing	--	can	you
spot	it?		Try	this:	use	the	View	Background	button	 	to	turn	the	background	on	and	off,
say	once	per	second.		As	it	flashes	on	and	off,	your	eye	can	usually	spot	differences	in	the
track	patterns.

Test	the	layout

Throw	the	switches.		If	you	can't	get	a	switch	to	throw,	it	probably	means	bad	trackwork
in	the	vicinity.

Test	the	turntables.		Make	sure	rotation	stops	where	it	should.

Drive	a	train.		The	ultimate	test	of	a	layout	is	whether	a	train	navigates	it	correctly.		Drive
around	and	see.

Track	Checker

TrackLayer	can	help	you	find	errors.		Use	the	command	Tools	>	Check	Track.		This	runs	a
series	of	tests	against	the	layout,	as	listed	in	the	table	below.		Results	are	reported	in	the
Track	Check	dialog.



If	you	are	laying	a	lot	of	track,	you	might	want	to	turn	on	Check	Track	While	Drawing	in	Track
Preferences.		This	will	alert	you	to	errors	as	soon	as	they	occur.

If	errors	are	found,	they	are	listed	in	an	alert	box	as	shown.		Each	error	is	listed	with	an
object	type	(3-letter	code	from	the	following	table),	the	object's	number,	and	the	error	text;
the	corresponding	track	or	junction	on	the	layout	is	highlighted	in	pink.

STR straight	track	section
CUR curved	track
JXN junction	/	switch
CTR circle	center
CAR car
TRN train
CIR circle
TTB turntable
STN station

In	the	example	shown,	tracks	34,	70,	and	153	meet	near	a	common	point,	but	there	is	no
switch	there.		The	fix	is	to	drag	junction	152	on	top	of	68,	so	a	switch	is	created.

Error	conditions	found	by	Check	Track	include:

Object	flagged	for	delete object	has	been	deleted
Invalid	object	ID object	ID	is	out	of	range
Unretrievable	object object	no	longer	exists	in	memory

Invalid	junction	number	on	track junction	number	on	one	end	of	track	is
out	of	range

Same	junction	number	on	both	ends
of	track track	has	both	ends	on	same	junction

Bad	track	length track	length	is	zero
Invalid	station	number track	points	to	non-existent	station
Object	has	zero	space track	or	circle	has	no	dimensions

Junction	has	no	tracks invalid	junction,	disconnected	from	any
track

Invalid	track	number	on	junction junction	is	connected	to	invalid	track	ID

Superimposed	junctions two	junctions	are	at	or	near	the	same
place

Invalid	radius circle	radius	is	zero	or	negative
Station	is	missing	name station	object	has	no	name

Tracks	superimposed two	track	segments	are	on	the	same
line	segment
endpoint	of	one	track	lies	near	point	on



Endpoint	on	track	but	no	junction another	track

Track	Numbers

To	identify	tracks	and	objects,	use	Tools	>	Show
Numbers	to	turn	on	the	display	of	track	and	junction
numbers.		Track	numbers	are	shown	in	blue,	junction
numbers	in	red.

	If	the	Scenery	Edit	tool	is	active,	instead	of	track	and
junction	numbers,	scenery	object	numbers	are	displayed	in
green.

This	command	is	a	toggle;	use	again	to	turn	off	the
numbers.

Another	way	is	to	use	tooltips.		Choose	Tools	>	Show	Tooltips	to	enable	this	feature.	
Then	hover	the	mouse	over	a	track,	junction,	switch,	circle,	turntable,	or	station	and	you
will	see	a	note	indicating	its	number	and	other	data.		If	you	do	not	see	the	tooltip,	try
clicking	in	the	layout	window	to	make	sure	it	is	the	active	window.

Highlight	a	Track	or	Junction

If	an	error	message	gives	a	track	or	junction	number	you're	having	trouble	finding	on	the
layout,	use	Tools	>	Highlight	Track.		This	brings	up	the	Track	Highlight	dialog:

In	this	dialog,	use	radio	buttons	to	indicate	whether	you	are	looking	for	a	track	or	a
junction,	then	enter	the	desired	number	or	label,	or	choose	a	number	from	the	drop-down.	
The	corresponding	object	will	be	highlighted	in	pink	on	the	layout.

Check	the	"Zoom	to	highlight	area"	box	if	you	want	the	view	to	move	to	that	location	when	you	click
OK.

To	turn	off	the	pink	highlight,	click	any	empty	space	on	the	layout.



Publishing	Your	Layout

	

If	you	have	an	interesting	layout	and	you've	gone	to	the	trouble	of	laying	track	on	it,
consider	sharing	it	with	other	TrainPlayer	users.		If	you	take	the	following	few	steps

to	make	it	ready,	and	are	the	artist	or	have	rights	to	distribute	the	artwork,	we	will	be	glad	to
post	it	in	our	user	collections.

1.	 Check	for	errors.		Run	Tools	>	Check	Track.		For	details,	see	Track	Check	Dialog.
	

2.	 Test	switches	and	turntables.		
	

3.	 Add	some	trains.		Put	suitable	rolling	stock	at	reasonable	locations	for	starting	an
operating	session.
	

4.	 Add	comments.		In	Layout	Properties,	add	as	much	commentary	as	you	like,	but	please
include	your	name,	the	author	or	designer	of	the	layout,	and	any	operating	instructions.
	

5.	 Use	File	>	Publish	to	bring	up	the	Layout	Publisher	dialog	to	finish	the	job.

If	you	do	not	have	any	external	files	--	you	created	your	layout	using	only	images	found	in	the	Scenery
folder	and	SCN	objects	made	from	them,	and	your	layout	does	not	have	a	bitmap	background	--	then	you
are	ready	to	publish.	and	can	skip	the	rest	of	this.

External	Files

A	TrainPlayer	layout	is	stored	in	a	text	file	with	extension	rrw.		This	file	contains	information	about	track,
stations,	and	other	layout	objects,	but	does	not	have	all	the	data	you	need	to	run	the	layout.		Additional
data	is	stored	in	external	files	referenced	by	the	rrw.		If	you	want	to	send	a	layout	to	someone	else,	you
need	to	know	about	these	files	and	make	sure	the	recipient	has	access	to	them.

One	external	file	is	the	background	image.		If	a	layout	has	a	background	image,	it	is	often	stored	in	a	file
in	the	same	folder	as	the	rrw,	with	the	same	filename	but	a	different	extension	--	jpg,	tpg,	bmp,	gif,	or
png.		But	this	does	not	have	to	be	the	case	--	the	background	image	can	reside	in	a	file	anywhere	on	your
disk,	with	its	pathname	referenced	in	the	rrw	file.

Many	external	files	are	stored	in	system	folders	common	to	all	TrainPlayer	users.		These	include	car
collections,	loads,	sounds,	and	many	scenery	objects.		When	you	open	a	layout,	the	program	looks	for
these	files	in	your	local	system	data	folder;	if	it	doesn't	find	them,	it	looks	in	the	TrainPlayer	web
collection,	and	offers	to	download	what	it	finds	there.		Failing	both,	the	program	proceeds	using	standard
replacements	for	the	missing	objects.		In	any	case,	you	do	not	have	to	provide	these	common	files	to	a
recipient.

Other	types	of	external	file	may	come	from	anywhere	on	your	disk.		These	include	background	images,
linked	layouts,	components	of	window	snapshots,	scenery	object	bitmaps,	and	module	layouts.		If	you
want	the	layout	to	work	for	the	recipient	the	same	way	it	does	for	you,	you	will	need	to	provide	these	files
along	with	the	rrw	file.		How	do	you	find	out	what	these	files	are,	and	what	is	the	best	way	to	transmit



them?

To	see	a	list	of	external	files	required	by	a	layout,	run	Track	Check	or	Layout	Publisher.

To	include	external	files	when	you	are	transmitting	a	layout,	you	have	several	choices.		This	is	because
when	the	recipient	opens	the	layout,	the	program	looks	in	several	places	to	find	them:

1.	 Alongside	the	rrw	file.		If	an	external	file	is	found	in	the	same	folder	as	the	rrw,	it	will	be	taken	from
there.

2.	 In	a	_files	subfolder.		If	the	layout	is	named	abc.rrw,	the	program	looks	for	a	folder	in	the	same
location	called	abc_files,	and	if	found,	looks	there	for	external	files.

3.	 At	the	path	stored	in	the	rrw.		What	is	stored	for	an	external	object	is	its	path	relative	to	the	rrw	file,
as	determined	at	the	time	the	file	was	saved.		(If	it	is	not	possible	to	derive	a	relative	path,	then	the
absolute	path	is	stored.)		This	means	that	if	the	layout	and	its	external	files	are	in	different	folders,
you	can	send	them	separately	as	long	as	you	maintain	their	locations	relative	to	each	other.

4.	 In	the	appropriate	system	folder	--	Layouts,	Scenery,	Sounds,	etc.		If	an	external	file	resides	in	the
system	folder	on	the	recipient's	computer,	then	it	will	be	taken	from	there.

The	simplest	way	to	transmit	a	layout	and	its	external	files	is	to	take	advantage	of	#1,	and	just	put	them	all
into	a	single	folder.

RZP	(Zip)	Files

TrainPlayer	Version	5	introduces	a	new	type	of	format	for	transferring	layout	data:	the	railroad	zip	file,
with	extension	rzp.		This	is	a	standard	zip	file	--	you	can	change	the	extension	to	zip	and	work	with	it	just
like	any	other	zip	file.		The	rzp	file	contains	a	layout,	background	bitmap	if	any,	and	a	_files	subfolder
containing	external	files.		The	recipient	can	open	it	directly,	just	as	they	would	for	a	normal	rrw	file.

To	save	a	layout	to	an	rzp	file:	use	File	>	Save	As,	choose	type	rzp	from	the	drop-down.		The	program
creates	a	zip	file,	copies	all	components	into	it,	and	saves	it	to	the	indicated	location.

To	open	an	rzp	file:	use	File	>	Open,	choose	type	rzp	from	the	drop-down,	then	browse	to	the	file.		Or:
drag	the	rzp	file	from	Windows	Explorer	into	TrainPlayer.		In	either	case,	the	program	unzips	the	file	into
a	temporary	location,	opens	the	rrw	from	there,	and	locates	its	external	files	in	the	_files	subfolder
alongside.

To	unzip	an	rzp	file	to	your	disk:		open	the	rzp	file	as	indicated	above,	then	use	File	>	Save	As	and
choose	type	rrw.		The	rrw	file	will	be	saved	to	the	indicated	location,	and	alongside	will	be	a	_files
subfolder	containing	external	files.



Choosers

A	chooser	is	dialog	used	to	select	layouts,	cars,	scenery,	or	sounds.

A	chooser	has	three	panels:	a	tree	control	(left),	a	list	box	(center),	and	a	preview	window
(right).	In	general,	what	you	do	is	click	a	folder	in	the	tree	to	see	its	contents	in	the	list,	click	an
item	in	the	list	to	see	its	preview,	then	double-click	to	open	it.

Each	chooser	has	two	tabs,	one	for	local	content	on	your	disk,	the	other	for	content	available
by	download	from	the	web.	As	long	as	you	have	an	internet	connection,	when	you	select	an
item	from	the	web	tab,	it	downloads	and	becomes	part	of	your	local	content.

nstructions	in	this	section	are	for	all	choosers.	For	details	specific	to	each	type,	see	the
individual	help	pages:

Layout	Chooser Layout	Web	Chooser
Car	Chooser Car	Web	Chooser
Sound	Chooser Sound	Web	Chooser
Scenery	Chooser Scenery	Web	Chooser

Contents	of	a	Chooser

In	general,	the	files	you	see	in	the	local	tab	of	a	chooser	are	those	in	the	corresponding	folder
(and	subfolders)	in	your	TrainPlayer	application	data	directory.*		The	files	and	folders	you	see
in	the	web	tab	are	those	on	our	website.

You	cannot	modify	the	Car,	Scenery,	or	Sound	chooser	trees.		If	you	want	the	files	in	these
sets	to	be	organized	differently,	you	can	rearrange	them	on	the	disk	and	the	chooser	trees	will
reflect	your	changes.		The	exception	is	the	local	Layout	chooser,	where	you	can	add	folders	of
your	own	and	reorganize	the	tree	to	suit.



*You	can	easily	locate	and	inspect	your	application	data	directory.		Choose	Open	Data	Folder
from	the	File	menu,	and	it	will	bring	up	Windows	Explorer	in	that	location.

Operating	a	Chooser

Components	of	a	chooser	work	generally	as	follows.		Details	differ;	see	the	individual	help
pages.

Tree:	Click	a	folder	to	select	it.		If	it	contains	files,	you	will	see	a	list	of	them	in	the	list	window.	
If	it	contains	subfolders,	click	the	+	sign	to	expand	it	so	you	can	select	a	subfolder.

List:	The	list	window	shows	a	collection	of	files	or	objects	as	either	a	table	or	a	set	of	icons.	
Icon	view	can	be	changed	to	list	view	using	the	context	menu.		Click	an	icon	or	a	row	of	the
table	to	make	a	selection;	in	most	cases	you	will	then	see	a	picture	of	the	selected	object	in	the
preview	window.

Preview:	The	preview	window	shows	a	small	picture.		In	the	Sound	chooser,	you	can	click	the
picture	to	play	the	sound;	in	other	choosers	the	preview	is	not	interactive.

Buttons:	Each	chooser	has	four	buttons	at	the	lower	right,	which	differ	depending	on	the
context.		Click	the	left	button	(which	might	say	OK,	Download,	Install,	Add	Car,	or	Done)	to
carry	out	the	default	action	on	the	selected	item;	Cancel	to	take	down	the	chooser	without
further	action;	Browse	to	browse	the	file	system	for	a	layout	(available	only	in	the	local	Layout
chooser);	or	Help	to	go	to	the	appropriate	page	of	the	help	system.

Resizing:	A	chooser	window	can	be	resized	by	dragging	its	lower	left	corner.		Individual	panes
can	be	resized	by	dragging	the	divider	bars	between	them.

Modality:	Layout	and	Sound	choosers	are	"modal,"	meaning	once	you	click	OK,	the	selected
item	is	opened	and	the	chooser	goes	away.		Car	collection	and	Scenery	choosers	are	not:	they
remain	on	the	screen	as	you	choose	multiple	items.

Context	menus:		Right-click	an	item	in	either	the	tree	or	list	window	to	see	a	menu	of	context-
specific	commands.		Menus	differ	depending	on	the	chooser;	see	the	individual	help	pages	for
menu	screen	shots	and	details.

Web	tab:	If	you	have	a	live	internet	connection,	the	web	tab	of	each	chooser	shows	content
available	on	our	website.		Selecting	an	item	or	collection	from	this	tab	causes	it	to	be
downloaded	to	your	machine	and	added	to	your	local	content.		Details	vary	depending	on
chooser;	see	individual	help	pages.

Search:	If	you	are	looking	for	a	particular	file,	use	Find	and	Find	Next	on	the	tree	context
menu.		Right-click	a	folder	to	search	through	it	and	its	subfolders	(to	search	all,	select	the
topmost	tree	item),	choose	Find,	and	enter	all	or	part	of	an	item	name	or	path.		If	a	match	is
found,	it	is	selected	in	the	list	window.		If	there	is	more	than	one	match,	Find	Next	goes	to	the
next	one.



Sort:	Items	in	the	list	window	can	be	sorted	on	any	column,	when	the	window	is	in	list	(not	icon)
view.		To	sort,	click	the	header	of	a	column.		To	sort	in	the	reverse	direction,	click	the	header
again.

Status	icons:		Web	chooser	lists	and	trees	show	icons	next	to	items,	indicating	how	the	local
version	of	a	file	compares	to	its	web	version.		There	are	three	choices:

	(empty	document)	--	you	do	not	have	a	local	version	of	this
file

	(filled	document)	--	you	have	an	up-to-date	local	version

	(filled	document	with	red	star)	--	you	have	a	local	version,	but	the	version	on	the	web	is
more	recent	than	the	local	one

For	car	collections,	icons	appear	on	the	entire	collections.	i.e.,	on	folders	in	the	tree	rather	than
rows	in	the	list	window.		A	legend	at	the	bottom	of	the	dialog	reminds	you	what	the	icons	mean.

Export:		contents	of	folders	in	chooser	trees	can	be	exported	to	text	or	xml	files.		This	is	an
expert	feature,	used	mostly	by	us	to	manage	our	file	collections,	but	you	might	find	it	useful	in
various	ways.

The	exported	file	contains	the	same	data	as	what	you	see	in	list	(not	icon)	view	--	item	name,
filename,	date,	etc.	--	for	each	file	under	the	folder	you	are	exporting.		To	export	the	entire	tree,
right-click	the	root	item.		Exported	data	can	be	in	one	of	two	formats:	comma-delimited	text,	or
structured	xml.

To	export	:

1.	 Right-click	a	folder	and	choose	Export.		This	will	export	data	about	all	files	contained	in	the
selected	folder	and	its	subfolders.

2.	 In	the	file	dialog,	specify	the	output	file	and	format	(.txt	for	delimited	text,	.xml	for
structured	xml).

3.	 Click	OK.	

The	file	is	generated.		Take	a	look	at	it	in	a	text	editor	or	web	browser.



Local	Car	Chooser

The	local	car	chooser	is	for	selecting	cars	and	adding	them	to	the	layout.		This	chooser	is	also
used	to	create	new	car	collections.

For	general	information	about	choosers,	see	Choosers.

To	Add	a	Car	to	the	Layout

1.	 Choose	a	car	collection	in	the	tree	and	click	to	open	it.		A	car	collection	is	shown	as	a
folder	with	a	locomotive	icon.		When	you	open	a	collection,	you	see	its	cars	in	the	list
window.

2.	 Click	one	of	the	cars	in	the	list	window.		You	see	its	side	and	top	view	in	the	preview
window.	

3.	 To	add	this	car	to	the	layout,	click	Add	Car,	or	double-click	the	icon.		The	car	is	added	to
the	currently-selected	train	at	the	current	position	of	the	insert	pin.		If	there	is	no	train
selected,	the	car	is	added	to	a	random	track.

The	car	chooser	is	a	modeless	dialog:	it	remains	on	the	screen	so	you	can	keep	adding	cars.	
When	you	are	finished,	click	Done.		If	you	change	your	mind,	use	Edit	>	Undo	to	remove	added
cars.

You	can	choose	whether	you	want	the	list	view	to	show	side	views	(as	shown	above),	or	top
views,	or	a	list	showing	type	name,	class,	AAR	code,	filename,	and	date.

Tree	Contents



Defaults Collections	which	can	be	selected	as	default	car	sets;	see	Default	Cars

50	px
Collections Our	standard	sets	of	medium-high-res	cars	and	engines

<other> Collections	downloaded	from	web

Tree	Menu

Open Open	folder	to	show	subfolders	or	files
Refresh Reload	contents	from	disk
Find... Search	for	name	or	filename.		See	Search.
Find	Next Go	to	next	hit	after	Find
Properties... Display	folder	or	car	collection	properties

Export	Filenames... Export	text	or	xml	file	of	folder	contents.	
See	Export.

Import	from	Folder...
Under	the	selected	folder,	create	new	car
collection	from	a	folder	of	image	files.	
Dimmed	if	selection	is	not	a	folder.		See
Creating	a	New	Collection.

List	Menu

Add	Car Add	selected	car	to	layout
Side	Views Display	icons	of	side	views
Top	Views Display	icons	of	top	views

List	View Show	contents	in	list	form.		List	includes	name,
class,	AAR	code,	date.

Properties... Display	and	edit	car	type	properties

Creating	a	New	Car	Collection

Here's	how	you	can	create	a	new	car	collection	if	you	have	a	set	of	side	and	top	images.		For
more	information,	see	Car	Collections.

1.	 Collect	or	prepare	the	set	of	images.		You	will	need	at	least	a	side	view	for	each	car	type;
for	top	views,	you	can	create	your	own	or	choose	from	among	the	ones	you	already	have.	
Many	side-view	icons	of	the	correct	size	are	available	as	gif	files	for	download	from
various	web	sites.

2.	 Gather	the	image	files	into	a	folder,	named	as	you	want	to	name	the	collection.		If	you
have	created	car-top	images,	you	need	to	make	sure	their	files	are	named	correctly.		In
the	example	below,	we	have	prepared	a	folder	of	images	called	"My	Cars."



3.	 Point	to	a	folder	in	the	tree	where	you	want	the	new	collection	to	appear.		This	must	be	a
folder,	not	a	car	collection.		In	the	example	below,	we	are	creating	the	new	collection	at	the
top	level,	right	under	Cartypes.

4.	 Right-click	and	choose	Import	from	Folder	(below	left).

																

5.	 	In	the	Browse	for	Folder	dialog,	navigate	to	the	folder	where	the	images	are	stored	(in
this	case,	"My	Cars").

A	new	collection	is	created	in	your	tree	and	under	the	TrainPlayer\Cartypes	folder.		The	image
files	are	copied	from	the	original	folder	into	the	new.		You	see	the	new	collection	in	your
chooser	tree	(above	right),	ready	to	use.

Large	Car	Images

If	the	selected	collection	has	large	car	images,	they	are	displayed	underneath	the	side	and	top
images,	as	shown	here:



For	optimum	viewing,	enlarge	the	right	panel	--	the	large	image	looks	best	when	drawn	full	size.



Local	Layout	Chooser

The	local	layout	chooser	is	for	selecting	a	layout	to	open	and	run.

For	general	information	about	choosers,	see	Choosers.

To	Open	a	Layout

The	local	layout	tree	shows	folders	of	layouts	which	reside	on	your	disk.	

1.	 If	a	folder	has	a	+	sign	next	to	it,	click	to	expand	it	and	show	its	subfolders;	if	not,	click	to
show	its	contents	in	the	list	window.	

2.	 Click	a	layout	in	the	list	to	see	its	preview.	

3.	 To	open	the	previewed	layout	and	take	down	the	dialog,	click	OK.

The	local	layout	chooser	has	features	not	available	in	other	choosers.		For	one,	you	can	click
the	Browse	button	to	bring	up	a	regular	file	dialog	to	choose	a	layout	to	be	opened.		For
another,	you	can	modify	the	contents	of	the	tree,	by	adding	and	populating	your	own	folders.	
For	instructions,	see	Adding	Your	Own	Layouts	below.

A	folder	is	shown	with	a	padlock	if	it	is	"locked",	meaning	it	represents	a	folder	on	the	disk	and
cannot	be	modified	(except	by	rearranging	the	files	on	the	disk).		An	unlocked	folder	is	one	you
create	by	hand,	which	you	can	populate	with	layouts	from	anywhere	and	organize	as	you	wish.

Tree	Contents

Layouts Entire	layouts	folder	from	TrainPlayer	app	data	directory
Recent Layouts	recently	opened	(same	as	at	bottom	of	File	menu)
Downloads Downloaded	layouts	(note	1)
CD	Layouts Layouts	residing	on	CD	(note	2)



<user-added	folders> Folders	created	manually	or	dragged	in;	see	Adding	Your	Own
Layouts

(1)	The	Downloads	folder	contains	aliases	to	layouts	recently	downloaded.		There	is	no	actual	folder	named	Downloads	on	the
disk.
(2)	The	CD	Layouts	folder	appears	in	the	tree	if	(a)	you	ran	the	installer	from	a	TrainPlayer	CD	and	chose	to	run	the	layouts	from
CD,	and	(b)	you	have	the	CD	currently	mounted.		In	this	case	the	CD	Layouts	folder	contains	the	entire	set	of	layouts	on	the	CD.

If	you	have	been	running	an	earlier	version	of	TrainPlayer,	you	may	not	see	all	your	previous	layouts	in	the	tree.		Folders	you
previously	added	by	hand	or	by	drag-and-drop	will	need	to	be	re-added.

Tree	Menu

Open Open	folder	to	show	subfolders	or	files
Refresh Reload	folder	contents	from	disk	(note	1)

Find... Search	for	name	or	filename.		See
Search.

Find	Next Go	to	next	hit	after	Find
New	Folder Create	folder	in	tree	(2)
Add	File... Browse	for	file,	add	to	open	folder	(2)
Remove Remove	file	or	folder	from	tree	(2,	3)
Rename Rename	folder	in	tree	(2,	3)
Properties... Display	folder	properties

Export	Filenames... Export	text	or	xml	file	of	folder	contents.	
See	Export.

(1)	Refresh	is	available	on	locked	folders	and	folders	containing	other	folders;	is	dimmed	for	folders	created	manually.
(2)	Editing	commands	are	dimmed	on	or	inside	a	locked	folder,	as	these	cannot	be	modified.		For	more,	see	Adding	Your	Own
Layouts.
(3)	Remove	and	Rename	are	dimmed	on	special	folders	(Layouts,	Recent,	Downloads).

List	Menu

Open Open	selected	layout	and	take	down
dialog

Refresh	Thumbnail Recreate	thumbnail	image	from	layout

Adding	Your	Own	Layouts	to	the	Tree

The	local	layout	chooser	is	more	flexible	than	the	others.		In	addition	to	showing	you	layouts
residing	in	your	TP	Layouts	folder,	it	can	also	show	layouts	stored	in	other	locations.		You	can
add	files	or	folders	to	the	chooser	and	organize	them	so	you	can	find	them	easily.

For	example,	you	might	create	a	"Favorites"	folder	containing	the	layouts	you	like	best.		One
way	to	do	this	would	be	to	create	a	new	folder	on	your	disk	and	copy	the	files	into	it,	a	process
which	requires	time,	expertise,	and	disk	space.		An	easier	and	more	economical	way	is	to	leave
the	files	where	they	are,	and	create	a	folder	in	the	chooser	tree	containing	shortcuts	pointing	to
them.		A	very	convenient	way	to	do	this	is	to	drag	files	or	folders	into	the	chooser	tree	from



Windows	Explorer.

There	are	restrictions	on	what	you	can	do	in	the	chooser	tree.		The	main	one	is	that	you	cannot
modify	a	locked	folder	--	you	can't	add	a	folder	or	file	to	one	of	these,	or	rearrange	subfolders
in	it,	or	rename	it,	otherwise	it	would	no	longer	match	what's	on	the	disk.		In	a	typical	situation
there	is	only	one	unlocked	folder	in	the	tree	--	the	Layouts	folder	at	the	top	--	so	this	is	the
starting	place	for	adding	your	own	content.

To	create	a	folder:

1.	 Right-click	a	folder	in	the	tree	and	choose	New	Folder	(below	left).		This	command	is
dimmed	in	most	places,	but	always	available	on	the	Layouts	folder	at	the	top.

2.	 The	folder	is	created	at	the	bottom	of	the	tree	and	called	"New	Folder,"	with	the	name
selected.		Type	the	name	you	want	for	the	folder	(below	right).

																						

To	create	a	subfolder,	repeat	the	process	starting	on	an	existing	folder.		To	delete	a	folder	or
subfolder,	right-click	and	choose	Remove	(dimmed	if	the	folder	is	locked	or	is	within	a	locked
folder).

To	add	a	layout	to	a	folder:

1.	 Right-click	the	folder	and	choose	Add	File.

2.	 In	the	file	dialog,	navigate	to	the	layout	(.rrw)	file	you	wish	to	add,	and	click	OK.

The	program	adds	an	alias	pointing	to	the	layout	file.		You	do	not	see	a	change	in	the	tree,	but
if	you	click	on	the	selected	folder,	you'll	see	the	layout	in	the	list	window.

To	add	layouts	from	Windows	Explorer:

1.	 Open	Windows	Explorer	and	position	it	alongside	TrainPlayer.

2.	 Navigate	in	Windows	Explorer	to	a	folder	containing	layouts	and/or	subfolders.		In	this
example,	we	are	bringing	in	a	folder	called	My	Layouts,	with	two	subfolders.

3.	 Position	the	mouse	on	the	folder	in	Windows	Explorer,	press,	and	drag	to	an	unlocked
folder	in	the	chooser	tree	(shown	by	the	arrow	below	left).



																		

When	you	release	the	mouse	button,	the	new	folder	and	subfolders	appear	in	the	chooser	tree
(above	right).

Dragged-in	folders	are	automatically	marked	as	locked,	because	their	contents	reflect	files	on
the	disk.



Local	Scenery	Chooser

The	local	scenery	chooser	is	for	selecting	scenery	objects	and	adding	them	to	the	layout.

For	general	information	about	choosers,	see	Choosers.

To	Add	Scenery	to	the	Layout

1.	 The	local	scenery	tree	shows	folders	of	scenery	objects	residing	on	your	disk.		Click	a
folder	to	see	its	contents	as	icons	in	the	list	window.	

2.	 Click	an	icon	to	see	a	larger	view	in	the	preview	window.	

3.	 To	add	the	selected	object	to	your	layout,	point	to	its	icon,	press	the	mouse	button,	and
drag	the	object	to	a	spot	on	your	layout.		Alternatively	click	OK	to	deposit	the	selected
object	in	the	center	of	the	layout	and	take	down	the	dialog.

Note:	You	can	click	on	a	spot	on	your	layout	with	the	chooser	open,	then	double	click	with
your	mouse	on	a	scenery	object	in	the	chooser	to	place	that	scenery	object	directly	where
you	wish	it	on	your	layout.

The	scenery	chooser	is	a	modeless	dialog:	it	remains	on	the	screen	so	you	can	keep	adding
scenery	(unless	you	clicked	OK	in	step	3).		When	you	are	finished,	click	Done	or	Cancel.

Tree	Contents



<named	folders> Scenery	objects	in	the	named	categories	(1)

(1)	Folders	in	this	tree	are	those	in	the	Scenery	folder	in	your	TrainPlayer	app	data	directory.		By	default	these	match	those
available	on	the	web.		However,	if	you	change	the	arrangement	of	files	on	your	disk,	the	changes	will	be	reflected	in	the	tree.

Tree	Menu

Open Open	folder	to	show	subfolders	or	files
Refresh Reload	contents	from	disk

Find... Search	for	name	or	filename.		See
Search.

Find	Next Go	to	next	hit	after	Find
Properties... Display	folder	properties

Export	Filenames... Export	text	or	xml	file	of	folder
contents.		See	Export.

List	Menu

Open Add	selected	scenery	object	to	layout
Icon	View Show	scenery	objects	as	icons
List	View Show	scenery	objects	in	list	form



Local	Sound	Chooser

The	local	sound	chooser	is	for	selecting	locomotive	horn	sounds,	or	layout	sounds	to	play	when
the	train	passes	a	given	area.

For	general	information	about	choosers,	see	Choosers.

To	Add	a	Sound	to	your	Layout

The	sound	chooser	shows	a	subfolder	of	sounds	on	your	disk;	which	folder	depends	on
whether	you	are	choosing	an	engine	horn	sound	or	a	layout	sound.	

1.	 Click	the	folder	in	the	tree	to	show	the	list	of	sounds	it	contains.	

2.	 Click	a	sound	in	the	list	to	select	it.	

3.	 Click	the	icon	on	the	right	if	you	want	to	hear	the	sound.	

4.	 If	you	like	it,	click	OK	to	choose	the	sound	and	take	down	the	dialog.

Tree	Contents

Sounds\Loco Engine	horn,	bell,	whistle	sounds.		Shown	when	chooser	is	called
from	"Other..."	on	Horn	menu	in	Train	Properties	(below	left).

Sounds\Layout
Sounds	to	play	when	the	train	passes	an	area	on	the	layout.		Shown
when	chooser	is	called	from	Sound	browse	button	in	Station
Properties	(below	right).



					

Tree	Menu

Open Open	folder	to	show	list	of	sounds

Refresh Reload	folder	contents	from	disk.		Dimmed
on	root	folder	of	tree.

Find... Search	for	name	or	filename.		See	Search.
Find	Next Go	to	next	hit	after	Find
Properties... Display	folder	properties

Export	Filenames... Export	text	or	xml	file	of	folder	contents.		SeeExport.

List	Menu

Open Choose	selected	sound,	take	down	dialog

For	more	information	about	sounds,	see	Horns	and	Sounds;	also	Stations.



Web	Car	Chooser

The	web	car	chooser	is	for	downloading	and	installing	car	collections	from	the	web.		You	must
have	a	live	internet	connection	while	using	this	chooser.

For	general	information	about	choosers,	see	Choosers.

To	Download	a	Car	Collection

1.	 Choose	a	car	collection	in	the	tree	and	click	to	open	it.		A	car	collection	is	shown	as	a
folder	with	a	locomotive	icon.		When	you	open	a	collection,	it	is	downloaded	to	a	temporary
directory	called	the	"cache,"	then	shown	in	the	list	window.		Once	a	collection	is
downloaded	to	the	cache,	it	remains	there	for	future	access,	until	you	(a)	use	the	Clear
Download	Cache	command,	or	(b)	choose	Refresh	on	the	collection.

2.	 Click	one	of	the	cars	in	the	list	window.		You	see	its	side	and	top	view	in	the	preview
window.	

3.	 To	add	this	collection	to	your	local	set,	click	Install.		This	copies	the	files	from	the	cache
directory	to	their	permanent	location	in	your	Cartypes	directory,	then	switches	to	the	Local
Car	Chooser	so	you	can	add	them	to	your	layout.

In	the	web	car	chooser,	unlike	others,	status	icons	are	shown	on	the	folders	in	the	tree	instead
of	on	individual	items	in	the	list.		Decorations	on	the	folder	icons	indicate	whether	you	have	a
local	copy	of	a	car	collection,	and	if	so,	whether	there	is	a	newer	version	available	on	the	web.	
For	more,	see	Status	Icons.

Tree	Contents



50	px	Collections Our	standard	sets	of	high-res	cars	and	engines

Defaults Balanced	collections	suitable	as	default	car	sets;	see	Default
Cars

Schenk	200px
Collections Extra	high-res	cars	and	engines	by	Jim	Schenk

<other> Obsolete	low-res	collections

Tree	Menu

Open Open	folder	or	download	collection	to
cache	folder	to	show	contents

Refresh
Re-download	car	collection	to	cache
folder.		Dimmed	unless	selected	item
is	car	collection.

Find... Search	for	name	or	filename.		See
Search.

Find	Next Go	to	next	hit	after	Find

Download	All...
Download	and	install	all	car	collections
within	the	selected	folder	and
subfolders.

Download	Missing
Items...

Look	at	all	web	car	collections	within
the	selected	folder	and	subfolders;	if
collections	available	on	the	web	are
not	yet	installed	on	your	local
machine,	download	and	install	those

Clear	Download	Cache
(on	root	Cartypes	folder	only)
Remove	local	cached	files,	force	re-
download

List	Menu

Install Install	selected	car	collection
Side	Views Display	icons	of	side	views
Top	Views Display	icons	of	top	views

List	View Show	contents	in	list	form.		List	includes	name,	class,
AAR	code,	date.



Web	Layout	Chooser

The	web	layout	chooser	is	for	downloading	layouts	from	the	web.		You	must	have	a	live	internet
connection	while	using	this	chooser.

For	general	information	about	choosers,	see	Choosers.

To	Download	a	Layout

The	web	layout	tree	shows	layouts	available	for	download	from	the	web.		The	folders	you	see
in	the	tree	may	show	the	entire	collection,	or	a	subset	of	it,	depending	on	the	license	you
purchased.		

1.	 If	a	folder	has	a	+	sign	next	to	it,	click	to	expand	it	and	show	its	subfolders;	if	not,	click	the
folder	to	show	its	contents	in	the	list	window.	

2.	 Click	a	layout	in	the	list	to	see	its	preview.		This	requires	a	short	download.

3.	 If	you	like	the	layout	and	want	to	use	it,	click	Download	to	download	it	and	add	it	to	your
local	collection.		The	dialog	then	switches	to	the	Local	Layout	Chooser	so	you	can	open
the	layout.

The	downloaded	version	will	go	into	the	same	folder	in	your	local	tree	as	its	folder	on	the	web.	
For	example,	in	the	above	illustration,	if	you	clicked	Download	you	would	get	a	copy	of
"Benjamin's	Room"	deposited	in	your	local	Layouts	folder	under	Standard\User.

Tree	Contents

Advanced	Ops
Layouts Ops-ready	layouts	of	all	sizes,	fully	set	up	and	ready	to	run

Demo Sample	layouts	for	use	with	free	demo	version
TP	Starter	Layouts Small	layouts	for	practice	and	tutorials



Scripts	and	Puzzles Scripted	layouts	ready	to	run,	switching	puzzles
<other> Many	more	layouts	including	user	contributions

Tree	Menu

Open Open	folder	to	show	subfolders	or	files
Refresh Always	dimmed	in	this	web	chooser
Find... Search	for	name	or	filename.		See	Search.
Find	Next Go	to	next	hit	after	Find

Download	All... Download	and	install	all	layouts	within	the
selected	folder	and	subfolders.

Download	Missing
Items...

Look	at	web	layouts	within	the	selected	folder
and	subfolders;	if	some	on	the	web	are	not
yet	installed	on	your	local	machine,	download
and	install	those

List	Menu

Open Download	selected	layout(s),	then	switch	to
Local	tab.		Works	over	multiple	selection.

Refresh	Thumbnail Redownload	thumbnail	image



Web	Scenery	Chooser

The	web	scenery	chooser	is	for	downloading	folders	of	scenery	objects	from	the	web.		You
must	have	a	live	internet	connection	while	using	this	chooser.

For	general	information	about	choosers,	see	Choosers.

To	Download	a	Scenery	Folder

1.	 The	web	scenery	tree	shows	folders	of	scenery	objects	available	on	the	web.		Click	to
open	a	folder	containing	the	types	of	object	you	want.

2.	 	The	objects	in	the	folder	are	downloaded	to	a	temporary	folder	on	your	disk	(called	the
"cache"),	and	the	list	window	displays	the	object	images.	

3.	 Click	an	icon	to	see	its	larger	image	in	the	preview	window.	

4.	 If	you	like	the	set	and	would	like	to	use	it	in	your	layouts,	click	Install.		This	copies	the	files
from	the	cache	into	your	local	scenery	folder,	then	switches	to	the	Local	Scenery	Chooser
so	you	can	add	them	to	your	layout.

As	an	alternative	to	icon	view,	you	can	choose	to	view	the	objects	in	list	form.		This	displays
status	icons	indicating	which	objects	you	do	and	don't	have	in	your	local	set,	and	which	are	new
on	the	web.



Tree	Contents

Scenery Named	folders	of	scenery	objects

Tree	Menu

Open Open	folder	to	show	subfolders	or	files

Refresh Re-download	scenery	folder.		Dimmed	on
parent	or	root	folder	of	tree.

Find... Search	for	name	or	filename.		See	Search.
Find	Next Go	to	next	hit	after	Find

Download	All... Download	and	install	all	scenery	objects	within
the	selected	folder	and	subfolders.

Download	Missing
Items...

Look	at	all	scenery	objects	within	the	selected
folder	and	subfolders;	if	some	on	the	web	are
not	yet	installed	on	your	local	machine,
download	and	install	those

Clear	Download
Cache

(on	Scenery	folder	only)	Remove	local	cached
files,	force	re-download

	List	Menu

Open Download	selected	scenery	folder,	then	switch	to
local	tab

Icon	View Show	scenery	objects	as	icons
Show	scenery	objects	in	list	form,	with	status



List	View icons	(see	Status	Icons)



Web	Sound	Chooser

The	web	sound	chooser	is	for	downloading	sounds	from	the	web.		You	must	have	a	live	internet
connection	while	using	this	chooser.

For	general	information	about	choosers,	see	Choosers.

To	Download	a	Sound

A	web	sound	chooser	shows	a	subfolder	of	sounds	available	on	the	web;	which	folder	depends
on	whether	you	are	choosing	an	engine	horn	sound	or	a	layout	sound.

1.	 		Click	the	folder	in	the	tree	to	show	the	list	of	sounds	it	contains.	

2.	 Click	a	sound	in	the	list	to	select	it.

3.	 Click	the	icon	on	the	right	to	hear	the	sound.

4.	 If	you	like	it,	click	Download	to	download	the	sound	and	add	it	to	your	local	collection.	
After	the	download,	the	chooser	switches	to	the	Local	Sound	Chooser	and	highlights	the
downloaded	sound.

Engine	running	sounds	(steam	chuffs,	diesel	grinds)	are
available	on	the	web,	but	not	through	a	chooser.		These	are
downloaded	when	you	choose	Download	from	the	Running
menu	in	Train	Properties,	shown	at	right.		You	only	see	this	choice	on	the	menu	if	there	are
running	sounds	on	the	web	you	do	not	already	have	in	your	local	collection.

Tree	Contents

Sounds\Loco Engine	horn,	bell,	whistle	sounds.		Shown	when	chooser	is	called	from
"Other..."	on	Horn	menu	in	Train	Properties.



Sounds\Layout Sounds	to	play	when	the	train	passes	an	area	on	the	layout.		Shown
when	chooser	is	called	from	Sound	browse	button	in	Station	Properties.

Tree	Menu

Open Open	folder	to	show	subfolders	or	files
Refresh Always	dimmed	in	this	web	chooser
Find... Search	for	name	or	filename.		See	Search.
Find	Next Go	to	next	hit	after	Find

Download	All... Download	and	install	all	sounds	within	the
selected	folder	and	subfolders.

Download
Missing	Items...

Look	at	all	sounds	within	the	selected	folder
and	subfolders;	if	some	on	the	web	are	not	yet
installed	on	your	local	machine,	download	and
install	those

List	Menu

Open Download	selected	sound	and	switch	to	local	tab

For	more	information	about	sounds,	see	Horns	and	Sounds;	also	Stations.



Load	Chooser

The	Load	Chooser	appears	when	you	(a)	select	Load	Chooser	from	the	Load	menu,	(b)
choose	Loaded	for	a	car	which	has	not	yet	been	assigned	a	load,	or	(c)	double-click	the	Load
Car	toolbar	icon.	

The	Load	Chooser	is	much	like	the	Car	Chooser.		It	shows	about	a	dozen	folders	named	for
types	of	goods,	each	containing	an	assortment	of	pictorial	loads	in	that	category.		When	you
click	a	load,	it	shows	top	and	side	views	in	the	preview	window,	and	data	in	the	lower	left	about
what	sorts	of	cars	can	carry	the	load.

Note:	the	behavior	of	the	Load	Chooser	changed	at	version	5.2.		The	following	instructions	have
been	revised.

To	operate:

Browse	the	collection	--	click	a	folder	in	the	tree	to	see	its	contents.

Select	a	load	by	clicking	its	image	in	the	middle	panel.		Note	the	indication	on	the	status	bar	at
lower	left:	it	shows	the	types	of	car	(by	AAR	code)	which	are	suitable	for	carrying	the	selected
load.

Press	on	the	load	image	and	drag	the	load	onto	the	layout.		As	you	move	over	a	suitable
car,	it	is	highlighted	with	a	red	outline,	meaning	that	the	load	can	be	deposited	there.		Release
the	mouse	button	over	the	car	you	want	to	load.

Hold	the	Ctrl	key	down	while	you	drag	if	you	wish	to	load	more	than	one	car	at	a	time.		When
Ctrl	is	down,	an	entire	cut	of	cars	is	highlighted	at	once	and	can	be	loaded	with	the	dragged
load.		(Cut	means	a	connected	group	of	cars	of	the	same	class.)



To	modify	a	load	or	see	its	properties,	right-click	the	load	icon	in	the	middle	window	and	choose
Properties.		You	get	the	Load	Collection	Editor.

Closed-car	loads

One	special	load	folder	works	differently:	closed-car	loads.		These	are	loads	without	pictures,
for	loading	on	boxcars,	refrigerated	cars,	covered	hoppers,	and	other	closed	cars.		When	you
select	this	folder,	the	center	panel	changes	to	list	view	and	shows	you	a	lengthy	collection	of
load	names:	

In	this	case	the	preview	window	shows	the	load	as	text,	which	will	be	displayed	above	side
views	of	the	car,	and	as	a	pattern	which	will	be	overlaid	onto	the	car	top	image.		By	default,	all
closed-car	loads	are	shown	as	a	pair	of	double	red	bars,	but	you	can	change	this:	right-click
the	load,	choose	Properties,	go	to	the	Images	tab,	click	Browse.



Local	Decal	Chooser

The	local	decal	chooser	is	for	selecting	decals	and	adding	them	to	the	car	image	in	Paint	Shop.

For	general	information	about	choosers,	see	Choosers.

To	Add	Decals	to	the	Car	Image

1.	 The	tree	shows	folders	in	your	Decals	directory.		Click	a	folder	to	see	its	contents	as	icons
in	the	list	window.	

2.	 Click	an	icon	to	see	a	larger	view	in	the	preview	window.	

3.	 To	add	a	decal	to	your	car,	press	and	drag	the	icon	from	the	list	window	onto	the	Paint
Shop	window.

Note:	The	size	of	the	decal	is	not	adjusted	as	you	drag.		Resizing	the	Paint	Shop	window
changes	the	relative	size	of	decal	vs.	car.

The	decal	chooser	is	a	modeless	dialog:	it	remains	on	the	screen	so	you	can	add	multiple
decals.

Tree	Contents

Folders	in	the	tree	are	those	in	the	Decals	folder	in	your	TrainPlayer	app	data	directory.



Tree	Menu

Open Open	folder	to	show	subfolders	or	files
Refresh Reload	contents	from	disk
Find... Search	for	name	or	filename.		See	Search.
Find	Next Go	to	next	hit	after	Find
Properties... Display	folder	properties

Export	Filenames... Export	text	or	xml	file	of	folder	contents.	
See	Export.

List	Menu

	

Icon	View Show	decals	as	icons

List	View Show	decal	filenames	in	list	form.		Paths	are
relative	to	Decals	folder.



Web	Decal	Chooser

The	web	decal	chooser	is	for	downloading	folders	of	decals	from	the	web.		You	must	have	a
live	internet	connection	to	use	this	chooser.

For	general	information	about	choosers,	see	Choosers.

To	Download	a	Decal	Folder

1.	 The	web	tree	shows	folders	available	on	the	web.		Click	to	open	a	folder.

2.	 	The	decals	in	the	folder	are	downloaded	to	a	temporary	folder	on	your	disk.		On
completion,	the	list	window	displays	the	images.	

3.	 Click	an	icon	to	see	a	larger	image	in	the	preview	window.	

4.	 To	use	the	folder	on	your	machine,	click	Install.		This	copies	the	files	from	the	cache	into
your	local	decals	folder,	then	switches	to	the	Local	Decal	Chooser	so	you	can	add	them	to
your	cars.

As	an	alternative	to	icon	view,	you	can	view	the	decals	in	list	form.		This	displays	status	icons
indicating	which	objects	you	have	in	your	local	set,	and	which	are	new	on	the	web.

Tree	Menu



Open Open	folder	to	show	subfolders	or	files
Refresh Dimmed,	not	available	for	decals.
Find... Search	for	name	or	filename.		See	Search.
Find	Next Go	to	next	hit	after	Find

Download	All... Download	and	install	all	decals	within	the
selected	folder

Download	Missing
Items...

Download	and	install	decals	available	on
web	but	not	locally

	List	Menu

Icon	View Show	decals	as	icons

List	View Show	decals	in	list	form,	with	status
icons	(see	Status	Icons)



Customize	Commands

For	arranging	commands	on	toolbars.	Called	from	Tools	>	Customize.

This	tab	allows	you	to	add	or	remove	buttons	on	toolbars.		To	add	a	button	to	a	toolbar,	locate
the	command	in	this	dialog	and	drag	it	onto	the	toolbar	where	you	want	it	to	go.		To	remove	a
button	from	a	toolbar,	drag	it	off	the	toolbar	and	drop	it	anywhere	(this	only	works	when	the
Customize	dialog	is	visible.)

Dialog	controls:

Categories
Select	a	menu	to	see	its	commands	on	the	right.		Or	choose	"All
Commands"	to	see	the	complete	list	of	commands	from	all	menus.	
The	"New	Menu"	item	can	be	dragged	onto	a	toolbar	to	create	a
new,	empty	menu.

Commands
Locate	a	command	in	this	list,	point	to	it,	press	the	left	mouse
button,	and	drag	the	command	onto	any	toolbar.		If	the	command
does	not	have	an	icon,	the	toolbar	button	will	show	the	command
name.



Customize	Keyboard

For	assigning	keys	to	menu	commands,	and	seeing	a	list	of	assignments.	Called	from	menu
command	Tools	>	Customize.

In	this	tab,	you	select	a	command	from	the	menu	and	choose	a	key	on	the	keyboard	to	execute
that	command.		If	the	command	already	has	a	key	assigned	to	it,	you	can	change	it.

The	Help	button	works	differently	in	this	tab.		On	the	first	click,	it	brings	up	this	page	you	are	reading.	
Take	this	down	and	click	Help	again	and	you	get	the	Keyboard	Guide	shown	below.		Alternate	clicks	of
the	Help	button	bring	up	one	or	the	other.

Dialog	controls:

Category Select	the	menu	containing	the	command	you	want	to
operate	by	keyboard.

Commands Select	the	command	you	want	to	attach	to	a	key.

Set	Accelerator	for This	is	non-functional,	always	set	to	Default.

Current	Keys Shows	the	keys(s)	currently	assigned	to	the	selected
command,	if	any.

Press	New	Shortcut
Click	this	box	so	it	has	the	focus,	then	press	the	key	you
want	to	assign	to	the	command.		The	key	name	will	echo



in	this	box.

Assign
Click	to	complete	the	assignment.		If	you	do	not	click
Assign,	nothing	will	change.		This	button	is	dimmed	if	no
key	has	been	entered.

Remove
Click	if	you	want	to	remove	the	current	key	assignment	for
the	command.		This	button	is	dimmed	if	no	key	is	currently
assigned.

Reset	All Erases	all	key	assignments	and	resets	to	factory	values.

Help Brings	up	this	help	page	or	Keyboard	guide	on	alternate
clicks.

Keyboard	Guide

Built	into	the	tools	customization	scheme	is	a	special	dialog	showing	all	the	commands	in	the
program,	with	the	description	string	attached	to	each	one	and	the	keyboard	assignment	if	any.	
(To	see	this,	click	Help	twice	on	the	Keyboard	tab	as	described	above.)

Instructions:	Choose	a	main	menu	name	in	the	Category	drop-down	and	you	will	see	the
commands	under	that	menu.		Click	a	column	header	to	sort	on	that	column.		The	Show
Accelerator	drop-down	is	not	used.	

You	can	select	a	row	by	clicking	it;	if	you	then	Shift-click	another	row,	it	selects	a	range.		Use
the	buttons	at	the	upper	left	to	print	the	list	or	copy	selected	rows	to	the	Windows	Clipboard,
suitable	for	pasting	into	Excel.



Customize	Menu

For	resetting	or	customizing	menus.	Called	from	menu	command	Tools	>	Customize.

Dialog	controls:

Application	Frame
Menus

Choose	one	of	the	two	main	menus:	Layout	(the	menu
when	a	document	is	open)	or	Default;	then	click	Reset	to
reset	the	selected	menu	to	factory	content.	

Context	Menus Choose	Popups,	then	click	Reset	to	reset	all	context
menus	to	defaults.

Menu	animations Choose	the	action	to	be	taken	when	you	expand	a
menu.

Menu	shadows Check	if	you	want	menus	to	have	a	three-dimensional
look	with	shadows.

It	may	be	necessary	to	reset	all	menus	after	you	upgrade	to	a	new	version,	if	the	menu
commands	don't	seem	to	be	doing	what	they	should.		To	reset	all	menus,	click	Reset	once	for
each	of	the	three	menu	choices.	



Customize	Options

For	setting	miscellaneous	toolbar	options.	Called	from	menu	command	Tools	>	Customize.

Dialog	controls:

Show	Screen	Tips Check	if	you	want	to	see	a	tooltip	whenever	the	mouse
hovers	over	a	toolbar	button.

Show	shortcut
keys

Check	if	you	want	a	tooltip	to	include	the	command's
keyboard	shortcut.		For	example,	with	this	box	checked	the
tooltip	for	File	New	becomes	"New	(Ctrl+N)."

Large	Icons Check	if	you	want	larger	icons	on	the	toolbars.



Customize	Toolbars

For	choosing	toolbars	to	be	displayed.	Called	from	menu	command	Tools	>	Customize.

Dialog	controls:

Toolbars Choose	which	toolbars	are	to	be	visible.		Most	can	also	be	made
visible	from	View	>	Toolbars	on	the	menu.

Reset
Reset	the	selected	toolbar	to	factory	settings.		This	synchronizes
the	toolbar	with	the	menu,	and	positions	it	in	default	docking
position.

Reset	All
Reset	all	toolbars	to	factory	settings.		This	may	be	necessary	after
upgrading	to	a	new	version,	if	toolbar	buttons	do	not	seem	to	be
working	as	expected.



Scenery	Preferences

Settings	for	scenery	options.	Called	from	menu	command	File	>	Preferences.

In	Scenery	Preferences,	you	indicate	settings	only	for	the	Scenery	Grid.		To	set	preferences	for
default	styles,	use	the	Scenery	Styles	dialog.

Grid	Preferences

Color:		color	of	grid	dots.		Default	is	medium	grey.

Spacing:		distance	between	dots.		Default	is	100	RRU,	or	1"	in	HO.

Units:		units	for	display	of	spacing	value.	



Scenery	Properties/Styles:	Background

Properties:	Background	fill	properties	of	the	selected	scenery	object(s).		Called	from
Properties	on	the	scenery	context	menu.		See	Editing	Scenery	Properties.

Styles:	Default	background	fill	style.		Called	from	arrow	button	on	Paint	tool	 		See	Scenery	Styles.

This	dialog	sets	properties	of	the	color	or	pattern	which	fills	the	object.		The	default	is	a	solid
ivory	color	(shown	above).		If	multiple	objects	are	selected	(including	grouped	objects),	the	fill
properties	chosen	in	this	dialog	apply	individually	to	each.

Dialog	controls:

Select	one	of	four	choices	using	the	radio	buttons.

No	Fill Choose	this	if	you	do	not	want	the	object	to	be	filled.		An	object	with	no	fill
is	transparent.

Solid
Choose	this	to	have	the	object	filled	with	a	solid	color.	

To	change	the	color,	click	the	colored	button	to	bring	up	the	Color	Chooser
dialog.

Choose	this	to	fill	the	object	with	one	of	the	system-defined	hatch
patterns.		Choose	a	pattern	from	the	drop-down	choice	list:



Hatched

Set	the	foreground	(line)	color	of	the	pattern	using	the	color	button	next	to
Hatched.		The	background	color	is	set	with	the	button	next	to	Solid.	

The	hatch	patterns	are	provided	by	system	"brushes."		They	do	not	offer
much	flexibility	--	you	cannot	change	the	line	width,	and	the	patterns	do	not
stretch	or	rotate.

Bitmap

Choose	this	to	fill	the	object	with	an	image.	Click	the	Browse	button	("...")
to	bring	up	the	Scenery	Chooser,	where	you	can	select	an	image	from	the
scenery	collection	or	import	one	from	the	file	system.

The	appearance	of	the	image	within	the	scenery	object	is	affected	by	the
Stretch/Tile	radio	described	below.	

Note:	a	shortcut	to	performing	this	operation	is	to	use	the	Load	Bitmap
command	on	the	Scenery	context	menu.

Stretch/Tile

Choose	Stretch	to	cause	the	image	to	stretch	so	that	it	fills	the	object.

If	Lock	Proportions	is	checked,	the	image	will	fill	as	much	of	the	object
space	as	possible	without	distorting;	otherwise,	the	image	will	fill	the
complete	space,	distorting	as	necessary.

	Choose	Tile	to	show	the	image	in	its	native	size	and	proportions,	drawn
repeatedly	to	fill	the	object	space.		Tiled	images	do	not	scale	or	rotate.

Transparency

Adjusts	the	degree	of	transparency	of	the	background	fill	or	pattern.	

When	set	to	zero	(slider	at	left),	the	object	is	completely	opaque,	and
obscures	objects	underneath.		When	set	to	100	(slider	at	right),	the	object
is	fully	transparent,	as	if	you	had	chosen	No	Fill.		Values	in	between	cause
the	background	to	be	semi-transparent	--	see-through	to	an	adjustable
extent.

Note:	choosing	a	non-zero	value	for	transparency	adds	complexity	and
slows	down	the	drawing	process.		It	is	not	recommended	that	you	use
transparency	for	large	background	objects.



Lock
Proportions

Specifies	whether	the	image	can	be	stretched	independently	in	both
directions	(unchecked)	or	must	retain	its	native	proportions	(checked).	

This	setting	is	ignored	unless	Stretch	is	chosen	as	the	display	mode.



Scenery	Properties:	General

General	properties	of	the	selected	scenery	object(s).		Called	from	Properties	on	the	scenery
context	menu.

See	also:	Editing	Scenery	Properties.

This	dialog	sets	general	properties	of	a	scenery	object.		If	multiple	objects	are	selected,	the
dialog	displays	"--"	for	values	which	differ	among	the	objects;	any	change	you	make	applies	to
all.		Most	of	the	values	in	this	dialog	are	normally	adjusted	by	moving	the	object	on	the	layout
rather	than	entering	numeric	values,	but	both	are	possible.

Dialog	controls:

Name Name	of	the	object.		This	is	a	program-generated	name	consisting	of
the	object's	type	and	its	ID.		It	cannot	be	changed.

Foreground Check	this	box	to	move	the	scenery	object	into	the	foreground	layer.	
Uncheck	to	move	to	the	background.

Size
Height	and	width	of	the	unrotated	object's	rectangular	bounds,	in	units
chosen	from	the	drop-down	menu.		You	can	enter	a	new	value	in	either
box	to	change	the	dimensions	of	the	object.

Location

Coordinates	of	the	upper	left	corner	of	the	unrotated	object,	relative	to
the	upper	left	corner	of	the	layout.		You	can	enter	new	values	to	change
the	object's	position	on	the	layout.		Units	are	as	chosen	from	the	drop-



down.

Units
Specifies	units	of	length	for	display	and	entry	of	size	and	location
values.		Any	choice	you	make	here	will	apply	in	similar	Units	menus
throughout	the	program.

Rotation
Angle	in	degrees	by	which	the	object	is	rotated	clockwise	from	normal.	
Enter	a	new	value	to	change	the	orientation,	or	enter	0	to	return	the
object	to	normal.

Hide	track	&
trains

Specifies	whether	the	object	sits
above	or	below	track	and	trains.

Check	this	box	if	you	want	the
object	to	appear	on	top,	so	that
track	is	obscured	and	trains
disappear	as	they	travel	beneath,
as	shown	here.

Uncheck	the	box	to	have	the	scenery	at	ground	level,	with	track	and
trains	passing	above	it.

Note:	if	the	object	has	a	non-zero	transparency	setting	(see	Background
Properties),	and	this	box	is	checked,	then	the	trains	will	disappear	but
the	track	will	be	partially	visible.



Scenery	Properties/Styles:	Line

Properties:	Line	properties	of	the	selected	scenery	object(s).		Called	from	Properties	on	the
scenery	context	menu.		See	Editing	Scenery	Properties.

Styles:	Default	line	style.		Called	from	arrow	button	on	Line	tool	 		See	Scenery	Styles.

This	dialog	sets	properties	of	the	line	bordering	the	scenery	object.		If	multiple	objects	are
selected,	this	dialog	sets	the	same	line	properties	for	all.		If	you	do	not	want	the	object	outlined,
set	its	line	width	to	zero.

Dialog	controls:

No	Line Choose	this	if	you	do	not	want	the	line	to	be	filled.		In
fact	this	will	make	it	invisible.

Solid
Choose	this	to	have	the	line	drawn	in	a	solid	color.	

To	change	the	color,	click	the	colored	button	to	bring
up	the	Color	Chooser	dialog.

Choose	this	to	fill	the	line	with	one	of	the	system-
defined	hatch	patterns.		Choose	a	pattern	from	the
drop-down	choice	list:



Hatched

Set	the	foreground	(line)	color	of	the	pattern	using	the
color	button	next	to	Hatched.		The	background	color	is
set	with	the	button	next	to	Solid.	

The	hatch	patterns	are	provided	by	system	"brushes."	
They	do	not	offer	much	flexibility	--	you	cannot	change
the	line	width,	and	the	patterns	do	not	stretch	or
rotate.

Bitmap

Choose	this	to	fill	the	line	with	an	image.	Click	the
Browse	button	("...")	to	bring	up	the	Scenery	Chooser,
where	you	can	select	an	image	from	the	scenery
collection	or	import	one	from	the	file	system.

The	bitmap	used	for	a	line	style	is	always	tiled,	not
stretched.

Line	Width Thickness	of	the	line,	in	RRU	(1	RRU	=	0.01"	in	HO).	
Default	is	10,	a	fairly	thin	line.	



Scenery	Properties/Styles:	Text

Properties:	Text	properties	of	the	selected	scenery	object(s).		Called	from	Properties	on	the
scenery	context	menu.		See	Editing	Scenery	Properties.

Styles:	Default	text	style.		Called	from	arrow	button	on	Text	tool	 		See	Scenery	Styles.

This	dialog	is	used	to	add	text	to	an	object	and	specify	its	style.		You	may	enter	a	single	line	or
multi-line	block	of	text	to	be	displayed	in	the	box,	aligned	left,	right,	or	center.		If	multiple
objects	are	selected,	the	text	is	applied	to	each	individually.		If	a	grouped	object	is	selected,	the
text	is	displayed	on	top	of	the	group.

Dialog	controls:

Text The	text	string	to	be	displayed	on	the	object.		Enter
whatever	you	want	it	to	say.

Show	text

Check	this	box	to	have	text	displayed	on	the	object.		In
order	to	see	text	on	the	object,	you	must	both	check
this	box	and	enter	a	text	string.

If	this	box	is	unchecked,	the	rest	of	the	dialog	is
inactive.

Click	to	bring	up	the	Font	dialog	to	change	the	text	font
and	style.		Change	the	settings	so	the	sample	looks
the	way	you	want,	then	click	OK.



Font

The	fonts	shown	in	the	dialog	are
those	available	on	your	machine.		They
may	not	display	the	same	way	on
another	machine.

The	size	you	choose	is	not	meaningful
in	an	absolute	sense	--	see	note	below	regarding	text
sizes.

Note:	in	the	current	version,	not	all	features	in	the	Font
dialog	are	working.		For	example,	choosing	Strikeout
or	Underline	has	no	effect.
	

Color Click	the	colored	button	to	bring	up	the	Color	Chooser
dialog.

Align Choose	Left,	Center,	or	Right	to	position	the	text
horizontally	within	the	box.

Rotate	text	with	image

Specifies	how	to	handle	text	in	a	rotated	object.

If	this	box	is	checked,	text	is	rotated	to	the	same
orientation	as	the	object,	as	if	it	were	painted	on	the
rooftop	--	this	is	shown	in	the	picture	above.

If	the	box	is	unchecked,	text	is	displayed	horizontally,
regardless	of	whether	the	object	is	rotated	--	like	a
label	on	a	map.	

This	option	applies	only	to	single-line	text.		Wrapped
text	cannot	be	rotated.

Wrap	Text

Check	this	box	if	you	want	the	text	to	be	displayed	on
multiple	lines,	wrapped	to	fit	within	the	box.

This	option	is	incompatible	with	text	rotation.		If	you
choose	to	wrap	text,	the	text	will	be	displayed
horizontally.

When	Wrap	Text	is	on,	you	can	manually	enter	a
carriage	return	into	a	text	block	by	entering	the
characters	"\n"	(backslash	n).		This	will	cause	a	break
between	lines	at	the	indicated	point.		For	example,	this
would	give	a	two-line	note:



line	one\nline	two



Scenery	Properties:	Transfer	Table

Properties:	Transfer	Table	properties	of	the	selected	scenery	object.		Called	from	Properties
on	the	scenery	context	menu,	when	a	Transfer	Table	is	selected.		See	Editing	Scenery
Properties.

This	dialog	sets	properties	of	the	selected	transfer	table.		To	create	one,	see	Creating	a
Transfer	Table.

Dialog	controls:

Show	Guide	Rails
Specify	the	number	of	rails	to	display	beneath
platform.		These	rails	are	thin	black	lines	purely	for
decoration.

Show	Bridge	Track Show	or	hide	tracks	on	platform.	

Bridge	Width

Width	of	platform,	in	current	units	(as	set	by	Units
dropdowns	in	several	other	dialogs).		This	value
applies	only	when	the	number	of	bridge	tracks	is	1;
otherwise	the	width	is	set	automatically	(see	note
below).

Bridge	Scenery
Specify	a	separate	scenery	object	which	is	to	move
along	with	the	bridge	platform.		For	details,	see
Decorating	a	Transfer	Table.



Bridge	Tracks Number	of	tracks	on	platform,	at	least	1,	up	to	8.	
Default	is	1.		See	note	below.

When	you	change	the	number	of	bridge	tracks,	the	program	automatically	sizes	the	platform
and	positions	the	tracks.		The	separation	between	tracks	is	the	distance	specified	in	Track
Preferences	called	"To	Parallel"	--	the	distance	used	when	using	track	snap	to	create	yards.	
The	platform	size	is	adjusted	to	fit	the	number	of	tracks	plus	the	same	gap	at	either	end,	so
that	if	you	have	N	tracks,	the	total	width	is	(N	+	1)	x	gap.

This	applies	only	if	there	are	multiple	bridge	tracks.		If	there	is	only	one,	then	the	platform	size
can	be	adjusted	in	the	Bridge	Width	box.



Script	Central

Script	Central	is	a	single	dialog	for	managing	scripts	of	all	types	on	your
layout.		It	is	a	tabbed	dialog,	with	tabs	as	listed	below.		It	is	modeless,	so	it
stays	on	the	screen	while	you	work,	and	provides	handy	reference	material
while	you	are	developing	or	trying	to	understand	a	scripted	layout.

Script	Central	Tabs

Script	Central	has	six	tabs	as	follows.		Links	go	to	detail	pages.

1	-	Scripts Train	scripts,	master	scripts,	and	script	notes Scripts	tab
2	-	Junction
Actions Junction	action	scripts Junction

Actions	tab
3	-	Subroutines Subroutines	and	procs	available	in	Scripts	folder Subroutines	tab

4	-	Reference Reference	data	for	commands,	variables,	and	other
language	elements Reference	tab

5	-	Settings Settings	and	actions	applying	to	all	scripts Settings	tab
6	-	Variables User-defined	variables Variables	tab

All	tabs	except	Settings	share	the	same	format	--	list	on	the	left,	text	box	on
the	right	--	and	support	many	of	the	same	operations,	such	as:

Click	a	row	in	the	list,	and	its	contents	show	up	in	the	text	box.		In	tabs
1-3,	the	text	can	be	edited	and	saved.
Right-click	a	row	in	the	list,	and	you	get	a	context	menu,	with
commands	applying	to	the	selected	script.
Double-click	a	row	(or	choose	Edit	from	the	context	menu)	to	edit	in	the



appropriate	editor,	depending	on	the	script	type.
Click	OK	or	Apply	to	save	changes	made	to	the	text.		These	changes	are
saved	with	the	layout	in	memory;	they	are	not	saved	permanently	until
you	save	the	layout.		Click	Cancel	to	take	down	the	dialog	without
saving.		Cancel	changes	to	Done	after	you	have	saved	any	change.	
Note	that	changing	tabs	in	the	dialog	saves	your	changes	quietly.

For	details	of	the	individual	tabs	and	their	context	menus,	click	links
above.



Script	Central	-	Junction	Actions	Tab

For	viewing	and	editing	junction	action	scripts.		See	also	Script	Central	Tabs.

This	tab	shows	a	list	of	all	junction	actions	on	the	layout.		If	there	is	more	than	one	action	at	the
same	junction,	they	are	listed	separately	and	given	different	id's.		When	this	tab	is	active,	a
junction	on	the	layout	is	highlighted	to	match	the	selected	item	in	the	list.

List	contents:

ID Unique	program-assigned	id	for	each	action.

Junction ID	of	junction	where	action	is	attached.

Trigger Trigger	type,	direction,	and	identifier	if	any;	as	specified	in	Junction
Action	Editor.

First	Line First	line	of	action	script.

Actions:

Click	list	item Selects	action	script	and	displays	it	in	the	text	window.		The
corresponding	junction	on	the	layout	is	highlighted.

Double-click
row Brings	up	Junction	Action	Editor	for	editing	and	viewing	script.



Right-click	row Brings	up	context	menu,	commands	as	listed	below.

Text	window
Text	is	editable.		Text	is	in	code	style:	fixed-size	font,	no	wrap.	
Changes	are	saved	on	clicking	OK	or	Apply	or	on	changing
tabs.

			

Context	menu:

Edit	in	JA	Editor Brings	up	Junction	Action	Editor	for	editing	and	viewing
script.

Delete Deletes	action	and	removes	from	the	list.

Copy Copies	selected	row(s)	to	Windows	Clipboard	as	tab-
delimited	text

Select	All Selects	all	rows	for	delete	or	copy

Enabled Check	to	enable	action,	uncheck	to	disable.		When
disabled,	no	cars	or	trains	cause	action	to	trigger.

Refresh Rebuilds	list;	sometimes	needed	if	changes	have	been
made	externally

Attach	To	Junction
Disconnects	action	from	current	junction,	brings	up	Choose
Junction	dialog	for	choosing	a	new	junction	where	action	is
to	be	connected

	



Script	Central	-	Reference	Tab

A	compact	reference	to	the	scripting	language.		Provides	information	about	commands,	wait
conditions,	system	and	local	variables.		See	also	Script	Central	Tabs.

The	Reference	tab	is	your	best	source	of	information	about	the	details	of	the	language.		It	is
built	into	the	program,	so	will	never	be	out	of	date	when	new	commands	are	added.		Unlike	a
paper	manual,	it	is	always	available,	and	conveniently	displayed	on	your	screen	as	you	work.	
You	can	copy	and	paste	from	it	to	save	typing.

Script	Doc	Notes	File

Much	of	the	information	shown	with	each	reference	entry	is	taken	from	a	text	file	distributed
with	the	program.		The	file	is	named	scr_doc_notes.txt	and	it	resides	in	the	root	TP	app	data
folder.		If	you	don't	have	this	file,	or	your	version	is	out	of	date,	and	you	have	an	internet
connection,	then	a	new	version	of	the	file	is	automatically	downloaded	when	you	bring	up	the
Reference	tab.

List	contents:

Type
Command,	wait	condition,	variable,	or	one	of	a	dozen	other	types	of
scripting	element.		Command	names	include	subcategory.		Function
and	variable	names	include	"r/w"	where	value	is	settable.

Name Command,	variable,	or	function	name	with	calling	sequence	when
applicable

DescriptionBrief	explanation	of	the	entry



Value For	system	variables,	functions	without	arguments,	and	user
variables:	current	value

Actions:

Click	list	item
Selects	item	and	displays	it	in	the	text	window.		The	text	includes
data	from	the	list	window	plus	notes	taken	from	the	system	doc
notes	file.

Right-click
row Brings	up	context	menu	shown	below.

Text	window Text	is	not	editable.	It	wraps	to	fit	the	box.

Context	menu:

Copy Copies	selected	row(s)	to	Windows	Clipboard	as	tab-delimited
text	(suitable	for	pasting	into	Excel)

Select	All Selects	all	rows	for	copy
Refresh Rebuilds	list	and	updates	variable	entries	to	latest	values

Editing	variables

As	of	version	6.4,	user-defined	variables	are	no	longer	displayed	or	edited	here;	instead	see
Variables	tab.



Script	Central	-	ScriptsTab

For	viewing	and	editing	train	scripts,	master	script,	script	notes,	and	interactive	command	box.	
See	also	Script	Central	Tabs.

Script	Notes

Script	notes	are	blocks	of	text	you	(the	script	author)	can	add	to	Script	Central.		You	might	use
these	to	give	instructions	for	a	user	of	your	script,	or	to	provide	background	info	about	it,	or	to
jot	notes	to	yourself	about	what's	going	on	in	the	scripts.		You	can	add	one	or	more	of	these	to
the	first	tab	of	Script	Central,	edit	as	desired,	and	then	bring	up	whenever	useful.

Interactive	Command	Box

In	the	Scripts	tab	you	may	create	a	special	type	of	window	called	the	interactive	command
box	(ICB).		This	starts	as	a	blank	space	(with	a	comment	at	the	top)	and	acts	as	a	sort	of
scratch	pad.		Enter	a	script	command,	then	press	Return	--	the	command	executes
immediately.		You	may	enter	a	new	line	or	edit	an	existing	one;	in	either	case,	when	you
position	the	cursor	at	the	end	and	press	Return,	the	line	is	executed.

There	are	some	special	considerations	when	executing	script	commands	one	by	one;	for
information,	see	Script	Command	Prompt.

Contents	of	the	ICB	are	saved	with	the	layout,	so	you	can	go	back	and	reuse	lines	entered	in
an	earlier	session.		There	is	only	one	ICB;	once	you	have	created	one,	the	command	is	dimmed
so	you	cannot	create	another.

List	contents:

ID Unique	program-assigned	id	for	each	row.



Script For	train	script:	script	name	and	owning	train;	otherwise,	item	type
("master"	or	"notes").

First
Line First	line	of	script	or	note.

Actions:

Click	list	item Selects	item	(script	or	note)	and	displays	it	in	the	text	window.

Double-click
row

For	train	or	master	script:	brings	up	Script	Editor	for	editing	and
viewing	script.		For	note:	does	nothing;	editing	is	done	here.

Right-click	row Brings	up	context	menu,	commands	as	listed	below.

Text	window
Text	is	editable.		Text	is	in	code	style:	fixed-size	font,	no	wrap.	
Changes	are	saved	on	clicking	OK	or	Apply	or	on	changing
tabs.

Context	menu:

Edit	in	Script
Editor

Brings	up	Script	Editor	for	editing	and	viewing	train	or
master	script;	for	a	note,	editing	is	done	in	this	tab.

Delete Deletes	item	and	removes	from	the	list.		For	a	train	script,
this	removes	the	script	from	the	train.

Copy Copies	selected	row(s)	to	Windows	Clipboard	as	tab-
delimited	text



Select	All Selects	all	rows	for	delete	or	copy

Enabled Master	script	only:	check	to	enable	automatic	run	on	open,
uncheck	to	disable.

Refresh Rebuilds	list;	sometimes	needed	if	changes	have	been
made	externally.

Add	Note Creates	a	new,	empty	note	and	selects	it	so	you	are	ready
to	enter	text	into	it.		See	Script	Notes.

Add	Master	Script Creates	an	empty	master	script	if	the	layout	does	not	have
one.		Dimmed	if	master	script	already	exists.

Add	Command	Box
Creates	an	Interactive	Command	Box	--	a	window	for
entering	script	commands	with	immediate	execution.		See
ICB	above.

Restart	Master
Script

Reruns	the	master	script	if	the	layout	has	one.		This
command	does	not	do	a	full	rewind	or	change	any	train
positions,	it	just	restarts	the	master	script	at	the	first	line.



Script	Central	-	Settings	Tab

For	script-related	actions	and	settings.		See	also	Script	Central	Tabs.

This	tab	is	a	standard	dialog,	not	the	list-text	style	of	the	others.		It	has	a	set	of	buttons	dealing
with	the	Rewind	Point,	and	these	other	items:

Trigger	on	Drag:	if	checked,	means	a	junction	action	can	be	triggered	by	dragging	an
appropriate	train	across	the	junction	by	hand.		If	unchecked,	the	train	must	be	driven	using	the
throttle	in	order	for	the	action	to	trigger.		Default	is	OFF	(unchecked),	to	prevent	accidental
triggerings	as	you	drag	trains	around	the	layout.		For	related	info,	see	Working	with	Junction
Actions	and	Junction	Action	Editor.

Text	font	size:	size	in	points	of	the	Courier	font	used	in	Script	Central	text	windows,	Script
Editor,	Junction	Action	Editor,	and	Schedule	Window.		As	of	version	6.6,	this	font	is	also	used	in
text	input	boxes	in	various	places,	including	Car	Data	Properties.		Default	size	is	16.

Command	MRU	list:	number	of	entries	in	the	drop-down	MRU	list	of	the	Script	Command
Prompt	dialog.		If	you	reduce	the	size	of	the	list,	it	will	be	truncated	and	older	entries	will	be
dropped.

The	Rewind	Point

A	rewind	point	is	a	snapshot	of	train	and	switch	positions.		If	a	rewind	point	has	been	saved,
then	after	a	session	of	moving	trains	around,	you	can	click	Rewind	(on	the	script	toolbar	or
menu)	to	put	the	trains	and	switches	back	where	they	started.		This	is	useful	when	you	are
developing	or	running	scripts,	since	a	script	relies	on	trains	being	in	certain	locations	when	it
starts	up.

There	is	only	a	single	rewind	point	associated	with	a	layout,	even	if	there	are	multiple	scripts.	
This	can	be	set	or	cleared	using	buttons	in	this	Settings	tab.		If	the	rewind	point	is	cleared,	then
it	reverts	to	the	initial	train	and	switch	positions	as	they	were	when	the	layout	was	opened.



Dialog	Buttons:

Set Save	the	current	train	and	switch	positions	as	the	layout's	rewind
point.		This	overwrites	any	previously-defined	point.

Clear Erase	any	saved	rewind	point,	and	replace	it	with	the	initial	positions
when	the	layout	was	opened.

Save Save	the	current	train	and	switch	positions	to	a	file,	with	extension
.xml	and	"_situ"	appended	to	the	filename.

Load Load	a	saved	situation	and	position	the	trains	and	switches
accordingly.		This	does	not	change	the	layout	rewind	point.



Script	Central	-	Subroutines	Tab

For	viewing	and	editing	subroutines	and	procs.		See	also	Script	Central	Tabs.

This	tab	shows	all	the	text	files	located	in	your	TP	Scripts	folder	and	subfolders,	whether	or	not
they	are	used	by	the	current	layout.		If	you	want	to	prevent	a	file	in	that	folder	from	appearing	in
this	list,	rename	it	to	start	with	underscore,	e.g.,	"_hiddenfile.txt".

Also	shown	in	the	list	are	any	procs	defined	in	code	which	has	been	processed	by	the	layout.	
Usually	procs	are	defined	in	the	master	script,	and	are	processed	automatically	on	layout	open,
so	they	appear	in	the	list	in	this	tab.

List	contents:

ID Unique	program-assigned	id	for	each	row.		Starts	with	S	for
subroutine,	P	for	proc.

Name Name	of	subroutine	file	or	proc.		Subroutine	files	are	in	folders
under	<TP	app	data	dir>\Scripts.

Subfolder Name	of	subfolder	under	Scripts	directory

First	Line First	line	of	routine.

Actions:

Click	list	item Selects	routine	and	displays	it	in	the	text	window.



Double-click
row

For	subroutine	file:	brings	up	Notepad.		For	proc:	does	nothing;
editing	must	be	done	in	code	where	proc	is	defined.

Right-click	row Brings	up	context	menu,	commands	as	listed	below.

Text	window
Text	is	editable.		Text	is	in	code	style:	fixed-size	font,	no	wrap.	
Changes	are	saved	on	clicking	OK	or	Apply	or	on	changing
tabs.

Context	menu:

Edit	in	Notepad Brings	up	Notepad	for	editing	and	viewing	selected	subroutine;
does	nothing	for	procs.

Delete
For	subroutine:	deletes	file,	after	confirmation.		Not	applicable
to	procs.		Does	not	work	over	multiple	selected	rows,	only	on
right-clicked	one

Copy Copies	selected	row(s)	to	Windows	Clipboard	as	tab-delimited
text

Select	All Selects	all	rows	for	copy

Refresh Rebuilds	list;	sometimes	needed	if	changes	have	been	made
externally

	



Script	Central	-	Variables	Tab

For	viewing	and	editing	user-defined	variables.		See	also	Script	Central	Tabs.

User	Variables

User	variables	are	those	defined	in	LET	and	SET	statements,	as	described	in	Variables	and
Functions.		When	a	variable	is	defined	and	given	a	value,	and	is	not	declared	LOCAL,	it
appears	in	the	Variables	tab.		The	value	can	be	changed	directly	in	this	tab,	either	in	its	cell	in
the	list	window,	or	in	the	text	box.

List	contents:

Name Variable	name	as	defined	in	LET	or	SET	statement

Value Current	value	of	variable;	can	be	edited	in-place

Actions:

Click	Name	cell Selects	variable	and	displays	it	in	the	text	window.

Click	Value	cell (or	double	click):	begin	editing	value

Right-click	row Brings	up	context	menu,	commands	listed	below.

Text	window Text	is	editable.		To	edit	a	value,	edit	the	text	which
follows(editable):	then	click	OK	or	Apply.



Context	menu:

Copy Copies	selected	row(s)	to	Windows	Clipboard	as	tab-delimited	text

Select	All Selects	all	rows	for	copy

Refresh Rebuilds	list	and	recalculates	current	values



OC	Advanced	Tab

The	last	tab	in	Ops	Central	is	the	Advanced	tab,	which	provides	tools	for	layout	authors	and
ops	developers.	

This	tab	is	in	two	sections.		On	top	are	settings	and	preferences;	underneath	a	drop-down
menu	of	development	actions,	with	a	box	for	output	or	editing.

OC	Advanced	Settings

Settings	made	in	the	Advanced	tab	apply	to	the	current	layout	only.

Setting Description

Cars	to	pull Approximate	number	of	cars	to	be	pulled	from	the	industries	in	a
switchlist.		Default	=	10.		See	Note	1.

Bridge	cars Minimum	and	maximum	number	of	bridge	traffic	cars	to	be	included	in
each	switchlist.		Default	=	2	to	6.

Show	Ops
Central

If	checked,	OC	is	opened	whenever	the	current	layout	opens;	if
unchecked	OC	does	not	appear	unless	requested.

Zoom	to	active
engine

If	checked,	whenever	the	current	layout	opens,	the	view	will	zoom	to
the	active	engine;	if	unchecked,	the	layout	opens	to	the	saved	view.

Notes

1.		Cars	to	pull:		A	similar	number	of	cars	will	be	supplied	to	the	industries	from	staging.	The
total	number	of	cars	to	move	in	a	switchlist	will	be	approximately	2x	the	value	entered	here.	
The	number	you	specify	is	not	exact	--	other	factors	can	modify	this	figure	such	as	unavailability
of	suitable	vacant	spots	for	the	available	car	types.



OC	Development	Combo

The	combo	box	in	the	Development	section	offers	a	variety	of	commands	to	prepare	the	layout
for	AO.	

Each	command	ending	with	ellipses	(...)	brings	up	a	confirmation	alert	and	allows	Cancel	before
taking	action.		The	text	in	those	alerts	is	the	same	as	shown	here.

For	details	about	what	these	commands	do	and	how	they	do	it,	see	the	AO	Documentation,	a
set	of	PDF	files	on	the	web.

Command Description
<Choose> (inactive	place-holder)

1.	Show	AO	Prep	Checklist Show	list	of	steps	in	AO	development,	with	status
reports.

2.	Build	Industries	Grid	from
Cars...

For	each	car	type	(AAR	code)	located	on	an	industry
track,	adds	one	R	row	to	the	Industries	grid.

3.	Add	Basic	Train
Sequence...

Chooses	an	arbitrary	engine,	assigns	a	train	name,	and
creates	an	initial	row	in	the	Sequence	grid.

4.	Flag	XO	Cars... Applies	XO	flag	to	engines,	cabooses,	and	passenger
cars,	as	required	before	switchlist	can	be	generated.

5.	Edit	Intro Displays	Intro	text	and	permits	editing.

6.	Test	Layout Runs	a	series	of	tests	on	the	AO	data	and	reports
results.

7.	Generate	First	Switchlist... Processes	data	in	AO	grids,	generates	waybills	and
creates	switchlist	#1.

Edit	Note Permits	entering	or	editing	a	page	of	notes.

Import	AO	Locations	from
Stations...

For	each	station:	generates	a	unique	label,	applies	it	to
the	station's	tracks,	adds	a	new	row	to	the	Locations
grid.

Import	AO	Industries	from
Stations...

For	each	station	having	industry	data:	adds	a	new	row	to
the	Industries	grid	for	each	in	and	out	load.

Import	AO	Data	From
YardMaster...

Adapts	a	YardMaster	layout	(ym,	y2,	y3)	for	AO	use	by
extracting	data	from	scripts	and	notes.

Show	Variables Displays	all	internal	AO	variables	and	current	values.

Show	Counts Displays	counts	of	AO	objects,	with	breakdowns	of	car
counts	by	AAR	code.

Reset	Trains	to	Start
Positions...

Moves	trains	and	switches	back	to	positions	captured	in
Gen	First	Switchlist.

Generate	New	Switchlist...
Erases	the	current	switchlist	and	creates	a	new	one	from
current	car	positions.	Normally	this	is	done	in	the	Award
window	after	completing	a	switchlist.
Moves	all	unspotted	cars	to	their	destinations,



Complete	Current	Switchlist... completing	the	current	switchlist.	This	operation	cannot
be	undone.

Switchlist	Robot

The	command	Complete	Current	Switchlist	is	new	in	Version	7.2.		It	uses	a	new	gadget	we
call	the	"Switchlist	Robot,"	which	goes	to	each	unspotted	car	and	instantly	transports	it	to	its
destination.		Or	tries	to!		Success	is	not	guaranteed,	depending	on	how	much	empty	track	is
available	at	the	target.		But	the	Robot	is	sophisticated,	makes	optimum	use	of	track	space,	and
usually	gets	the	job	done.		The	next	step	after	CCS	would	normally	be	to	generate	a	new
switchlist.

The	command	can	be	run	from	the	above	Dev	Combo,	or	from	one	of	the	script	subroutines:

CCS	--	Complete	Current	Switchlist	--	delivers	the	current	set	of	unspotted	cars.		Should
be	followed	with	a	Generate	New	Switchlist.
ASL		--	Advance	Switchlist	--	automatically	completes	one,	then	generates	another,	over	a
specified	number	of	cycles

These	routines	can	be	found	in	the	Subroutines	tab	of	Script	Central.		All	contain	info	and
instructions	in	the	text.		The	ASL	routine	is	described	in	the	PDF	document	Advanced	Ops	for
the	Expert.

We	developed	the	Robot	for	purposes	of	testing	and	tweaking	ops	plans	on	complex	layouts.	
Testing	becomes	very	efficient	when	you	can	click	a	button	and	watch	it	automatically	run
through	twenty	switchlists!		For	the	record,	it	would	have	to	be	considered	cheating	if	you	used
this	command	instead	of	driving	your	engine	and	properly	delivering	the	cars.		But	for	the	well-
intentioned	user	who	is	stuck	completing	the	job	or	otherwise	ready	to	move	on:	feel	free	to
CCS.

When	you	complete	a	switchlist	using	the	Robot,	there	is	no	award.

https://www.trainplayer.com/Features/AO/AO3_AdvancedOps_Expert.pdf


Cars	Grid

The	Cars	Grid	shows	the	list	of	all	cars	on	the	layout,	with	images	and	a	lot	of	detail	about
each	one,	some	of	it	editable.	The	ability	to	sort	or	group	by	various	properties	makes	this	a
handy	tool	for	managing	your	rolling-stock	inventory.

Cars	Grid	Rows

Every	car	on	the	layout	is	is	shown	in	the	Cars	grid,	even	those	also	shown	in	the	XO	Cars	grid.

Cars	Grid	Columns:

Column	Name Input	Type Hidden? Description
Car r/o Label	on	car
Image r/o Car	image
Type r/o Car	type
AAR r/o Car	class	from	AAR	codes	list

Location r/o Current	location	of	car	--	station	or	track
label

Load combo	(LD) Load	currently	in	car,	or	MT	or	"Empty"
if	unloaded

Class r/o H General	car	class

Car_ID r/o H Internal	numeric	ID	of	car	(also	called
Tag)

Train r/o H Name	of	train	containing	car,	if	train	is
named

Train_ID r/o H Internal	numeric	ID	(tag)	of	train
containing	car

Consist r/o H One-word	description	of	train	consist



SortOrder edit H User-supplied	tag	for	sorting	grid

ExcludeOps edit H Flag	indicating	whether	car	is	excluded
from	ops

CarNote edit H User-supplied	note	attached	to	car
Dest combo	(TL) User-	or	script-supplied	destination	code

TrackLabel edit H Label	assigned	to	track	where	car	is
located

PropsStr edit H Second	user-supplied	string	attached	to
car

IsSpotted r/o H 1	if	car	is	located	at	its	destination,	else
0

AarOverride edit H AAR	code	to	apply	to	this	car,	overriding
code	from	cartype

For	general	information	about	the	grids,	see	About	AO	Grids.



Industries	Grid

The	Industries	Grid	shows	the	list	of	industries	on	the	layout,	with	editable	data	about	their
shipping	and	receiving	requirements.	

The	Industries	grid	can	be	constructed	by	hand	--	adding	rows	to	the	grid	and	filling	them	in	one
at	a	time	--	or	automatically,	either	by	importing	older	data	or	generating	rows	based	on	cars.

Industry	S/R	Directives	

An	Industry	is	defined	by	a	row	in	the	Locations	grid,	where	it	is	assigned	Class	=	Industry	and
given	a	name.		If	it	is	to	be	served	by	the	railroad,	it	must	also	be	represented	by	one	or	more
rows	in	the	Industries	grid.

Each	row	in	the	grid	is	a	"Ship/Receive	Directive,"	an	order	from	the	industry	for	a	particular
type	of	load	to	be	shipped	or	received	in	a	specified	type	of	car,	possibly	with	directions
regarding	routing.

Industry	Grid	Columns:

Column	Name Input	Type Hidden? Description
ID r/o Row	identifier

Locale r/o Track	location	name	(assigned	in
Locations	grid)

Industry combo	(TL) Track	label	classified	as	Industry	in
Locations	grid

AAR combo	(AAR) Car	type	required	for	shipment	to/from
industry

S/R combo	(SR) Shipping	vs.	Receiving
Load combo	(LD) Load	name



Staging combo	(TL) Car	source	or	destination	yard

ViaIn combo	(TL) Optional	way	point	where	inbound	car
must	change	to	another	train

ViaOut combo	(TL) Optional	way	point	where	outbound	car
must	change	to	another	train

BridgeTraffic edit H
<Staging><Loadname>	=	routing	of
bridge	traffic	for	this	AAR	(see	note
below)

Comment edit H Author-provided	comment	regarding	this
industry

Note	regarding	Bridge	Traffic:		What	this	column	refers	to	is	the	car	types	listed	in	the
Industries	Grid	(nothing	else).	As	far	as	Bridge	Traffic	is	concerned	the	only	columns	that	are
relevant	are	the	AAR	column	and	the	Bridge	Traffic	Column	as	though	these	two	columns	were
a	separate	Bridge	Traffic	grid	of	AAR,	Staging	Start,	and	Load	Name.	None	of	the	other	data	in
the	grid	is	used	in	this	calculation.	

When	generating	a	switchlist	(according	to	the	AO	Expert	doc):

If	the	Switchlist	Generates	Bridge	Traffic	(train	travels	from	one	Staging	yard	to	another
Staging	Yard.
And	if	there	are	still	unallocated	cars	Available	in	the	StartAt	staging.
Then	we	can	select	extra	cars,	up	to	the	Max	Bridge	value,	to	travel	from	one	staging	yard
to	the	other.
If	the	car	type	selected	does	not	have	an	entry	in	the	Bridge	Column	it	is	applied	a	default
load.
If	the	car	type	selected	does	have	an	entry	in	the	Bridge	Column	and	it	Starts	from	the
StartAt	Staging	yard.
Then	it	will	carry	the	listed	load	(which	can	include	the	MT	code	to	make	it	travel	empty).
This	is	what	permits	us	to	force	all	Coal	Hoppers	to	travel	across	a	layout	as	loaded	cars
in	one	direction	and	as	empty	cars	in	the	opposite	direction.

Generating	Industry	Data

The	best	way	to	generate	an	initial	version	of	the	Industries	grid	is	this	three-step	process:

(a)	ensure	the	Locations	grid	has	an	entry	for	every	industry	to	be	served;
(b)	at	each	of	these	locations,	place	at	least	one	car	of	the	appropriate	class	(loaded	or
not)	to	be	delivered	to	the	industry;
(c)	use	the	Dev	command	Build	Industry	Grid	From	Cars	(aka	BIGFC).

This	creates	an	initial	grid	with	one	row	per	industry,	each	having	the	corresponding	car	and
load	type,	and	marked	as	"Receiving."	This	basic	grid	can	then	be	enhanced	by	duplicating	and
editing	rows.

https://www.trainplayer.com/Features/AO/AO3_AdvancedOps_Expert.pdf


Importing	Industry	Data

In	pre-7	layouts,	stations	could	be	designated	as	industries,	and	given	commerce	data	such	as
lists	of	incoming	and	outgoing	loads.	This	data	can	be	converted	to	a	basic	Industries	grid,
using	the	Dev	command	Import	Industry	Data	From	Stations.	For	each	station-based
industry,	this	generates	two	rows	in	the	grid,	one	Shipping,	one	Receiving,	using	the	first	name
on	each	load	list.

This	method	is	not	the	preferred	one	--	BIGFC	generally	gives	better	results.		Either	way	is	just
a	start;	the	resulting	grid	needs	to	be	inspected	and	edited.

For	general	information	about	the	grids,	see	About	AO	Grids.



Locations	Grid

The	Locations	Grid	shows	the	list	of	track	labels	on	the	layout,	with	editable	fields	for	friendly
location	names	and	track	classifications.	

The	grid	shows	a	row	for	every	track	label	on	the	layout.	You	cannot	directly	add	or	delete
rows	in	this	grid,	only	by	adding	or	deleting	labels	on	the	tracks	themselves.

A	special	feature	of	the	Locations	grid	is	that	it	can	be	used	to	modify	the	tracks.	If	you	change
a	track	label	in	the	grid,	it	prompts	for	confirmation,	then	makes	the	same	change	to	the	track
labels	on	the	layout.

In	earlier	versions,	locations	were	indicated	by	"stations"	--	named	regions	of	track.		These	are
no	longer	used	for	ops,	but	can	be	used	to	add	location-specific	sounds	to	your	layout;	see
Stations.

An	alternative	to	creating	the	Locations	grid	by	hand	is	to	import	station	data	from	an	older
layout,	described	below.

About	Locations

A	Location	is	a	set	of	tracks	sharing	a	common	track	label.		Each	location	is	classified	as	one
of	five	types:

Industry	--	a	customer	site	which	generates	traffic	for	the	railroad,	can	either	dispatch	or
receive	loads.	
	
Classification	Yard	--	an	intermediate	site	for	sorting	and	routing	cars	into	new	trains
(load	status	is	not	changed).
	
Staging	Tracks	--	the	connection	with	the	extended	railroad	system,	all	individual	car
movements	will	start	and	end	in	Staging.	



	
Interchange	--	a	specialized	form	of	Staging	Track	used	to	simulate	transferring	cars	to
and	from	other	railroads.
	
XO	Reserved	--	tracks	for	the	predefined	routing	of	XO	dedicated	service	cars	which	are
excluded	from	the	AO	waybill	system.

Creating	a	location	by	hand	is	a	two-step	process.	First	you	apply	a	label	to	the	track(s)	on	the
layout,	then	find	the	corresponding	row	here	in	the	Locations	Grid	and	enter	name	and	location
type.

Locations	Grid	Columns:

Column
Name

Input
Type Hidden? Description

ID r/o Row	identifier
Locale edit Friendly	name	for	this	location
Track edit Short	track	label	identifying	location

Class combo
(TT) industry,	yard,	staging,	interchange,	XO

VacantSpots edit number	of	cars	which	can	be	accommodated	on
location	tracks

Importing	Location	Data

In	pre-7	ops,	a	location	was	identified	by	a	Station,	a	named	object	associated	with	a	set	of
tracks.	In	the	current	version,	these	can	be	converted	to	Locations	using	the	Dev	command
"Import	Locations	from	Stations."	This	takes	the	the	following	action	at	each	Station:

(a)	generates	a	unique	two-letter	track	label	from	the	station	name;
(b)	applies	that	label	to	the	associated	tracks;
(c)	copies	the	station's	name	to	the	locale	name;	
(d)	assigns	the	location	type	from	station	properties	--	Industry	unless	flagged	as	Yard	or
Interchange.

The	result	is	a	first	pass	at	a	Locations	grid,	in	need	of	inspection	and	editing.

Stations	are	referenced	in	this	process	but	not	removed	even	though	no	longer	needed.	They
can	be	deleted	by	hand	using	the	Station	tool.

For	general	information	about	the	grids,	see	About	AO	Grids.



Sequence	Grid

The	Sequence	Grid	shows	the	list	of	trains	to	be	run	in	sequence	in	an	operating	session.

The	Sequence	Grid	shows	all	sequenced	trains	in	the	order	they	are	to	run.	This	grid	is
normally	built	by	hand,	but	there	is	a	shortcut	to	build	a	simple	sequence,	as	described	below.

Sequenced	Trains,	Active	Train

A	typical	railroad	has	limited	equipment	to	serve	many	customers,	so	scheduling	is	necessary.
In	AO	this	takes	the	form	of	a	list	of	trains	to	be	run	in	sequence.	Each	row	of	the	grid
represents	a	"Sequenced	Train"	--	a	regular,	named	run	between	two	designated	points,	using
a	specific	engine.

At	any	given	time,	exactly	one	row	is	marked	with	an	X	in	the	"Active	Train"	column.		The	Active
Train	is	the	one	currently	working	on	the	switchlist.		When	this	train	completes	its	run,	a	new
switchlist	is	generated,	the	next	train	in	sequence	becomes	active,	the	X	changes	rows.

Zoom	To	Active	Train	--	zoom	and	center	the	layout	view	on	the	active	engine	--	is	an	action
you	can	carry	out	in	several	ways:

automatically	on	opening	an	ops-ready	layout	--	this	happens	if	Zoom	To	Active	Engine	is
checked	in	Ops	Central	Advanced	tab
by	double-clicking	on	the	Car	Monitor	window	in	the	control	panel
by	right-clicking	the	layout	and	choosing	Zoom	>	To	Active	Engine
by	clicking	the	button	on	the	Ops	toolbar	

Sequence	Grid	Columns:

Column	Name Input
Type Hidden? Description



ID r/o Row	identifier

Engine combo
(EN) ID	of	engine	assigned	to	drive	train

TrainName edit Name	to	be	assigned	to	train

StartAt combo
(STG)

The	Staging	or	Interchange	supplying	inbound
traffic	to	the	industries	(see	note	below)

EndAt combo
(STG)

The	Staging	or	Interchange	receiving	outbound
cars	pulled	from	the	Industries	(see	note)

Visits edit Industries	to	be	visited
Comment edit Notes	regarding	train	route,	frequency
Active r/o X	=>	this	row	is	currently	the	active	train
CarsToPull edit 	 Number	of	cars	for	this	train	to	pull	per	switchlist

Note	regarding	StartAt/EndAt:	StartAt	and	EndAt	is	not	a	literal	translation	(although	it	often
is)	--	it	is	all	about	where	the	cars	start	and	end	at,	not	the	train.	The	train	starts	from	wherever
it	has	been	located	(or	parked)	on	the	layout.

The	actual	start	and	end	point	of	the	train	is	dictated	by	the	engine	position	--	an	engine	could
start	and	end	at	the	EndAt	position	but	travel	to	the	StartAt	position	to	locate	the	inbound
traffic.	Similarly	a	train	could	start	from	an	intermediate	class	yard,	visiting	both	the	start	and
end	points	for	car	movements	before	returning	to	the	class	yard.	That	is	it	could	gather	up	all
the	outbound	cars	from	the	industries	and	take	them	to	the	EndAt	location,	then	visit	the	StartAt
location	to	bring	in	all	the	new	cars	intended	for	the	industries.	StartAt	and	EndAt	are	often	(but
not	always)	the	same	location.

Creating	a	Basic	Sequence

In	a	new	layout,	or	a	small	one	with	a	simple	operating	scheme,	a	basic	sequence	can	be
generated	using	the	Dev	command	Add	Basic	Train	Sequence."This	creates	a	single	row	in
the	Sequence	grid	--	basic,	but	adequate	for	generating	switchlists	and	operating.

For	general	information	about	the	grids,	see	About	AO	Grids.



Switchlist	Grid

The	Switchlist	Grid	shows	the	list	of	cars	to	be	moved	during	the	current	operating	session.

The	Switchlist	Grid	is	generated	automatically	and	cannot	be	edited.	It	shows	a	row	for	each
move	to	be	completed	--	that	is,	one	for	each	unspotted	car	--	and	is	automatically	updated	as
cars	are	moved.

Note	that	it	is	not	necessary	to	view	the	switchlist	in	order	to	operate.	The	necessary
information	is	displayed	on	the	car-top	label:	blank	if	the	car	is	spotted	at	its	destination,	or	a
track	label	indicating	where	it	is	to	be	delivered	next.	These	labels	are	updated	as	moves	are
completed.

Switchlist	Moves

A	switchlist	is	a	statement	of	work	to	be	carried	out,	in	terms	of	cars	to	be	moved	from	one
location	to	another.	Each	row	is	a	"Switchlist	Move"	(SLM),	which	specifies	a	car	and	an	action:
either	pull	the	car	from	its	current	location,	or	spot	it	at	a	given	destination.	Once	the	car	has
left	its	spot	or	arrived	at	the	new	one,	the	move	is	complete	and	is	removed	from	the	switchlist.

Switchlist	Grid	Columns:

Column
Name

Input
Type Hidden? Description

ID r/o Row	identifier
Car_ID r/o H Numeric	ID	of	car	assigned	to	this	move

SR_ID r/o H ID	of	row	in	Industries	grid	which	requested	the
car



Car r/o Label	of	car	assigned	to	this	move
PullFrom r/o 	 Track	label	=	current	location	of	car
Dir r/o Always	>>
SpotAt r/o Track	label	=	car	destination
Load r/o Name	of	load	being	transported
Image r/o H Car	side	image

Generating	a	Switchlist

A	switchlist	can	be	generated	in	one	of	three	ways:

1.	In	a	new	or	newly-upgraded	layout,	suitably	prepared	and	tested,	use	the	Dev	command
"Generate	First	Switchlist."	This	generates	a	first	switchlist	and	makes	the	layout	ready	for	AO
operation.

2.	On	completion	of	a	switchlist,	enjoy	your	award,	then	click	the	New	Switchlist	button.	This
generates	the	next	switchlist	to	be	carried	out,	based	on	current	car	positions	and	waybills.

3.	If	you	completed	a	switchlist	but	dismissed	the	Award	dialog,	you	can	find	a	"Generate	New
Switchlist"	command	in	the	Dev	menu.	This	does	the	same	as	if	you	had	clicked	the	button.

For	general	information	about	the	grids,	see	About	AO	Grids.



XO	Cars	Grid

The	XO	Cars	Grid	shows	the	list	of	cars	not	being	used	for	regular
industry-driven	freight	service.		This	includes	cars	incapable	of	carrying
freight,	bulk	trains	with	blocks	of	cars	travelling	as	a	single	entity,	along
with	others	set	aside	for	special	purposes.		This	grid	is	used	to	specify
those	purposes.

About	XO	Cars

Each	row	in	the	grid	represents	a	car	marked	"XO,"	which	stands	for
"Excluded	From	Ops."		A	car	marked	XO	is	exempt	from	regular	service	and
will	not	be	assigned	a	waybill	automatically.		In	an	AO	layout,	engines,
tenders,	and	cabooses	are	automatically	marked	XO.		Other	cars	so	marked
have	been	selected	by	the	layout	author	for	dedicated	service	--	passenger
runs,	maintenance	of	way	trains,	and	others.

Note:	to	mark	a	car	as	XO,	right-click	the	car	and	choose	Exclude	from	Ops,
or	use	the	checkbox	in	Car	Data	Properties.

Every	XO	car	on	the	layout	is	shown	in	the	grid.		Several	columns	identify
the	car	and	its	current	location,	some	of	them	copied	from	other	grids	and
included	here	for	convenience;	these	are	not	editable.		Other	columns
specify	that	certain	goods	are	to	be	transported	over	a	given	route;	two	of
these	are	maintained	by	the	program	as	the	car	progresses.

XO	Cars	Grid	Columns:



Column	Name Input	Type Hidden? Description
ID r/o H Row	identifier
Car r/o Label	on	the	car
Location r/o Car's	current	location	(track	label)
Route edit List	of	stops	specifying	the	route

Shipment combo
(LD) Load	name

LoadAt combo	(TL)
List	of	locations	where	car	should	be
loaded	(or	retain	current	load)	before
departure	(note	below)

Note edit Stops	remaining	along	route	(for	internal
use)

Dest combo	(TL) Location	where	car	is	to	be	delivered	next
(for	internal	use)

Image r/o H Car	side-view	image
Class r/o H Car	class
Locale r/o H Track	location	name	(from	Locations	grid)
ID r/o H Car	ID
AAR r/o H Car	AAR	code

Note	regarding	LoadAt:		cars	are	not	normally	loaded	in	Class	Yards,	and
for	XO	cars	loading	is	not	limited	to	Staging	or	Interchanges.	It	can	also
occur	at	Industries	and	XOreserved	tracks.	If	a	location	that	the	car	is
directed	to	is	missing	from	this	loadat	list	the	car	will	be	unloaded.

Other	details	of	what	all	this	means	and	how	to	set	it	up	are	to	be	found	in
the	AO	User's	Guide.		The	casual	ops	user	does	not	really	need	to	know
any	more	than	what	is	shown	on	the	car	tops	--	that	certain	moves	in	the
switchlist	come	from	instructions	in	this	grid.

For	general	information	about	the	grids,	see	About	AO	Grids.



Script	Editor

The	Script	Editor	is	a	dialog	for	developing	train	scripts,	and	watching	them	in	action.		It
provides	an	editable	text	box	with	special	features	for	script	development,	along	with	player
buttons	for	playing,	stopping,	recording,	and	rewinding	the	script.		As	the	script	executes,	the
active	line	is	highlighted	in	the	text	box,	so	you	can	follow	along	with	the	action.	

To	bring	up	a	Script	Editor,	(a)	select	a	train	and	choose	Train	>	Script	>	Edit	from	the	menu;	(b)	click
the	Edit	Script	button	on	the	Scripts	toolbar;	(c)	double-click	a	train	script	entry	in	the	Scripts	tab	of
Script	Central.

Each	train	script	has	its	own	Script	Editor	window.		If	you	have	multiple	scripts	on	your	layout,	you	can
have	multiple	windows	showing	the	different	actions	in	each.		The	dialog	is	modeless,	so	it	remains	up	as
you	run	the	layout.

If	there	are	multiple	train	scripts	on	the	layout,	then	the	buttons	in	each	Script	Editor	work	differently	from
the	corresponding	ones	on	the	Script	Toolbar.		In	the	latter,Play,	Stop,	and	Rewind	apply	to	all	scripts	at
once;	in	the	Script	Editor,	buttons	apply	only	to	the	script	in	the	window.

Dialog	controls:

The	Script	Editor	is	always	working	on	a	single	script.		If	you	bring	it	up	on	a	train	having	no	script,	it
creates	an	empty	one	for	you	to	fill	in.

Text	box Editable	box	for	script	text.		Highlight	shows	current	line.		Right-click	for	editing	or	Go	To
commands.

Play Begin	executing	the	script	at	the	current	line.	

Stop Stop	the	script	and	the	train.		If	recording	is	in	progress,	stop	it.

Rewind Reset	to	first	line	of	script,	restore	train	and	switch	positions	to	layout	Rewind	Point
Record Begin	recording	train	moves,	capturing	them	starting	at	the	current	line.

Apply:	update	scripts	on	layout	(not	saved	permanently	until	layout	save);	OK:	apply	and



Buttons dismiss;	Cancel:	dismiss	without	saving	--	changes	to	Done	after	any	save.

Context	Menu

The	context	menu	in	the	Script	Editor	and	other	script	windows	gives
access	to	standard	editing	commands,	as	shown	here.		In	addition,	the
Script	Editor	provides	an	additional	command:	

Set	Next	Command	Here

Set	Next	Command	Here	is	handy	for	debugging	and	development.		Point	to	any
line	in	the	script,	right-click	and	choose	Set	Next	Command	Here,	and	that	line
becomes	highlighted	--	the	next	to	execute	when	you	press	Play.	

This	command	is	undoable.		Undo	goes	back	to	the	statement	which	was	active	before.

There	is	a	catch.		This	feature	lets	you	start	at	the	script	statement	to	be	executed,	but	does	not	reposition
the	trains.		It's	up	to	you	to	make	sure	the	trains	are	in	suitable	positions	when	you	start	playing	the	script.

Switch	Shortcuts

As	another	convenience	for	script	authors,	you	can	insert	text	into	the	script	window	by	choosing	a
command	from	a	context	menu	on	the	layout.		As	long	as	the	Script	Editor	is	visible,	and	you	are	using	the
track	or	edit	tool,	then	right-click	a	junction	or	switch	and	you	get	three	new	commands	on	the	context
menu:

Each	of	these	commands	inserts	a	bit	of	text	at	the	position	of	the	cursor	in	the	text	box.		What	is	inserted
depends	on	what	you	right-clicked:

Insert	junction	number Insert	the	number	of	the	clicked	junction.		Need	not	be	a	switch.

Insert	throw	here Insert	a	THROW	statement	with	the	junction	number	and	its
current	position;	for	switches	only

Insert	throw	alternate Insert	THROW	plus	junction	number	plus	alternate	position;	for
2-way	switches	only



This	applies	to	the	Junction	Action	Editor	also,	and	to	the	script	windows	in	Script	Central	--	whenever
any	of	these	is	visible	on	screen,	junction	context	menus	can	insert	into	it.		If	more	than	one	is	showing,
the	frontmost	one	gets	the	insert.



Junction	Action	Editor

The	Junction	Action	Editor	is	a	dialog	for	creating	and	editing	junction	actions.	To	bring	it	up,	(a)	using
the	track	edit	tool,	right-click	a	junction	and	choose	Action...,	or	(b)	double-click	a	row	in	the	Junction
Actions	tab	in	Script	Central.		Either	way,	the	dialog	comes	up	with	reference	to	a	specific	junction,
where	there	might	be	one	or	more	actions	defined	to	trigger	on	different	events.

The	dialog	is	modeless,	so	it	can	remain	on	the	screen	while	you	work	on	the	layout.		You	can	move
around	to	different	junctions	(or	change	your	selection	in	Script	Central)	and	change	what	junction	the
dialog	is	showing.		The	dialog	works	on	one	action	at	a	time,	with	arrow	keys	for	moving	through	the	list
of	actions	at	the	junction.

The	Junction	Action	Editor	is	a	good	place	to	develop	action	scripts,	but	unlike	the	Script	Editor,	it	is	not
a	place	to	run	or	test	them.		There	are	no	Play	or	Stop	buttons	in	this	dialog.		To	test	a	junction	action,	you
have	to	run	a	suitable	car	across	the	junction.

Junction	Action	Triggers

A	junction	action	begins	execution	when	some	train	or	car	passes	across	it.		You	can	choose	what	triggers
the	action	--	a	specific	car	or	train,	or	a	class	of	them.		The	list	of	choices	for	trigger	type	is	as	follows,
where	the	first	column	is	the	name,	second	tells	what	kind	of	argument	is	required	if	any,	third	shows	what
will	actually	trigger	the	action:

Any	Train 	 first	car	of	any	train

Car car	id car	with	specified	id	(id	=	label)
AAR aar	code car	with	aar	code	matching	(or	starting	with)



specified	code

Train train	id first	car	of	train	with	specified	id	(id	=	name	or
train+no)

Train	Type train	type train	of	type	Freight,	Passenger,	Mixed,	or	Switcher,
as	assigned	by	the	program

Any	Last	Car 	 last	car	of	any	train

Last	Car	Of train	id last	car	of	train	with	specified	id

Any	Car 	 any	car	of	any	train

A	trigger	has	both	a	type	and	a	trigger	direction.		Consider	a	track	going	horizontally	across	the	screen,
with	a	junction	in	the	middle:		a	train	can	cross	it	from	left	to	right	(W->E)	or	the	other	way	(E->W).		You
can	specify	whether	an	action	is	to	be	triggered	by	one	or	the	other	or	both.

The	orientation	of	the	layout	is	taken	into	account	at	the	time	you	assign	a	direction	to	a	trigger.		If	travel
across	the	junction	is	more	or	less	horizontal,	then	the	choices	you	have	are	W-E	or	E-W;	if	closer	to
vertical,	they	become	N-S	or	S-N.		(If	you	assign	a	direction	and	later	rotate	the	layout,	results	are
unpredictable.		If	it	triggers	the	wrong	way,	change	it	to	the	other.)

For	additional	notes	regarding	triggers,	see	Working	With	Junction	Actions.

Dialog	controls:

The	Junction	Action	Editor	is	always	working	on	a	single	action.		If	you	bring	it	up	on	a	junction	having
no	action,	it	creates	an	empty	one	with	a	default	trigger.

Label Upper	left	of	dialog	indicates	the	junction	number;	if	it	is	a
switch,	its	position	is	also	given

Trigger Choose	one:	trigger	when	crossed	by	car(s)	as	specified
below;	or	disabled,	do	not	trigger

When	Crossed
By: Controls	enabled	if	trigger	is	not	disabled:

				Type Trigger	type,	as	listed	above

				Name Name	or	identifier	or	other	required	argument	if	any;	see	note
below

				Direction Choose	one:	E-W,	W-E,	or	Any.		Choices	change	to	N-S,	S-N
depending	on	tracks	at	junction

Take	Action Action	script,	an	editable	text	box.



Or	Actions: Other	actions	defined	at	the	same	junction:
				Arrows	 Move	through	list;	dimmed	if	only	one	entry
				Add	 Create	a	new	action	at	the	end	of	the	list

				Delete	 Delete	the	current	action	from	the	list.		If	there	is	only	one
action,	this	removes	it	from	the	junction.

Buttons
Apply:	update	actions	on	layout	(not	saved	permanently	until
layout	save);	OK:	apply	and	dismiss;	Cancel:	dismiss	without
saving	--	changes	to	Done	after	any	save

Note:		The	choices	offered	in	the	Name	drop-down	are	limited	to	cars	and	trains	currently	sitting	on	the
layout.		You	cannot	assign	a	trigger	to	a	car	or	aar	type	which	is	not	present.		This	is	a	limitation	we	may
remove	in	future	versions.

On	clicking	OK,	if	you	have	created	a	new	action	at	a	junction,	it	is	displayed	with	a	Junction	Action
indicator	(as	long	as	edit	or	track	tool	is	active):



Route	Finder

If	the	switchlist	tells	you	to	deliver	a	string	of	hoppers	to	Punky	Junction,	the	first	thing	you'll
need	to	know	is	how	to	get	there.		Even	on	a	small	layout,	it's	not	always	easy	to	figure	this
out.		That's	why	we	developed	the	Route	Finder,	a	device	which	calculates	all	possible	routes
between	two	points	and	displays	them	interactively	so	you	can	choose	one.

To	use,	select	Tools	>	Route	Finder	or	the	button	on	the	Ops	toolbar.		You	see	this	dialog:

Boxes	at	the	top	are	for	input	of	the	two	endpoints;	below	is	a	listbox	showing	details	of	each
route	as	it	is	discovered.

To	operate:

1.		In	the	“From”	and	“To”	boxes,	select	the	endpoints	of	the	route	you	want	to	find.		For	each
end,	you	can	select	one	of	the	following	from	the	appropriate	drop-down	menu:

Junction	number	--	a	specific	track	junction	or	switch.		This	is	the	most	precise	way	to
identify	a	location.
Track	label	--	track(s)	having	a	given	label.		The	actual	route	endpoint	is	the	junction
closest	to	the	center	of	a	rectangle	enclosing	all	tracks	with	the	given	label.
Locale	--	name	of	a	location,	as	listed	in	the	Locations	tab	of	Ops	Central.		This	is	the
same	as	specifying	a	track	label;	the	locale	name	is	simply	an	alias.
Station	--	name	of	a	station.		The	endpoint	is	the	junction	closest	to	the	center	of	the
station's	track	set.

As	soon	as	you	have	made	choices	for	both	ends,	the	dialog	shows	the	distance	between	the
two	points,	expressed	in	current	units	(as	set	in	many	other	dialogs).



2.		Click	Go.		The	program	begins	finding	routes,	and	displays	a	new	row	in	the	list	for	each
one	it	finds.		The	information	shown	for	each	route	is:

Name:	unique	name	assigned	to	the	route.
From,	To:	actual	junctions	used	as	endpoints,	based	on	choices	made	in	step	1;	same	for
every	row.
Via:	comma-delimited	list	of	the	locations	the	route	passes	through	on	its	way.
Length:	total	length	by	rail	of	the	route.		To	change	the	units	of	measure,	select	from	a
Units	drop-down	in	some	dialog	which	has	one	(e.g.,	Layout	Properties).
Switches:	number	of	switches	the	route	passes	through.
Turns:	number	of	junctions	where	the	train	is	going	to	have	to	reverse	direction	along	the
route.
Route:	a	list	of	junction	numbers	along	the	route	where	switches	are	located,	with	optional
switch	positions.		See	item	5	below.

3.		If	the	resulting	list	is	too	long,	click	the	Filter	button	to	bring	up	the	Route	Finder	Filters
dialog:

Here	you	can	cut	down	the	number	of	results	by	eliminating	those	which:

have	more	than	a	given	number	of	throwable	switches	along	the	route
have	more	than	a	given	number	of	"turns"	--	acute	angles	requiring	change	in	direction	of
motion
have	too	much	overlap	with	another	route,	expressed	in	percent	of	the	total	route	length
are	too	long	from	one	end	to	the	other	(as	the	crow	flies),	expressed	as	a	multiple	of	the
shortest	route's	length
have	more	than	a	given	number	of	cars	sitting	on	tracks	along	the	route

After	you	change	one	of	these	settings	and	click	OK,	the	table	of	routes	is	recalculated.

4.		Click	a	row	in	the	list	and	the	corresponding	route	is	highlighted	in	pink	on	the	layout,	like
this:



If	you	have	Map	View	visible,	the	route	is	also	highlighted	there.

5.		It	is	possible	to	make	use	of	a	route.	The	string	in	the	Route	column	can	be	read	and
interpreted	by	some	scripting	applications.		In	support	of	this	is	the	context	menu	you	get	on
right-click	of	a	row:

The	first	three	commands	provide	ways	to	copy	the	route	string(s)	to	the	Windows	Clipboard,
suitable	for	pasting	into	a	text	file	or	script	editor.		The	next	command	Display	Switch
Positions	(DSP)	is	a	toggle	which	changes	the	format	of	the	string	between:

Normal:	space-delimited	list	of	junction	numbers	defining	the	route
With	DSP	on:	comma-delimited	list	of	pairs,	junction	number	followed	by	switch	position;
position	is	0	or	1	for	a	normal	two-way	switch,	blank	for	any	other	switch.

Set	Switches	Along	Route	throws	all	the	switches	along	the	selected	route,	so	that	a	train
starting	at	one	end	will	follow	the	route	to	the	other	end.

Note:	the	Route	Finder	does	not	find	the	shortest	or	most	efficient	or	most	logistically	effective
route	for	you.	It	finds	ALL	possible	routes	(subject	to	filters	that	you	set).	The	selection	of	the
BEST	route	is	up	to	you	and	depends	on	a	number	of	factors	in	each	session.



Waybill	Window

The	Waybill	Window	shows	the	current	waybill	for	the	selected	car.		This	tells	the	status	of	the
car	and,	if	applicable,	where	it	is	headed.		The	waybill	is	for	information	only.		To	see	it,	right-
click	a	car	and	choose	Show	Waybill.

About	Waybills

In	regular	operation	a	waybill	describes	an	ops-oriented	task	assigned	to	a	car	in	response	to	a
directive	received	from	an	industry.		Typically	it	describes	a	cycle	--	for	example,	the	car	is	to
transport	a	given	load	to	a	given	destination	and	then	return	empty	to	a	given	yard.		A	waybill
identifies	a	car	and	its	class,	and	typically	represents	a	series	of	car	moves.

Cars	marked	XO	(Exclude	from	Ops)	are	not	assigned	waybills	by	this	scheme;	see	About	XO
Cars.

Every	waybill	is	one	of	the	following	types,	as	displayed	in	the	title	of	the	waybill	window:

WAYBILL	--	an	order	to	move	a	loaded	car	to	or	from	an	industry.
HOME	ROUTE	ORDER	--	an	order	to	return	an	empty	car	from	an	industry	to	its	home
staging	location.
EMPTY	CAR	ORDER	--	an	order	to	move	an	empty	car	to	an	industry	to	collect	an
available	shipment.
CAR	MOVEMENT	ORDER	--	an	order	to	move	an	engine	or	other	non-revenue-earning
car	to	a	new	location.
ROUTED	CAR	MOVEMENT	ORDER	--	an	order	to	move	a	dedicated	service	car	over	a
regular	route	to	a	new	location	(or	series	of	locations).
NOT	IN	SERVICE	--	an	unused	car	in	staging	(or	interchange)	which	is	available	for	loading
or	for	fulfilling	an	empty	car	order.

Depending	on	the	waybill	type,	additional	information	is	shown	in	the	window.		This	might
include	the	car's	home	location,	ultimate	destination,	routing	info,	or	other	data	appropriate	to
the	order.	



Waybills	are	created	automatically	to	satisfy	customer	demand	each	time	a	new	switchlist	is
generated.	Only	cars	located	in	Staging	or	Interchange	can	receive	new	waybills,	and	all	cars
already	tasked	must	complete	all	the	legs	of	their	intended	journey	before	they	become
available	for	retasking.

Waybill	Window

The	Waybill	Window	is	modeless,	so	it	stays	up	as	you	click	around	on	different	cars.		To	close,
click	the	X.

The	window	can	be	moved,	resized,	or	minimized.		There	is	no	context	menu.



Advanced	Layout	Properties

For	viewing	and	editing	advanced	properties	of	the	layout.	Called	from	Properties	on	the	Layout
context	menu.			See	also	About	the	Properties	Dialog.

Advanced	layout	data:

Path
Full	pathname	of	the	layout	(.rrw)	file.		This	item	is	not
editable;	to	change	the	path,	save	the	layout	to	a	different
location.

Open	for	read	only
Check	to	mark	the	layout	as	open	for	read	only.		When	this
box	is	checked,	then	the	next	time	you	save	the	file,	you	will
be	prevented	from	overwriting	the	original.		For	more,	see
Read-Only	Layouts.

Module
Indicates	whether	the	layout	is	designed	to	be	used	in	a
modular	layout,	and	if	so,	what	kind	of	module.	

See	Module	Tags,	Building	a	Module.

Road	Styles...
Calls	up	the	dialog	for	viewing	and	editing	the	road	styles
belonging	to	the	layout.		See	Road	Styles	and	Road	Styles
Dialog.

Background	Image

Pathname	of	the	background	image	file,	blank	if	none.		To
remove	the	background	image	from	a	layout,	erase	the
contents	of	this	box.		To	change	to	a	different	image,	enter
a	filename	or	use	the	browse	(...)	button	to	browse	for	a
different	image	file.

Caution:	it	is	not	recommended	to	change	the	background
image	file!		If	you	change	from	one	background	to	another,



it	is	likely	that	the	track	will	no	longer	match	the
background,	the	size	and	shape	of	the	background	will	be
wrong,	and	other	problems	will	arise.		You	are	warned
about	this	when	you	dismiss	the	dialog.

Background	Color

Background	color	of	the	layout.		A	color	button	appears	on
the	dialog	if	the	layout	is	new	or	has	no	background	image.	
Click	to	bring	up	the	color	chooser	to	select	a	new
background	color	for	the	layout.		

The	default	color	is	set	in	Preferences	(Style	tab)	--	this
applies	to	all	new	layouts.	The	color	you	choose	here	in
Layout	Properties	applies	only	to	the	current	layout.

Trick:	choose	black	as	the	background	color,	and	it	will
reset	the	layout	to	the	default	color.		If	you	really	want	a
black	background,	choose	a	nearly-black	shade	instead.



Car	Collection	Publisher

Copies	a	car	collection	to	an	output	folder.	Called	from	Export	button	in	Car	Collection	Editor.

Publishing	a	car	collection	means	preparing	it	for	delivery	to	other	users:	checking	for	errors,
gathering	all	the	image	files	in	one	place,	giving	them	uniform	names,	splitting	multi-image	files
into	separate	parts,	creating	a	new	xml	index,	and	so	on.

The	job	is	done	in	this	dialog,	called	up	when	you	are	editing	a	car	collection.		It	does	not
modify	the	original	collection,	but	makes	a	new	copy	in	a	different	location.		The	new	copy	is
not	activated	or	added	to	your	chooser	tree,	although	you	can	drag	it	into	the	tree	if	you'd	like
to	see	it.		If	you	edit	properties	in	this	dialog,	the	changes	will	apply	to	the	published	copy	only;
an	alternative	is	to	edit	the	properties	of	the	original	before	publishing.

To	publish	a	car	collection:

1.	 Inspect	the	Notes	box.		If	errors	are	reported,	cancel	the	dialog,	fix	the	errors,	and	try
again.

2.	 Inspect	and	edit	Name	and	Comments.		These	should	be	made	presentable	for	other
users.		If	the	comment	box	is	empty,	you	should	add	descriptive	information	and	author
name.		You	might	consider	doing	this	to	the	original	collection	instead	of	here	--	cancel	this
dialog,	edit	in	Car	Collection	Editor,	then	publish.

3.	 Choose	an	output	folder.		You	do	not	need	a	new	folder	for	each	collection	--	typically	you
have	one	output	folder	where	you	put	all	published	collections.		Note:	if	you	have	already
published	this	collection	to	that	location,	the	old	version	will	be	overwritten	without	warning.

4.	 Inspect	the	output	filename.		You	should	not	normally	change	this.		This	filename	(minus
xml	extension)	is	used	as	the	collection	identifier,	and	is	written	into	layout	files;	if	you
change	it,	then	layouts	using	the	original	collection	will	not	recognize	the	new,	and	vice-
versa.



5.	 Click	Publish.		Files	are	copied,	the	new	published	collection	is	created,	and	the	dialog	is
dismissed.		An	alert	informs	you	of	successful	publication.

6.	 If	you	want	to	send	the	collection	to	another	user,	zip	the	files	in	the	output	folder.		Include
the	xml	file	plus	the	folder	of	image	files	(which	has	the	same	name	as	the	xml	file).

Dialog	controls:

Name
Name	of	the	collection.		This	can	be	any	name	you	like.	
Changing	the	name	here	will	affect	only	the	published
collection,	not	the	original.

Comments Description	and	author.		If	this	box	is	blank,	please	provide
some	information	to	be	included	in	the	published	version.

Input	file Full	pathname	of	original	collection	xml	file.		This	file	is	not
modified	by	the	publish	operation.

Output	folder
Destination	for	the	published	collection.		The	xml	file	will	go	in
this	folder,	along	with	a	subfolder	containing	the	image	files.	
To	select	a	new	output	folder,	use	the	Browse	(...)	button.

Output	file
Name	to	be	given	to	the	published	xml	file.		This	is	usually	the
collection	name	plus	xml	extension.		Use	caution	when
changing	this	name:	you	may	break	existing	layouts.

Notes Errors	encountered	while	processing,	if	any.

Publish

Click	to	carry	out	the	publish	operation.		A	confirmation
message	is	displayed	on	completion.

Note:	no	warning	is	given	if	the	output	collection	already	exists
--	it	will	be	overwritten.

Cancel Click	to	abort	without	publishing.

For	more	information,	see	Car	Collections.



Control	Panel

For	operating	trains.	Called	from	menu	command	Tools	>	Control	Panel.

Note:	this	control	panel	has	been	superseded	by	the	Train	Control	Bar.		The	one	described
below	is	still	available	--	call	it	the	"old-fashioned	free-standing	control	panel"	--	but	the	TCB	is
the	preferred	device.

		

The	TrainPlayer	Control	Panel	provides	all	the	tools	you	need	to	operate	trains,	in	a	classy
brass-and-walnut	frame.		If	it	takes	too	much	room	on	your	screen,	you	can	choose	the
minimized	version	and	still	control	speed	and	direction.	

The	panel	operates	a	single	train	at	a	time.		If	you	have	more	than	one	train,	select	the	one	you
want	to	operate	--	see	Selecting	Cars	and	Trains.		The	selected	train	appears	in	the	control
panel	train	window,	and	speed	and	direction	indicators	are	adjusted	to	match.

Features	of	the	control	panel:

Train	Window:	Displays	the	train	being	controlled.		Allows	selecting	a	car	and/or



uncoupling	point,	scrolling	the	train,	viewing	car	or	train	properties.		For	details,	see	Train
Window.	

Horn	Button:	Press	and	hold	to	sound	the	horn.		Right-click	to	choose	horn	type.

Speed	Dial:	Controls	the	train	speed.		To	rotate,	press	and	drag	anywhere	on	the
perimeter	of	the	dial.		Double-click	a	point	on	the	perimeter	and	the	speed	dial	will	jump	to
that	value.		In	Yard	Mode,	you	can	rotate	counter-clockwise	past	stop	and	go	into	reverse.

Speed	Dial	Knob:	Shows	the	current	dial	setting.		Press	and	drag	on	knob	to	rotate	dial.

Forward/Reverse:	Click	to	change	the	direction	of	train	movement.		Green	light	indicates
forward,	red	reverse.

Minimize	Button:	Change	control	panel	to	compact	form.		The
minimized	control	panel	allows	dial	rotation,	stop	by	click,	and	reverse
direction	when	yard	mode	is	enabled.

Uncoupling	Pin:	Shows	location	of	the	next	uncouple,	add	car,	or	paste	operation.		To
change	the	position	of	the	pin,	click	between	cars,	press	right	or	left	arrow	keys,	or	select
a	car.		For	more,	see	Train	Window.

Train	Scroller:	Press	to	scroll	the	train	horizontally	within	the	window.		Press	and	hold	to
auto-scroll.		Pressing	the	right	scroller	moves	the	train	to	the	left,	and	vice-versa.

Uncouple	Button:	Click	to	uncouple	at	the	current	position	of	the	uncoupling	pin.		This
button	has	no	effect	if	pin	is	at	front	or	end	of	train.

Speed	Display:	Displays	current	speed	in	miles	per	hour
(MPH)	or	kilometers	per	hour	(KPH).		To	change	from	MPH	to
KPH,	select	a	metric	setting	in	Layout	Properties	or	various
other	dialogs.

Stop	Button:	Click	to	stop	the	train.		Button	shows	lit	red	when
stopped,	flashing	red	when	in	yard	mode.	Clicking	stop	exits	yard	mode	and	returns
direction	to	forward.

Close	Button:	Click	to	remove	control	panel	from	the	screen.		To	bring	it	back,	use	Tools
>	Control	Panel.

Context	menu.		Right-click	anywhere	on	the	control	panel	(except	in	train	control	window)
to	access	the	context	menu,	with	these	commands:

Lock	in	position:	When	checked,	causes	the	control	panel	to	become	unmoveable	so
it	can't	be	dragged.		When	unchecked,	panel	can	be	dragged	anywhere	on	screen.	
Used	to	prevent	accidentally	dragging	while	operating	controls.

Enable	yard	mode:	When	checked,	allows	control	panel	to	be	operated	in	yard
mode.		Uncheck	for	normal	operation.		You	can	also	enable	yard	mode	by	using	the



Yard	Mode	toolbar	button,	or	choosing	Enable	Yard	Mode	from	the	Tools	menu.

Locked:	Icon	appears	when	control	panel	is	locked	and	unmoveable.		To	lock,	choose
Lock	in	position	from	the	context	menu.		To	unlock,	use	the	same	menu	command	or	simply
click	on	the	lock	icon.

Yard	mode	enabled:	Icon	appears	when	Yard	Mode	is	enabled.		To	enable	or	disable
Yard	mode,	see	above.		You	can	also	disable	yard	mode	by	clicking	the	Y	icon.

The	TrainPlayer	control	panel	was	custom	designed	by	Rick	Fernandez	of	creativeblox.

http://www.creativeblox.com/


Layout	Publisher

For	copying	layout	components	to	an	output	folder.	Called	from	menu	command	File	>	Publish.

Publishing	a	layout	means	preparing	it	for	delivery	to	other	users:	checking	for	errors,	gathering
the	layout	and	image	files	in	one	place,	giving	the	files	uniform	names,	creating	a	thumbnail
image,	and	other	steps.

The	job	is	done	in	this	dialog.		It	does	not	modify	the	original	layout,	but	makes	a	new	copy	in	a
different	location.		The	new	copy	is	activated	and	remains	open	after	publishing.		If	you	edit
properties	in	this	dialog,	the	changes	will	apply	to	the	published	copy	only;	an	alternative	is	to
edit	the	properties	of	the	original	before	publishing.

Three	files	are	created	when	you	publish	a	layout:	<name>.rrw,	the	layout	file	in	xml	format;
<name>.jpg	[.gif,	.bmp,	etc.],	the	background	image	file	in	a	graphics	format;	and
<name_T>.jpg,	a	thumbnail	image	of	the	background.

To	publish	a	layout:

1.	 Inspect	the	Notes	box.		If	errors	are	reported,	cancel	the	dialog,	fix	the	errors,	and	try
again.		If	the	layout	has	links	to	external	files	or	car	collections,	you	should	publish	those
too.

2.	 Inspect	and	edit	Name	and	Comments.		These	should	be	made	presentable	for	other
users.		If	the	comment	box	is	empty,	you	should	add	descriptive	information	and	author
name.		You	might	consider	doing	this	to	the	original	layout	instead	of	here	--	cancel	this
dialog,	edit	in	Layout	Properties,	then	publish.

3.	 Choose	an	output	folder.		You	do	not	need	a	new	folder	for	each	layout	--	typically	you
have	one	output	folder	where	you	put	all	published	layouts.		If	this	layout	has	already	been
published	to	the	output	folder,	you	are	prompted	to	confirm	overwrite.

4.	 Inspect	the	output	filename.		Keep	this	name	simple	but	descriptive.		Warning:	if	there	are
other	layouts	with	links	to	this	one,	changing	the	filename	will	break	the	connections.



5.	 Click	Publish.		The	new	published	layout	is	created,	and	the	dialog	is	dismissed.	
6.	 If	you	want	to	send	the	layout	to	another	user,	zip	the	three	files	created	in	the	output

folder.

Dialog	controls:

Name
Name	of	the	layout.		This	can	be	any	name	you	like.		Changing
the	name	here	will	affect	only	the	published	layout,	not	the
original.

Comments Description	and	author.		If	this	box	is	blank,	please	provide
some	information	to	be	included	in	the	published	version.

Input	file Full	pathname	of	original	layout	file.		This	file	is	not	modified	by
the	publish	operation.

Output	folder
Destination	for	the	published	layout.		Three	new	files	will	go	in
this	folder.		To	select	a	new	output	folder,	use	the	Browse	(...)
button.

Output	file Name	to	be	given	to	the	published	layout	file.		This	is	usually
the	layout	name	plus	rrw	extension.

Notes Errors	encountered	while	processing,	list	of	external	links,	if
any.

Publish Click	to	carry	out	the	publish	operation.

Cancel Click	to	abort	without	publishing.

	



Missing	Car/Scenery	Alert

To	report	and	optionally	download	missing	cars	and	scenery.		Comes	up	automatically	if	you
open	a	layout	which	references	data	not	found	in	your	local	collection.

When	you	open	a	layout,	it	attempts	to	retrieve	the	required	cars	and	scenery	from	your	local
data	folder.		If	it	fails	to	find	some	of	them,	you	see	this	alert,	with	a	list	of	the	missing	items	in
the	window.		To	proceed,	you	have	four	choices.		Click	one:

Dialog	controls:

OK
Open	the	layout	without	the	missing	items.		Cars	not	found	are
converted	to	generic	types;	missing	scenery	objects	are
simply	omitted.		These	conversions	are	temporary;	the	next
time	you	open	the	layout,	you	will	get	this	alert	again.

Cancel Cancel	and	do	not	open	the	layout.

Download

Connect	to	the	web	and	look	for	missing	items	there.		If	a
missing	car	type	is	found	on	the	web,	the	entire	car	collection
is	downloaded	and	installed;	missing	scenery	items	are
downloaded	individually,	so	that	you	may	end	up	with	partially-
filled	scenery	folders	on	your	local	machine.

Convert
Permanently	convert	missing	cars	to	generic	types,	so	that	the
next	time	the	layout	is	saved,	the	missing	cars	will	be
dropped.		Applies	only	to	cars,	not	scenery.	



If	you	choose	to	download	missing	items,	you	may	not	get	all	of	them.		If	for	example	the	layout
author	included	custom	scenery	objects	not	in	the	TrainPlayer	collections,	then	the	download
will	not	retrieve	them.

	



Road	Styles	Dialog

The	Road	Styles	Dialog	is	used	to	create	and	manage	the	set	of	road	styles	belonging	to	a
layout.		It	is	called	up	from	(a)	the	Road	Styles...	button	in	Advanced	Layout	Properties	or	(b)
the	Road	Styles...	item	in	the	Style	drop-down	menu	in	Track	Properties.

For	background,	see	Road	Styles.		Road	styles	are	designed	and	named	in	this	dialog,	but	not
applied	to	tracks;	that	is	done	in	Track	Properties.	

The	Road	Styles	Dialog	has	a	tab	for	each	of	the	four	style	components.		Each	tab	shows
details	specific	to	that	component,	then	has	a	section	shared	by	all	tabs.

	

Tab-Specific	Controls

Show	<feature>	checkbox	at	the	upper	left	of	each	tab.		Check	to	turn	the	feature	on	in
the	current	road	style,	uncheck	to	turn	it	off.		In	the	Default	style,	the	state	of	this	checkbox
is	linked	to	toolbar	buttons*.

Color	button	--	displays	and	sets	the	color	of	the	feature.		In	the	case	of	roadbed,	applies
only	when	type	is	solid.	

Note:	handy	shortcut	--	right-click	any	color	button;	you	can	copy	and	paste	colors
between	color	buttons	in	all	dialogs.

Units	combo	on	some	tabs--	selects	units	for	all	dimension	values.		Any	choice	of	units
made	in	any	tab	applies	to	all	other	tabs.

Feature-specific	properties:



tab control units description

Line Weight pix thickness	of	track	center	line

Roadbed Solid	vs
Bitmap 	 whether	roadbed	is	solid	color	vs.	tiled	bitmap

pattern

	 Bitmap 	 path	of	bitmap	in	Scenery	folder;	click	(...)	to
browse

	 Width dim overall	width	of	roadbed
Ties Length dim length	of	each	tie;	see	diagram	>>
	 Width dim width	of	tie;	see	diagram	>>
	 Spacing dim distance	between	tie	centers;	see	diagram	>>
Rails Spacing dim distance	between	rails
	 Weight pix thickness	of	each	rail

Values	marked	dim	are	dimension	values,	displayed	and	edited	in	units	chosen	in	any	Units
combo.		Those	marked	pix	are	line	thickness	values	--	pixels	more	or	less,	but	scalable.

*	Note:	When	you	are	working	on	the	Default	style,	the	visibility	of	a	feature	as	given	by
the	Show	<feature>	checkbox	is	just	temporary.		Features	of	the	default	style	can	be
turned	on	and	off	in	this	dialog	but	also	outside	it	by	using	commands	on	the	View	Options
toolbar.

Common	Controls

Track	sample	diagram	--	shows	how	the	track	looks	according	to	the	current	choices	in
all	tabs.		To	enlarge	the	sample,	resize	the	dialog.

Selector	panel	--	used	to	move	among	the	set	of	styles	and	operate	on	them:

<	>	Arrows Click	to	choose	a	style	for	viewing	and	editing.		Dimmed	if	there	is
only	one;	use	the	Options	menu	to	create	a	new	one.

Name	box Shows	the	style	name.		Can	be	edited	in	all	styles	except	Default.
ID Shows	the	Road	Style	ID.		Assigned	by	program,	cannot	be	edited.
Options	button Click	to	display	the	Options	menu,	described	below.



OK,	Cancel	--	when	you	work	in	the	Road	Styles	dialog,	you	are	working	with	a	temporary
set	of	styles	copied	from	the	caller.		Click	OK	to	copy	the	modified	set	back	and	save	all
changes	made	to	any	style	on	any	tab.		Click	Cancel	to	discard	all	changes	and	leave	the
caller	unmodified.*

For	the	most	part,	modifying	the	road	style	set	is	undoable.		After	clicking	OK	in	the	Road
Styles	dialog,	you	may	use	Edit	>	Undo	to	revert	most	changes.*

*	Exception:	when	you	delete	a	style,	the	associated	tracks	revert	back	to	default.		This
operation	is	NOT	undoable,	nor	reversed	on	Cancel.

Options	Menu

The	Options	menu	provides	a	set	of	commands	which	for	the	most	part	operate	on	the	current
style.

Create	New	Style Adds	a	copy	of	the	default	style	to	the	end	of	the	list,	gives	it	an
ID	and	a	generic	name,	then	positions	to	it	for	editing.	

Delete	Style...
Deletes	the	current	style,	removes	it	from	the	list,	and	removes
references	to	it	from	any	connected	tracks,	which	then	revert	to
default	style.	(1)

Copy	Style Copies	the	current	style	to	the	clipboard,	suitable	for	pasting
into	a	style	in	this	or	another	layout.	(2)

Paste	Style Replaces	the	current	style	with	that	on	clipboard.		Dimmed	if	no
style	has	been	copied.

Select	By	This	Style Selects	all	tracks	on	layout	having	the	current	style,	and	reports
how	many	were	affected.	(3)

Make	This	The
Default...

Copies	the	current	style	into	global	registry	settings	so	it
becomes	the	default	for	new	layouts.		This	does	not	affect	the
current	layout.

Set	To	Factory	Default Sets	the	current	style	to	factory-supplied	settings.

1.		Delete	Style	asks	for	confirmation,	because	it	is	not	undoable	--	once	a	deleted	style	is
removed	from	associated	tracks,	it	cannot	be	restored,	except	by	closing	the	file	without
saving,	or	using	File	>	Revert	To	Saved.

2.		The	road	style	clipboard	is	internal,	not	associated	with	the	Windows	clipboard.	
Contents	of	the	road	style	clipboard	are	lost	on	program	exit.

3.		Select	By	This	Style	actually	searches	by	ID,	not	by	style.		It	finds	all	tracks	having	the
same	road	style	ID	as	the	current	choice	in	the	dialog,	whether	or	not	that	style	matches
what	is	showing	on	the	screen.		If	the	style	in	the	dialog	has	been	modified	but	not	yet
saved,	the	results	may	not	be	what	you	expect.



Track	Checker

For	testing	track	and	reporting	layout	condition.	Called	from	menu	commmand	Tools	>	Check
Track.

The	Track	(Layout)	Check	dialog	checks	your	layout	for	track	and	train	errors,	and	for	certain
non-error	conditions.		Use	this	dialog	to	check	for	mistakes	while	you	are	drawing	a	layout,	or
after	the	drawing	is	finished.		Also	use	it	to	inspect	a	layout	before	publishing	or	sending	to	a
friend.

Four	columns	are	shown	in	the	list	box:

Condition:	what	the	line	is	reporting	--	one	of	the	following:
track	or	junction	error
duplicate	car	or	train	ID
link	to	external	layout	(not	an	error)
required	car	collection	(not	an	error)

No.:	the	track	or	junction	number	where	the	error	occurred.		This	item	is	blank	for
conditions	other	than	track	errors.		Double-clicking	on	a	row	zooms	to	that	area,	as	long	as
there	is	a	track	or	junction	number	associated

Details:	nature	of	the	error,	name	of	the	linked	file,	or	other	information

Extra:	when	applicable,	an	additional	bit	of	information	depending	on	the	condition.		For
example,	"superimposed	junctions"	shows	one	of	the	two	junctions	in	the	No.	column,	the
other	under	Extra.

The	dialog	not	only	reports	errors,	but	helps	you	fix	them.		When	you	double-click	a	numbered
item	in	the	list,	it	zooms	in	and	highlights	the	track	or	junction	in	error.		The	dialog	is	modeless,
so	it	stays	up	while	you	fix	errors.

In	addition	to	reporting	errors,	the	Layout	Check	dialog	reports	if	your	layout	has	any	links	to
external	layouts,	or	requires	any	car	collections	not	normally	installed.		This	information	can	be
useful	if	you	are	planning	to	publish	the	layout.



Dialog	controls:

[list	box]
Displays	errors	and	external	links.

If	an	error	has	a	number	in	the	No.	column,	you	can	double-
click	that	line	to	zoom	in	and	highlight	the	error	area.

Refresh
Click	to	repeat	the	track	check,	for	example	after	you	have
fixed	an	error.		The	layout	is	rechecked	and	a	new	list	of
errors	presented.

Repair	IDs Click	to	repair	Duplicate	ID	errors.

Track	Errors

The	comprehensive	list	of	errors	reported	by	the	track	checker	is	given	here.		Many	of	these
are	designated	"internal,"	meaning	they	are	program	errors	a	user	should	not	see	unless	the
layout	has	been	corrupted.

Unspecified	error internal

Object	flagged	for	delete internal

Invalid	object	ID internal

Unretrievable	object internal

Invalid	junction	number	on	track internal

Same	junction	number	on	both	ends
of	track internal

Bad	track	length usually	means	there	is	an	invisible	track	of
zero	length

Invalid	station	number track	references	a	non-existent	station



Object	has	zero	space track	or	circle	is	defined	at	a	point

Jxn	has	no	tracks a	junction	exists	but	has	no	tracks	connected
to	it

Invalid	track	number	on	junction junction	references	a	non-existent	track

Superimposed	junctions two	junctions	are	very	close	together

Invalid	radius internal

Station	is	missing	name a	station	has	been	defined	with	a	blank	or
empty	name

Tracks	superimposed two	sections	of	track	share	the	same	line

Endpoint	on	track	but	no	junction one	track	almost	meets	another	but	does	not
connect

Duplicate	ID two	cars	or	trains	have	the	same	ID

Station	has	no	tracks station	is	not	connected	to	any	track

Most	of	these	errors	are	rare.		The	two	most	common	are	illustrated	in	the	diagram	above:

Endpoint	on	track	but	no	junction	(see	right-hand	red	circle	in	diagram):	one	track
endpoint	lies	near	another	track	but	doesn't	quite	touch	it.		Normally	this	indicates	you
meant	to	create	a	switch	but	didn't	quite.		The	fix	is	to	use	the	Edit	tool,	pick	up	the	stray
end,	and	drop	it	carefully	on	the	other	track.
	
Superimposed	junctions	(left-hand	circle):	means	two	junctions	are	very	close	together.	
Normally	this	means	you	meant	to	have	a	single	junction	but	accidentally	created	two
instead.		The	fix	is	to	move	one	junction	on	top	of	the	other,	so	they	fuse	into	one.		In	the
diagram,	the	problem	is	that	there	is	a	tiny	piece	of	stray	track;	the	fix	is	to	delete	it.

If	you	get	other	errors	and	can't	figure	them	out,	drop	us	a	note	and	send	the	rrw	file.		Most
problems	can	be	fixed	by	editing	the	rrw	file,	as	a	last	resort.



	

	



Clock	Settings

For	setting	clock	parameters.	Called	from	Settings	on	Clock	context	menu.

The	TrainPlayer	clock	has	properties	you	don't	find	in	an	ordinary	clock:	it	can	run	at	the	speed
of	your	choice,	and	with	one	click	it	can	be	reset	to	a	specific	time	when	you	want	your
operating	session	to	begin.		These	properties	are	set	in	this	dialog.		Some	of	these	settings	can
also	be	made	directly	from	the	context	menu.

Dialog	controls:

Start

Click	to	start	the	clock	running.		Button	is	dimmed	if	clock	is
already	running.	

Note:	the	clock	starts	automatically	whenever	it	is	visible	and
you	start	any	train	running.

Stop Click	to	stop	the	clock.

Reset Click	to	reset	clock	back	to	the	indicated	start	time.

Start	Time Time	the	clock	will	show	on	program	startup	and	on	reset.	
Default	is	5AM.

Speed	Factor
Clock	speed	as	a	multiple	of	wall	clock	speed.		Default	is	6,
meaning	the	TP	clock	runs	6	times	faster	than	a	wall	clock	--
one	TP	hour	goes	by	in	ten	actual	minutes.

Face Choose	Digital	or	not;	if	digital,	24-hour	or	not.		You	cannot
choose	a	font,	but	you	can	adjust	its	size	here.



For	more	information,	see	Clock.

	



Paint	Shop

For	painting	and	decorating	cars	and	engines.	Called	from	Tools	>	Paint	Shop	or	toolbar
button	 .		The	dialog	is	modeless	and	resizable,	and	works	on	one	car	at	a	time,	both	side
and	top	view.		To	bring	a	car	into	Paint	Shop,	click	to	select	the	car	on	the	layout.

For	background,	see	Decorating	Cars.

Tour	of	Paint	Shop

View

At	the	top	of	the	dialog	is	a	resizable	window	showing	the	working	car	image,	either	side	or	top
view	as	selected	by	the	view	choice	button.		Around	the	image	is	a	grey	frame	showing	the
image	bounds,	the	space	defined	by	the	image	file.		Decals	should	not	extend	beyond	these
bounds,	as	they	will	be	clipped	when	drawn	on	the	layout.

Note:	The	background	color	in	the	image	window	is	the	same	as	the	one	for	the	Train	Bar,	and
can	be	modified	in	Train	Bar	Settings.

Decals

The	decal	section	contains	a	button	to	bring	up	the	Decal	Chooser	--	a	gallery	of	pictures	you
can	drag	into	Paint	Shop	--	along	with	the	Drop	Transparent	checkbox,	specifying	how	a
picture	should	initially	look	when	dragged	in.		A	decal	brought	from	the	chooser	is	called	file-



based	because	it	is	from	an	image	file	in	the	Decals	folder;	to	create	other,	non-file-based
decal	types,	press	and	drag	as	described	below.

Colors

This	section	is	for	managing	the	list	of	color	changes	to	be	applied	to	the	car.		Each	item	in	the
list	has	two	colors:	the	FROM	color,	one	of	the	colors	in	the	original	image	file,	as	displayed	on
an	uneditable	swatch;	and	the	TO	color,	the	color	you	choose	to	replace	FROM,	as	displayed
on	an	interactive	color	button.		Clicking	the	button	brings	up	the		Color	Chooser,	updated	and
enhanced	for	use	with	Paint	Shop.

To	move	up	and	down	the	list	of	changes,	use	the	color	change	selector	buttons.		To	add	a
new	item	to	the	list,	start	by	choosing	a	FROM	color	using	Select	This	Color	(see	below),	then
click	the	right	button	to	choose	a	TO	color.

Note:	you	can	right-click	either	button	and	choose	Copy	Color.		You	can	then	Paste	Color	to
another	color	button.

Slider,	Gradient

The	slider	adjusts	the	"precision"	of	the	FROM	color.		At	the	left	end	(position	0),	it	selects
exactly	that	color	and	no	others.		Moving	to	the	right	selects	an	increasingly	wide	range	of
colors	around	the	one	shown,	until	at	the	right	end	(position	20),	FROM	contains	all	the	non-
background	colors.

The	Gradient	checkbox	specifies	how	the	selected	color	change	is	to	be	applied.		Unchecked
means	change	every	shade	in	the	FROM	band	to	the	single	TO	color.		Checked	means
"maintain	the	range"	when	converting	FROM	to	TO	--	convert	F	to	T,	F+1	to	T+1,	F-1	to	T-1,
etc.		This	has	the	effect	of	preserving	any	gradients	in	the	image	while	still	changing	the	base
color.

Text	Labels

Beneath	each	color	are	shown	its	RGB	values.		Below	those	are	the	current	list	position	and
slider	position.

Car	ID	identifies	the	car	you	are	working	on	and	its	collection.		Note:	to	see	the	raw	image
files,	select	the	car	on	the	layout	and	go	to	Properties	>	Collection	>	Images.

Below	the	Car	ID	is	an	area	for	status	messages,	such	as	when	you	are	pointing	to	a	decal.

Paint	Shop	Mouse	and	Keyboard	Actions

When	you	move	the	mouse	over	a	decal,	it	is	highlighted	with	a	frame,	and	its	description
appears	at	the	lower	left	of	the	dialog.	The	cursor	is	a	4-	or	2-headed	arrow,	indicating	that	you
can	(a)	press	and	drag	to	move	or	resize	the	decal	in	that	direction,	or	(b)	press	an	arrow	key
to	move	by	one	pixel.



When	you	are	not	on	a	decal,	or	when	Shift	is	down,	the	cursor	is	a	plus	(+).		Press	and	drag
to	create	a	new	solid	white	decal.	When	you	release	the	drag,	Decal	Properties	comes	up	for
you	to	specify	type	and	details.

To	create	a	new	decal	on	top	of	an	existing	one,	press	Shift	before	you	drag.	

To	create	a	copy	of	a	decal,	point	to	it	and	press	Ctrl,	then	drag.

These	keyboard	accelerators	are	hard-coded	in	Paint	Shop	and	not	customizable:	Ctrl+C/X/V	=
Copy/Cut/Paste,	Ctrl+Z/Y	=	Undo/Redo,	Del	=	Delete.

Paint	Shop	Menu

Comes	up	on	right-press	at	a	point	where	there	are	no	decals,	or	at	any	point	when	Shift	is
down.

Select	This	Color

pick	the	color	where	the	mouse	button	was	pressed.		Dimmed	if	pointing	to
the	background	color.	Normally	creates	a	new	entry	in	the	color-change	list,
with	the	selection	shown	as	both	FROM	and	TO	and	the	slider	set	to
default.		If	the	selected	color	is	already	in	the	list	as	either	FROM	or	TO,	then
that	entry	becomes	active.	

Paste	Decal
if	a	decal	has	been	copied	to	the	clipboard	(using	Copy	Decal,	below),	this
command	pastes	a	copy	of	it	at	the	cursor	position.		Command	is	dimmed	if
there	is	no	decal	on	the	clipboard.

Undo,	Redo revert	or	restore	the	last	Paint	Shop	action	--	color	change,	decal	move,
property	change.

Show	All	Decals display	highlight	frames	around	all	decals	at	once.		To	remove	the	highlights,
click	anywhere.

Revert	to	Factory
remove	all	or	part	of	the	paint	job	from	the	current	view.		A	confirmation
dialog	offers	the	choice	of	deleting	all	decals,	or	removing	all	color	changes,
or	both.

Decal	Menu

Comes	up	on	right-press	within	a	decal.		Commands	apply	to	the	highlighted	decal	only.

Copy,	Cut,	Delete these	edit	commands	apply	to	the	highlighted	decal

Position	commands these	move	the	highlighted	decal	higher	or	lower	in	the	display
order.		Applicable	to	all	types	except	mask	regions.

Transparent
(file-based	decal	only):	toggle	background	transparency	on	or	off.	
This	is	a	shortcut;	it	can	also	be	done	in	Decal	Properties,	or	by
setting	the	Drop	Transparent	check	and	then	dragging	a	decal	in
from	the	chooser.

Lock	Proportions toggle	the	ability	to	change	proportions	upon	resizing.		Defaults	to
on	(checked)	for	any	decal	dragged	in	from	the	chooser.



Flip (file-based	decal	only):	invert	the	image	horizontally	or	vertically	or
both.

Edit	in	Paint

(file-based	decal	only):	open	the	image	file	in	MS	Paint	(or	your
choice	of	editor	--	see	under	editing	car	images).		Caution:	if	you
modify	the	image	in	Paint	and	save	it,	you	will	overwrite	the	factory
version.		To	see	the	changes	in	the	Decal	Chooser,	refresh	it	or
close	and	reopen.

Return	to	Clone	Site
(clone	region	only):	move	the	clone	region	back	to	the	location
where	it	was	originally	defined.		This	original	site	is	highlighted	with
a	green	outline	whenever	you	press	on	the	clone	region.

Properties bring	up	the	Decal	Properties	dialog,	to	set	decal	type	and	details.

Decal	Properties

Decal	Properties	is	a	modal	dialog	brought	up	(a)	from	Properties...	on	the	menu,	or	(b)
automatically	whenever	you	drag	out	a	new	rectangle.

Decal	Type	is	one	of	seven	choices.		The	selected	type	determines	the	meaning	of	the	three
dialog	controls:	the	edit	box,	the	browse	(...)	button,	and	the	color	button.

Decal	Transparent File-based	decal	with	native	background.		Edit	box	shows	the	image	pathname	relative	to	the
Decals	folder.		Browse	button	brings	up	the	Decal	Chooser.		Color	button	is	not	used.

Decal	Opaque File-based	decal	with	transparent	background.		Controls	same	as	above.

Solid	Color Rectangle	of	solid	color.		Color	button	is	active,	others	do	not	apply	and	are	dimmed.

Mask	Region Rectangle	where	all	color	changes	are	prevented.		No	controls	apply.

Text	Box
Text	string	with	transparent	background.		Edit	box	shows	the	text	to	be	displayed.		Browse
button	brings	up	the	Font	dialog.		Text	color	may	be	selected	there,	or	by	using	the	color
button.

Clone	Region Rectangle	of	paint	copied	from	original	location.		No	controls	apply.

See-Through	Region Rectangular	invisible	region..		No	controls	apply.

Shaded	Cylinder Horizontal	cylinder	with	shading	gradient	from	darker	than	selected	color	to	lighter.



Wireframe Rectangular	region	which	picks	up	dark	lines	to	be	applied	on	top	of	other	coloring.

Paint	Shop	How-Tos

How	Paint	Your	Car

Factory	car:	buttons	show	primary	color TO	color	changed

1.	 Bring	up	Paint	Shop.		Bring	in	the	car	by	clicking	it	on	the	layout	or	train	bar.		Choose	the
view	to	work	on	(side	or	top).		The	TO	and	FROM	colors	are	automatically	set	to	the
primary	color	of	the	image	(as	shown	above	left).

2.	 Click	to	TO	button	and	choose	a	new	primary	color	(for	example	as	above	right).
3.	 If	the	color	does	not	fill	the	area	you	want,	experiment	with	the	slider.		Moving	it	to	the	right

causes	a	wider	range	of	FROM	values	to	convert	to	TO.
4.	 To	make	a	second	color	change,	point	to	a	pixel	of	the	second	color,	right-click	and	choose

Select	This	Color.	
5.	 Repeat	steps	2-3	until	the	second	change	looks	good.
6.	 Continue	for	as	many	color	changes	as	you	need.		Use	Undo	to	go	back	a	step,	or	Revert

to	Factory	to	remove	all	and	start	over.		Use	Apply	or	OK	to	apply	the	paint	job	to	the	car
on	the	layout.

How	to	Apply	Regular	Decals



Dragging	a	decal	from	chooser	to	car

1.	 Click	the	Chooser	button	to	bring	up	the	Decal	Chooser.
2.	 Navigate	to	the	image	you	want.		Drag	it	onto	the	car	in	Paint	Shop	(for	example	as

illustrated).
3.	 Slide	it	into	position	and	resize	as	needed.		Note	that	the	initial	relative	size	of	decal	to	car

can	be	adjusted	by	resizing	the	Paint	Shop	window	before	dragging	the	decal.
4.	 By	default,	the	decal	shape	is	locked	--	resizing	can	only	be	done	by	dragging	a	corner,

retaining	proportions.		To	unlock,	right-click	and	uncheck	Lock	Proportions.
5.	 To	create	a	second	copy,	press	Ctrl	and	drag	the	decal.		If	you	have	overlapping	decals,

use	position	commands	(Bring	to	Front,	etc.)	to	set	the	order.

How	to	Hide	Old	Decorations

Many	car	images	come	with	logos,	lettering,	and	other	decorations	you	want	to	hide	before
applying	your	own	scheme.		The	left	picture	shows	an	example	--	say	we	want	to	cover	the
block	of	lettering	shown.

Creating	clone	region	on	blank	space Moving	region Result

One	way	is	to	create	a	decal	of	solid	color	covering	the	block.		This	is	straightforward,	but
works	only	if	the	car	has	a	uniform	color.		A	more	general	method	is	to	use	a	Clone	Region,	as
follows:

1.	 Locate	a	blank	area	the	size	and	shape	of	the	area	to	be	covered.	
2.	 Drag	to	create	a	new	decal	on	that	area,	and	choose	its	type	as	Clone	Region.		Click	OK,



and	you'll	get	a	highlight	frame	around	the	new	CR	(see	picture	at	left).
3.	 Drag	the	CR	on	top	of	the	area	to	be	covered	(middle	picture).		While	you	drag,	the

original	site	of	the	clone	is	highlighted	with	a	thick	green	frame.		This	happens	whenever
you	point	to	a	CR	and	press	the	mouse.

4.	 Let	go	and	observe	the	result	(right	picture).		You	can	resize	the	CR	a	little	if	necessary.
5.	 The	context	menu	for	a	CR	includes	the	command	Return	to	Clone	Site.		This	moves	the

CR	back	to	where	it	was	originally	defined.	
6.	 If	you	want	to	redefine	the	clone	site,	(a)	move	the	CR	to	the	new	site,	(b)	right-click	and

choose	Properties,	(c)	click	OK.

How	to	Create	Your	Own	Decals

If	you	have	a	graphic	file	you	would	like	to	use	as	a	decal,	all	you	have	to	do	is	place	it	in	your
Decals	folder	(or	any	subfolder).		Close	and	reopen	the	Decal	Chooser,	and	you	should	see	the
new	image,	ready	to	use.

Caution:	if	you	use	one	of	your	own	decals	in	a	layout,	then	want	to	share	that	layout	with
another	user,	you	will	need	to	supply	the	decal,	along	with	instructions	about	where	to	put	it.	
The	program	doesn't	provide	support	for	this	situation.

How	to	Create	a	Shaded	Tankcar

1.	 Start	with	a	tankcar.		Drag	a	decal	over	the	body	of	the	tank	and	select	Shaded	Cylinder:

2.	 Choose	a	base	color	for	the	cylinder,	using	the	Color	button.
3.	 Click	OK,	and	you	get	a	result	like	this:

The	chosen	color	forms	two	stripes,	at	1/4	and	3/4	of	the	decal	height,	and	other	stripes	are
generated	to	give	a	smooth	gradient	both	darker	and	lighter	than	the	base	color.

How	to	Work	with	Wireframes



Wireframe	decals	are	useful	for	painting	certain	cars	which	have	dark	details.		Many	of	the
Chris	Pedersen	cars	are	in	this	category.		What	you	do	is	create	a	wireframe	decal	to	capture
the	details,	then	erase	or	repaint	the	car,	then	apply	the	decal	on	top.

1.	 Start	with	a	car	image	having	dark	lines	you	wish	to	capture.		Below	for	example	is	a
Pedersen	boxcar	with	dark	framing.

2.	 Drag	a	decal	over	the	body	and	select	Wireframe.
3.	 Click	OK	and	nothing	appears	to	happen,	but	in	fact	you	have	created	a	new	decal	which	is

positioned	exactly	over	the	image.		Below	left	shows	after	moving	the	new	wireframe	decal
off	the	image	so	you	can	see	it.

4.	 Now	you	can	apply	a	solid-color	decal	on	top	of	the	original	image,	then	put	the	wireframe
on	top	of	that,	and	you	get	the	result	shown	on	the	right.

							



Color	Chooser

For	selecting	colors.		Called	via	color	buttons	on	several	dialogs.

The	Color	Chooser	offers	two	panels	for	selecting	colors	("palettes"):	a	64-cell	hexagonal	grid
of	standard	colors	(shown	below	left)	vs.	a	rainbow	spectrum	with	luminance	slider	(right).	
Click	the	Palette	button	to	toggle	between	these	modes.

					

To	select	a	color,	do	one	of:

Click	a	color	in	the	panel,	then	click	OK.
Double-click	a	color	in	the	panel.
Enter	numbers	in	the	text	boxes	to	specifyHue/Saturation/Luminance	or	Red/Green/Blue



values.
Click	the	Select	button,	then	move	the	cursor	around	the	screen	(including	outside	the
application	window)	and	click	when	you	find	the	color	you	want.		The	New	box	updates	as
you	move,	showing	the	color	under	the	cursor.

Dialog	controls:

Color	panel
One	of	the	two	palettes	described	above.		In	the	full-spectrum
mode,	you	can	cover	the	full	range	of	colors	by	dragging	the
white	cursor	and	the	vertical	slider.

Select
Click	to	change	cursor	to	an	eyedropper,	then	move	the
dropper	around	the	screen	until	New	shows	the	color	you	want,
then	click.		To	cancel,	press	ESC.

New/Current
New	shows	the	color	you	will	select	by	clicking	OK.		Current
shows	the	original	color	in	effect	when	the	dialog	was	brought
up	(the	one	you	will	replace).		The	New	color	is	also	reflected	in
the	HSL	and	RGB	values,	and	by	a	highlight	in	the	color	panel.

Palette Click	to	toggle	between	color	panels.

Hue/Sat/Lum
Values	showing	the	New	color	in	HSL	(hue,	saturation,
luminance	or	lightness)	representation.		Adjust	to	suit.		Note
that	as	you	drag	the	cursor	around	the	rainbow	palette,	the
luminance	value	stays	fixed.

Red/Green/BlueValues	showing	the	New	color	in	RGB	representation.		Adjust	tosuit.
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